
March 2013Greg M. Pohll
Rosemary W.H. Carroll 
Donald M. Reeves 
Rishi Parashar 
Balasingam Muhunthan 
Sutharsan Thiyagarjah 
Tom Badger 
Steve Lowell 
Kim A. Willoughby

WA-RD 787.1

Office of Research & Library Services

WSDOT Research Report

Design Guidelines for
Horizontal Drains used for
Slope Stabilization



 



Design	Guidelines	for	

Horizontal	Drains	used	for	

Slope	Stabilization	

 
 

 

Greg M. Pohll, DRI 

Rosemary W.H. Carroll, DRI 

Donald M. Reeves, DRI 

Rishi Parashar, DRI 

Balasingam Muhunthan, WSU 

Sutharsan Thiyagarjah, WSU 

Tom Badger, WSDOT 

Steve Lowell, WSDOT 

Kim A. Willoughby, WSDOT 

 

  



 
ii 

1. REPORT NO. 2. GOVERNMENT ACCESSION 

NO. 
3. RECIPIENTS CATALOG NO 

WA-RD 787.1   

4. TITLE AND SUBTITLE 5. REPORT DATE 

Design Guidelines for Horizontal Drains used for Slope 

Stabilization 

March 2013 

6. PERFORMING ORGANIZATION CODE 
 

7.  AUTHOR(S) 8. PERFORMING ORGANIZATION REPORT NO. 

Greg M. Pohll, Rosemary W.H. Carroll, Donald M. Reeves, Rishi 

Parashar,Balasingam Muhunthan, Sutharsan Thiyagariah, Tom 

Badger, Steve Lowell, Kim A. Willoughby 

 

9. PERFORMING ORGANIZATION NAME AND ADDRESS 10. WORK UNIT NO. 

Desert Research Institute 

2215 Raggio Parkway 

Reno, NV 89512 

 

11. CONTRACT OR GRANT NO. 

GCA6381 

12. CO-SPONSORING AGENCY NAME AND ADDRESS 13. TYPE OF REPORT AND PERIOD COVERED 

Washington State Department of Transportation 

310 Maple Park Ave SE 

Olympia, WA 98504-7372 

Research Manager: Kim Willoughby 360.705.7978 

Final Report 

14. SPONSORING AGENCY CODE 

 

15. SUPPLEMENTARY NOTES 

This study was conducted in cooperation with the U.S. Department of Transportation, Federal Highway 

Administration through the pooled fund, TPF-5(151) in cooperation with the state DOT’s of California, 

Maryland, Mississippi, Montana, New Hampshire, Ohio, Pennsylvania, Texas, Washington and 

Wyoming. 

16. ABSTRACT 

The presence of water is one of the most critical factors contributing to the instability of hillslopes. A common 

solution to stabilize hillslopes is installation of horizontal drains to decrease the elevation of the water table 

surface.  Lowering the water table dries a large portion of the hillslope which increases the shear strength of the 

soil, thereby decreasing the probability of slope failure.  The purpose of this manual is to provide a single 

comprehensive reference for geotechnical engineers and hydrogeologists on designing horizontal drainage 

systems to improve slope stability.  Guidelines are provided for translational and rotational failure and consider 

fractured systems.  Basics of hydrogeologic and geotechnical terminology, site characterization and 

conceptualization, groundwater modeling techniques and template projects help to guide the user with respect 

to identifying important parameters to drainage design.   An iterative approach is presented for determining the 

minimum drain construction to lower water levels enough to keep the factor of safety (FOS) greater than 1.2. 

17. KEY WORDS 18. DISTRIBUTION STATEMENT 

Subsurface drainage, slope stabilization, horizontal 

drains 

 

19. SECURITY CLASSIF. (of this report) 20. SECURITY CLASSIF. (of this page) 21. NO. OF PAGES 22. PRICE 

None None 377  

  



 
iii 

ACKNOWLEDGMENTS 

 

Funding for this project was obtained from the Washington State Department of Transportation through 

the Transportation Pooled Fund, TPF-5(151). The partner states of TPF-5(151) included: California, 

Maryland, Mississippi, Montana, New Hampshire, Ohio, Pennsylvania, Texas, Washington and Wyoming. 

The DRI contract was 650-646-0250. 

Project oversight and data transfer was facilitated by Tom Badger, Steve Lowell and Kim Willoughby with 

the Washington State Department of Transportation (WSDOT).  Geotechnical modeling was 

accomplished by Dr. Balasingam Muhunthan and doctoral student Sutharsan Thiyagarjah from 

Washington State University (WSU). The Desert Research Institute (DRI) performed all hydrologic 

analysis.  Dr. Greg Pohll acted as project manager, Dr. Rosemary Carroll performed all modeling and Dr. 

Donald Reeves and Dr. Rishi Parashar conducted all fracture analysis.  

DISCLAIMER 

The contents of this report reflect the views of the authors, who are responsible for the facts and the 

accuracy of the data presented herein. The contents do not necessarily reflect the official views or 

policies of the Washington State Department of Transportation or the Federal Highway Administration. 

This report does not constitute a standard, specification, or regulation.  

 

Authorship of the document: 

Chapter 1 – Greg Pohll 

Chapter 2 – Balasingam Muhunthan  

Sutharsan Thiyagarjah 

Chapter 3 – Rosemary Carroll 

Chapter 4 – Rosemary Carroll 

Donald M. Reeves 

Rishi Parashar 

Balasingam Muhunthan 

Sutharsan Thiyagarjah 

Chapter 5 – Rosemary Carroll 

Chapter 6 – Rosemary Carroll 

Chapter 7 – Rosemary Carroll 

Balasingam Muhunthan 

Sutharsan Thiyagarjah 

Chapter 8 – Donald M. Reeves 

Rishi Parashar 

Chapter 9 – Rosemary Carroll 

Appendices A-D – Rosemary Carroll 

  



 
iv 

EXECUTIVE SUMMARY 

 

The presence of water is one of the most critical factors contributing to the instability of hillslopes. A 

common solution to stabilize hillslopes is installation of horizontal drains to decrease the elevation of 

the water table surface.  Lowering the water table dries a large portion of the hillslope which increases 

the shear strength of the soil, thereby decreasing the probability of slope failure.  The purpose of this 

manual is to provide a single comprehensive reference for geotechnical engineers and hydrogeologists 

on designing horizontal drainage systems to improve slope stability.  Guidelines are provided for 

translational and rotational failure and consider fractured systems.  Basics of hydrogeologic and 

geotechnical terminology, site characterization and conceptualization, groundwater modeling 

techniques and template projects help to guide the user with respect to identifying important 

parameters to drainage design.   An iterative approach is presented for determining the minimum drain 

construction to lower water levels enough to keep the factor of safety (FOS) greater than 1.2.   

Simple systems may only require an analytic approach to computing maximum water levels. Techniques 

are supplied for steady state conditions given a flat surface, a sloped surface less than 10° and a 

discussion is provided on the influence of recharge and hydraulic conductivity on drainage design.  

Analytic equations for transient solutions for a flat surface are given for different drain depths with 

respect to the impermeable barrier as well as for sloping surface with a declining water table over time. 

Past research has found that flow to ditches; water table elevation and the rate of water table decline 

were independent of slope for slopes less than 15-30%.  For these relatively shallower slopes, flat-

surfaced assumptions can be maintained with little error.  In all cases drainage design based on analytic 

(and graphical) approaches is focused only on drain spacing or the location of the first interceptor drain 

in a sloped system.  However, analytic results can be used to assess impact of system response to 

lowering the overall water table prior to a rapid rise caused by a large storm event.   

Irregular drain networks, heterogeneous or anisotropic aquifer conditions, complex slope geometry, a 

rapid rise in pore pressures, as well as fractured rock network may mandate a numeric modeling 

approach.  As a general rule, drains installed a significant distance into the hillslide at the lowest possible 

elevation, will capture the majority of groundwater and have the largest effect on lowering the water 

table.  Drains located in the upper region of a slope are found to have no real significance if additional 

deeper drains are in the lower part of a slope as the water table will eventually be reduced to the lowest 

drain level and any drains above the lowest-most drain will no longer be effective. The only exception to 

this rule might be for site conditions that have the ability to setup significant perched water table 

conditions.  

Translational failure of thin geologic sections is found more sensitive to water level increases in the 

upper slope compared to groundwater seepage in the lower slope.  In contrast, rotational failure in the 

slope toe is susceptible to rising pore pressers in the lower slope region.  In both cases, toe drains should 

be installed, with length and density of drain network increasing with decreasing hydraulic conductivity 

and storage and with increasing anisotropy.  Horizontal drains may be ineffectual at promoting slope 

stability in low conductive soils with low storage.  The ability to stabilize slopes with horizontal drains 

declines for all soil types with increased anisotropy. 
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Chapter	1	

Introduction	

1.1 Problem Statement 

The presence of water is one of the most critical factors contributing to the instability of hillslopes.  A 

common solution to improve the stability of hillslopes is the installation of horizontal drains to decrease 

the elevation of the water table surface and reduce pore pressures within the effected soil/rock units.  

Reduction of water pressures results in a corresponding increase in the shear strength of soil or 

decrease in hydrostatic pressures within discontinuities in a fractured rock mass, thereby improving 

slope stability.  

Due to the complex geometry of slopes and subsurface conditions, the heterogeneity and anisotropic 

nature of hydraulic conductivity, and the transient nature of the groundwater, the design of such drains 

for hillslope drainage can be a difficult task.  Aquifer characterization and groundwater modeling 

techniques common to hydrogeologic practice are generally not well known or routinely employed in 

the geotechnical practice of stabilizing slopes with subsurface drainage by governmental transportation, 

public works, and resource agencies.  The reasons for this might be attributed to the higher investigation 

costs for adequate hydrogeologic characterization, as compared to a more standard geotechnical 

investigation, and the necessary knowledge or experience in this discipline that many geotechnical 

specialists lack.  Furthermore, while a wealth of literature exists for the design of drainage systems in 

relatively flat irrigated areas (e.g., Maasland, 1940; Donnan, 1946; Israelsen, 1950; Talsma & Haskew, 

1959; Kirkham, 1958;U.S. Department of the Interior, 1978), robust design approaches for hillslope 

drainage are not readily available. As a result, subsurface drains for hillslopes have often been installed 

in a makeshift manner with varying degrees of success.  

The purpose of this manual is to consolidate information related to, and provide guidance for, the 

design of horizontal drains for slope stability.  The design guidance provides the necessary information 

and techniques to better characterize the hydrogeology and then estimate water levels under drained 

conditions, applying a clear methodology.  The approach taken is to provide options for the geotechnical 

designer such that the hydrogeologic analysis can be tailored for site-specific conditions.  For example, a 

straightforward approach to drainage design using currently available analytic/graphical methods may 

be appropriate for hillslopes with simple geologic and hydrogeologic regimes. In other instances, 

subsurface conditions may be sufficiently complex to require additional characterization and numerical 

modeling of the groundwater system.  Ultimately, geotechnical designers will be able to use this 

guidance to better assess hydrogeologic conditions and develop a drainage design to improve slope 

stability with more predictable results and optimal efficiencies.  
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1.2 Background 

As the intended audience for this manual is primarily the geotechnical specialist, only a brief overview of 

slope stability analysis involving common failure modes in soil and rock and the associated contribution 

of groundwater are provided in Chapter 2. 

Numerous textbooks, peer-reviewed journal articles, and agency reports (e.g. U.S. Geological Survey, 

U.S. Bureau of Reclamation, etc.) exist that describe how to collect and analyze hydrogeologic data.  

Some of the more popular hydrogeology textbooks include Freeze & Cherry (1979), Fetter (1996; 2001), 

Domenico & Schwartz (1990), and Driscoll (1986).  Although there are a number of similarities amongst 

these textbooks, each one has a slightly different focus.  The critical elements of hydrogeologic science 

are summarized in Chapter 3 of this manual.  Topics such as hydraulic head, fluid potential, Darcy’s Law, 

hydraulic conductivity, permeability, anisotropy and heterogeneity are summarized for those less 

familiar with these concepts.  These textbooks, along with  other references, such as, Jacob (1940), 

Cooper & Jacob (1946), and Papadopulos, et al. (1973),  and Bennett (1976), provide excellent sources 

for the measurement of hydrogeologic parameters (i.e. hydraulic conductivity, and storage parameters) 

using slug and pumping tests, with only rudimentary discussion provided here. 

Another important component to characterizing a site is the construction of a conceptual hydrogeologic 

model.  Anderson & Woessner (1991) provide an excellent overview of this process.  Regardless of the 

complexity of site conditions, a conceptual model provides a simplification of the field conditions and 

organization of the associated field data so the system can be analyzed more readily.  Typical data 

sources for a hydrogeologic assessment include: 

• Geologic maps and cross sections 

• Topographic maps and digital terrain models 

• Maps of surface water features such as streams and springs 

• Water table and potentiometric maps 

• Generalized maps of hydraulic conductivity distributions 

• A groundwater budget including rates of groundwater recharge, evapotranspiration, and any 

natural groundwater inflows and outflows 

This information is detailed in Chapter 4 of the manual to provide a basis for the groundwater 

characterization effort.   

The need for a design method for drains has been noted by several researchers and various charts and 

diagrams were initially developed to aid in the analysis and design of drains (Choi, 1974; Kenney et al., 

1978; Prellwitz, 1978; Nonveiller, 1981).  Typically, they describe effectiveness in terms of increased 

factor of safety (ratio of shear strength to shear stress) once horizontal drains are installed.  In addition, 

some early studies on drainage design for slope stability employed physical and centrifuge modeling 

techniques on idealized slopes (Kennedy et al. 1977; Resnick and Znidarcic 1991), but these tools have 

yet to be calibrated against field data. 
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There have been a few studies (Royster, 1980; Lau & Kenney, 1984; Martin et al., 1994, Pathmanathan, 

2009), which attempted to describe in part the many parameters controlling the horizontal drainage 

design or evaluate the feasibility of using a system of horizontal drains to lower groundwater levels in 

hillsides (e.g., Craig and Gray, 1985). For example, Martin et al., 1994 suggested that a small number of 

drains installed at appropriate locations in accordance with a well-conceived conceptual groundwater 

model may be more effective than a large number of drains installed at uniform spacing over the slope. 

Presently, there isn’t a single comprehensive reference within the geotechnical literature that provides 

practical guidelines for the design of subsurface drainage for improving slope stability. 

Existing drainage design guidelines fall into two distinct categories: steady-state, and transient-based 

methods.  Since slope stability problems commonly occur during or shortly following intense 

precipitation events, over relatively short periods, the steady-state design equations may not be 

appropriate for drainage design for slope stability. The transient design equations rely on analytic 

solutions to the groundwater flow equation and require a number of simplifying assumptions such as 

parallel and regularly spaced subsurface drains, and homogeneous hydraulic conductivity.  Although 

these conditions may not be met in real field situations, the analytic design equations may still prove 

useful for preliminary design purposes.   

Research developed over the last seven decades provides numerous analytic solutions for a variety of 

field conditions and assumptions.  Hooghoudt (1940) presented one of the first design equations for 

subsurface drainage conditions and this method falls into the steady-state category.  U.S. Department of 

Interior (1978) provides useful transient design equations to determine appropriate drain spacing and 

depth.  The U.S. Department of Interior (1978) method was developed for flat conditions, but other 

researchers have found that it is applicable for steep slopes (Ram & Chauhan, 1987).  The equations 

require an estimate of the hydraulic conductivity (K), specific yield (Sy), and the depth to an 

impermeable barrier.  The design manual also provides a relationship between rainfall and the amount 

of rainfall and infiltration that becomes groundwater recharge.  The trial-and-error solution begins with 

a measured pre-drainage water table elevation, and then curves are provided that relate maximum 

water table height to hydrogeologic parameters (K and Sy), groundwater recharge, and drain spacing and 

depth.  Drain spacing and depth are adjusted until the maximum water table height is lower than a pre-

defined design condition.   

Drainage of sloping lands has been discussed by many writers (Bouwer, 1955; Schmid & Luthin, 1964; 

Wooding & Chapman, 1966; Childs, 1971; Towner, 1975; Lesaffre, 1987; Lesaffre & Zimmer, 1988; Ram 

& Chauhan, 1987; Fipps & Skaggs, 1989), but it has seldom been studied in transient conditions with 

variable recharge.  Furthermore, limited in situ investigations and model validations have been carried 

out.  Most of the validation has been achieved by use of Hele-Shaw viscous flow models, such as the one 

developed by Luthin & Guitjens (1967) and Marei & Towner (1975). Results indicated that slopes up to 

30% have little effect on the designed drain spacing, and this result was confirmed by Chauhan et al. 

(1968) and Childs (1971). Benoıt & Bornstein (1972) focused on the hydrologic drainage functioning of a 

transverse sloping system. Lesaffre (1987) demonstrated that under steady-state conditions, the 

influence of slope depends on the ratio between the net recharge rate and the saturated hydraulic 

conductivity.  More importantly, these papers provide analytic, semi-analytic, or graphical solutions to 
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aid in the design of drainage systems on sloping land.  Hartani et al. (2003) incorporated these drainage 

solutions into the drainage model SIDRA, which simulates hourly values of water table elevations and 

drain flow rates. 

In many situations, the complexity of the field site requires the use of a numerical model to develop 

accurate estimates of water table position under drainage conditions.  Highly heterogeneous hydraulic 

conductivity fields (e.g. fractured systems) and/or complex drainage geometries are examples of 

conditions that require a more robust modeling approach.  Cai, et al. (1998) simulated the effect of 

horizontal drains on the water table position using a three-dimensional finite element model.  They 

extended the modeling effort by integrating a three-dimensional, elasto-plastic shear strength, finite 

element model to calculate a global safety factor.  The model was used to investigate the influence of 

drain spacing, orientation, and length; rainfall intensity; and hydraulic conductivity on the increase in the 

safety factor.  Their research found the safety factor is linearly dependent on pressure heads near the 

slope surface.   

Rahardjo et al. (2003) performed a rigorous measurement campaign combined with numerical modeling 

to determine the effectiveness of horizontal drains for slope stability.  One of the key findings is that 

shallow drains are ineffective in improving the stability of a slope and drains are most effective when 

placed at the lowest elevation possible.  The basic tenet is to lower the main water table, with less 

emphasis placed on direct capture of infiltration.  If installed a significant distance into the hillside at the 

lowest possible elevation, drains will capture the majority of groundwater and have the largest effect on 

lowering the water table.  These results are also consistent with the research findings of Lau & Kenney 

(1984) and Martin et al. (1994).  

There are a variety of numerical groundwater models that can be used to analyze the impact of drainage 

systems on water table behavior.  In general there are two main categories of groundwater models: fully 

saturated and saturated/unsaturated models.  MODFLOW (Harbaugh, et al., 2000) is, by far, the most 

popular saturated groundwater flow model used by hydrogeologists.  One reason for its popularity is its 

modular structure, which allows developers to easily incorporate packages to simulate a variety of 

subsurface processes.  Two such packages that are useful for drainage analysis include the “drain 

package” and the “unsaturated-zone flow package”.  The drain package has been used for over two 

decades to simulate subsurface drainage (e.g. Pohll & Guitjens, 1994).  The recent addition of the 

unsaturated-zone flow package allows one to simulate the vadose zone in an efficient manner 

(Niswonger et al., 2006).  Given the results of Rahardjo, et al. (2003), unsaturated zone analysis may not 

be necessary for most sites.  The use of the unsaturated zone package may prove useful for cases where 

the exact timing of flow through the vadose zone to the saturated groundwater system becomes 

important. Most recently, the U.S. Geological Survey released the GSFLOW model which is a fully 

coupled ground-water and surface-water flow model based on PRMS and MODFLOW (Markstrom et al., 

2008).  Although this model would provide the most rigorous analysis for drainage design by linking 

surface and groundwater processes, site-specific models require numerous input parameters, significant 

pre-processing, and calibration before they can be used effectively. As such, it is unlikely that complex 

models such as GSFLOW would be used for regular analysis of slope stability problems.  
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1.3 Objective of Manual 

The primary focus of the design manual is to provide hydrogeologic assistance to geotechnical 

engineers.  Specific objectives include: 

1. To review all applicable literature related to the design of subsurface drainage systems. 

2. To develop a standard protocol for proper hydrogeologic site characterization using standard 

and accepted methodologies common to geotechnical and hydrogeological practice. 

3. Select design guidelines that utilize both analytic and numerical models to cover a wide range of 

field conditions.  

4. Validate selected design methodologies against field data. 

5. Provide charts, equations, and useful numerical models for the optimal design of a subsurface 

drainage system. 

Benefits to users of this manual include: 

• A single comprehensive reference that can be used by geotechnical engineers and 

hydrogeologists to design horizontal drainage systems to increase slope stability. 

• Safety of unstable slopes and landslides should increase significantly as designs mitigating 

subsurface drainage are better understood. 

• As drainage systems become better understood, they will most likely be used more extensively 

for slope stabilization which will significantly reduce expenditures for slope stabilization, 

improve performance, and provide for more rapid installation. 

• Drainage designs should become more efficient and cost-effective. 

• Construction projects using these designs should have more predictable results. 

The manual is organized into nine chapters and four appendices: 

Chapter 1: Provides an overview of the problem and a review of previous research relevant to objectives 

of this work. 

Chapter 2: Briefly presents slope stability analysis involving common failure modes in soil and rock and 

the associated contribution of groundwater. 

Chapter 3: Includes a presentation of critical hydrologic parameters that are required to properly 

parameterize a groundwater system.  This includes an explanation of aquifer types, aquifer properties, 

Darcy’s Law, the groundwater flow equation and groundwater recharge. 

Chapter 4: Details are provided on how to characterize a field site for hydrologic parameters necessary 

for drain design. Data collection techniques are discussed, along with how these data define hydrologic 

parameters, the pragmatic use of these parameters for groundwater modeling and how to estimate 

these parameters if data are not collected.   
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Chapter 5: Recharge calculations based on the SCS curve number are detailed with step-by-step 

guidelines.  Calculations for steady state, 100-year precipitation events, as well as observed precipitation 

time series data are outlined.   

Chapter 6: Groundwater modeling basics are provided to familiarize one with a standard and defensible 

approach to numeric modeling. This includes the development of a conceptual model, defining 

boundary conditions, typical calibration procedures and the verification of model results. 

Chapter 7: Drain design is catalogued with analytical solutions and numeric techniques. For numeric 

techniques, generic sites for translational and rotational failure.  Proper communication between 

groundwater modeling and geotechnical analysis is outlined for efficient drain design.  Results point to 

sensitive hydrologic parameters and threshold processes important to drain design guidelines.   

Chapter 8: Techniques to characterize the hydraulic conductivity tensor for fractured rock are discussed 

in the context of data collected on fracture spacing, orientation and length.   

Chapter 9: Summarizes design considerations and modeling results. 

Appendix A: Contains a comprehensive list of symbols used in the manual with units and definitions. 

Appendix B: Is a step-by-step guide to creating a groundwater model for a translational failure surface 

using the GUI Groundwater Vistas.  The guide includes developing a conceptual model, how to build a 

finite difference grid, add boundary conditions and stresses, integration with geotechnical analysis, 

importing/exporting data, visual analysis.  Analysis is done with and without calibration. 

Appendix C: Provides a demonstration site for groundwater modeling is presented that contains long 

term data.  The site is a single layer of disrupted claystone.  The site is complex but affords a discussion 

of modeling techniques as well as the advantages and limitations of the approach. 

Appendix D: Contains a listing of major soils and associated hydrologic soil groups to aid in curve 

number calculation necessary for the SCS approach used to calculate recharge. 
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Chapter	2	

Slope	Stability	Analysis	

2.1 Introduction 

Gravitational and seepage forces contribute to slope instability.  The most important types of slope 

failure are illustrated in their generalized form in Figure 2.1.  They are the circular rotational slip; non-

circular rotational slip; translational slip and compound slip. 

 

 

Figure 2.1: Types of slope failures (Craig 1997) 

 

In practice, limit-equilibrium methods are used in the analysis of slope stability.  It is considered that 

failure is incipient along an assumed or a known failure surface.  The shear strength required to maintain 

a condition of limit equilibrium is compared with the available shear strength of the soils giving the 

average (lumped) factor of safety along the failure surface.  

The critical role ground water plays in the stability of slopes was recognized by Terzaghi (1923) in his 

principle of effective stress; σ
’
 = σ

 
– u, where σ

’
 is the effective normal stress, σ the total normal stress, 

and u the pore water pressure.  It is evident that a slope stability analysis carried out in terms of 

effective stress requires an understanding of the distribution of pore water pressures in the slope, and 

this understanding implies knowledge of the groundwater flow system.   When sufficient funding is 
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available and a slope failure or potential failure surface has been identified, piezometers can be installed 

and pore pressures can be measured directly.  However, even with such measurements, extrapolations 

must often be made over large distances to approximate pore pressure distribution between known 

points (Hodge and Freeze 1977).   

The mathematical simulation of groundwater systems similar to the one reported here using the 

MODFLOW would prove to be useful as an independent check on field measured pore pressures, and 

when anomalies arise, they may point to unanticipated field conditions that can lead to a modification 

of the subsurface model used for analysis.  It is also important to note that serious errors may result in 

the factor-of-safety evaluation using limit-equilibrium stability analyses if groundwater data are 

inadequate or incorrectly interpreted. 

This chapter first presents a summary of the widely used limit-equilibrium-based slope stability analysis.  

It is concluded with an analysis (Iverson 1991) that highlights the importance of the groundwater flow 

field, especially the direction of pore pressure gradients, in influencing the stability of infinite slopes.  

The insights drawn from this and other such studies would apply to other more complex limit-

equilibrium analyses. 

2.2 Factor of Safety 

Factor of safety (FOS) is defined as the ratio of available shear strength (τf) to shear strength (τm) which 

must be mobilized to maintain a condition of limiting equilibrium. This is illustrated by equation 2.1, 

FOS = ��
��           (2.1) 

An FOS ≤ 1 indicates an unstable slope.  The acceptable minimum value of factor of safety is variable. 

FOS on the order of 1.2 to 1.3 are considered stable.  For slopes where critical structures are sited,  a 

higher minimum  of 1.5 is commonly adopted as the consequences of failure are severe. 

2.3 Methods of Slope Stability Analysis 

Slope stability analysis can be carried out by using different methods with the primary ones being the 

slice method and the plane translational slip method. 

2.3.1 Slice Method 

The potential failure surface is assumed to be a circular arc with center O and radius r as shown in Figure 

2.2.  Width of each slice is b, u is the pore water pressure at the center of the base, and l is the length of 

the base.  For any slice the inclination of the base to the horizontal is α, and the height, measured on the 

center-line, is h.  Factor of safety is taken as being same for each slice.  The forces acting on the slices 

are the total weight of the slice (W); total normal forces on the base(N); the shear force on the base (T); 

total normal forces on the sides (E1 and E2); and shear forces on sides (X1 and X2).  
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Figure 2.2: The method of slices (Adapted from Craig, 1997) 

 

Considering momentum about O, the sum of the moments of the shear forces T on the failure arc AC 

must equal the moment of the weight of the soil mass ABCD.  For any slice the level arm of W is r sin α, 

and therefore 

∑	
 = ∑�
 sin ∝          (2.2) 

Shear force (T) on the base is calculated by using: 

	 = ���           (2.3) 

Equation (2.1) can be rewritten as:  

�� = ��
���           (2.4) 

Substituting Eq. (2.4) into Eq. (2.3)  

	 = ��
��� �            (2.5)  

Substituting Eq. (2.5) to Eq. (2.2)  

	∑ ��
��� � = ∑� sin ∝          (2.6) 
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	��� = ∑���
∑ !"#∝           (2.7) 

For analysis in terms of effective stress, according to Mohr-Coulomb failure criterion available shear 

strength is calculated by using:  

�$ = %& + (&)*+,′          (2.8) 

Here, c’ is cohesion; .’ is friction angle and σ
’
 is effective normal stress. 

Substituting Eq. (2.9) to Eq. (2.7) results in: 

��� = ∑(012314567&)�∑ !"#∝            (2.9) 

9& = (&�           (2.10) 

Where N’ is the effective normal force.      

If arc length AC is La,    

∑ � = :*           (2.11) 

Substituting Eqs. (2.10) and (2.11) into Eq.(2.9)  

��� = 01;524567& ∑<&∑ !"#∝            (2.12) 

Since the problem is statically indeterminate, assumptions need to be made in order to estimate N' in 

Eq. (2.9).  The methods of slices differ in the manner in which these assumptions are made.  We present 

a summary of the methods that are used in this report.  Detailed accounts of these and other methods 

are available in soil mechanics texts.  Computer software that uses most of these methods are widely 

available.  This study uses the XSTABL program and the student version of SLOPE/W. 

2.3.2 Janbu’s Method 

Janbu (1954) developed a general method of slices on the basis of limit equilibrium of blocks.  It allows 

for an arbitrary shaped, slope failure surface.  Forces and moments acting on individual blocks must 

satisfy the equilibrium except the uppermost block.  The blocks are created by dividing the soil above 

the slip surface with dividing planes.  Forces acting on individual blocks are showed in the Figure 2.3.  

Forces and moment are calculated on individual blocks by taking the following assumptions 

(www.finesoftware.eu):  

• the dividing planes between blocks are always vertical,  

• the line of action of the block weight Wi passes through the center of the i
th

 segment of slip 

surface represented by point M,  

• the normal force Ni is acting in the center of the i
th

 segment of slip surface, at point M,  
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position  Zi of the forces Ei acting between blocks is assumed at the slip surface end points where z=0.  

 

 

Figure 2.3: Forces acting on an individual block (adapted from www.finesoftware.eu) 

 

The following relationships are used to find the factor of safety:  

• relationship between effective and total value of the normal force acting on the slip surface,  

• Mohr-Coulomb condition representing the relation between the normal and shear forces on a 

given segment of the slip surface (Ni a Ti),  

• force equation of equilibrium in the direction normal to the i
th

 segment of the slip surface,  

• force equation of equilibrium along the i
th

 segment of the slip surface, and  

• moment equation of equilibrium about point M. 

2.3.3 Morgenstern-Price Method 

Morgenstern and Price (1965 and 1967) developed a general method of slices on the basis of limit 

equilibrium.  Forces and moments acting on individual blocks must satisfy the equilibrium.  The blocks 

are created by dividing the soil above the slip surface with dividing planes.  Forces acting on individual 

blocks are showed in the Figure 2.3.  

Forces and moments are calculated on individual blocks by taking the following assumptions 

(www.finesoftware.eu): 

• dividing planes between blocks are always vertical, 

• the line of action of the block weight Wi passes through the center of the i
th

 segment of slip 

surface represented by point M, 

• the normal force Ni is acting in the center of the i
th

 segment of slip surface at point M,and 
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• the inclination of forces Ei acting between blocks is different on each block (δi) at slip surface 

end point δ=0. 

The relationships similar to those used in Janbu’s method are used to calculate the factor of safety 

(section 2.3.2).  

2.3.4 Infinite Slope Method 

The infinite slope or plane translational slip surface model is shown in Figure 2.4.  The angle β indicates 

inclination of the slope with the horizontal, and z indicates depth of the failure plane.  Location of the 

water table is taken at a height of mz above the failure plane.  The m value lies between 0 and 1.  

 

 

Figure 2.4: Plane translational slip (Craig, 1997) 

 

There are five assumptions considered in the plane translational failure analysis:  

• potential failure surface is parallel to the surface of the slope;  

• potential failure surface is at a depth that is small compared with the length of the 

slope; 

• length of the slope is infinite; 

• water table is parallel to the failure surface; and 

• water table is between failure surface and top soil surface. 

 

The shear strength (�$) of the soil along the failure plane according to Mohr-Columb criterion is given in 

terms of effective stress as: 
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�$ = %& + (( − >))*+,          (2.13) 

Here, c' is cohesion Φ is the friction angle; u is the pore water pressure; and σ is the total normal stress.   

� is shear strength which must be mobilized to maintain a condition of limiting equilibrium as shown in 

Figure 2.4. 

�� = �             (2.14)  

Substituting Eqs.  (2.13) and (2.14) into Eq. (2.1), results in the factor of safety (FOS) as: 

FOS = 012(3?@)4567&�            (2.15) 

Expressions for σ, τ, and u are given respectively by: 

( = A(1 − C)D + CDE54FG cosJ K          (2.16) 

� = A(1 − C)D + CDE54FG sinK cos K          (2.17) 

> = CGDL cosJ K           (2.18) 

where γ and γsat are the dry and saturated unit weights of the soil, respectively. 

2.3.5 Wedge Method of Analysis 

The wedge slip surface is shown in the Figure 2.5.  The angle β indicates inclination of the slope with the 

horizontal, and θ indicates the angle of the failure plane with the horizontal.  

 

 

 

 

 

 

 

 

 

Figure 2.5: Wedge slip surface 
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Multiplying Eq. (2.1) by the area of AC results in: 

	� = ��
�O =

��×(5QR5	S$	TU)
�O×(5QR5	S$	TU)          (2.19) 

�� × (*
V*	WX	YZ) = 	 = � sinN                (2.20) 

*
V*	WX	YZ = [
!"# \	                      (2.21) 

Substituting Eqs (2.20), (2.21) and (2.8) into Eq. (2.19) results in: 

� =
]
^_` a(0′23′ bc#7′)

 !"#\                 (2.22) 

The above expression can be simplified as: 

			� =
d1]
^_`a2( ef!7′ 	bc#7′)

 !"# \                   (2.23) 

Weight (W) of the soil wedge is given by: 

� = D	 × (		*
V*		WX	YgZ) = hJ 	
i	[j

!"# k !"# \ 	sin(K − N)	            (2.24)  

Substituting (2.24) into (2.23) results in the factor of safety (F) as: 

� = bc#7&bc# \ +	
J	0&
i	[ 	

!"# k
(!"#(k?\) !"# \)                  (2.25) 

 

The limit-equilibrium-based method of slope stability analysis uses the pore pressure 

information along an assumed failure surface with little consideration of the gradient of the 

seepage vector or the complex ground water flow pattern that is contributed by hydraulic 

anisotropy, presence of impermeable strata, heterogeneity, and other such factors.  In addition, 

while the assumption that the slope-parallel flow assumed in most infinite slope stability 

models (Fig. 2.4) allows for simplicity, the actual directionality of the hydraulic gradients 

(contributed by flow fields)  involved require careful evaluation of the resultant stability as 

shown below.   

2.3.6 Infinite slope: Hydraulic gradient effects 

Iverson (1991) considered the state of static equilibrium in an infinite slope shown in Fig. 2.6 with 

hydraulic head gradients in X and Y directions and developed a method to calculate the factor of safety.   

The hydraulic head (h) is given (in infinite slope) as: 

ℎ = m
in − o cos N −	 p sin N           (2.26) 
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where, p is the pore water pressure and – y cosθ and x sinθ is the vertical elevation with respect to 

horizontal datum that passes through the origin (Fig. 2.6).  

 

 

 

Figure2.6: Schematic profile and definition on geometric parameters for an infinite slope with 

groundwater head gradient in an arbitrary direction λ.  Note that water table necessarily parallels 

the ground surfaces as do all surfaces with constant p in infinite slopes (Iverson et al. 1997). 

 

The hydraulic gradient in X and Y direction is obtained by from Eq. (2.26) respectively: 

qℎ qp⁄sssssssss = − sin N             (2.27) 

qℎ qo⁄sssssssss = h
in 	
tm
tu −	cos N          (2.28) 

Where,    
tm
tu  is the mean gradient of p between the water table and depth y=Y. 

Along the hypothetical failure surface, the effective normal ((( − >)) and shear stress (�) are, 

respectively: 

(( − >) = A	D4v −	DL(v − w)F cos N −	 DL(qℎ qo⁄sssssssss)(v − w)      (2.29) 

� = A	D4v −	DL(v − w)F sin N − DL(qℎ qp⁄sssssssss)(v − w)       (2.30) 
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where, D4  is total unit weight of the soil. 

Substituting Eqs (2.27), (2.28) ,(2.29),(2.30) and (2.31) into Eq. (2.15) results in the factor of safety (F) as: 

� = xef! \2y
z
{?h|

}
~�	
��
��� bc#�2

d
~�{

!"#\                (2.31) 

For the special case,  
tm
tu = DL%W�N , which implies the hydraulic head gradient parallels the slopes, Eq. 

(2.31) reduces to the factor of safety (Eq. 2.15) derived earlier.  In general cases, however (Iverson 

1991),      

tm
tu = DL y

!"#\
bc#� + cosN|                 (2.32) 

In which λ is the angular direction of hydraulic gradient measured with respect to an outward-directed 

surface-normal vector (Figure 2.6).   

In order to compare the above equation with conventional derivation, it is convenient to express Eq. 

(2.31) as the sum of a friction term (Tf), ground water term (Tw), and a cohesion term (Tc) (Iverson 1992; 

Iverson et al. 1997): 

� = 	$ + 	L + 	0 			 	 	 	 	 	 	 	 	 (2.33a) 

In which,  

	$ = tan�tanN  

	L = A(w/v) − 1F(q� qo
⁄ ) tan�

D4 sinN  

Cohesion term=	0 = 0
i��	!"# \. 

A quantitative understanding of ground water effects can be gained by examining Eqs. (2.33) and 

analyzing the influence of Tw, Tf, and Tc on the factor of safety. Figure 2.7 shows the variation of   
tm
tu   as 

a function of λ several values of the slope angle θ. It can be seen that the condition 
tm
tu > 0    results for 

all cases in which λ < 180°-θ, that is, for all values of λ smaller than that which specifies a vertically 

downward -∇h.  Thus, unless -∇h is vertically downward or directed more normally into the slope, 
tm
tu   is 

positive, Tw is negative, and groundwater tends to destabilize the slope.  Figure 2.7 also shows that this 

destabilizing groundwater effect varies systematically as a function of the slope angle.  Moreover, the 

destabilizing effect is most pronounced for small values of λ, because (2.32) requires that  
tm
tu  → ∞  as λ 

→ 0.   
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The ratio Tw/Tf measures the relative contribution of ground water and friction to the factor of safety.  

This ratio can be obtained by combining Eqs. (2.33 b, c) and (2.32) (Iverson 1992): 

�n
�� =

A(�/�)?hF(tm tu⁄ )
i� ef! \    or as		 	 	 	 	 	 	 	 	 (2.33b) 

�n
�� =

in
i� �
�
� − 1� �

456\
456λ + 1�           (2.33c) 

Figure 2.7 also shows the variation of Tw/Tf (multiplied by γt/γw which typically has a value of 2) for 

various slope angles. The stabilizing and destabilizing effect of this term on slope stability is evident. 

 

 

 

 

 

 

 

 

 

Figure 2.7 Graphs 

illustrating the influence of 

the hydraulic gradient 

direction on (A) the pore-

pressure gradient 

magnitude and (B) the size 

of the groundwater term 

(Tw) normalized by the 

friction term (Tf ) for infinite 

slopes inclined at various 

angles. Shaded zones 

denote the parts of the 

parameter space in which 

groundwater effects reduce 

the stability of the slope. 

(Iverson et al. 1997). 
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Chapter	3	

Introduction	to	Groundwater	Hydrology	

One of the foremost texts on basic hydrogeologic principals is given by Fetter (1994), and most of the 

concepts presented here can be referenced to this text. Aquifer characteristics and the principals of 

groundwater flow are presented to provide an understanding of these parameters that are necessary to 

predict groundwater elevations. 

3.1 Aquifer Types 

Aquifers are classified as unconfined, confined or perched.  Slope stability analysis in this manual is 

primarily limited to unconfined systems, but it is necessary to define all three aquifer types for greater 

context.  Unconfined aquifers exhibit a water table, or a surface at which pore water pressures are equal 

to atmospheric pressure.  Since the water table surface is not under pressure, water table levels in an 

observation well placed in an unconfined aquifer will rise to the elevation of the water table (Figure 3.1).  

Recharge to the aquifer principally occurs from the downward seepage of infiltrated water through the 

unsaturated zone above the water table.  Horizontal movement of groundwater in unconfined aquifers 

tends to exhibit the following properties: (1) if the water table is flat, then groundwater movement does 

not occur, (2) groundwater movement occurs if the water table is sloping, with movement from higher 

water table elevations to lower water table elevations, (3) groundwater discharge may occur in 

topographic lows, (4) the water table surface has the same general shape as surface topography and (5) 

groundwater generally flows from topographic highs to topographic lows. 

Confined aquifers (refer to Figure 3.1) are overlain by a geologic layer with low ability to transmit water.  

This low-transmitting unit is termed a confining unit.  The pressurized water level, or potentiometric 

surface, in a confined aquifer will rise above the top of the aquifer.  If water levels drop below the top of 

the aquifer, then the system reverts to unconfined status.  Recharge will occur in recharge zones where 

the aquifer outcrops, or via slow downward movement of infiltrated precipitation through the confining 

unit.  

Lastly, perched aquifers (Figure 3.2) occur where groundwater mounds upon a geologic layer of 

relatively impermeable sediments.  Unsaturated conditions exist below these impermeable sediments, 

and seepage of water can occur where the impermeable layer intersects with land surface to create a 

spring. 

3.2 Hydraulic Head 

The total mechanical energy of water is expressed as hydraulic head (h).  Head is in units of energy per 

unit weight, or ML
2
/T

2
 divided by ML/T

2
 (M=mass, L=length, and T=time), which equals length units (e.g. 

feet, meters).  The Bernoulli equation (Eq. 3.1) for head considers three types of energy: kinetic, 

gravitational potential, and fluid pressure.   
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Figure 3.1: A schematic of unconfined and confined aquifers depicting water level rise (white 

triangle) in wells screened in each aquifer type, (A) unconfined aquifer, (B) flowing well in the 

confined aquifer, and (C) non-flowing well in the confined aquifer.  Screened intervals are marked. 

 

 

Figure 3.2:  A schematic diagram of unconfined and perched aquifers.  
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ℎ = 	 ��
��
� + 
 +	 �

∗


��
           (3.1) 

Where v is velocity (L/T), g is gravitational acceleration (L/T
2
), z is elevation (L), P

*
 is pressure (M/LT

2
), 

and ρw is water density (M/L
3
).  Kinetic energy is very small for groundwater systems, with karst aquifer 

systems being the exception, and is safely discarded in laminar-dominated groundwater flow systems, 

resulting in a simplified equation (3.2). 

ℎ = 	
 +	 �
∗


��
           (3.2) 

3.3 Properties of Aquifers 

The hydrologic properties of aquifers most important to estimating water levels are those that define 

the abilities of the soil and rock to transfer and store water.  Several techniques to estimate parameter 

values are discussed in Chapter 6. Focus in this chapter is on the physical meaning of important 

parameters and to give a numeric context of these parameters in the governing equations of 

groundwater flow. 

3.3.1 Porosity and Sorting 

Porosity is the fraction of earth material that is void of material. It is the void space that fluid may 

occupy.  Porosity can be a function of depositional environment (water, wind, ice or gravity), or 

secondary processes of dissolution (e.g. karst) or fracturing.  Mathematically, porosity (n) is defined as, 

� =	 ���� ,           (3.3) 

Where Vv is the volume of voids (L
3
), and VT is the total volume of the earth material, including voids (L

3
).  

If the mineral grains in a sedimentary setting are uniform spheres and packed directly above one-

another, which is known as cubic packing (Figure 3.3a), then the associated porosity is 47.65% (Meinzer 

1923a).  If the spheres stack in the hollow spaces, or rhombohedral packing (Figure 3.3b), the resulting 

porosity is reduced to 25.95% (Meinzer 1923a).  The end members of porosity for well-sorted, rounded 

sediment grains are independent of the diameter of the grains.  If the sediment is a mixture of grain 

sizes, then smaller grains will fill in the spaces and significantly reduce its porosity (Figure 3.3c).  The 

wider the range of sediment sizes, then the smaller the porosity.  Geologic processes that can result in 

large particle-size variability include glaciation (e.g. glacial tills) and mass wasting.  

The uniformity coefficient (Cu) is a measure of sorting and is defined as the ratio of the grain size that is 

60% finer by weight (d60) to the grain size that is 10% finer by weight (d10). 

�� =	 ������
           (3.4) 

A sample is well sorted if Cu is less than 4, and poorly sorted if Cu is greater than 6.  Figure 3.4 is an 

example taken from Fetter (1994).  Two materials have similar average grain sizes (0.15 – 0.2 mm).  The  
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Figure 3.3: Different packing arrangements for 

spherical grains (a) cubic packing with porosity 

= 47.65%, (b) rhombohedral packing with 

porosity = 25.95% and (c) cubic packing with 

pore spaces occupied with grains of smaller 

diameter. Resulting porosity is significantly 

lowered. (Adopted from Fetter C.W., Applied Hydrogeology, 

3
rd

 Edition © 1994, pp 82-83, Reprinted by permission of 

Pearson Education, Inc., Upper Saddle River, NJ). 

 

silty fine to medium sand Cu =0.15 mm/0.018 mm = 8.3 is poorly sorted (Fig. 3.4a), while the fine sand Cu 

= 0.21/.15 = 1.4 and is well sorted (Fig. 3.4b). Correspondingly, the fine sand will have a larger porosity 

compared to the poorly sorted silty fine to medium sand, despite having similar median grain size. 

The percent porosity in sedimentary rocks can vary tremendously.  Clastic rocks can range from 3% to 

30%, while limestones and dolomites can have porosities as low as 1% and high as 30%.   Clays can have 

very large porosities based on irregular shapes that reduce packing and the dispersive effect of 

electrostatic charge, which causes some clays to repel each other. 

Although porosity is an important parameter, and is often measured in geotechnical studies, it is only 

used directly in quantitative assessment of groundwater transport and not in the analysis of head.  

Porosity is discussed primarily to compare with specific yield and specific storage, which are the 

parameters used for quantitative assessment of groundwater levels. 
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3.3.2 Specific Yield 

Specific yield (Sy) is the ratio of the volume of water that drains from a saturated rock due to gravity to 

the total volume of rock (Meinzer 1923b).  Surface tension will hold some water to the  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.4: Grain size distributions curve for (a) a silty fine to medium sand with Cu=8.3 and (b) fine 

sand with Cu=1.4 (Adopted from Fetter C.W., Applied Hydrogeology, 3
rd

 Edition © 1994, pp 85-86, Reprinted by permission of 

Pearson Education, Inc., Upper Saddle River, NJ).  
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Table 3.1: Specific yield ranges for various 

sediment textures. Table obtained from Fetter 

(1994), page 91 with original source Johnson 

(1967). (Adopted from Fetter C.W., Applied Hydrogeology, 3
rd

 

Edition © 1994, Reprinted by permission of Pearson Education, Inc., 

Upper Saddle River, NJ). 

 

 

 

 

 

 

surface of mineral grains.  Finer grains will retain more water through surface tension, under gravity, 

than coarser grains. Therefore, clays may have a porosity of 50%, but retain 48% of water and have a 

specific yield of only 2%.  In all cases, Sy will be less than porosity.   Table 3.1 provides characteristic 

values of Sy for various sediment textures.  The highest Sy values occur in medium to coarse sands (0.5 to 

1.0 mm diameter), and decrease rapidly with increased percentages of silt and clay. 

3.3.3 Specific Storage and Storativity 

In a confined aquifer, water is released from storage but the aquifer remains saturated.  This is the 

result of the expansion of mineral grains and water as pressure is reduced. Specific storage (Ss) is the 

amount of water per unit volume of saturated material that is stored (or expelled) as a function of 

compressibility of the mineral skeleton and pore water per unit decrease in water level (1/L).  This is 

sometimes referred to as the elastic storage coefficient.  Jacob (1940, 1960) and Cooper (1966) define 

specific storage as, 

�� =	���(� + � ),          (3.5) 

where ��	is the density of water (M/L
3
), g is acceleration of gravity (L/T

2
), α is the compressibility of the 

aquifer’s skeleton (1/M/LT
2
), n is porosity, and β is the compressibility of water (1/M/LT

2
). The value of 

Ss is very small (generally less than 0.0001/ft).   

For a confined aquifer, storativity (S) is the specific storage multiplied by the aquifer thickness B and 

accounts for the release of water across the entire thickness of the aquifer. Storativity is dimensionless. 

� =	"��            (3.6) 

For an unconfined aquifer, 

Minimum Maximum Average

Clay 0 5 2

Sandy Clay 3 12 7

Silt 3 19 18

Fine Sand 10 28 21

Medium Sand 15 32 26

Coarse Sand 20 35 27

Gravelly Sand 20 35 25

Fine Gravel 21 35 25

Medium Gravel 13 26 23

Coarse Gravel 12 26 22

Specific Yield (Percent)
Material
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Material C

Very fine sand, poorly sorted 40-80

Fine sand with appreciable fines 40-80

Medium sand, well sorted 80-120

Coarse sand, poorly sorted 80-120

Coarse sand, well sorted, clean 120-150

� =	 �# + 	ℎ��           (3.7) 

With the head (h) equal to the saturated thickness of the unconfined aquifer.   The second term on the 

right hand side of equation 3.7 generally ranges from 5x10
-3

 to 5x10
-5

 and is several orders of magnitude 

smaller than Sy  (refer to Table 3.1) and is often ignored for unconfined systems. 

3.3.4 Hydraulic Conductivity 

Hydraulic conductivity in horizontal direction (x-direction) is a function of the material’s ability to 

transmit water (e.g. size and shape of grains, sorting, fracturing) as well as the fluid’s properties (e.g. 

density and dynamic viscosity).  Material properties of size and sorting are defined by the intrinsic 

permeability (Ki) given by, 

2
CdK i =            (3.8) 

where C is a dimensionless shape factor with ranges for common soil types provided in Table 3.2, and d 

is pore size diameter.  The shape coefficient decreases with decreasing grain size.  This reflects an 

increase in sediment surface area and the potential for increased contact between water and sediment 

when grain sizes are small.  The result is greater frictional resistance to flow, and a decline in intrinsic 

permeability.  Intrinsic permeability is in units of area (L
2
), but in petroleum engineering literature is 

often expressed in units of darcy, with 1 darcy equal to 9.87x10
-9

 cm
2
.   

Hydraulic conductivity combines intrinsic permeability with the properties of the fluid,  









=

µ

ρ g
KK w

ix           (3.9) 

were ρ is the fluid density (M/L
3
), g is acceleration of gravity (L/T

2
), and µ is dynamic viscosity (F T/L

2
).  

For fresh water at 20˚C, ρ = 0.998 g/cm
3
, µ = 0.010 g/s·cm.  Ranges of intrinsic permeability and 

hydraulic conductivity are given in Table 3.3.  Groundwater movement is sensitive to the value of 

hydraulic conductivity, but ranges in Kx span several orders of magnitude for any given material. 

Therefore these ranges should act only as a guide.  More accurate methods to estimate Kx based on 

grain size distribution, laboratory techniques and aquifer tests are given in Chapter 4 on site 

characterization. 

 

Table 3.2: Ranges of the dimensionless shape coefficient hydraulic conductivity of soils (Adopted from 

Fetter C.W., Applied Hydrogeology, 3
rd

 Edition © 1994, page 99, Reprinted by permission of Pearson Education, Inc., Upper Saddle River, 

NJ). 
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Intrinsic Permeability

Material (darcys) (cm/s) (ft/d)

Clay 10
-6

 to 10
-3

10
-9

 to 10
-6

2.8x10
-6

 to 0.0028

Silt, sandy silts, clayey sands, till 10
-3

 to 10
-1

10
-6

 to 10
-4 0.0028 to 0.28

Silty sands, fine sands 10
-2

 to 1 10
-5

 to 10
-3 0.028 to 2.8

Well-sorted sands, glacial outwash 1 to 10
2

10
-3

 to 10
-1 2.8 to 283

well-sorted gravel 10 to 10
3

10
-2

 to 1 28.3 to 2834

Hydraulic Conductivity

 

Table 3.3: Ranges of intrinsic permeability and hydraulic conductivity for unconsolidated sediments 
(Adopted from Fetter C.W., Applied Hydrogeology, 3

rd
 Edition © 1994, page 98, Reprinted by permission of Pearson Education, Inc., Upper 

Saddle River, NJ). 

 

 

 

 

 

3.3.5 Transmissivity 

Transmissivity (T) is analogous to storativity, in that it provides an overall response of the system based 

on aquifer thickness.  Transmissivity (L
2
/T) is used to describe the amount of water an aquifer can 

transmit through a unit width of aquifer material,  

$ = "%&            (3.10) 

The primary assumption is that water is flowing horizontally.  For unconfined aquifers, saturated 

thickness is less than aquifer thickness and head (h) is substituted into equation 3.10 for aquifer 

thickness (B).  

3.3.6 Homogeneity and Isotropy 

An aquifer is considered homogenous if hydraulic properties (Kx, Sy, Ss, T) are the same at all locations.  

The system is heterogeneous if these properties change spatially.  Heterogeneity can be as simple as a 

thickening wedge of sandstone, such that T and S increase, despite Kx and Ss remaining the same.  

Stratigraphic layering in the vertical direction (Figure 3.5a) or facies changes in the horizontal direction 

(Figure 3.5b) are common examples of heterogeneity.  To compute an effective hydraulic conductivity 

for each case, respectively, use equations 3.11 and 3.12, where m = the number of layers, and b is the 

individual layer thickness (L). 

%&� = '
∑ )* +,,*⁄/
*0�

           (3.11) 

%&� =	∑
+,,*
'

1
23�            (3.12) 

For equation 3.11 and Figure 3.5a, the drop in head is equal for each layer, but the flow through 

individual layers are different.  With respect to equation 3.12 and Figure 3.5b, flow across each layer is 

the same, but the drops in head across individual layers are different.   

An isotropic condition is a property that is constant in all directions, while anisotropic means an aquifer 

property is dependent on direction.  Figure 3.6 shows an example of each, with anisotropy caused by  
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Figure 3.5: Heterogeneous 

formations (a) horizontal 

layering (b) vertical 

layering. 

 

 

 

 

 

 

 

 

 

 

(a) (b) 

Figure 3.6 Examples of (a) isotropic conditions and (b) anisotropic conditions due to grain shape and 

arrangement (Adopted from Fetter C.W., Applied Hydrogeology, 3
rd

 Edition © 1994, page 122, Reprinted by permission of Pearson 

Education, Inc., Upper Saddle River, NJ).  
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flattened grains.  Hydraulic conductivity is at a minimum orthogonal to maximum Kx.  Figure 3.7 shows 

anisotropy in a fractured system, with groundwater flow constrained by the orientation of fractures. 

 

 

Figure 3.7 Fracture network and associated anisotropy. 

 

Flow paths in homogenous and isotropic systems will be perpendicular to lines of constant head. Figure 

3.8a shows a cross section with a recharge and discharge zone in homogeneous and isotropic sediments. 

Lines of equal head are color coded with flow moving right to left. In anisotropic conditions, flow 

direction is a function of gradient (change in head over distance) and the resultant hydraulic 

conductivity vector.  If the two vectors are not parallel, then flow paths adjust based on the angular 

difference. 

With respect to Figure 3.8b, Kx is 10 times greater than Ky.  The bias toward the x-direction is witnessed 

with flow paths that do not align with modeled equipotential lines at 90 degrees.  Instead, flow bends 

toward the horizontal.  For Figure 3.8c, the opposite is true, with flow paths bending toward the vertical 

in the recharge and discharge zones.  The no-flow boundary condition at the bottom of the modeled 

cross section, however, forces flow in the horizontal in the center of the domain. 

Flow paths in heterogeneous materials follow the law of refraction, where groundwater flow bends 

away from the normal in less conductive materials.  As an example, in Figure 3.8d, groundwater moves 

around the low conductivity lens, but moves toward and through the more conductive lens in Figure 

3.8e.  In the case of subsurface drains that have a higher conductivity than the surrounding material, the 

drainage pipes will consequently act as conduits for flow with gradients bending toward them. 

3.3.7 Representative Elementary Volume (REV) 

A representative elementary volume, or REV, refers to the scale at which a cube of porous material is 

large enough to represent the properties of that porous material, but small enough that a change in 

head in that volume is relatively small.  Within the REV groundwater flow is treated as a continuum and 

one needs to define effective hydraulic properties of hydraulic conductivity and storage for the size of  
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Figure 3.8: Cross section of flow paths 

(blue lines) in sediments that are (a) 

homogeneous and isotropic, (b) 

homogeneous and anisotropic (Kx =10Ky), 

(c) homogeneous and anisotropic (Kx = 

0.1Ky), (d) heterogeneous and isotropic 

with lens 100 times less conductive than 

surrounding rock and (e) heterogeneous 

and isotropic with lens 100 times more 

conductive than surrounding rock.  Lines 

of equal head are color lines (red = high 

head, blue = lower head) 
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the REV (e.g aquifer testing, water balances, model calibration, or literature cited properties).  The REV 

approach is a means of smoothing small scale heterogeneity to a macroscopic scale that is homogenous.     

3.4 Darcy’s Law 

Darcy’s law defines the steady state rate of fluid flow through porous media (flow in = flow out) as, 

4 = 	5%&6 (7�87�)
(&�8&�)

,          (3.13) 

with parameters displayed in Figure 3.9.  Q is the flow rate through the porous material (L
3
/T), A is the 

cross sectional area perpendicular to flow, h1 is the head (L) (i.e. water level elevation) at location x1 (L), 

and h2 is the head at location x2. The proportionality constant Kx (L/T) is the hydraulic conductivity of the 

porous medium in the x-direction (horizontal).  Flow rate will increase if the head difference increases, 

length is shortened, pipe diameter is increased and/or Kx is increased.   

As an example, a medium-grained sand with a Kx = 0.017 cm/s (48 ft/d), a cross sectional area of 30 cm
2
, 

length of 20 cm and a change in head of 10 cm results in a discharge Q = -0.017(30)(-10/20) = 0.255 

cm
3
/s.   

 

 

 

 

 

 

 

 

 

 

 

Figure 3.9: Horizontal pipe filled with unconsolidated porous medium to demonstrate Darcy’s Law. 
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3.5 Groundwater Flow Equation for a Confined Aquifer 

3.5.1 Transient Conditions 

The groundwater flow equation is the governing equation for groundwater hydrology to describe 

groundwater movement.  It combines Darcy’s Law with the conservation of mass.  The conservation of 

mass states that the mass into a unit volume minus the mass out of the unit volume is equal to a change 

in storage.  

9:;;	<� 59:;;	=>? = �ℎ:��@	AB	�?AC:�@       (3.14) 

Figure 3.10 focuses on the conservation of mass in the x-direction for a fully saturated control volume. 

 

 

 

 

 

 

 

Figure 3.10: Control 

volume for flow 

through a confined 

aquifer with flow 

per unit cross 

sectional area in the 

x-direction (qx) 

shown. 

 

The assumption is that no internal sources or sinks exist in the control volume.  The net change in the 

control volume due to fluid movement parallel to the x-direction (left hand side of equation 3.14) is, 

��D&∆F∆
 5 GD&∆F∆
 +	 HH& (��D&)∆I∆F∆
J       (3.15) 

And results in,5 H
H& (��D&)∆I∆F∆
, with similar terms derived for the other two directions -

H
H# K��D#L∆I∆F∆
 and 5 H

HM (��DM)∆I∆F∆
.   

The mass in the control volume, 
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9 = ���∆I∆F∆
          (3.16) 

Where n is porosity. The change in mass of water (right hand side of equation 3.14) with respect to time 

requires one to take the derivative of equation 3.16.  The vertical dimension ( ∆
) is allowed to 

compress/expand with time while the other dimensions are assumed fixed.   

HN
HO = ∆I∆F H

HO (���∆
)          (3.17) 

In order to get terms as a function of head, it is necessary to convert n and ρw into functions of pressure 

and time.  From the product rule 

H
HO (���) = �∆
 H
�HO +	��∆
 HPHO +	���

H∆M
HO        (3.18) 

And the chain rule and P = pressure (M/LT
2
),  

H
�
HO =	 H
�H�

H�
HO            (3.19) 

 
HP
HO =	

HP
H�

H�
HO            (3.20) 

H∆M
HO =	H∆MH�

H�
HO            (3.21) 

Equations 3.19, 3.20 and 3.21 are substituted into 3.18 and rearranged to produce, 

∆I∆F H
HO (���∆
) = ∆I∆F Q�∆
 H
�H� +	��∆
 HPH� + ��� H∆M

H� R
H�
HO      (3.22) 

Where 
H
�
H�  is the compressibility of water (β) with respect to pressure and is assumed constant. 

 =	 �
�
H
�
H� = 4.4I108�WX�

YZ         (3.23) 

If one assumes that the aquifer matrix is elastic, then the coefficient of compressibility of solids (α) is 

defined as either a function of ∆z or n as, 

� = �
∆M

H(∆M)
H� 	= 	 �

(�8P)
HP
H�          (3.24) 

Equation 3.22 becomes, 

∆I∆F H
HO (���) = ∆I∆F∆
K��(� 5 	�)L H�HO        (3.25) 

The right hand and left hand sides of equation 3.14 are equated, 

H(
�[,)
H& +	H(
�[\)H# + H(
�[])

HM = 5��(� 5 	�) H�HO 		      (3.26) 

Rearranging equation 3.2, 
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^ = (ℎ 5 
)���          (3.27) 

Taking the time derivative of equation 3.27 and assuming ρw is constant, 

H�
HO = ��� H7

HO            (3.28) 

And substituting equation 3.26 results in, 

H[,
H& +	H[\H# + H[]

HM = 5���(� 5 	�) H7HO         (3.29) 

Specific storage (Ss) is the constant that controls the amount of fluid volume that the aquifer matrix can 

hold and does not differentiate between compressibility due to water and the compressibility of aquifer 

matrix.  Ss is defined in equation 3.5.  Substituting equation 3.5 and Darcy’s Law for flow per unit cross 

sectional area into equation 3.29 results in the groundwater flow equation for a confined aquifer that is 

both heterogeneous and anisotropic and for transient conditions becomes, 

H
H& Q%&

H7
H&R +

H
H# Q%#

H7
H#R +

H
HM Q%M

H7
HMR = �� H7HO        (3.30) 

3.5.2 Homogonous/Isotropic 

If the confined aquifer is considered homogenous, then hydraulic conductivity does not change with 

location and can be pulled from the space-derivative.  Equation 3.30 simplifies to, 

%& H�7
H&� +%# H�7

H#� + %M H
�7

HM� = �� H7HO         (3.31) 

If the aquifer is isotropic, then K = Kx = Ky = Kz.  If the aquifer is homogenous and isotropic, the 

groundwater flow equation further reduces to, 

H�7
H&� +

H�7
H#� +

H�7
HM� =

_`
+
H7
HO =	

_
a
H7
HO          (3.32) 

3.5.3 Steady State Conditions 

Steady state means that head does not change over time and 
H7
HO  = 0, and storage terms are no longer 

required for the solution.  The simplest groundwater flow equation is for 1-dimensional flow given 

steady state conditions in a confined aquifer.  The groundwater flow equation reduces to, 

H�7
H&� = 	0.           (3.33) 

Equation 3.33 is relatively easy to solve analytically by integrating once (indefinitely), then substituting 

in Darcy’s Law, separating the variables and integrating to produce, 

ℎ� =	ℎ� 5	 [,+, I.          (3.34) 

For flow per unit width (Q’) is equated to flow per unit area (qx) as, 
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4b =	D&"           (3.35) 

For an example, refer to Figure 3.11.  Given h1 = 100 ft, K = 1 ft/d, B = 100 ft, x = 1000 ft and Q’ = 1 ft
2
/d 

then qx = 1/100 ft/d, and h2 = 100 – (1)(1000)/(1)(100) = 90 ft 

 

 

 

 

 

 

 

 

 

 

Figure 3.11: Schematic diagram for a confined aquifer in one dimension. 

3.6 Groundwater Flow Equation for an Unconfined Aquifer 

3.6.1 Transient Conditions 

Refer to Figure 3.12 for the head profile in a 1-dimensional, unconfined aquifer with the water table 

surface defined by equation 3.2.  The water table (point A) is at atmospheric pressure and P/ρwg = 0.  

Therefore, all mechanical energy at point A is from potential energy, such that h = z, and hydraulic head 

is equal to the saturated thickness of the aquifer. 

The area (A) term in Darcy’s law (Equation 3.13) is impacted by replacing aquifer thickness (B) with 

saturated thickness.  Flow is defined as, 

4 = 	5%ℎc �7
�& ,          (3.35) 

Where w = unit aquifer width (L).  Use of Darcy’s law assumes that flow is horizontal.  For unconfined 

flow, the hydraulic gradient (
�7
�&) must be small compared to the overall saturated thickness for this 

assumption to be valid (also referred to as Dupuit assumption).  To be valid, the hydraulic gradient (or 

tanθ) should closely match the slope of the water table (sinθ), where θ is the angle from horizontal.  This 

assumption is valid for θ< 15°. 
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Figure 3.12: Schematic diagram for an unconfined aquifer in one dimension. 

 

Drainage in an unconfined aquifer results in a lowering of the water table and the saturated thickness is 

reduced, as is the ability of the aquifer to transmit water (T = Kh). The resulting non-linear, groundwater 

flow equation becomes, 

H
H& Q%&ℎ

H7
H&R +

H
H# Q%#ℎ

H7
H#R +

H
HM Q%Mℎ

H7
HMR = �# H7

HO       (3.36) 

For homogenous and isotropic conditions, 

H�7�
H&� +

H�7�
H#� +

H�7�
HM� = _\

+
H7
HO          (3.37) 

3.6.2 Steady State Conditions 

Using equation 3.35 for flow per unit width, 

4′ =	5%ℎ �7
�&           (3.38) 

and integrate, 

4b =	5 +
�& (ℎ�

� 5 ℎ��)          (3.39) 

To compare with the example provided in a confined aquifer (section 3.5.2).  Given h1 = 100 ft, K = 1 

ft/d, B = 100 ft, x = 1000 ft and Q’ = 1 ft
2
/d then h2 =( 100

2
 – (2)(1)(1000)/(1))

0.5
 = 89.4 ft.  For the same 

flow rate in an unconfined aquifer, head drop is more than 0.5 ft greater than for a confined aquifer 

over the same distance. 

  

h1
h2

P
h z

gρ

= +

•
A
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Chapter	4	

Site	Characterization	

4.1 Introduction 

Site characterization is focused on defining the parameters necessary to construct and parameterize a 

hydrogeologic model (refer to Chapter 6), as well as defining the geotechnical aspects for subsequent 

slope stability analyses.  For the purposes of this report, the hydrogeologic model includes 

1. the topography and watershed boundaries, 

2. the stratigraphy with associated hydrogeologic characteristics, and  

3. the precipitation and surface runoff characteristics that influence groundwater recharge. 

4.2 Hydrogeologic Model 

Details are provided on how to characterize a field site for hydrogeologic parameters necessary for drain 

design. Data collection techniques are discussed, along with how these data define hydrogeologic 

parameters, the pragmatic use of these parameters for groundwater modeling, and how to estimate 

these parameters if field data are not collected. 

4.2.1 Watershed Delineation and Topography 

Watershed delineation is an important initial step in establishing hydrologic divides and will define the 

extent of the hydrogeologic model domain.  The watershed boundary is recognized as a no-flow 

boundary condition, which greatly simplifies water budget components and characterization of numeric 

model boundary conditions. 

Several documents (e.g. http://www.nh.nrcs.usda.gov/technical/Publications/Topowatershed.pdf) and 

computer programs (e.g. ArcGIS) exist to aid in reading or generating topographic maps and how to 

delineate a watershed boundary.  Using the example provided in Figure 4.1, the first step of establishing 

the watershed boundary is to define the outlet, or downstream location of the study site.  This 

topographic low spot is highlighted with a circle in Figure 4.1a.  Second, it is necessary to find the high 

points, or ridges, along both sides of the drainage system beginning from the watershed outlet, and 

extending uphill to the watershed’s headwaters.  In the case of a uniform slope with no distinct surface 

drainage pattern or with no surrounding hydrologic divides, establishment of the watershed boundary 

should be made by extending the study site well beyond the region of concern and assuming lateral 

inflow is minimal.  In this circumstance, the upgradient boundary condition is monitored with on 

observation well to track water level response to precipitation events.  

Surface water falling anywhere in the watershed’s area will flow through the basin and eventually exit 

the basin via the system’s outlet.  Regional groundwater flows can occur across watershed domains, but 
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the necessity of quantifying groundwater flux across the watershed boundary is minimized by including 

the entire watershed in the analysis.  

Topographic data is often available as a digital elevation model (DEM) from U.S. Geological Survey 

topographic mapping, generated from conventional land surveying or use of a Light Detection and 

Ranging (LiDAR) survey.  Graphical user interfaces (GUI) developed specifically for groundwater models 

allow importation of topographic data as well as several interpolation algorithms to assign elevations 

across the model domain. Appendix B provides a step-by-step guide on how to import topographic data 

into a groundwater model platform.  Scale of the topographic survey will depend on the level of 

heterogeneity, the water level change in space and time (i.e. perturbed by recharge) and should be 

indicative of the REV discussed in chapter 3.3.7.  Those systems experiencing a large change in water 

level over small spatial or temporal scales will need a smaller resolution in their survey.  Topographic 

surveys on the order of 1 m intervals or the use of USGS 30 m DEM grids should be adequate for most 

circumstances.  Surveys of well locations, and piezometer elevations should be accurate (tenths to 

hundredths of a meter) to properly quantify water level (or pore pressure) changes in the system. 

 

 

 

 

 

 

 

 

 

(a)       (b) 

Figure 4.1: (a) Topographic map showing land surface elevation at 5 ft intervals. The black circle 

(right edge) represents watershed outlet and thick black line delineates the watershed. (b) A surface 

map showing elevation in color scale and the watershed boundary given as a white line. 

 

4.2.2 Hydrostratigraphy 

The next site characterization step is to define the hydrostratigraphy within the watershed boundary.  

Stratigraphy refers to the composition, thickness, and distribution/position/orientation of the 
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hydrogeologic units that underlie the site.  Hydrostratigraphy controls how and where groundwater is 

recharged, moves through the watershed, and is discharged.    

Distinct geologic units can have similar hydrogeologic properties and can be combined into a single 

water bearing unit.  In contrast, facies changes within a single geologic unit, or highly heterogeneous 

strata  may result in highly variable hydrogeologic properties, requiring a single geologic unit to be 

subdivided into distinct hydrogeologic units. The decision to combine or subdivide geologic units into a 

single or multiple hydrogeologic units is based on measured values for hydraulic conductivity, porosity, 

storage and ability of groundwater models to replicate observed water levels.   

The development of the stratigraphy of a site is common practice for geotechnical design.  Typical 

resources and methods employed include published/unpublished geologic mapping and other 

geotechnical/geologic/hydrogeologic references, airphotos and remotely sensed data, geologic site 

reconnaissance and mapping, subsurface exploration, and geophysical methods.   

The review of regional-scale geologic maps and remotely sensed data are usually insufficient for detailed 

site characterization and generally need to be augmented with site-specific data collection. Geologic site 

reconnaissance and mapping is highly valuable for identifying local surface drainage patterns, 

geomorphic processes, and surficial distribution of geologic units, and informs the scope of further site 

investigation.   

Subsurface explorations are typically necessary to develop the stratigraphy underlying the site and to 

provide needed hydrogeologic data.  Most often, these would include test borings and/or test pits and 

trenches.   A boring/well log is prepared summarizing the composition, depth and thickness of the 

geologic units encountered, as well as any water-bearing zones.  If possible, subsurface conditions 

encountered in the explorations should be correlated with regional geologic conditions.  Land surface 

elevation, coordinates of the boring/well, and boring construction details are also required.  If pracitical, 

borings should penetrate the full depth of the geologic unit of interest and be screened in that unit for 

which analysis is pertinent.  Typically, a minimum of two to three borings is needed to define subsurface 

conditions for a simple slope. These can be placed down the central axis of the slope. More complex 

slope geometry and/or stratigraphy will require a greater number of borings. 

Surface geophysical methods can be extremely useful and a cost-effective means to gain additional 

subsurface data between widely spaced borings and outcrops.  According to Fetter (1994), the most 

common surficial geophysical techniques for hydrogeologic characterization include: 

• Direct current resistivity: This technique has large application to hydrologic studies. Current is 

introduced into the ground between two metal electrodes. Knowing the current flowing through 

the ground, and the potential difference between the electrodes, it is possible to compute the 

resistivity of earth materials, which can vary widely.  Gravel has a higher resistance than does silt 

or clay under similar moisture conditions because of the greater number of charged surfaces 

associated with finer materials. As moisture increases so does the material’s ability to conduct 

electricity.  Therefore, dry materials have a higher resistance compared to those that are wet.   
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• Electromagnetic conductivity: This is the inverse technique to resistivity.  A magnetic field is 

generated by passing an alternating current through a transmitter coil.  The magnetic field 

induces an electric current through the ground at different strengths depending on the 

material’s conductivity, with field strength measured via a passive receiver coil.  Changes in 

phase, amplitude and orientation can be measured in space or time and are related to electrical 

properties of the earth. There are several electromagnetic methods, with all being relatively 

rapid to conduct. Similar results are attainable with resistivity and electromagnetic conductivity 

surveys. 

• Seismic refraction: Seismic methods are often used to determine the depth to bedrock, slope of 

bedrock, or depth to water table and often used in hydrogeologic mapping.  Seismic refraction is 

most common for determining thickness of unconsolidated sediment overlying bedrock. An 

artificial seismic wave underground will travel more slowly through unconsolidated material in 

comparison to solid bedrock.  The travel time of seismic waves over varying distances will allow 

mapping of the bedrock-unconsolidated material interface.  

• Ground-penetrating radar (GPR):  This technique is based on the transmission of repetitive 

pulses of electromagnetic waves into the ground.  These pulses are reflected back to the surface 

when they encounter the interface between materials with differing dielectric properties, and 

show variations in strata. Lower frequency waves (down to 10 MHz) will travel to greater depth, 

while higher frequencies (1000 MHz) are limited to shallower depths but provide greater 

resolution. Ranges in GPR signal depths are about 20 ft in fine-grained glaciolacustrine 

sediments and may be up to 70 ft in coarse-grained sands and gravels.  GPR, in conjunction with 

borehole data, can distinguish fine-grained and coarse-grained sediments, bedrock, as well as 

the water table in coarse grained material. The depth to the water table in fine-grained material 

(with a substantial capillary fringe) is not easily identified with GPR. 

• Magnetic surveys:  Magnetic anomalies indicate the types of rocks in a very general way, and 

can be used to track those types of rocks that exhibit magnetic behavior.  Most unconsolidated 

sediments are not magnetic and cannot be delineated with a magnetic survey.   

• Gravity anomalies: The mass of rock in the subsurface will affect the local value of the 

acceleration of gravity.  Using a reference value and several corrections for elevation, latitude, 

terrain and tidal effects, it is possible to map buried bedrock.   

Geophysical techniques used within a test boring are common in the petroleum industry, research 

projects and with large municipal wells. They are less common with small production wells and small 

projects.  However, several of these techniques are helpful in estimating porosity, permeability and 

changes in lithology, and are noted (Fetter, 1994). 

• Single-Point Resistance: Several resistive techniques are available with the simplest being the 

single-point technique. A single electrode is lowered down the borehole while the second 

electrode is kept at land surface.  The single point approach measures resistance of all the rocks 

between the electrodes. If the fluid in the borehole is homogenous, then changes in resistance 

are due to changes in lithology.  Sand, gravel, sandstone and lignite have high resistance. Clay 
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and shale have the lowest resistance.  Fractures will exhibit lower resistance, as will increased 

salinity. 

• Resistivity: Resistivity is different than resistance. The former is measured in ohm-meters, while 

the latter is given in ohms. Two current electrodes are lowered down the borehole with 

resistance measured between two additional electrodes. Resistivity traces are similar to the 

single-point resistance technique, but this technique allows for different electrode 

configurations (e.g. short normal and long normal) to provide resistivity at varying radial 

distances from the borehole. All resistivity configurations will provide data at greater distances 

compared to the single-point resistance technique.   

• Natural Gamma Radiation: This techniques measures the natural radiation of gamma from 

potassium-40, part of the uranium-238 and thorium-232 decay series.  Increased gamma activity 

will occur from sedimentary rocks that contain potassium-rich shale, clays or rocks containing 

phosphate.  Therefore, lithologic differences in the rock can be distinguished. For example, a 

shaley sandstone will have much higher radiation than a clean, quartz-rich sandstone. 

• Neutron Logging: A probe containing a radioactive substance, such as PbBe, is lowered down the 

borehole.  Neutrons emitted from the probe collide with the nuclei of hydrogen atoms, and 

detectors measure the resulting gamma radiation produced by these interactions or the energy 

levels of the neutrons that are captured or moderated by the hydrogen atom.  Water in the pore 

spaces is the dominant source of hydrogen. Therefore, saturated rocks with high porosity will 

capture/moderate more neutrons than rocks with low porosity.  Along with porosity, it is 

possible to measure specific yield in unconfined aquifers. Above the water table, moisture 

content can be measured but not porosity.  

• Gamma-Gamma Radiation: This technique allows an estimate of porosity based on a material’s 

bulk density (weight of rock divided by the total volume).  Cobalt-60 is lowered down the 

borehole which emits gamma radiation. Gamma protons are absorbed or scattered by all 

material it comes into contact with, with absorption proportional to bulk density.  

The reader is referred to Wightman et al. (2004) for more in depth treatment of geophysical methods 

and their sutability for characterizing a variety of site conditions. 

4.2.3 GroundwaterData 

Initial water level (or pore pressure) data should be collected at the time of drilling, and piezometers 

should be installed in suspected water-bearing zones to monitor water levels over time.  Accurate 

characterization of the stratigraphy and proper piezometer construction and development are vital to 

ensure accurate characterization of groundwater levels.  For standpipe-type piezometers, 

screened/sanded intervals within suspected water-bearing zones must be sufficiently isolated from 

overlying water-bearing zones to avoid cross communication of aquifers and inaccurate groundwater 

measurements.  Driscoll (1986) provides a thorough treatment of well construction.   Alternatively, 

vibrating wire piezometers can be sanded or grouted in place within the desired geologic unit of 

interest.  Piezometer construction should be well detailed on the boring log to document the source 

zone and to be able to assess the quality of the groundwater data. 
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Consideration should be given to monitoring frequency of piezometers.  Infrequent manual 

measurements may be sufficient for aquifers that do not respond rapidly to precipitation (or drainage) 

and fluctuate slowly through wet and dry seasons.  For aquifers that exhibit flashy response, continuous 

monitoring with the use of a datalogger should be considered.  Often, the degree of responsiveness is 

not known or is misjudged at the beginning of an investigation (Fig 4.2).  Higher initial equipment costs  

 

 

Figure 4.2 Graph depicts groundwater response to rainfall (data collected on 4-hour intervals with 

dataloggers) in a large landslide complex on the western Olympic Peninsula, Washington that 

receives about 120 inches of precipitation annually. Piezometer H-6c-05 is constructed in a glacially 

over-consolidated outwash consisting of very dense silty gravel with sand; note large flashy 

response to storm events.  Piezometer H-5b-06 is constructed within intensely sheared siltstone; 

note comparable responsiveness. 

 

for continuous monitoring are offset by increased labor costs for frequent manual readings and more 

complete and useful data. 

As mentioned in section 4.2.2, a minimum of two to three borings are required for fairly simple slope 

configurations, with a greater number of borings necessary for more complex slopes and subsurface 

conditions.  If possible, one boring should be placed at/near the upper edge of the site domain to 

measure the groundwater conditions entering the system.  A minimum of three wells are also required 
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to determine the shape of the potentiometric surface and horizontal movement of groundwater flow.  If 

vertical head differences are important, then piezometer nests are needed, with piezometers placed in 

conjunction with different screened intervals.  If the well is fully screened, then piezometer nests are not 

informative. Nested piezometers should be installed if anisotropy is expected to be important.  Such 

examples occur if there exist extensive silt/clay lenses, confining layers and/or thick units of glacial till. 

4.2.4 Precipitation 

Precipitation can vary significantly by geographic location based on elevation and slope aspect.  

Therefore, it is highly recommended that on-site precipitation data is collected.  Rain depths at six hour 

intervals, or less, are used to compute groundwater recharge and are useful when evaluating aquifer 

responsiveness (refer to Chapter 5).  The standard rain gauge consists of an 8-inch open cylinder with a 

funnel and a smaller measuring tube inside.  The measuring tube is constructed with a cross sectional 

area 1/10 that of the larger collecting cylinder.  Therefore, one-tenth of an inch of rain will rise one inch 

in the measuring tube and make measuring rain depth more precise.  The tipping bucket gauge is an 

alternative to the standard gauge.  Collection buckets tip when they sense the weight of 0.1 inches of 

precipitation, which an electronic signal sent to the recorder each time a bucket tips. The tipping bucket 

is good at measuring light rain, but can fail to keep up during large events.  Lastly, weighing-rain gauges 

are available, in which the depth of water is tracked based on the weight of water in the collection 

container. Automated gages for weighing and tipping are available. 

If on-site precipitation collection is not possible, or not coordinated with observed water level data, then 

agency data should be used.  Agency data are typically archived at the daily level and easily 

downloadable. Data at a finer temporal resolution can be available, but may require special inquiry and 

a fee to obtain.   

The primary data archive site is with NOAA’s regional climate centers 

(http://www.ncdc.noaa.gov/oa/climate/regionalclimatecenters.html).  These are federal-state 

cooperatives and managed by NOAA’s National Climate Data Center (NCDC). There are six regional 

centers with Figure 4.3 showing centers by region/state.  As an example, follow links to the Western 

Regional Climate Center (WRCC).  Listed are two programs with readily available data  

o Remote Automatic Weather Service (RAWs) under WRCC Projects 

(http://www.raws.dri.edu/index.html)  

o Historic Climate Information (http://www.wrcc.dri.edu/CLIMATEDATA.html) 

RAWs data provides historic daily data, while historic stations (e.g. COOP stations) provide averaged 

daily values, with minimum and maximum observed, for specified periods of record.  If necessary, 

scaling of weather station data with study site data is recommended to fill in data gaps. However, 

variability between weather stations and the study site are not consistent and can introduce significant 

error. 
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Figure 4.3: Regional climate centers by state (figure obtained from 

http://www.ncdc.noaa.gov/oa/climate/regionalclimatecenters.html) 

 

4.2.5 Hydrologic Soil-Cover Complexes 

Soil type and vegetation status, as well as land use, are used to predict the amount of precipitation that 

is partitioned into groundwater recharge.  While rigorous approaches to soil infiltration are available, 

such as Horton (1933, 1939), Philip (1957, 1969) or Green-Ampt (1911), a relatively simple approach 

developed by the USDA Natural Resources Conservation Service (NRCS), formally called the Soil 

Conservation Service (SCS), is recommended.  A full description of the SCS approach is discussed in 

Chapter 5 of this manual with hydrologic soil groups provided in Appendix D. 

Hydrologic characteristics of soils are defined in terms of a dimensionless curve number (CN). The curve 

number ranges between 0 and 100, with 100 representing an impervious surface (e.g. concrete).  

Natural systems have CN < 100.  Examples of CNs for “other” agricultural lands are provided in Table 4.1, 

while arid and semi-arid rangelands are given in Table 4.2.  The National Hydrology Engineering 

Handbook (630), Chapter 7 (USDA, 2009) discusses hydrologic soil groups, while Chapter 8 classifies land 

use treatments in the field (USDA, 2002).  Chapter 9 of the National Hydrology Engineering Handbook 

(USDA, 2004) provides curve number estimates for forest ranges in the western United States, with CN 

modified by ground cover density and soil group.  The Handbook is found online at 

www.nrcs.usda.gov/wps/portal/nrcs/detailfull/national/wntsc/?&cid=stelprdb1043063.Hydrologic soil 

groups are affected by subsurface permeability and soil-intake rates.  Soils are classified into one of four 
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groups (A, B, C and D) according to their minimum infiltration rate on bare soil and after prolonged 

wetting. Soil groups are defined as follows (NRCS, 1986,). 

o Group A: low runoff potential and high infiltration rates even when thoroughly wetted.  

Generally consist of deep, well to excessively drained sands or gravel and have a high 

transmission rate of water (> 0.30 inches per hour) 

o Group B: Moderate infiltration rates when thoroughly wetted. Generally consists of deep, 

moderately well to well drained soils with moderately fine to moderately coarse textures.  

Water transmission rates are on the order of 0.15 to 0.30 inches per hour. 

o Group C: Soils have low infiltration rates when thoroughly wetted.  Soils generally contain a 

layer that impedes downward movement of water, with soils of moderate to moderately-fine 

texture. Transmission rates are on the order of 0.05 to 0.15 inches per hour. 

o Group D: Soils have a high runoff potential. Infiltration rates are very low when thoroughly 

wetted.  Soils consist primarily of clays with a high swelling potential, permanently high water 

table, claypan or clay layer at or near the land surface and/or shallow soils over an impervious 

material.  Transmission rates are 0 to 0.05 inches per hour.  

TR-55 (USDA, 1986) lists many of the major soils and associated soil groups in the United States and is 

provided in Appendix D.  Soils in a specific area of interest are obtained by soil reports conducted by 

local SCS offices or water conservation districts.  The USDA also offers archived papers discussing local 

sources of runoff CN, past and present procedures of the SCS approach, etc. 

http://www.nrcs.usda.gov/wps/portal/nrcs/detailfull/national/water/manage/?&cid=stelprdb1043053.   

Cover type (bare soil, vegetation type and density) are determined by a field reconnaissance, aerial 

photographs and/or land use maps, while hydrologic condition refers to the effect of cover type and 

condition on runoff potential. Hydrologic condition can be assessed by density of vegetation, amount of 

year round cover, amount of grass, or degree of surface roughness. Good hydrologic condition denotes a 

soil with low runoff potential for a specific hydrologic soil group, cover type and treatment. 

Modifications of the CN, based on antecedent moisture conditions or slope, are discussed in Chapter 6 

of this manual, along with sensitivity of estimated recharge to uncertainty in CN.  Chapter 7 examines 

the impacts on drain design based on uncertainty in CN for a site susceptible to translational failure. 

4.2.6 Hydraulic Conductivity 

Hydraulic conductivity (Kx) ranges over 12 orders-of-magnitude, depending on the water-transmitting 

characteristics of the aquifer materials (refer to Figure 4.4).  Hydraulic conductivity of similar materials 

can vary over several orders-of-magnitude based on heterogeneity, anisotropy, sorting, as well as post-

diagenetic circumstances (e.g. solution cavities, fracturing). It is therefore not recommended to use 

material type of an aquifer as the sole basis of estimating hydraulic conductivity. Instead, material type 

should be used as a means to check measured values for consistency. 

Most common practices for estimating hydraulic conductivity include correlation with sediment grain-

size distribution, lab-scale permeameters, field-scale slug or pump tests, and numeric model calibration.  
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The latter is discussed in Chapter 6 – Introduction to Groundwater Modeling, while a step-by-step guide 

to calibrating hydraulic conductivity is given in Appendix B.  

 

Table 4.1: Runoff curve numbers (CN) for other agricultural lands 
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Table 4.2: Runoff curve numbers (CN) for arid and semi-arid rangelands. 

 

 

 

 

 

 

 

 

 

 

Figure 4.4: Ranges of hydraulic conductivity (ft/d) for many aquifer materials (modified from Fetter, 

1994). 
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4.2.6.1 Grain-Size Distribution 

The first, and simplest, method for estimating hydraulic conductivity is to assume a correlation with 

grain-size distribution.  As the medium grain size increases, so does hydraulic conductivity due to larger 

pore openings.  However, if a sample is poorly sorted (i.e. well graded) then the standard deviation of 

particle sizes increases and permeability will decrease. The Hazen method gives large weight to grain-

size variability with the following relationship, 

2

10CdK
x

=            (4.1) 

Where Kx is in units of cm/s, C is the dimensionless shape coefficient provided in the discussion of 

aquifer properties (Table 3.2), and d10 is the effective grain size (cm) defined by the grain size that is 10% 

finer by weight.  To help illustrate the importance of sorting on estimates of hydraulic conductivity 

computed with the Hazen method, refer to Figure3.4.  The median grain size in both distributions are 

nearly equal (0.15-0.2 mm) but variance in gain size for the silty fine to medium sand is much larger than 

for the fine sand.  For the poorly sorted, silty fine to medium sand, d10 = 0.018 mm, C is estimated at 80 

and the resulting Kx = 2.6x10
-4

 cm/s (0.74 ft/d).  In contrast, a well sorted (poorly graded) fine sand with 

d10 = 0.15 mm and C estimated at 80 will produce Kx = 1.8x10
-2

 cm/s (1555 ft/d), or an increase in 

hydraulic conductivity by over three orders-of-magnitude.  

4.2.6.2 Laboratory Estimates of Hydraulic Conductivity 

Hydraulic conductivity can also be measured in the laboratory with a permeameter.  These devices are 

typically cylindrical chambers that hold a sample of rock or sediment.  Two types of permeameters are 

widely used.  The constant-head permeameter (Figure 4.5) works well for non-cohesive materials, such 

as sands, gravels, or rock.  It contains an inflow reservoir of constant water level and steady state 

outflow rates.  Hydraulic conductivity is computed using Darcy’s Law such that h = h1-h2 and L = length of 

the sample or x1-x2., 

�� = − ��
�	.           (4.2) 

Fetter (1994) warns that hydraulic gradients should approximate those seen in the field and that the 

change in head (h) should never be more than 0.5 times the sample length L.  If the head is too large, 

then flow velocities can become large enough to produce turbulent flow and negate Darcy’s law (quick 

sand conditions can arise).   

A falling-head permeameter is used for cohesive materials with potentially low hydraulic conductivities 

and a relatively low volume of water moving through the sample, (Figure 4.6).  The initial water level (h0) 

compared to the outflow height at initial time t0, and the water level (h1) at a later time t1 = t are 

tabulated.  It is also necessary to know the inside area of the falling tube (At), the length of the sample 

(L) and the cross sectional area of the sample (Ac).  
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Figure 4.5: Schematic of a constant-head permeameter. 
(Adopted from Fetter C.W., Applied Hydrogeology, 3

rd
 Edition © 1994, page 105, Reprinted by permission of Pearson Education, Inc., 

Upper Saddle River, NJ). 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.6: Schematic of a falling-head permeameter. 
(Adopted from Fetter C.W., Applied Hydrogeology, 3

rd
 Edition © 1994, page 105, Reprinted by permission of Pearson Education, Inc., 

Upper Saddle River, NJ). 
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Using Darcy’s law and the principal of continuity that states Qin = Qout, 

−
�
�	
�� =  ��



	
�           (4.3) 

Solving for hydraulic conductivity in the x direction,  

�� =  − ���
��	

�	
��            (4.4) 

and integrating from t0= 0 to t1= t, given h = h0 at t=0 and h = h1 at t1 produces, 

�� = ���
��� �� �	�

	�
�          (4.5) 

 

4.2.6.3 Slug Tests 

Slug tests allow relatively quick and inexpensive point-estimates of hydraulic conductivity at the field 

scale to account for system heterogeneity at a larger scale than measured in the laboratory.  Slug test 

estimates of hydraulic conductivity can be conducted across the site, or combined with laboratory or 

grain-size distribution estimates for more complete site characterization.  In addition, slug tests can be 

used at contaminated sites to limit the discharge of contaminated water and can be used as a precursor 

to larger multi-well pump test as a means for design.   

Data collected for a slug tests includes an initial measurement of water level in a monitoring well prior 

to any disturbance.  This is followed by a rapid removal, or addition, of a known quantity of water to 

closely approximate instantaneous change in head (Figure 4.7).  The rate at which the water level rises 

or falls to its original state is used to compute hydraulic conductivity in the immediate vicinity of the 

well.  For analytical considerations, head displacement is assumed positive regardless of whether water 

is removed or added to the well. 

 

 

 

 

Figure 4.7: Schematic of a slug test in which the 

dashed line is the water original water level in 

the well prior to any disturbance.  

Displacement due to an addition of water (+h0), 

or rapid removal of water (-h0), is recorded, as 

are water levels over time as the well returns 

to its original state. 
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Several methods for solving for Kx given slug-test data exist (e.g. Cooper et al., 1967; van der Kamp, 

1976). This manual will focus on the Bouwer-Rice method (Bouwer and Rice, 1976; Bouwer, 1989) for its 

general applicability.  The Bouwer-Rice approach can be performed in open boreholes or screened wells 

and is applicable to fully or partially penetrating wells.  The method was originally designed for 

unconfined systems, but it can also be used in confined aquifers if the bottom of the confining layer is 

far above the top of screened interval in the well (Fetter, 1994).  For higher hydraulic conductivity 

materials (1-100 ft/d), it is recommended to repeat the slug test two or three times (rising and falling 

scenarios) with consistent hydraulic conductivity values asserting proper well development and proper 

recording of well response to pulse input.  

The Bouwer-Rice slug test analysis is given below with important well design parameters noted in Figure 

4.8.  

�� =  
����� ���

��
�

 ��

!
� �� �	�

	�
�          (4.6) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.8: Well parameters defined for the Bouwer-Rice slug test analysis given in equations 4.7, 4.8 

and 4.9. 
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where h0 is the drawdown/rise at time t= 0, while ht is drawdown at time t=t; Re is the effective radial 

distance at which head is dissipated, and can be thought of as the distance away from the well for which 

hydraulic conductivity is being measured.  It is not possible to measure Re.  Therefore it is necessary to 

estimate its value and then test the validity of the choice of Re using theoretical considerations.  If the 

monitoring well is partially penetrating such that Lw is less than the saturated thickness of the aquifer 

(h), the Re is calculated as, 

"# =  $%�&'( ) !.!
�� ��� ��⁄ , �-./01	2 ��3/��

��/��
5

2!
�       (4.7) 

If the well is fully penetrating (Lw=h), then the relationship simplifies to, 

"# =  $%�&'( ) !.!
�� ��� ��⁄ , 6

��/��
5

2!
�        (4.8) 

The coefficients A, B and C are graphically derived from Figure 4.9 or gotten from Table 4.4  It is also 

common to assume that Re = rc or Re = rw, using the latter relationship if the filter pack surrounding the 

well is more than twice as permeable as the formation (Butler, 1997).   

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.9: Dimensionless parameters A, B and C plotted as a function of Le and rw, and used in 

equations 4.7 or 4.8 based on Lw with respect to h.  
(Reprinted from Ground Water, 27(3), Bouwer, H., The Bouwer and Rice Slug Test – An Update, pp 304-309, 1989, with permission from 

John Wiley and Sons). 
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Table 4.4: Empirical look up table for Bouwer-Rice method for slug test analysis 
 (Credit: U.S. Geological Survey, Departmnt of the Interior/USGS, taken from Halford and Kuniansky, 2002). 

 

 

 

 

 

 

 

 

 

 

 

 

To solve Kx in equation 4.6, it is necessary to plot the value of ht versus time on a semi-logarithmic plot 

with ht on the log axis. Data will fall on a straight line from small values of time and large displacements.  

As time progresses, points will begin diverting from a straight line.  Figure 4.10 shows that at very short 

times a straight line (A-B) may form with a steeper slope than for slightly later times (A-C).  This initial 

steep slope reflects rapid movement of water into or out of the gravel pack encasing the well.  In 

contrast, the second straight line (B-C) represents movement of water into the geologic material and 

should be the line which one does the following analysis for hydraulic conductivity. 

Any two points are picked along the straight line portion of the graph (B-C) to solve Kx. in which h1 and h2 

are the head displacements at time t1 and t2 respectfully. 

�� =  
����� ���

��
�

 ��

!
���2��� �� �	�

	�
�         (4.9) 

A warning is given to possible “skin effects” as a consequence of well development.  This is the result of 

low hydraulic conductivity materials, such as clays and drilling muds, being smeared along the screen of 

the well. If the material is not removed during well development via pumping or surging the well to stir 

up the fines, then slug tests will produce incorrectly low Kx values.  

log(Le/rw) A B C

0.5000 1.738 0.229 0.835

0.6891 1.738 0.229 0.835

0.8911 1.802 0.269 1.09

0.9893 1.87 0.265 1.192

1.2849 2.175 0.339 1.696

1.4578 2.464 0.407 2.023

1.6855 3.057 0.49 2.698

1.8274 3.604 0.585 3.283

1.9870 4.397 0.738 4.183

2.2708 6.022 1.103 6.732

2.4581 7.069 1.51 8.675

2.6754 8.062 2.1275 10.58

2.9806 9.156 2.8485 12.32

3.2772 9.767 3.3175 13.126
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The USGS has developed excel spread sheets to aid practitioners in the calculation of hydraulic 

conductivity using the Bouwer-Rice analysis for slug tests (Halford and Kuniansky, 2002). These tools are 

available to the public for download at http://pubs.usgs.gov/of/2002/ofr02197/.  

 

 

 

 

 

 

 

 

 

 

 

Figure 4.10:  Head in a borehole as a function of time during a slug test.  The line-segment B-C is 

used in the analysis for Bouwer- Rice to calculate hydraulic conductivity. 
(Reprinted from Ground Water, 27(3), Bouwer, H., The Bouwer and Rice Slug Test – An Update, pp 304-309, 1989, with permission from 

John Wiley and Sons). 

 

4.2.6.4 Aquifer Pump Tests  

Aquifer pump tests are based on drawdown response in a well based on pumping.  In contrast to slug 

tests, the imposed stress of pumping for greater time durations should provide estimates of hydraulic 

properties over a greater region than the immediate vicinity of the well.  Pump tests, however, take 

significantly more planning and are considerably more expensive to carry out than slug tests.  Pump test 

planning will require the following: 

• An estimate of maximum drawdown at the pumped well.   

• Estimate of maximum pumping rate. 

• Evaluation of the best method to measure the pumped volume. 

• Plan discharge of pumped volumes away from the well. 

• Estimate drawdowns at observation wells. 

• Ensure the system is at steady state before initiating the pump test. 

• Ability to maintain a constant pumping rate. 
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• Construct at least two observation wells 

• Establish how drawdown and/or recovery will be measured. 

• Determine time interval(s) for water level measurement. 

Driscoll (1986) is an excellent reference for all aspects of well design, drilling and testing, while 

Kruseman and de Ridder (1994) provide detailed guidance on aquifer tests.  The USGS has software 

programs for analysis of pump tests, including WTAQ (Barlow and Moench, 1999) for radial 

axisymmetric flow to a well under confined and unconfined conditions.  TENSOR2D (Sepulveda, 1992) 

will solve the transmissivity tensor using multi-well tests under anisotropic conditions, while Halford and 

Kuniansky (2002) have created user-friendly spreadsheet applications for several pump test methods 

(http://pubs.usgs.gov/of/2002/ofr02197/). 

Pump test analysis is done using analytic solutions to well equations.  A full derivation of these 

approaches is beyond the scope of this manual.  Instead, the following discussion focuses on governing 

assumptions and application for the different approaches presented.  Well equations can be divided into 

various classes based on confined or unconfined conditions, as well as steady state or transient pumping 

scenarios.  Additional modifications for leaky aquifers (Huntush-Jacob, 1955), storage in an aquitard 

(Huntush-Jacob, 1955), fracture flow via double porosity (Warren Root, 1963), and wellbore storage 

(Cooper et al, 1967) are available but not discussed. 

The performance of pump tests and the analysis of the results may be beyond internal technical 

capabilities of some State DOT geotechnical groups and may warrant external contracting for the 

hydrogeological expertise.  

4.2.6.4.1 Confined/Steady State (Theis andThiem) 

The Theis (1935) is a method that predicts drawdown in a fully confined aquifer given knowledge of 

transmissivity (T = KxB) and the storage coefficient (S). A pumping well and single observation well are 

required. The Theis method is useful for estimating water level response to pumping, pump capacity and 

well spacing, all necessary for designing a successful pump test.  The Theis solution assumes the aquifer 

is (1) infinite in extent, (2) homogenous, (3) isotropic, and that (4) well discharge is constant, (5) the well 

fully penetrates a confined aquifer resulting in horizontal flow to the well, (6) flow to the well is laminar, 

the aquifer has uniform thickness and is horizontal and (7) the potentiometric surface is initially 

horizontal.  The Theis equation solves for drawdown, 

ℎ8 − ℎ =  �
9:; < #=>

? @AB
C          (4.10) 

Where h0 is the initial head prior to pumping (L), and h is the steady-state head (L). Therefore,σ = h0-h is 

drawdown.  T is transmissivity (L
2
/T) and the well integral, D�E� = < #=>

? @AB
C , where  

E =  ��F
9;�           (4.11) 
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And r is the radial distance from the pumping well that an observation occurs. The well integral can be 

approximated by truncating the infinite sum in equation (4.12).  Tabulated values for the well integral 

are also readily available on the web or in Fetter (1994).   

D�E� =  −0.577216 − ln�E� , E −  C�

 ∙ ! ,  CQ

R∙R! −  CS

9∙9! , ⋯     (4.12) 

Assuming a value for S and T, one can solve for u in equation (4.11), then solve for W(u) using equation 

(4.12) and solve for estimated drawdown for a given pumping rate (Q) in equation (4.10). 

The Thiem (1906) equation for steady radial flow in a confined aquifer is used to estimate transmissivity.  

This approach integrates Darcy’s Law in radial coordinates and solves for transmissivity given two 

monitoring wells at a distance from the pumping well at r1 (L) and r2 (L),  with pumped steady-state 

water levels of h1 and h2, respectfully. 

U =  �
 :�	�2 	�� �� ���

��
�          (4.13) 

Q, h, r and T only need to be in consistent units of length and time. Given steady-state conditions, it is 

not possible to solve for the storage coefficient (S), however, the estimate of T (or Kx) is likely more 

accurate than subsequent transient methods. 

4.2.6.4.2 Unconfined/Steady (Thiem) 

A variation of the Thiem equation is used to solve for hydraulic conductivity in an unconfined aquifer 

knowing the drawdown in two observation wells located at a distance from a pumping well. 

U =  �
:�	��2 	��� �� ���

��
�          (4.14) 

4.2.6.4.3 Confined/Transient (Cooper-Jacob) 

The Cooper-Jacob (1946) analysis is the simplest approach for analysis given confined, transient 

conditions.  More complex graphical methods for the Theis equation are available but not discussed.  

The Cooper-Jacob approach is best utilized given a minimum of a single observation well and assumes 

that when  

E =  ��F
9;� < 0.05 ,          (4.15) 

then W(u) is solved using only the first two terms on the right hand side of equation (4.12).  The limiting 

condition is met at either large times or small radial distances from the pumping well (r), and reduces 

the Theis equation to, 

W�$, Y� =   .R�
9:; �Z[ � . \;�

��F �         (4.16) 

Analysis is then a two-step process.  First, the drawdown over one log-cycle of time (e.g. 1 minute and 

10 minutes) will reduce to � . \;�
��F � = 1 ; then, it is possible to solve for T.  Second, at t = t0, it is assumed 

there is no drawdown and �Z[ � . \;�
��F � = 0, meaning � . \;�

��F � = 1 .  It then is possible to solve for S.  As 
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an example taken from Fetter (1994), refer to Figure (4.11) in which drawdown in an observation well is 

plotted over time. Q = 42,000 ft3/d, and r = 824 ft.  

U =  .R�
9:]	 =   .R�9 ,888�

9:�\.\� = 1,400 _Y /@        (4.17) 

` =  . \;��
�� =   . \�!988��R.a�!8=Q�

�b 9�� = 1.7'102\       (4.18) 

Now it is necessary to see if the limiting criterion is met (equation 4.15). If it is not, then data at greater 

times is necessary (and was hopefully collected). 

E =  ��F
9;� =  �b 9��c!.d�!8=ef

9:�!988� = 6.6'1029  < 0.05       (4.19) 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.11: An example of the Cooper-Jacob method for a fully confined aquifer.  Drawdown data 

(white circles) are plotted as a function of logarithmic time. to is the time when a straight line 

intersects the zero drawdown (3.6x10
-3

 days), while ∆h (L) is drawdown over one log-cycle of time. 

  

Halford and Kuniansky (2002) provide a spreadsheet application of the Cooper-Jacob method given no 

observation well (http://pubs.usgs.gov/of/2002/ofr02197/).  The single-well test allows estimates of 

transmissivity, but not storage. Examples are given for a pumping and recovery scenario. 

4.2.6.4.4 Unconfined/Transient (Graphical Theis) 

The Theis graphical solution for unconfined, unsteady aquifer pump test is relatively complicated, but 

several private graphical user interfaces are available to aid the practitioner (e.g. Aquifer Test).  The 
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USGS program WTAQ (Barlow and Moench, 1999) can also be used to help solve more complex pump 

test problems with included uncertainty in estimated hydraulic parameter values.  For guidance, the 

basics are presented here.  

The solution to the flow equation is, 

W =  �
9:; D�E? , Eg , Γ�.         (4.20) 

With tabulated W(ua,Γ) and W(ub,Γ) tabulated by Fetter (1994).  Early-time drawdown when water is 

released from storage uses, 

E? =  ��F
9;�.           (4.21) 

While at later times gravity drainage is more important, such that,  

Eg =  ��Fi
9;�            (4.22) 

where Sy is specific yield.  The gamma function is defined as, 

Γ =  ��jk
.�jl

           (4.23) 

where Kv is the vertical hydraulic conductivity in the aquifer, and B is the initial saturated thickness of 

the aquifer.  It important that drawdown (σ) is small compared to B; if this is not true, then 

modifications to the approach are recommended (Neuman, 1974).  

The graphical method requires both Theis Type A and Type B curves to be plotted as W(ua) and W(ub) 

versus 1/ua or 1/ub, respectfully, in log-log scale.  Type curves are presented in Figure 4.12. Using the 

same log-log scale, drawdown is plotted on the y-axis and time (minutes) plotted on the x-axis.  The data 

should have a similar form to the Type curves.  The Type curves are laid over the observed data until 

they are lined up. Refer to Figure 4.13.  Once the curves are aligned, Γ can be determined.  Next, two 

match points are chosen. They do not need to be on the curve.  The easiest match points to pick are 

represented by W(ua) = 1 and 1/ua = 1, as well as W(ub) = 1 and 1/ub. From these match points, one 

reads drawdown and t, units are converted to be consistent, and finally equations 4.20, 4.21, 4.22 and 

4.23 are rearranged to solve for T, S, Sy, and Κz, the latter is solved since Kx equal to T/B.  
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Figure 4.12: Theis Type A (early time) and B (later time) curves for drawdown data in an unconfined 

aquifer.  Deviation from curves due to leakage is included with Γ (adopted from Fetter, 1994, Source  

Neuman, 1975). 

 

 

 

 

 

 

 

 

 

 

Figure 4.13: Schematic of lining data (black circles) along a Type Curve (black line) and picking a 

match point. (Adopted from Fetter C.W., Applied Hydrogeology, 3
rd

 Edition © 1994, page 105, Reprinted by permission of Pearson 

Education, Inc., Upper Saddle River, NJ). 
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4.3 Specific Yield 

Laboratory and field tests for specific yield, Sy, are expensive and time consuming.  A large number of 

tests must be conducted to get an average for the study site.  Undisturbed soil samples can be collected 

and carefully packaged in an air tight container to prevent drying or cracking in transport. In addition, 

the samples should not be subjected to vibration to maintain soil structure.  In the lab, tension tables 

are used for soils with little swelling clay, while pressure cookers are used for samples containing 

swelling clay to prevent excessive cracking.  Whether a tension table or pressure cooker, these devices 

should be able to maintain a constant tension from 0 to 160 cm of water.  Field tests rely on mercury 

manometers placed at each significant change in soil texture.  Most field offices are not equipped to 

measure Sy.   

Alternatively, Figure 4.14 provides a recommended correlation method to estimate specific yield from 

the hydraulic conductivity (U.S. Department of the Interior, 1978). This correlation is derived from 2,000 

laboratory tests on a wide variety of soil samples, and is within 10% of the best attainable value.   

 

 

 

Figure 4.14: Curve showing general relationship between specific yield and hydraulic conductivity 

(adopted from the U.S. Department of the Interior, 1978) 

 

Hydraulic Conductivity – Inches per Hour (in/hr) 
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4.4 Horizontal Drain Characteristics and Drain Flow 

When horizontal drains are installed to reduce water levels, drain location, drain dimensions (length, 

diameter), drain elevations, angle of drilling, construction details should be noted.  Water level data in 

observation wells should be collected prior to drain installation and after, along with drain flow from 

individual drain clusters. 

An example of mapped drains is provided in Figure 4.15 for site SR101 MP321.  Knowledge of drain 

elevations is critical to properly assessing impact of drains on water levels in the system.  Drilling logs 

should note the subsurface conditions encountered for correlation with the hydrogeologic model.   

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.15: Horizontal drain placement for slide site SR101 MP321 with topographic contour lines 

at 1 ft intervals.  Road is identified as is the Hood Canal.  Drain lengths, collar and tip elevations and 

estimated angle for each drain bank, or cluster, provided (Lowell, 2001). 

 

Various texts provide guidelines on drain installation (e.g., U.S. Department of the Interior, 1978; 

Forrester, 2001) with respect to grade and alignment issues, envelope materials, stability considerations 

and are not discussed here.  However, understanding drain efficiency is very important to properly 

predicting water level response to drain placement.  In groundwater studies, drain efficiency is defined 

via drain conductance (Cd, L
2
/T) and is discussed in Chapter 6.  Drain conductance represents all head 
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losses between the aquifer and the drain, including convergent flow toward the drain (Figure 4.16), flow 

through the envelope material, and flow through the wall of the drain.  The last is dependent on the 

degree that slots in the drain are blocked by chemical precipitates, plant roots or other obstructions.  

Each of these processes can be assumed proportional to drain discharge and added in series.  However, 

in practice this is very difficult to quantify.  Head loss across the envelope and drain can be 

approximated by assuming the hydraulic conductivity of the envelope materials represent the drain as a 

whole and are the major cause of head loss in the system, 

m� =  ��
/n′           (4.24) 

Where A is the surface area (L
2
) of the drain, B’ is the thickness of the drain material (L) and Kd is the 

hydraulic conductivity of the drain and its envelope material (L/T).  Diameter of the drain and thickness 

of the envelope material surrounding the drain are needed for the calculation. The hydraulic 

conductivity of the drain, Kd is dominated by the permeability of the envelope material.  

Envelope material surrounding the drain provides a permeable path for water to move from the base 

material to the drain.  Base material refers to the geologic unit being drained.  The U.S. Bureau of 

Reclamation (BOR) (1993) provides design considerations for envelope material with respect to base 

material in Table 4.5, but is limited to low-head conditions in agricultural settings for which design is 

based.  However, knowledge of envelope grain-size distribution can aid in a quick calculation of Kd using 

equation 4.1.  In addition, constant-head permeameters using envelope material can offer guidance on 

the value of Kd.  As a general guideline, hydraulic conductivity of the envelop material that is ten-times 

the base material will adequately move water from the aquifer into the drain system (BOR, 1993).  

Using equation 4.24 to calculate Cd is only an estimate and likely underestimates head loss, since it fails 

to acknowledge convergent flow toward the drain, which forces progressively steeper head gradients in 

the vicinity of the drain. In practice, the way to capture all three components impacting head loss is to 

measure values of drain flow versus head in the drain and head in the surrounding aquifer.  But if the 

change in head in not accurately known, then Cd is most often adjusted to match drain flow (equation 

6.4), with Kd estimates from equation 4.24 used as an upper guide of drain conductance 

Flow meters should be set at drain outlets, with manual spot-checks done to verify flow meter output.  

Long-term data collection will allow assessment of efficiency response to large rain events, and ascertain 

if efficiency is declining over time (i.e. clogging).  

Table 4.5: Relationships between base materials and envelope materials for low head conditions 

(BOR, 1993) 

 

Base Material

40% retained

Particle Diameter (mm) 0 40 70 90 95 100 0 40 70 90 100

0.02-0.05 9.52 2 0.81 0.33 0.3 0.074 38.1 10 8.7 2.5 0.059

0.05-0.10 9.52 3 1.07 0.38 0.3 0.074 38.1 12 10.4 3 0.059

0.10-0.25 9.52 4 1.3 0.4 0.3 0.074 38.1 15 13.1 3.8 0.059

0.25-1.0 9.52 5 1.45 0.42 0.3 0.074 38.1 20 17.3 5 0.059

Envelope Material Size Limits - Particle Diameter (mm)

Lower Limit - % Retained Upper Limit - % Retained
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Figure 4.16: Cross section through cell I,j,k illustrating head loss in convergent flow to a drain 

(modified from McDonald and Harbaugh, 1988) 

4.5 Fractured Rock Characterization 

This section, with the exception of the displacement-length scaling relations, is a slightly altered version 

of Section 2: Fractured Rock Characterization in: Reeves et al. (2011).   

Bedrock typically has little or no primary porosity and permeability, and networks of fractures serve as 

primary conduits for fluid flow. These networks are spatially discontinuous and highly irregular in 

geometry and hydraulic properties. Full characterization of fractured rock masses is not possible since 

known fracture locations and their attributes consist of an extremely small sample of the overall 

fracture network, i.e., any fracture characterization effort grossly undersamples a field site due to 

limited accessibility to the fractures themselves. Fractured rock masses are typically characterized 

during field campaigns that measure fracture attributes from a number of sources including boreholes, 

rock outcrops, road cuts, tunnel complexes, seismic images and hydraulic tests. This fracture data can 

then be used to generate representative, site-specific fracture networks through the derivation of 

probabilistic descriptions of fracture location, orientation, spacing, length, aperture, hydraulic 

conductivity/transmissivity and values of network density (Figure 4.17). This theoretical treatment of 

fracture networks is necessary to guide drainage network design for successful hillslope dewatering. 

Statistical analysis of the fracture attributes collected from field data is extensively covered in this 

section.  
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Figure 4.17: Illustration showing the correspondence between two- and three-dimensional fracture 

networks. The three-dimensional network (top) is generated according to two fracture sets with 

significant variability about mean fracture orientations, a power-law length distribution exponent of 

a = 2, and a relatively sparse density. The two-dimensional network at the bottom left is computed 

by projecting all fractures onto the yellow horizontal slice located in the center of the three-

dimensional network. The two-dimensional network on the bottom right is the result of identifying 

the hydraulic backbone by eliminating all dead-end fracture segments and non-connected clusters. 

Once the hydraulic backbone is identified, flow can then be computed for the network. (Reprinted with 

permission from Reeves, D.M. et al., Radioactive Waste, 2012, InTech Publishing.) 
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Fracture networks commonly have two or more fracture sets characterized by similar fracture 

orientation (e.g., Barton, 1995; Bour, 1999; Bonnet et al., 2001; Pohlmann et al., 2004, Reeves et al., 

2010). The presence of at least two intersecting sets of fractures reflects the physics of rock fracture 

propagation, where two sets of fractures can arise from a single, stationary stress field (Jaeger et al., 

2007; Twiss and Moores, 2007). Unless fractures are very long, such as regional-scale faults, it is 

important from a groundwater flow perspective to have at least two intersecting fracture sets to 

promote connectivity through a rock mass. 

The orientation of fracture planes is generally denoted by either strike and dip or dip and dip direction 

conventions. Analysis of fracture orientation begins with projecting the poles of measured fracture 

planes onto a stereonet plot and using contours of pole density to identify fracture sets (Figure 4.18). 

Upon identification of fracture sets, mean orientation and the variability of fracture poles for each 

fracture set can be determined. 

 

 

 

Figure 4.18: Stereonet plots of poles to fracture planes with contour plots of all poles (left) and 

identified fracture sets along with prior probability (right). (Reprinted with permission from Reeves, D.M. et al., 

Radioactive Waste, 2012, InTech Publishing.) 

The distribution of fracture orientation is usually modeled using a Fisher distribution (Fisher, 1953): 
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where the divergence, x (degrees), from a mean orientation vector is symmetrically distributed 

π π 
− ≤ ≤ 
 2 2

x  according to a constant dispersion coefficient, κ. The Fisher distribution is a special case 

of the Von Mises distribution, and is similar to a normal distribution for spherical data (Mardia and Jupp, 

2000). The extent to which individual fractures cluster around the mean orientation is described by κ 

where higher values of κ describe higher degrees of clustering. It is our experience that values of κ are 

commonly in the range of κ≤ ≤10 50 for natural fracture networks. Stochastic simulation of Fisher 

random deviates in the discrete fracture networks in the Chapter 8 on Fractured Media Flow is based on 

the method proposed by Wood (1994). 

The Bingham distribution provides an alternative to the Fisher distribution for cases in which fracture 

strike and dip are asymmetrically clustered around mean fracture orientations (Bingham, 1964): 

( ) ( ) ( )κ κ κ

π

 + +
 

=

⋅

2 2 2

1 1 2 2 3 3
exp

( )
4 (1 / 2;3 / 2; )

M x M x M x
f x

F E        (4.26) 

where κ1, κ2, and κ3  are dispersion coefficients that satisfy the condition: κ κ κ≤ ≤ =1 2 3 0 ; M1, M2, and 

M3 are the column vectors of matrix M, E is the eigenvector matrix, and F(1/2,3/2;E) is a hyper-

geometric function of the matrix argument. The probability distribution function described by (4.26) can 

occur for faults that exhibit a greater range in deviations in strike than dip. A shortcoming of the 

Bingham distribution, however, is that it is not mathematically possible to use (4.26) for the stochastic 

generation of asymmetric deviates. 

4.5.1 Spacing 

Fracture spacing refers to the linear distance between fractures. This distance also provides a length 

scale for unfractured matrix blocks. Fracture spacings from a data set require a correction (Terzaghi, 

1965): 

α′= ( )D D sin            (4.27) 

to convert the apparent spacing D' measured along a transect to true fracture spacing D. Values of α 

denote the angle of the transect relative to the mean fracture orientation or a pre-determined 

reference direction (Figure 4.19). Apparent spacing is equal to true spacing, if the transect is 

perpendicular to the mean fracture orientation or reference direction. If α = 90°, the Terzaghi correction 

factor f = sin(α) reduces to 1. 

Once the spacing between fractures is corrected, values of fracture frequency and average fracture 

spacing can be computed. Fracture frequency [units of inverse length, L
-1

] is defined as the total number 

of fractures along the distance of a transect. Average fracture spacing [units of length, L] is simply the 

inverse of fracture frequency, and defines the size of the unfractured matrix block. 

Spacing in natural fracture networks is most commonly an exponentially distributed, random variable. 

This can be tested by plotting the inverse empirical cumulative distribution function of fracture spacing, 
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also known as a survival function (Ross, 1985). If spacing is exponential, the probability decay of the tail 

of the empirical fracture spacing distribution will exhibit a straight line on a semi-log plot (Figure 4.20).  

A Poisson-point process, defined by independent and identically distributed uniform deviates, provides 

easy generation of exponential spacing (Ross, 1985). 

 

 

 

 

 

 

Figure 4.19: Illustration showing how the Tergazhi 

correction accounts for the bias between apparent 

spacing D' and true spacing D based on the 

orientation of the sample transect in relation to 

mean fracture orientation. After 

http://www.rocscience.com/downloads/dips/Web

Help/dips/Terzaghi_Weighting.htm. (Reprinted with 

permission from Reeves, D.M. et al., Radioactive Waste, 2012, InTech 

Publishing.) 

 

 

Figure 4.20: Survival plots of 100 synthetic fracture spacings generated according to a Poisson-point 

process along a 500 m transect. Exponential trends are linear on a semi-log plot (left) and steeply 

decay in log-log plots (right). Note that this transect has a 0.5 m
-1

 fracture frequency, which 

corresponds to an average spacing of 5 m. 
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Other possible distributions of fracture spacing include uniform (Rivers et al., 1992) and fractal 

clustering (Barton, 1995; Darcel et al., 2003), both of which are considered extreme end members. 

Uniform spacing may occur in thin geologic layers, which restrict fracture growth in the vertical direction 

and promote long horizontal fracture growth with nearly constant spacing (Rives et al., 1992). Exact 

causes of fractal clustering are less known and may be related to the role of mechanical fracture 

interaction during propagation, which likely controls fracture length and spacing (Segall and Pollard, 

1983; Olson, 1993; Ackermann and Schische, 1997; Darcel et al., 2003). Networks with fractal clustering 

can be generated via a multiplicative cascade process (Mandelbrot, 1974; Schertzer and Lovejoy, 1987). 

4.5.2 Length 

Fracture length denotes the trace length of a fracture. There is a consensus in recent literature that 

fracture lengths above a lower length cutoff, lmin, are power-law:  

−

> =( )
a

P L l Cl            (4.28) 

with a power law exponent, a, that ranges between 1 and 3 in natural fracture networks  

(Bonnet et al., 2001; Bour and Davy, 1997, 1999; Renshaw, 1999). C is a constant based on lmin and a. 

Though log-normal distributions of fracture length have been reported in the literature, they are a result 

of improper sampling of the largest fractures within a sampling window. Log-normal distributions easily 

arise in data sets with power-law tails, if the largest values are censored (e.g., Figure 4.21). 

 

 

Figure 4.21: Censored data from Figure 4.20 intended to simulate an outcrop exposure where the 

longest fracture is constrained by the size of the sampling window (100 m). Note that the censoring 

of the 23 fracture lengths greater than 100 m causes the power-law trend observed in Figure 4.20 to 

become an exponential (left). A probability plot indicates that the censored data fits a log-normal 

distribution (right). 

 

Determination of the distribution of fracture length is similar to that of fracture spacing and involves the 

analysis of an inverse empirical cumulative distribution function. Fracture lengths that are power-law 
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will exhibit linear trends on a log-log plot for the tail of the distribution (Figure 4.22). In this example, the 

tail of the distribution refers to the greatest 5-10% of length values. The slope of the power-law trend of 

the data is equal to -a. 

 

 

Figure 4.22: Survival plot of 500 synthetic fracture lengths generated according to an alpha-stable, 

heavy-tailed distribution with a = 1.5. Best-fit line (black) depicts trend of power-law decay for 

largest fracture lengths. Deviations from the trend line for the largest 5-8 values are attributed to 

numerical oscillations. Power-law distributions exhibit linear trends in log-log plots. Random 

deviates generated using the program STABLE written by J.P. Nolan, are available at 

http://www.academic2.american.edu/~jpnolan. 

 

Truncations can frequently occur in fracture length data, due to constraints imposed by the finite scale 

of the sampling window. For example in Reeves et al. (2010), the longest fracture measured in a tunnel 

drift was parallel to the drift and was approximately two-thirds of the total drift length. Instead of 

choosing between a traditional power-law or log-normal distribution, an upper truncated Pareto (power 

law) model (Aban et al., 2006): 
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          (4.29) 

was used to compute the power-law trend in the data, where 
( ) ( ) ( )

K

1 2
, , ,

n
L L L are fracture lengths in 

descending order, and L(1) and L(n) represent the largest and smallest fracture lengths, γ  and υ are lower 

and upper fracture length cutoff values, and a describes the tail of the distribution. Truncated power-

law models like (4.29) can also be useful for imposing an upper length scale to the generation of 

stochastic networks at the regional scale. Lacking evidence of domain-spanning faults (with the 
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exception of bounding faults of the stock itself) for a 5 km wide granitic stock, Reeves et al. (2010) 

assigned an upper limit of 1 km in the stochastic generation of fault networks. 

4.5.3 Displacement-Length Scaling Relations 

There are many situations where fracture characterization efforts produce little or no data on fracture 

lengths. This is unfortunate as fracture length is a critical parameter that controls connectivity of 

fractures within a network (e.g., de Dreuzy, 2001; Reeves et al. 2008b; Klimczak et al., 2010). This 

typically occurs when data on fracture length is limited to only very small outcrops or road cuts, or 

fracture data is exclusively collected from boreholes. In these situations, displacement-length scaling 

relations allow for estimation of fracture dimensions based on displacement (Scholz, 1997; Olson, 2003; 

Schultz et al., 2006, 2008; Klimczak et al., 2010; Schultz et al, in review). Displacement-scaling relations 

are based on the mechanics of rock fracture propagation, and their formulation is unique to fracture 

displacement mode, i.e., shear-mode fractures (e.g., faults) exhibit different displacement-scaling 

relations than opening-mode fractures (e.g., joints). 

Displacement-scaling relations for faults can be described by (Scholz, 1997, Schultz et al., 2006, 2008): 

( )
( )

ν

σ σ

−

= −

2
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d y

D
N C

L E
  change C to C*      (4.30) 

where Dmax is the maximum shearing displacement located at the fault midpoint, L is the horizontal fault 

trace length, σd is the shear driving stress, σy is the yield strength of the rock at the fault tip, E and υ are 

Young's modulus and Poisson's ratio of the rock mass, respectively, N is the ratio of geologic offset to 

short-term slip, and C* is a variable that relates to how the stress singularity at the fault tip is removed    

[e.g., Schultz et al. (1996)]. These parameters can be either measured in the field or inferred from 

literature values. However, direct field measurement of fault lengths and displacement reduces (4.30) to 

the form: 

γ=maxD L   (4.31) 

where 
( )

( )
ν

γ σ σ

−

= −

2
2 1

d y
N C

E
. Compilation of displacement-length scaling for a variety of fault types 

across a broad scale consisting of 9 orders of magnitude in length show that values of γ are in a 

surprisingly narrow range of γ≤ ≤0.001 0.1 , with a central tendency of 0.01 (Figure 4.23). This implies 

that, on average, horizontal fault trace length can be related to maximum displacement according to 

=max 0.01D L . On a final note, the dimensions of faults tend to be asymmetric with regards to length and 

height. A review paper on this subject by Nicol et al. (1996) suggests that normal fault length is typically 

2.2 times greater than height. 
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Figure 4.23: Compilation of displacement-length scaling of faults from Schultz et al. (2008). Normal 

faults (NF) open symbols; strike-slip faults (SSF), gray symbols; thrust faults (TF), filled symbols. Lines 

of constant slope (dotted) are shown for different values of γ. (Reprinted from Journal of Structural Geology, 30, 

Schultz, R.A., R. Soliva, H. Fossen, C. Okubo, and D.M. Reeves, Dependence of Displacement-Length Scaling Relations for Fractures and 

Deformation Bands on the Volumetric Changes Across Them, pp 1405-1411, 2008, with Permission from Elsevier.) 

Displacement-length scaling relationships for joints can be described by (Olson, 1993; Schultz et al., 

2008; Klimczak et al, 2010): 

( )ν

π

−

=

2

max

1 8cK
D L

E
  (4.32) 

where Dmax is maximum distance (or width of void opening) between fracture walls located at the 

midpoint of a joint (also referred to as aperture), Kc is fracture toughness which describes the critical 

stress intensity at which a fracture propagates in an elastic medium, and E and υ are Young's modulus 

and Poisson's ratio of the rock mass, respectively. Similar to (4.30) for faults, parameters in (4.32) can be 

measured in the field or inferred from literature values. Direct field measurement of joint lengths and 

displacement (aperture) reduces (4.32) to: 

α=
0.5

maxD L   (4.33) 

where 
( )ν

α

π

−

=

2
1 8cK

E
. Unlike fault data, compilation of displacement-length scaling for a variety of 

opening-mode (tensile) fractures across a broad scale consisting of 7 orders of magnitude in length show 

that values of α are within a relatively wide range of α≤ ≤0.0001 1.0 (Klimczak et al., 2010). However, 

restricting the analysis to data sets for joints and veins in Klimczak et al. (2010) yields a more realistic 

range of α≤ ≤0.01 0.0001 . A central tendency is not present within this range. Displacement-length 

scaling relations assume that joints are 'penny-shaped' and have symmetric length to height ratios. 
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4.5.4 Hydraulic Conductivity 

Boreholes are commonly used to characterize fractured rock masses. Borehole geophysics can provide 

useful information about fractures within the rock, including fracture frequency, orientation, aperture 

and presence of mineral infilling. Fracture aperture, defined as the width of the void space normal to 

fracture walls, can be used to infer hydraulic properties of fractures. Fracture apertures at land surface 

have low confining stresses that are not representative of subsurface confining stresses within a rock 

mass. We therefore recommend that fracture aperture values used to compute flow are measured in 

boreholes where in-situ stress is preserved. 

The cubic law, a solution to the Navier-Stokes equation for laminar, incompressible flow between two 

parallel plates, describes a general relationship between fluid flow and fracture aperture (Snow, 1965): 

ρ

µ

= ∇
3

12

g
Q b h

           (4.34) 

where fluid discharge per unit width, Q [L
2
/t], is proportional to the cube of the hydraulic aperture, b. 

Similar to Darcy's Law, the cubic law (10) assigns discharge through a fracture as a linear function of the 

hydraulic gradient, ∇h. The relationship between hydraulic aperture and transmissivity (T), hydraulic 

conductivity (K) and permeability (k) is described by: 
ρ

µ

=
3

12

g
T b , 

ρ

µ

=
2

12

g
K b , and =

2k b , respectively. 

Fluid-specific properties density, ρ, and viscosity, µ, allow for conversions between permeability and 

hydraulic conductivity/transmissivity. As a note of caution, the relationship between mechanical 

aperture, the physical distance between fracture walls, and hydraulic aperture, the equivalent aperture 

for a given flow rate, is unclear. As a general rule, hydraulic aperture is typically smaller than mechanical 

aperture (Cook et al., 1990; Renshaw, 1995; Zimmerman and Bodvarsson, 1996; Chen et al., 2000). 

Discrepancies between mechanical aperture and hydraulic aperture are attributed to surface roughness, 

flow-path tortuosity, and stress normal to the fracture. Though empirical correction factors have been 

used to correlate mechanical and fracture apertures (Bandis et al., 1985; Cook et al., 1990; Renshaw, 

1995), no method is reliable for a wide range of aperture values. 

Hydraulic testing of boreholes yields reliable estimates of fracture T and K. While there are many 

different hydraulic testing techniques, the isolation of specific intervals during testing with the use of 

dual-packer systems provides the best data to characterize the distribution of hydraulic 

conductivity/transmissivity. These tests yield flow rate information for applied fluid pressures, which 

also allows for the inverse computation of hydraulic aperture using (4.34). These aperture values, in 

addition to T and K estimates, are useful for parameterizing flow models. 

Studies in well characterized rock masses have shown that fracture K is extremely heterogeneous and 

may encompass 5 to 8 orders of magnitude (Paillet, 1998; Guimera and Carrera, 2000; Andersson et al., 

2002a,b). Often the distribution of K (and T) is considered log-normal: 



 
76 

( )µ

σπσ

− − 
=  

 
22

log1
( ) exp

22

x
p x

x         (4.35) 

where x is the mean and σ is the standard deviation. Values of log(σK) are typically around 1 for 

fractured media (Stigsson et al., 2001; Andersson et al., 2002a,b). However, other studies suggest 

power-law distributions (Gustafson and Fransson, 2005; Kozubowski et al., 2008), and that these log-

normal distributions, similar to length, could be caused by censoring flow data, possibly due to 

instrument limitations. Additionally, flow through rough-walled fractures can be non-Darcian (Cardenas 

et al., 2007; Qian et al, 2011; Quinn et al., 2011). This may further complicate the estimation of hydraulic 

conductivity in field hydraulic tests, as flow is no longer linearly proportional to a pressure gradient as 

described by (4.34). 

4.5.5 Density 

Fracture networks consist of two-dimensional planes embedded within a rock matrix (Figure 4.17). The 

lack of access to the total rock volume makes it impossible to directly measure the three-dimensional 

fracture density of a rock mass. Instead, three-dimensional density for discrete fracture networks is 

estimated from density measurements of lower dimensions, i.e., one-dimensional fracture frequency 

from boreholes and/or tunnel drifts or two-dimensional fracture density from outcrops and fracture 

trace maps. Definitions of fracture density according to dimension are: one-dimensional density (also 

known as fracture frequency), ρ1D [L
-1

], is expressed as the ratio of total number of fractures, fi, to 

transect length, L: ρ

=

=∑1

1
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l ; two-dimensional fracture density, ρ2D  [L/L
2
], is expressed as the ratio of 

the sum of fracture lengths, l, to area, A: ρ
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], is expressed as the ratio of the sum of fracture plane area, Ai, to rock volume, V: ρ
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Numerical techniques can be used to upscale one-dimensional fracture frequency [L
-1

] estimates to a 

three-dimensional spatial density [L
2
/L

3
] (Holmén and Outters, 2002; Munier, 2004}. For example, one-

dimensional transects can be used to upscale two-dimensional networks by adding fractures until the 

one-dimensional transect density is satisfied along several transects placed along the two-dimensional 

network. Three-dimensional networks can be generated in a similar fashion by either generating 

fractures until the frequency along one-dimensional boreholes is satisfied or by projecting fractures 

onto sampling planes (e.g., Figure 4.17) until a two-dimensional density criterion is satisfied. 

Fracture density is highly dependent on the distribution of fracture lengths in a model domain, where 

the density at the percolation threshold increases with increasing values of a (Renshaw, 1999; Darcel et 

al., 2003; Reeves et al., 2008b; Klimczak et al., 2010). This will become apparent in the fracture network 

examples shown in Chapter 8 on flow in fractured rock. 
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4.6 Geotechnical Characterization 

The purpose of this manual is for geotechnical specialists and only generalized information is provided 

for completeness.  One is refered to Mayne et al. (2002) and Sabatini et al. (2002) for detailed 

descriptions pertaining to geotechnical site characterization.   

Geological information for slope characterization can be obtained from different sources. Widely used 

sources of geological information are listed Table 4.6.  

Geotechnical parameters of the subsurface layers can be obtained either by laboratory testing or by in-

situ testing. Laboratory testing is conducted on soils sample from a location.  Soil sampling are divided 

into two categories; disturbed and undisturbed sampling. If soil experiences large structural disturbance 

during sampling then it is termed disturbed sample. If soil experiences absolute minimum structural 

disturbance, then it is termed undisturbed sample.  

The popular disturbed sampling method is the split barrel sampler. There are some other methods also 

available those are Retractable Plug method; Auger method (Continuous Helical Flight, Disc, Bucket and 

Hollow Stem) and Diamond Core Barrels (single tube, double tube and triple tube). Sampling method 

can be used to explore undisturbed samples are Shelby Tube; Stationary Piston; Hydraulic Piston 

(Osterberg); Denison; and Pitcher Sampler and Hand cut block or cylindrical sample. Suitable sampler 

can be obtained to get disturbed and undisturbed samples by using Tables 4.7 and 4.8 respectively.   

There are several types of test boring can be used. Those are Auger boring; Hollow-stem flight auger; 

Wash-type boring for undisturbed or dry sample; rotary drilling; Percussion drilling (Churn drilling); rock 

core drilling and wire-line drilling. Suitable test boring type can be selected by using Table 4.9.  

Requirements for Boring Layout vary with investigation area. Suitable boring layout can be selected by 

using Table 4.10.  

4.6.1 In-Situ Testing 

Soil properties can also be found from in-situ testing. Over the years, several in-situ testing devices have 

emerged to characterize soil and to measure strength and deformation properties. The most popular 

devices are Standard penetration test (SPT) Vane shear test (VST) Cone Penetration Test (CPT) 

Pressuremeter test (PMT) and Flat plate dilatometer test (DMT). Any of these in-situ methods can be 

used for site investigation.  Most in-situ device data rely on empirical or semi-theoretical correlations. 

For example if we use standard penetration test, the corrected penetration resistance can be correlated 

to soil strength properties as shown in Tables 4.11 and 4.12. 
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Table 4.6: Sources of geological information NAVFAC (1982). 

 

  

Publications Description of Material

U.S. Geological Survey (USGS)

Consult USGS Index of Publications from Superintendent of Documents, 

Washington, D.C. Order publications from Superintendent of Documents. 

Order maps from USGS, Washington, D.C. Contact regional distribution 

offices for information.

Geological index map
Individuals maps of each state showing coverage and sources of all 

published geological maps.

Folios of the Geological Atlas of 

the United States

Contains maps of bedrock and surface materials for many important urban 

and seacoast areas. When out of print, obtain folios through suppliers of 

used technical literature.

Geological Quadrangle Maps of 

United States

This series supplants the older geological folios including areal or bedrock 

geology maps with brief descriptive text. Series is being extended to 

cover areas not previously investigated.

Bulletins, professional papers, 

circulars, annual reports, 

monographs

General physical geology emphasizing all aspects of earth sciences, 

including mineral and petroleum resources, hydrology and seismicity. 

Areal and bedrock geology maps for specific locations included in many 

publications.
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Table 4.6 continued: 

 

Publications Description of Material

Water supply papers

Series includes papers on groundwater resources in specific localities and 

are generally accompanied by description of subsurface conditions 

affecting groundwater plus observations of groundwater levels.

Topographic maps 
Topographic contour maps in all states, widespread coverage being 

continually expanded.

Libraries
Regional office libraries contain geological and seismological information 

from many sources. Data on foreign countries are often suitable.

State Geological Surveys/State 

Geologist’s Office

Most states provide excellent detailed local geological maps and reports 

covering specific areas or features in the publications of the state 

geologists. Some offices are excellent sources of information on foreign 

countries.

U.S. Department of Agriculture 

(USDA), Soil Conservation 

Service

Consult “List of Published Soil Surveys,” USDA, Soil Conservation Service, 

January 1980 (published annually). Listing by states and countries.

Soil maps and reports

Surveys of surface soils described in agricultural terms. Physical geology 

summarized. Excellent for highway or airfield investigations. Coverage 

mainly in midwest, east, and southern United States.

National Oceanic and 

Atmospheric Administration 

(NOAA), National Ocean Survey 

(NOS)

Consult Catalog 1, Atlantic and Gulf Coasts; 2, Pacific Coast; 3, Alaska; 4, 

Great Lakes; and 5, Bathymetric Maps and Special Charts. Order from 

Distribution Service, National Ocean Survey, Riverdale, Maryland 20840.

Nautical Charts

Charts of coastal and inland waterways showing available soundings of 

bottom plus topographic and cultural features adjacent to the coast or 

waterways.

Geological Society of America 

(GSA)

Write for index to GSA, P.O. Box 9140, 3300 Penrose Place, Boulder, 

Colorado 80302.

Monthly bulletins, special 

papers, and memoirs.

Texts cover specialized geological subjects and intensive investigations of 

local geology. Detailed geological maps are frequently included in the 

individual articles.

Geological maps
Publications include general geological maps of North and South America, 

maps of glacial deposits, and Pleistocene aeolian deposits.
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Table 4.6 continued: 

 

  

Publications Description of Material

Association of Engineering 

Geologists (AEG)

Their journal covers topics in engineering geology, geological engineering 

and geotechnical engineering. Occasionally extensive articles concerning 

the engineering geology aspects of a city will be published.

Trautmann & Kulhawy (1983)

paper that summarizes many data sources: Data Sources for Engineering 

Geologic Studies, Bulletin of the Association of Engineering Geologists, 

Vol. XX, No. 4, 1983, pp. 439 – 454.

Library of Congress

Maintains extensive library of U.S. and foreign geologic reports by 

geographical area. Inquiry to Library of Congress, 10 First Street, 

Washington, D. C. 20540.

Worldwide National Earth-

Science Agencies

For addresses consult “Worldwide Directory of National Earth-Science 

Agencies,” USGS Circular 716, 1975.

World Wide Web (WWW) You can (almost) find just about everything, if you have time, patience!
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Table 4.7: Common Samplers for Disturbed Soil Samples and Rock Cores 

 

Sampler Dimensions

Best Results in 

Soil or Rock 

Types 

Methods of 

Penetration 

Causes of 

Disturbance or 

Low Recovery 

Remarks 

Split Barrel  2: OD – 1.375" 

ID is standard. 

Penetrometer 

sizes up to 4" 

OD – 3.5" ID 

available. 

All fine-

grained soils in 

which sampler 

can be driven. 

Gravels 

invalidate 

drive data. 

Hammer driven Vibration SPT is made using 

standard penetrometer 

with 140# hammer 

falling 30". Undisturbed 

samples often taken 

with liners. Some 

sample disturbance is 

likely. 

Retractable 

Plug 

1" OD tubes 6" 

long. Maximum 

of 6 tubes can 

be filled in 

single 

penetration. 

For silts, clays, 

fine and loose 

sands. 

Hammer driven Improper soil 

types for 

sampler. 

Vibration. 

Light weight, highly 

portable units can be 

hand carried to job. 

Sample disturbance is 

likely. 

Augers: 

Continuous 

Helical Flight 

3" to 16" dia. 

Can penetrate 

to depths in 

excess of 50 

feet. 

For most soils 

above water 

table. Will not 

penetrate hard 

soils or those 

containing 

cobbles or 

boulders. 

Rotation Hard soils, 

cobbles, 

boulders. 

Rapid method of 

determining soil profile. 

Bag samples can be 

obtained. Log and 

sample depths must 

account for lag between 

penetration of bit and 

arrival of sample at 

surface. 

Disc Up to 42" dia. 

Usually has 

maximum 

penetration of 

25 feet. 

Same as flight 

auger. 

Rotation Same as flight 

auger. 

Rapid method of 

determining soil profile. 

Bag samples can be 

obtained. 

Bucket Up to 48" dia. 

common. 

Larger 

available. With 

extensions, 

depths greater 

than 80 feet 

are possible 

For most soils 

above water 

table. Can dig 

harder soil 

than above 

types, and can 

penetrate soils 

with cobbles 

and small 

boulders when 

equipped with 

a rock bucket 

Rotation Soil too hard to 

dig 

Several type buckets 

available including those 

with ripper teeth and 

chopping buckets. 

Progress is slow when 

extensions are used. 
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Table 4.7 continued: 

 

  

Sampler Dimensions

Best Results in 

Soil or Rock 

Types 

Methods of 

Penetration 

Causes of 

Disturbance or 

Low Recovery 

Remarks 

Standard sizes 

1-

1/2" to 3" OD, 

7/8" to 2-1/8" 

core. Barrel 

lengths 5 to 10 

feet for 

exploration. 

Fractured rock. 

Rock too soft 

Has inner barrel or 

swivel which does not 

rotate with outer tube. 

For soft, erodible rock. 

Best with bottom 

discharge bit. 

Same as 

Double 

Same as Differs from Double 

Tube. Double Tube. Tube by having an 

additional inner split 

tube liner. Intensely 

fractured rock core best 

preserved in this barrel. 

Double Tube Non-uniform, 

fractured, 

friable and soft 

rock. 

Improper 

rotation or 

feed rate in 

fractured or 

soft rock. 

Triple Tube 

Augers:  

Hollow Stem 

Hard rock. All 

barrels can be 

fitted with 

insert bits for 

coring soft rock 

or hard soils. 

Single Tube Primarily for 

strong, sound 

and uniform 

rock 

Drill fluid must circulate 

around core – rock must 

not be subject to 

erosion. Single tube not 

often used for 

exploration. 

Diamond          

Core Barrels

Generally 6" to 

8" OD with 3" 

to 4" ID hollow 

stem. 

Same as 

Bucket. 

Same Same A special type of flight 

auger with hollow center 

through which 

undisturbed samples or 

SPT can be taken. 
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Table 4.8: Common Samplers for Undisturbed Samples  

 

 

Sampler Dimensions
Best Results in 

Soil Types 

Methods of 

Penetration 

Causes of 

Disturbance
Remarks 

Shelby Tube 3" OD - 2.875" 

ID most 

common. 

Available from 

2" to 5" OD. 30" 

sampler length 

is standard. 

For cohesive 

fine-grained or 

soft soils. 

Gravelly soils 

will crimp the 

tube. 

Pressing with 

fast, smooth 

stroke. Can be 

carefully 

hammered. 

Erratic pressure 

applied during 

sampling, 

hammering, 

gravel 

particles, 

crimping tube 

edge, improper 

soil types for 

sampler. 

Simplest sampler for 

undisturbed samples. 

Boring should be 

clean before lowering 

sampler. Little waste 

area in sampler. Not 

suitable for hard, 

dense or gravelly 

soils. 

Stationary 

Piston 

3" OD most 

common. 

Available from 

2" to 5" OD. 30" 

sample length 

is standard. 

For soft to 

medium clays 

and fine silts. 

Not for sandy 

soils. 

Pressing with 

continuous, 

steady stroke. 

Erratic pressure 

during 

sampling, 

allowing piston 

rod to move 

during press. 

Improper soil 

types for 

sampler. 

Piston at end of 

sampler prevents 

entry of fluid and 

contaminating 

material. Requires 

heavy drill rig with 

hydraulic drill head. 

Generally less 

disturbed samples 

than Shelby. Not 

suitable for hard, 

dense or gravelly soil. 

No positive control of 

specific recovery 

ratio. 

Hydraulic 

Piston 

(Osterberg) 

3" OD most 

common – 

available from 

2" to 4" OD, 36" 

sample length. 

For silts-clays 

and some 

sandy soils. 

Hydraulic or 

compressed air 

pressure. 

Inadequate 

clamping of 

drill rods, 

erratic 

pressure. 

Needs only standard 

drill rods. Requires 

adequate hydraulic or 

air capacity to activate 

sampler. Generally 

less disturbed 

samples than Shelby. 

Not suitable for hard, 

dense or gravelly soil. 

Not possible to limit 

length of push or 

amounts of sample 

penetration. 
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Table 4.8 Continued: 

 

  

Sampler Dimensions
Best Results in 

Soil Types 

Methods of 

Penetration 

Causes of 

Disturbance
Remarks 

Denison Samplers from 

3.5" OD to 7-

3/4" OD. 

(2.375" to 6.3" 

size samples). 

24" sample 

length is 

standard. 

Can be used for 

stiff to hard 

clay, silt and 

sands with 

some 

cementation, 

soft rock. 

Rotation and 

hydraulic 

pressure. 

Improperly 

operating 

sampler. Poor 

drilling 

procedures. 

Inner tube face 

projects beyond outer 

tube which rotates. 

Amount of projection 

can be adjusted. 

Generally takes good 

samples. Not suitable 

for loose sands and 

soft clays. 

Pitcher 

Sampler 

Sampler 4.125" 

OD used 3" 

Shelby Tubes. 

24" sample 

length. 

Same as 

Denison. 

Same as 

Denison. 

Same as 

Denison. 

Differs from Denison 

in that inner tube 

projection is spring 

controlled. Often 

ineffective in 

cohesionless soils. 

Hand cut block 

or cylindrical 

sample 

Sample cut by 

hand. 

Highest quality 

undisturbed 

sampling in 

cohesive soils, 

cohesionless 

soil, residual 

soil, 

weathered 

rock, soft rock. 

Change of state 

of stress by 

excavation. 

Requires accessible 

excavation. Requires 

dewatering if 

sampling below 

groundwater. 
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Table 4.9: Types of Test Boring 

 

  

Denison Samplers from 3.5" OD to 7-3/4" OD. 

(2.375" to 6.3" size samples). 24" 

sample length is standard. 

Can be used for stiff to hard clay, silt 

and sands with some cementation, soft 

rock. 

Pitcher 

Sampler 

Sampler 4.125" OD used 3" Shelby 

Tubes. 24" sample length. 

Same as Denison. 

Hand cut block 

or cylindrical 

sample 

Sample cut by hand. Highest quality undisturbed sampling 

in cohesive soils, cohesionless soil, 

residual soil, weathered rock, soft rock. 

Hollow-stem 

flight auger

Power operated, hollow stem serves as 

a casing.

Access for sampling (disturbed or 

undisturbed) or coring through hollow 

stem. Should not be used with plug in 

granular soil. Not suitable for 

undisturbed sampling in sand and silt.

Wash-type 

boring for 

undisturbed or 

dry sample

Chopping, twisting, and jetting action 

of a light bit as circulating drilling fluid 

removes cuttings from holes. Changes 

indicated by rate of progress, action of 

rods, and examination of cuttings in 

drilling fluid. Casing used as required to 

prevent caving.

Used in sands, sand and gravel without 

boulders, and soft to hard cohesive 

soils. Most common method of subsoil 

exploration. Usually can be adapted for 

inaccessible locations, such as on 

water, in swamps, on slopes, or within 

buildings. Difficult to obtain 

undisturbed samples.

Ordinarily used for shallow 

explorations above water Table in 

partly saturated sands and silts, and 

soft to stiff cohesive soils. May be used 

to clean out hole between drive 

samples. Very fast when power-driven. 

Large diameter bucket auger permits 

examination of hole. Hole collapses in 

soft soils and soils below groundwater 

Table.

Hand or power operated augering with 

periodic removal of material. In some 

cases continuous auger may be used 

requiring only one withdrawal. 

Changes indicated by examination of 

material removed. Casing generally not 

used.

Auger boring

Boring Procedure Utilized Applicability
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Table 4.9 Continued: 

 

Table 4.10: Requirements for Boring Layout (NAVFAC, 1982) 

 

Percussion Power chopping with limited amount 

of water at bottom of hole. Water 

becomes slurry that is periodically 

removed with bailer or sand pump.

drilling (Churn Changes indicated by rate of progress, 

Rock core 

drilling

Power rotation of a core barrel as 

circulating water removes ground-up 

materials from hole. Water also acts as 

coolant for core barrel bit. Generally 

hole is cased to rock.

Used alone and in combination with 

boring types to drill weathered rocks, 

bedrock, and boulder formations.

Wire-line 

drilling

Rotary type drilling method where the 

coring device is an integral part of the 

drill rod string which also serves as a 

casing. Core samples obtained by 

removing inner barrel assembly from 

the core barrel portion of the drill rod. 

The inner barrel is released by a 

retriever lowered by a wire-line 

through drilling rod.

Efficient for deep hole coring over 100 

feet on land and offshore coring and 

sampling.

Boring Procedure Utilized Applicability

Not preferred for ordinary exploration 

or where undisturbed determining 

strata changes, disturbance caused 

below chopping bit, difficulty of access, 

and usually higher cost. Sometimes 

used in combination with auger or 

wash borings for penetration of coarse 

gravel, boulders, and rock formations. 

Could be useful to probe cavities and 

weakness in rock by changes in drill 

rate.

Areas of Investigation Boring Layout

Slope stability, deep cuts, high 

embankments.

Provide three to five borings on line in the critical 

direction to provide geological section for analysis. 

Number of geological sections depends on extent of 

stability problem. For an active slide, place at least one 

boring upslope of sliding area.
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Table 4.11: Correlations and Approximations for Cohesive Soils. 

 

 

Table 4.12: Correlations and Approximations for Granular Soils. 

 

 

  

Consistency Very Soft Soft Medium Stiff Very Stiff Hard

Compressive 

strength, qu 

(kPa)

< 25 25 – 50 50 – 100 100 – 200 200 – 400 > 400

Compressive 

strength, qu (tsf)
< 0.25 0.25 – 0.5 0.5 – 1.0 1.0 – 2.0 2.0 – 4.0 > 4.0

Corrected 

Standard 

Penetration 

Resistance, N1

0 – 2 3 – 5 6 – 9 10 – 16 17 – 30 > 30

Approx. range 

of moist unit 

weight, g, 

(kN/m
3
)

16 – 18 16 – 19 17 – 20 18 – 21 19 – 22 19 – 22

NOTE:  The undrained strength is ½ of the unconfined compressive strength

Description Very Loose Loose Medium Dense Very Dense

Relative Density, Dr 

(%)
0 – 15 15 – 35 35 – 65 65 – 85 > 85

Corrected Standard 

Penetration 

Resistance, N1

0 – 4 5 – 10 11 – 30 31 – 50 > 50

Approx. Angle of 

Internal Friction, f
25° – 30° 27° – 32° 30° – 35° 35° – 40° 38°– 43°

Approx. range of 

moist unit weight, 

g(kN/m
3
)

11.0 – 16 14 – 18 17 – 20 18 – 22 20    – 24
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Chapter	5	

Estimating	Groundwater	Recharge	

5.1 Introduction 

Recharge is defined as that proportion of precipitation that reaches the water table.  An estimation of 

recharge is needed for the design of subsurface drainage.  A very simplified approach is provided to 

estimate the amount and timing of precipitation that becomes groundwater recharge.  Specifically, the 

method employed is that developed by the United States Department of Agriculture Soil Conservation 

Service (USDA-SCS, 1972) to estimate abstractions, or the depth of precipitation that does not become 

overland flow or is lost to evapotranspiration.  Abstraction is analogous to infiltration. Estimating both 

steady state recharge, or long term average conditions (e.g. annual rate), as well as transient recharge of 

100 year 24-hour precipitation event, are discussed. 

5.2 SCS Method for Abstractions 

The SCS methodology is based on the assumption that direct runoff, after some initial abstraction (e.g. 

loss to storage depressions, interception, and plant uptake) will depend on land surface cover, land use, 

soil type and antecedent moisture conditions.  The approach is widely accepted and used in a variety of 

hydrologic, erosion and water quality models (e.g. Foster et al., 1980;, Williams et al., 1984a; 1984b; 

Young et al., 1987; Arnold et al., 1990; Meinardus et al., 1998).  The approach uses one parameter – the 

curve number (CN), which has been defined over a wide range of geographic, soil and land management 

conditions.  Chapter 4 on Site Characterization provides literature sources for estimating the curve 

number based on hydrologic soil cover complexes. 

One of the earliest equations for infiltration was developed by Horton (1933, 1939) in which infiltration 

begins at some initial rate (f0) and decreases exponentially over time until it reaches a constant rate (fc), 

where k is the decay constant (1/T). 

���� = 	 �� + ��� −	�
��
�
�          (5.1) 

A plot of f(t) is superimposed on precipitation rates in Figure 5.1.  Using Figure 5.1 for reference, the SCS 

approach to estimating storm precipitation assumes that  

• The depth (amount measured in length, i.e., inches) of cumulative excess precipitation (Pe) for 

runoff is always less than cumulative total precipitation (P). 

• The depth of precipitation that recharges the system (Fa) is less than some potential maximum 

retention (S’). 

• There is some amount of rainfall (Ia) that occurs before any runoff can occur such that the 

maximum runoff is P-Ia. 

• The ratio of actual-to-potential (maximum) for infiltration and runoff are equal. 
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The resulting ratios become, 

�
����

�������
=	

��

��
=	

��

��	��
          (5.2) 

From continuity, runoff Pe equals, 

�� = 	� −	  � −	!�           (5.3) 

Combining equations 5.2 and 5.3 and solving for cumulative recharge, Fa, 

!� = 	
�����	���

��	��"��
.           (5.4) 

It is assumed that initial losses are equal to 20% of total storage potential, 

 �	 = 0.2&',           (5.5) 

with storage (inches) assumed to be a function of the soil’s curve number such that, 

&' = 	
(���

)*
− 10.          (5.6) 

Assigning a CN and knowing the cumulative precipitation (P), one can then solve for cumulative 

recharge, Fa.  For modeling purposes it is assumed that Ia does not recharge the groundwater system.  

Instead, it is assumed to be lost to soil storage, plant interception and evapotranspiration. 

 

 

 

 

 

Figure 5.1: Graphical 

representation of the SCS 

method of rainfall 

abstractions where Ia = 

initial abstractions, Pe = 

rainfall excess and Fa = 

continuing abstractions 

(modified from Chow et 

al., 1988) 
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5.2.1 Example Calculation for Recharge 

To illustrate the calculation of recharge, Table 5.1 lists hourly precipitation for a single storm event 

lasting seven hours.  For a CN = 80, the the basin’s storage potential is computed as S’ = (1000/80)-10 = 

2.5 inches, and the initial abstraction Ia = 0.2S’ = 0.2(2.5 inches) = 0.5 inches.  This means that 0.5 inches 

of rain must fall before any runoff or recharge is generated.  From Table 5.1, only 0.2 inches of rain falls 

in the first hour and no recharge occurs.  In the second hour, 0.7 inches falls, and the cumulative 

precipitation (P) of 0.9 inches surpasses the initial abstraction.  From equation 5.4, Fa = 2.5(0.9-0.5)/(0.9-

0.5+2.5) = 0.34 inches of recharge.  Note that 0.5 + 0.34 = 0.84 inches. Given 0.9 inches of rain has fallen, 

the balance of 0.06 inches of rain becomes runoff (Pe).  During the second hour, an additional 0.37 

inches of rain falls.  P = 1.27.  From equation 5.4, Fe = 0.59 inches.  This is cumulative, and the 

incremental recharge for the third hour, Fa,inc = 0.59 – 0.34 = 0.24 inches of recharge.  Over the 7-hour 

storm, SCS calculations given a CN = 80 produce 1.65 inches of recharge.  For comparison, a CN = 65 will 

produce 70% more recharge (2.39 inches) while a CN = 95 will generate a lot of runoff and very little 

recharge (0.48 inches). 

For individual storms it is necessary to reinitialize the sequence such that the initial abstraction is met 

prior to any recharge. It is recommended that individual storms are separated by at least 24 hours with 

no rain.  However, site specific expert judgment should be used as to what lag between rainfall 

constitutes an individual storm event.  

 

Table 5.1: Example calculations for a 7-hour rain event given CN = 80. Pinc = incremental 

precipitation, P = cumulative precipitation, Ia = initial abstraction, Fa = cumulative recharge, Fa,inc = 

incremental recharge and Pe = cumulative runoff. 

 

 

5.2.2 Modifications to the Curve Number 

The curve number designated to various soil hydrologic groups may need to be modified based on 

antecedent moisture conditions (USDA-SCS, 1972).  The designated CN are based on normal antecedent 

moisture class (AMC II).  If soil conditions are dry (AMC I) or wet (AMC III), then empirical evidence 

suggests equivalent curve numbers are computed as, 

time P inc P I a F a F a,inc Pe

hr inches inches inches inches inches inches

1 0.20 0.20 0.20 0.00 0.00 0.00

2 0.70 0.90 0.50 0.34 0.34 0.06

3 0.37 1.27 0.50 0.59 0.24 0.18

4 1.04 2.31 0.50 1.05 0.46 0.76

5 2.25 4.56 0.50 1.55 0.50 2.51

6 0.73 5.29 0.50 1.64 0.10 3.15

7 0.07 5.36 0.50 1.65 0.01 3.21
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,-� � = 	
../)*����

(���.�01)*����
          (5.7) 

,-�   � = 	
/2)*����

(�"�.(2)*����
         (5.8) 

Classification of antecedent moisture classes are provided in Table 5.2.  The curves for dry and moist 

antecedent moisture conditions are non-linear.  Curves deviate most from AMC II conditions at low CN 

values and converge toward AMC II conditions at high CN values.  Therefore, characterizing soil moisture 

conditions becomes more critical for systems with relatively large infiltration capabilities.   In addition, 

Table 5. 1 is not site specific.  For example, two inches of rain over a five day period on the Olympic 

Peninsula, WA may not require one to consider the system AMC III, but for an arid system in eastern 

Washington, it would. Under these circumstances, it is best to use the lower CN in the calculations as it 

will produce the most groundwater recharge and force a conservative approach to horizontal drainage 

design. 

 

Table 5.2: Classification of antecedent moisture classes (AMC) for SCS method of rainfall 

abstractions (modified from USDA-SCS, 1972). 

 

 

 

 

 

The CN approach is based in agricultural sciences where slopes are generally less than 5°.  If surface 

runoff increases with increased slope, then adjustment to the CN may be required.  Huang et al. (2006) 

empirically derived an expression for gradients on the order of 0.14 to 1.4 (8°-54°) 

,-�  �4 = ,-�  �
2//.56"(0.724

4"2/2.0/
 ,        (5.9) 

where α is the slope gradient (L/L).  

Figure 5.2 shows the impact on estimated recharge (expressed as a cumulative depth over time) when a 

CN of 75 is modified for dry, wet or steep slope conditions.  For dry AMC the CN(I) falls to 56 (equation 

5.7), while for moist AMC the CN(III) increases to 87 (equation 5.8).  A larger CN correspond to greater 

runoff and less groundwater recharge.  A steep slope of 40° increases the CN(II) for flat surfaces only 

slightly from 75 to 77.6.  Impacts to cumulative recharge (Fa) as a result of wet AMC or steep slope are 

not large compared to changes in recharge as a function of dry moisture conditions.  A reduction in CN 

from 75 to 56 causes a delay in the onset of recharge based on a larger initial abstraction (Ia, soil 

AMC Group Dormant Season Growing Season

I < 0.5 < 1.4

II 0.5 to 1.1 1.4 to 2.1

III > 1.1 > 2.1

total 5 day antecedent rainfall (inches)
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storage, plant interception and evapotranspiration), but after 5 hours the amount of cumulative 

recharge surpasses wet conditions and steep slope conditions. 

 

 

 

 

 

 

 

 

 

 

Figure 5.2:  Impact on cumulative recharge (Fa) by modifying the CN(II) = 75 based on AMC and slope 

(α = 40°) for a given precipitation event over 7 hours. 

 

5.3 SCS	100-Year 24-Hour Storm Event 

For horizontal drain design a large event is simulated to see if the drains can lower water levels quickly.  

The extreme event chosen for design considerations is the 100-year 24 hour event, though less extreme 

events could also be considered depending upon the criticality of the application.    

The U.S. Department of Agriculture, SCS (1986) developed synthetic storm hyetographs for storms given 

a 24-hour duration.  Four storm types in the United States are identified, Type IA, I, II and III.  Figure 5.3 

gives the geographic locations for each storm type.  Rainfall distributions are tabulated in Table 5.3 and 

plotted in Figure 5.4. Types IA and I define the Pacific maritime climates with wet winters and dry 

summers.  Type III is for the Gulf of Mexico and Atlantic coastal regions where tropical storms result in 

large 24-hour rainfall amounts.  Type II storms are for the remainder of the nation. Type II and III storms 

have the largest intensity, in that a greater proportion of rain for these storms falls over a relatively 

short period of time.  Type IA distributes its precipitation more gradually across the 24-hour period. 

Rainfall in a 24-hour period is obtained from the National Weather Service (NWS) for different parts of 

the country.  NWS Technical Paper 40, or TP-40 (Hershfield, 1961) gives 24-hour isopluvial maps for the 

areas east of the 105
th

 meridian, with the map of the 100-year return period provided in Figure 5.5.  For 

regions west of the 105
th

 meridian, TP-40 has been superseded by NOAA Atlas 2 (1972).  NOAA (1972)  
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Figure 5.3: Location with in the US the 24-hour storm hyetographs for each of the four SCS storm 

types (USDA-SCS, 1986).  

 

 

 

 

 

 

Figure 5.4:  SCS 24-

hour storm 

hyetographs (USDA-

SCS, 1986) 
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Table 5.3: USDA-SCS (1986) 24-hour rainfall 

distributions for different storm types. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

isopluvial maps for 6-mo, 2-, 5-10-, 25-, 50- and 100-year return periods for individual states in the 

western US are archived by WRCC (http://www.wrcc.dri.edu/pcpnfreq.html).  The 100-year return 

period for Washington State is given in Figure 5.6. 

Recharge as a function of CN and total precipitation in a 100-year, 24-hour storm event (for a type IA 

storm distribution) is plotted in Figure 5.7.  Recharge depth increases with total precipitation for all 

values of CN.  For low total precipitation depths, low CNs will have lower total recharge than higher CN 

values, based on losses to the initial abstraction.  As an example, total precipitation must be greater 

than 3.2 inches for a CN of 55 to produce more recharge than a CN equal to 80 (marked in Figure 5.7a).  

For larger precipitation totals (P > 5 inches), raising the CN will always cause a decrease in estimated 

recharge.  Focusing on the percentage of precipitation that becomes recharge (Figure 5.7b) shows that 

for CN < 80, the percentage of recharge decreases with increased total precipitation.  For CN values 

equal to or less than 80, maximum recharge occurs between 3 and 5 inches.  Lower total precipitation 

loses water to initial abstraction, while larger precipitation forces more water to run off.  Maximum 

recharge is always less than 50% the total precipitation when Ia is assumed not to recharge the 

groundwater system. 

1A I II III

0 0 0 0 0

2 0.05 0.035 0.022 0.02

4 0.116 0.076 0.048 0.043

6 0.206 0.125 0.08 0.072

7 0.268 0.156 0.098 0.089

8 0.425 0.194 0.12 0.115

8.5 0.48 0.219 0.133 0.13

9 0.52 0.254 0.147 0.148

9.5 0.55 0.303 0.163 0.167

9.75 0.564 0.362 0.172 0.178

10 0.577 0.515 0.181 0.189

10.5 0.601 0.583 0.204 0.216

11 0.624 0.624 0.235 0.25

11.5 0.645 0.654 0.283 0.298

11.75 0.655 0.669 0.357 0.339

12 0.664 0.682 0.663 0.5

12.5 0.683 0.706 0.735 0.702

13 0.701 0.727 0.772 0.751

13.5 0.719 0.748 0.799 0.785

14 0.736 0.767 0.82 0.811

16 0.8 0.83 0.88 0.886

20 0.906 0.926 0.952 0.957

24 1 1 1 1

Fraction of Storm Total
hours
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Figure 5.5: 100-year, 24-hour rainfall depth (inches) for regions east of the 105
th

 meridian.  Map 

published by Hershfield (1961) and TR-55 (USDA-SCS, 1986). Isopluvial contours at one inch. 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.6: 100-year, 24-hour isopluvial map for Washington State (NOAA, 1972). Depths in 10
th

 of 

an inch.  
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Table 5.4: Computed recharge (R, ft/d) for site MP 321 for a 100-year, 24-hour storm event, 

assuming a CN = 80. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Storm Dist. P

IA inches Fa inches R ft/d

0 0.000 0 0 0.0000 0.0000

2 0.083 0.05 0.45 0.0000 0.0000

4 0.167 0.116 1.044 0.4468 0.4468

6 0.250 0.206 1.854 0.8783 0.4315

7 0.292 0.268 2.412 1.0834 0.4102

8 0.333 0.425 3.825 1.4270 0.6873

8.5 0.354 0.48 4.32 1.5111 0.3361

9 0.375 0.52 4.68 1.5644 0.2132

9.5 0.396 0.55 4.95 1.6007 0.1454

9.75 0.406 0.564 5.076 1.6167 0.1281

10 0.417 0.577 5.193 1.6311 0.1149

10.5 0.438 0.601 5.409 1.6564 0.1013

11 0.458 0.624 5.616 1.6794 0.0917

11.5 0.479 0.645 5.805 1.6992 0.0795

11.75 0.490 0.655 5.895 1.7084 0.0730

12 0.500 0.664 5.976 1.7164 0.0643

12.5 0.521 0.683 6.147 1.7328 0.0658

13 0.542 0.701 6.309 1.7478 0.0598

13.5 0.563 0.719 6.471 1.7622 0.0575

14 0.583 0.736 6.624 1.7753 0.0524

16 0.667 0.8 7.2 1.8207 0.0454

20 0.833 0.906 8.154 1.8845 0.0319

24 1.000 1 9 1.9318 0.0237

Computed Recharge
hours day
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 (b) 

 

Figure 5.7: Cumulative recharge as a function of CN and total 24-hour precipitation given a SCS type 

IA storm distribution in (a) inches, (b) percentage of total precipitation.  



 
104 

5.3.1 Example Problem: Recharge Calculation for 100-Year, 24-Hour Storm. 

For the example site, SR 101 MP 321 is located in western WA with a type IA 24-hour storm pattern. 

Figure 5.8 is an enlargement the NOAA (1972) Atlas 2 of Washington State with MP 321 location 

identified.  Contours are given at the 10
th

 of an inch for total storm precipitation. Storm total for MP 321 

is approximately 9 inches.  

For the 8
th

 hour in the storm, the cumulative fraction of storm total is 0.425, or P = 3.83 inches given a 

storm total of 9 inches.  Initial abstraction for a CN = 80 is 0.5.  Since P>Ia, then Fa from equation 5.4 

equals 1.43 inches.  Fa for the previous time step (t = 7 hours) is 1.0834 inches, therefore the 

incremental recharge is 0.34 inches in one hour, or 0.69 ft/day.  Table 5.4 gives computed recharge 

estimates for all storm stress periods.  

 

 

 

 

 

 

 

 

 

Figure 5.8: NOAA Atlas 2 (1972) for 

100-year 24-hour rain totals (10
th

 of an 

inch contours).  Map is of western 

Washington State with MP 321 

identified by red-circle and historic 

weather station site Quilcene COOP 

approximated with a red X.   
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Table 5.4: Computed recharge (R, ft/d) for site MP 321 for a 100-year, 24-hour storm event, 

assuming a CN = 80. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.4 Steady State Recharge 

Steady state recharge represents the long-term, or average, recharge.  It does not include episodic 

events such as the 100-year storm event discussed in the previous section.  Instead, steady state 

recharge and resultant steady state groundwater levels (or pore pressures) indicate a system in 

equilibrium.  Quantifying steady state conditions is necessary to understanding baseline conditions prior 

to a large and/or sudden perturbation in system stress (such as a 100 year storm).  

Two different methods for assigning steady state recharge are provided, depending on availability of 

site-specific precipitation data.  If site-specific data is available and collected over a significant period of 

Storm Dist. P

IA inches Fa inches R ft/d

0 0.000 0 0 0.0000 0.0000

2 0.083 0.05 0.45 0.0000 0.0000

4 0.167 0.116 1.044 0.4468 0.4468

6 0.250 0.206 1.854 0.8783 0.4315

7 0.292 0.268 2.412 1.0834 0.4102

8 0.333 0.425 3.825 1.4270 0.6873

8.5 0.354 0.48 4.32 1.5111 0.3361

9 0.375 0.52 4.68 1.5644 0.2132

9.5 0.396 0.55 4.95 1.6007 0.1454

9.75 0.406 0.564 5.076 1.6167 0.1281

10 0.417 0.577 5.193 1.6311 0.1149

10.5 0.438 0.601 5.409 1.6564 0.1013

11 0.458 0.624 5.616 1.6794 0.0917

11.5 0.479 0.645 5.805 1.6992 0.0795

11.75 0.490 0.655 5.895 1.7084 0.0730

12 0.500 0.664 5.976 1.7164 0.0643

12.5 0.521 0.683 6.147 1.7328 0.0658

13 0.542 0.701 6.309 1.7478 0.0598

13.5 0.563 0.719 6.471 1.7622 0.0575

14 0.583 0.736 6.624 1.7753 0.0524

16 0.667 0.8 7.2 1.8207 0.0454

20 0.833 0.906 8.154 1.8845 0.0319

24 1.000 1 9 1.9318 0.0237

Computed Recharge
hours day
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time to reflect wet and dry seasons (e.g. one or more years), then recharge is computed and averaged 

over the period of record.  For example, using the 2010 water year precipitation record of site MP 321, 

Fa is calculated at approximately 10 inches/year.  Given 365 days, the steady state recharge rate is 

estimated at 0.0023 ft/d.  

If data are not readily available, or only available for a short period of record, then steady state recharge 

can be approximated by using the average annual total precipitation for the site based on precipitation 

records tabulated by regional climate centers (refer to Chapter 4.2.4) and using historic data.  For site 

MP 321, and assuming Quilcene 2SW (COOP) historic data most closely represents MP 321 (refer to 

Figure 5.8), average depth of precipitation is 51 inches per year (between years 1920 and 2010).  For this 

site, the 100-year 24-hour event is 9 inches and a CN = 80 will produce 1.93 inches of recharge, or 21% 

(refer to Figure 5.7 or Table 5.5).  If one assumes the same percentage of recharge between the 100-

year storm and the long-term average, then 51 inches multiplied by 0.21 will equal 10.7 inches, or a 

recharge rate of 0.0024 ft/d. 

 

Table 5.5 Recharge and maximum infiltration rates as a function of CN, storm total precipitation and 

storm type. 

 

  

Recharge 

(inches) % recharge

CN

24 hr Total 

P (inches)

All Storms 

Types all types IA I II III

55 1 0.00 0 0.00 0.00 0.00 0.00

55 2 0.35 17 0.09 0.09 0.12 0.13

55 3 1.17 39 0.33 0.47 2.70 1.78

55 4 1.83 46 0.84 3.22 7.23 2.79

55 5 2.38 48 0.95 5.38 9.98 5.78

55 6 2.85 47 1.64 5.85 10.76 6.32

55 7 3.24 46 1.84 6.22 11.34 6.74

55 8 3.58 45 1.95 6.51 11.77 7.07

55 9 3.88 43 2.04 6.73 12.08 7.32

55 10 4.14 41 2.11 6.89 12.30 7.52

55 11 4.37 40 2.17 7.01 12.44 7.66

55 12 4.57 38 2.22 7.10 12.52 7.77

55 13 4.76 37 2.26 7.15 12.56 7.84

55 14 4.92 35 2.29 7.18 12.56 7.89

Storm Max Recharge Rate (ft/d)
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Table 5.5 Continued: 

 

  

Recharge 

(inches) % recharge

CN

24 hr Total 

P (inches)

All Storms 

Types all types IA I II III

60 1 0.00 0 0.00 0.00 0.00 0.00

60 2 0.61 30 0.14 0.21 0.54 0.38

60 3 1.33 44 0.46 1.64 4.78 2.12

60 4 1.90 48 0.77 4.34 8.06 4.67

60 5 2.37 47 1.40 4.81 8.84 5.20

60 6 2.75 46 1.53 5.16 9.38 5.59

60 7 3.06 44 1.63 5.42 9.75 5.89

60 8 3.33 42 1.71 5.59 9.99 6.10

60 9 3.57 40 1.77 5.72 10.14 6.25

60 10 3.77 38 1.82 5.80 10.21 6.35

60 11 3.95 36 1.85 5.84 10.24 6.41

60 12 4.10 34 1.88 5.86 10.22 6.45

60 13 4.24 33 1.89 5.86 10.16 6.46

60 14 4.37 31 1.91 5.84 10.09 6.45

65 1 0.00 0 0.00 0.00 0.00 0.00

65 2 0.79 39 0.22 0.35 1.90 1.23

65 3 1.42 47 0.60 3.37 6.24 3.14

65 4 1.89 47 1.12 3.87 7.11 4.18

65 5 2.27 45 1.25 4.21 7.64 4.57

65 6 2.57 43 1.35 4.44 7.97 4.83

65 7 2.82 40 1.42 4.59 8.16 5.01

65 8 3.03 38 1.46 4.68 8.25 5.12

65 9 3.21 36 1.50 4.72 8.27 5.19

65 10 3.36 34 1.52 4.73 8.24 5.21

65 11 3.49 32 1.54 4.72 8.17 5.21

65 12 3.61 30 1.54 4.69 8.08 5.19

65 13 3.71 29 1.54 4.65 7.98 5.15

65 14 3.80 27 1.54 4.60 7.86 5.11

70 1 0.14 14 0.05 0.04 0.04 0.03

70 2 0.90 45 0.40 1.33 3.38 1.39

70 3 1.43 48 0.76 3.00 5.53 3.24

70 4 1.81 45 1.00 3.36 6.09 3.64

70 5 2.11 42 1.09 3.57 6.39 3.89

70 6 2.34 39 1.15 3.69 6.54 4.04

70 7 2.52 36 1.19 3.75 6.58 4.12

70 8 2.68 33 1.21 3.77 6.55 4.15

70 9 2.81 31 1.23 3.75 6.49 4.14

70 10 2.92 29 1.23 3.72 6.39 4.12

70 11 3.01 27 1.23 3.67 6.27 4.07

70 12 3.10 26 1.22 3.61 6.15 4.02

70 13 3.17 24 1.21 3.55 6.01 3.95

70 14 3.23 23 1.20 3.48 5.88 3.89

Storm Max Recharge Rate (ft/d)
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Table 5.5 Continued: 

 

  

Recharge 

(inches) % recharge

CN

24 hr Total 

P (inches)

All Storms 

Types all types IA I II III

75 1 0.30 30 0.07 0.10 0.27 0.19

75 2 0.95 48 0.38 2.17 4.03 2.33

75 3 1.37 46 0.77 2.58 4.69 2.80

75 4 1.67 42 0.85 2.80 5.00 3.05

75 5 1.88 38 0.91 2.90 5.11 3.18

75 6 2.05 34 0.94 2.93 5.11 3.22

75 7 2.18 31 0.95 2.92 5.04 3.22

75 8 2.29 29 0.96 2.88 4.94 3.19

75 9 2.38 26 0.95 2.83 4.82 3.14

75 10 2.46 25 0.94 2.77 4.69 3.08

75 11 2.52 23 0.93 2.70 4.56 3.01

75 12 2.58 21 0.92 2.63 4.42 2.94

75 13 2.62 20 1.00 2.56 4.29 2.87

75 14 2.67 19 1.05 2.49 4.16 2.80

80 1 0.42 42 0.12 0.26 1.22 0.75

80 2 0.94 47 0.54 1.85 3.39 2.00

80 3 1.25 42 0.64 2.10 3.75 2.29

80 4 1.46 36 0.69 2.19 3.84 2.40

80 5 1.61 32 0.71 2.19 3.80 2.42

80 6 1.72 29 0.72 2.16 3.71 2.39

80 7 1.81 26 0.71 2.11 3.58 2.34

80 8 1.88 23 0.70 2.04 3.45 2.28

80 9 1.93 21 0.69 1.97 3.32 2.21

80 10 1.98 20 0.77 1.90 3.18 2.13

80 11 2.02 18 0.80 1.84 3.06 2.06

80 12 2.05 17 0.82 1.77 2.93 1.99

80 13 2.08 16 0.83 1.71 2.82 1.92

80 14 2.11 15 0.85 1.65 2.71 1.86

85 1 0.47 47 0.20 1.12 2.08 1.09

85 2 0.85 43 0.44 1.46 2.62 1.59

85 3 1.06 35 0.49 1.55 2.71 1.70

85 4 1.19 30 0.51 1.54 2.64 1.70

85 5 1.28 26 0.50 1.48 2.52 1.65

85 6 1.34 22 0.49 1.42 2.39 1.58

85 7 1.39 20 0.54 1.35 2.25 1.51

85 8 1.43 18 0.57 1.28 2.13 1.44

85 9 1.47 16 0.59 1.21 2.01 1.37

85 10 1.49 15 0.60 1.15 1.90 1.30

85 11 1.51 14 0.61 1.10 1.80 1.24

85 12 1.53 13 0.62 1.05 1.71 1.19

85 13 1.55 12 0.62 1.00 1.63 1.13

85 14 1.56 11 0.63 0.96 1.56 1.08

Storm Max Recharge Rate (ft/d)
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Table 5.5 Continued: 

 

 
  

Recharge 

(inches) % recharge

CN

24 hr Total 

P (inches)

All Storms 

Types all types IA I II III

90 1 0.46 46 0.26 0.86 1.56 0.93

90 2 0.68 34 0.31 0.98 1.70 1.07

90 3 0.79 26 0.32 0.94 1.61 1.05

90 4 0.86 21 0.31 0.88 1.47 0.98

90 5 0.90 18 0.36 0.81 1.34 0.91

90 6 0.93 16 0.37 0.74 1.23 0.84

90 7 0.95 14 0.39 0.69 1.13 0.78

90 8 0.97 12 0.39 0.64 1.04 0.72

90 9 0.99 11 0.40 0.59 0.97 0.67

90 10 1.00 10 0.40 0.56 0.90 0.63

90 11 1.01 9 0.40 0.52 0.84 0.59

90 12 1.02 8 0.39 0.49 0.79 0.56

90 13 1.02 8 0.39 0.46 0.75 0.53

90 14 1.03 7 0.39 0.44 0.71 0.50

95 1 0.33 33 0.15 0.46 0.80 0.51

95 2 0.41 21 0.15 0.41 0.68 0.46

95 3 0.45 15 0.18 0.34 0.57 0.39

95 4 0.46 12 0.19 0.29 0.48 0.33

95 5 0.48 10 0.19 0.25 0.41 0.29

95 6 0.48 8 0.19 0.22 0.36 0.25

95 7 0.49 7 0.18 0.20 0.32 0.23

95 8 0.49 6 0.19 0.18 0.29 0.21

95 9 0.50 6 0.21 0.16 0.26 0.19

95 10 0.50 5 0.23 0.17 0.24 0.17

95 11 0.50 5 0.24 0.18 0.22 0.16

95 12 0.50 4 0.26 0.20 0.21 0.15

95 13 0.51 4 0.27 0.21 0.19 0.14

95 14 0.51 4 0.28 0.22 0.18 0.13

99 1 0.09 9 0.04 0.05 0.08 0.05

99 2 0.10 5 0.04 0.03 0.04 0.03

99 3 0.10 3 0.06 0.05 0.03 0.03

99 4 0.10 2 0.06 0.05 0.04 0.04

99 5 0.10 2 0.07 0.06 0.05 0.04

99 6 0.10 2 0.07 0.07 0.05 0.05

99 7 0.10 1 0.08 0.07 0.06 0.05

99 8 0.10 1 0.08 0.07 0.06 0.06

99 9 0.10 1 0.08 0.08 0.06 0.06

99 10 0.10 1 0.08 0.08 0.07 0.06

99 11 0.10 1 0.08 0.08 0.07 0.07

99 12 0.10 1 0.09 0.08 0.07 0.07

99 13 0.10 1 0.09 0.08 0.07 0.07

99 14 0.10 1 0.09 0.08 0.07 0.07

Storm Max Recharge Rate (ft/d)
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Chapter	6	

Introduction	to	Groundwater	Modeling	

6.1 Introduction 

The purpose of chapter 6 is to familiarize the reader with basic groundwater modeling terminology and 

approaches.  Appendix C provides a tutorial for MODFLOW, with the purpose of walking individuals 

through an example of model creation, model calibration and verification.   Chapter 6 provides the 

basics of groundwater modeling in an abridged format.  Refer to the text Applied Groundwater 

Modeling: Simulation of Flow and Advective Transport  (Anderson and Woessner, 1992) for greater 

depth on the topic as well as many examples. 

What is a model, and how can groundwater modeling help a practitioner evaluate slope stability? First, a 

model is a simplified approximation of the natural system.  Physical groundwater models would include, 

as an example, sand tanks in the laboratory to investigate groundwater flow.  In contrast, mathematical 

models solve for flow using a governing equation believed to represent important physical processes.  

The groundwater flow equation is the governing equation for groundwater hydrology, and is presented 

in Chapter 3.  The groundwater flow equation is constrained by equations that represent flow and/or 

water levels at the boundaries of the model domain (called boundary conditions), and if time 

dependent, will also incorporate equations defining the beginning water levels at the start of the 

simulation (called initial conditions).   Analytic solutions for drainage problems are presented in Chapter 

7, but these approaches impose many simplifying assumptions and may not be appropriate for many 

complex, real-world situations.  For example, analytic solutions cannot account for complex geology, 

horizontal drains in a fan array, or boundary conditions. For these more complex groundwater flow 

problems, a numeric model is needed.  A numeric model is a powerful tool that allows practitioners to 

relax assumptions on system homogeneity, as well as allow complex geometry and/or superimpose 

multiple boundary conditions and stresses, by approximating solutions to the groundwater flow 

equation through numeric techniques.   

Numeric models are generally used for prediction purposes.  For example, what horizontal drain 

configurations will suffice in lowering water levels below some critical point to prevent slope failure 

during a 100-year 24-hour storm event? How will drain configuration change based on geologic 

materials and storm pattern? And what data are most important to determine drain design?  In this 

sense, models not only help one predict system response, but can be used to gain insight on controlling 

parameters and possible threshold responses to stresses on the system.  To create an effective and 

verifiable numeric model necessitates a full understanding of the assumptions applied, can require 

significant amounts of data, and be expensive to build.  However, numeric models can more fully 

incorporate data into a unified conceptual rendering of the site so more informed decisions can be 

made on designing, constructing, and managing the drainage system.   
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The purpose of the model must be defined first, followed by the degree of certainty required and funds 

available for the project.  The general rule of thumb is to use the simplest model available to achieve the 

stated purpose or goal of the project.  In some situations, analytic solutions are appropriate if data and 

money are limited. However, numeric models should be used if simpler approaches fail to account for 

processes considered.   

6.2 Conceptual Model 

Building a conceptual model is fundamental to creating a worthwhile numeric model.  Without proper 

conceptualization of the site, the model may be inadequately defined and fail to capture important 

components of the physical system. Subsequently, the resultant solutions are likely incorrect.  All 

conceptual models are simplified versions of the actual system. However, simplifying assumptions must 

be valid, and enough detail must be maintained to capture observed system response.  

Prior to collecting data, an initial conceptual model should be established. This will dictate what data 

and where sampling will occur.  With data collection, and preliminary modeling, one may need to revisit 

the conceptual model and revise it based on an inability to correctly capture system response.  In these 

circumstances, it may be necessary to collect more data and revise the modeling approach. 

Four steps are required to construct a conceptual mode:  (1) define the model boundary, (2) define 

hydrostratigraphic units, (3) delineate important water budget components and (4) define the flow 

system (Anderson and Woessner , 1992).   

The first step is to establish the model boundaries.  Ideally, model boundaries should be placed along 

natural hydrologic boundaries. For example, flow divides, water bodies, or impermeable bedrock.  In 

Chapter 4, Figure 4.1 shows an example of assigning the model domain to the watershed boundary.  

Flow divides occur at the watershed boundaries with all flow exiting the site at the topographic low.  By 

placing model boundaries at natural groundwater divides, one greatly simplifies the conceptual 

rendering of the site and limits the amount of data needed to define the model .  When the model 

domain is restricted to an area less than the natural boundaries, then data collection needs to include 

water levels and/or groundwater flux estimates at the edges of the model domain to properly capture 

all water budget aspects of the site.  

The second step to developing a valid conceptual model is to map the important hydrogeologic units at 

the site.   Chapter 4 discusses hydrogeologic mapping in some detail.   Locations, thicknesses and 

hydraulic properties for each unit are required to parameterize a groundwater model.   

At the conceptual model development phase, water budget components need to be identified.  Figure 

6.1 shows possible water sources and sinks related to site SR101 MP321.  Block arrows depict boundary 

condition fluxes that must be quantified before model execution can occur.   Measuring seepage from 

the basalt basement is difficult and simplifying the conceptual model may be warranted to avoid this 

quantification.  If one assumes that glacio-lacustine silts and clays (Unit 2) are relatively impermeable, 

then the no flow boundary is assigned to the top of this unit.  If the assumption is not valid, then model 

results will fail to capture water level response to precipitation events and the assumption will need to 
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be discarded.  If silts and clays (Unit 2) as well as the underlying glacial tills (Unit 3) are included in the 

model domain, then water level information specific to these units must be collected (piezometers 

isolated only in these units).  To further simplify the conceptual model, it may be possible to assume 

that up-gradient fluxes are small compared to water entering the system via recharge.  This may be valid 

if the domain extends to the ridge defining the watershed boundary.  However, inter-basin groundwater 

flow can occur and the assumption may not be valid.  Placing a piezometer at the model boundary and 

tracking observed heads with respect to precipitation events will aid in defining this component of the 

water budget.  

 

 

 

 

 

 

 

 

 

Figure 6.1: Water budget components for a conceptual model of SR101 MP321. (Figure modified 

from WSDOT, 2000) 

 

Lastly, one needs to understand the flow system.  For many natural slopes, flow systems are relatively 

simple with unconfined water table surfaces mimicing topography.  However, if faulting, complex 

stratigraphy, fracturing and/or presurized aquifers are located within the model domain, it is necessary 

to use observed water levels to help define flow paths. 

6.3 MODFLOW 

MODFLOW (McDonald and Harbaugh, 1988; Harbaugh and McDonald, 1996; Harbaugh et al., 2000; 

Harbaugh, 2005; Niswonger et al., 2011) is a widely accepted, finite-difference, public domain 

groundwater flow model produced by the United States Geologic Survey (USGS).  MODFLOW uses the 

groundwater flow equation (refer to equation 3.36 for unconfined aquifers) as its governing equation.  

Head is solved by MODFLOW in both space and time such that the solution to the groundwater flow 

equation satisfies initial conditions and all boundary conditions.   
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6.3.1 Finite Difference Numerical Method 

Finite difference is a numerical method used to obtain approximate solutions to the governing equation, 

in which a continuous system is broken into discrete points in both space and time and partial 

derivatives are replaced by the differences in head between these discrete points.  MODFLOW uses a 

block-centered approach with the groundwater flow equation solved for the center of each cell (refer to 

Figure 6.2).  An example of converting a conceptual model into a finite difference grid is provided in 

Figure 6.3.  Cells are defined by their row, column (and by layer in three dimensions).  Using the 

continuity equation all flow into the cell less the flow out of the cell is the change in water stored in the 

cell.  The change in storage is represented as, 

���∆��∆��∆	
� �
,�,�∆� =	���∆��∆��∆	
� ��
,�,�
� �	�
,�,����

��	�	���� �      (6.1) 

Where Ss is specific storage (1/L); ∆��∆��∆	
  is the cell volume hi,j,k is the head at node I,j,k and ∆t is 

change in time (T).  As an approximation of the time derivative at time t
m

 the head difference is divided 

by the time interval.  Since the head at time t
m

 is estimated by going backwards in time and using the 

head preceding it, or head at t
m-1

, the analysis is termed backward-difference.  Flow across all six faces of 

the cell are accounted for, as are external sources of water (i.e. boundary conditions). As an example of 

flow across a cell face, refer to Figure 6.4.  Flow is calculated entering the cell i,j,k from cell i,j-1,k (along 

a row), with positive flow assigned to water entering the cell, 

��,���
�.


=	��
,����,�∆��∆ 
	
��
,���,��	�
,�,��

∆!����
        (6.2) 

Where ��,���
�.


 is the volumetric flow rate through the cell face between I,j-1,k and I,j,k (L3/T); ��
,����,�  is 

the hydraulic conductivity along the row between the nodes i,j-1,k and i,j,k (L/T); ∆��∆ 
	is the area of 

cell face perpendicular to flow; ℎ�,��#,
 −	ℎ�,�,
 is the difference in heads between nodes i,j-1,k;  and i,j,k 

and ∆����
�
 is the distance between nodes i,j-1,k and i,j,k (L).  The notation of ½ indicates an effective 

property for the region between the cell nodes considered, and not a specific point.  It is noted, that the 

default for computing effective hydraulic conductivity between two nodes (in this case I,j-1, k and I,j,k) 

in MODFLOW is via the harmonic mean (Collins, 1961). 

Sources/sinks of water external to the cell are applied as either head dependent, such as through a river 

bed (Pi,j,khi,j,k), or independent of head (Qi,j,k), such as recharge.   

All flow into and out of the model cell is represented by a set of linear, algebraic difference equations 

given below,  
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Figure 6.2: A center-blocked grid used in MODFLOW. Discrete points, or nodes, for which the 

groundwater flow equation is solved are located at the center of user defined cells.  Cells are located 

by position in the grid in terms of row (i) and column (i), with i and j representing  indices of cell 

location (k is the index for the layer if modeling in three dimensions).  For reference, a few cells are 

identified by (i,j).  Cell dimensions are given by DELRj , which is the length of a cell along a row, and 

DELCi, the length of cell along columns (modified from Harbaugh, 2005). 

 

 

 

 

 

Figure 6.3: (a) A conceptual model and (b) the finite 

difference grid describing it.  The center of each cell 

represents the location that the groundwater flow 

equation is approximated (modified from McDonald 

and Harbaugh, 1988).  
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Figure 6.4: Flow into cell I,j.k from cell I, j-1,k (modified from McDonald and Harbaugh, 1988). 
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All seven heads at time t
m

 are unknown making it impossible to solve the single equation 6.3 

independently. Unknown heads are highlighted in gray (duplicates of ℎ�,�,
. are not highlighted).  

However, if this equation is written for each active cell in the model domain, and there is only one 

unknown for each cell, then there are n-equations with n-unknowns, and the system of equations can 

be solved simultaneously. 

6.3.2 Grid Design 

Grid design is focused on grid orientation, scale and linking the grid to the real-world site.  For 

anisotropic conditions (e.g. fracture flow), grids should be orientated such that axis are collinear with 

the diagonal terms of the hydraulic conductivity tensor.  Figure 6.5 shows grid rotation with respect to 

the hydraulic conductivity tensor. 

If flow is isotropic (Kx -= Ky), then the grid should be aligned to decrease the number of active cells and to 

coincide with natural boundaries, such as topographic flow divides, and in the primary direction of flow.  

Grid scale is based on the expected change in water level over the model domain. Large change in water 

levels will require more nodes (more cells).  Similarly, the greater the spatial heterogeneity the greater  
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Figure 6.5: Grid orientation based on fracture traces (red lines).  

 

number of nodes needed.  It is important to maintain a grid scale that allows proper representation of 

hydrologic features, including wells, surface water bodies, spatially variable recharge, as well as fault 

length and thickness. And it is important that the size of the cell adequately portray the representative 

elementary volume (REV) described in Chapter 3. 

Computational efficiency is linked to the number of nodes, with large heterogeneity decreasing 

efficiency.  As a general rule of thumb, less than 10,000 nodes is very efficient, but it’s possible to model 

over 1,000,000 nodes. Only very large and fast computers can handle large numbers of nodes on the 

order of 20,000,000.  Techniques are available to provide a finer resolution but limit the number of cells.  

This includes finite element modeling and telescopic mesh refinement.  However, these techniques are 

beyond the scope of this manual. In addition, modeling with a single layer is recommended for most 

slope stability as complexity in model greatly increases with increased model layers.  However, it is 

noted, that vertical discretization can be accomplished independent of geology or can depend on 

geology (Figure 6.6).  If model layering is independent of hydrogeologic units, then it is necessary to 

define cell parameters with an average, or effective value, for the region of the cell.  MODFLOW offers 

the HUF package to help the user convert hydrogeologic units into effective properties for model 

execution. 
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(a) Credit: USGS Geological Survey, Department of the Interior/USGS 

 

 

 

 

 

 

 

(b) 

 

Figure 6.6: Vertical discretization for MODFLOW (a) independent of geology (modified from Belcher 

et al., 2004) and (b) dependent on geology. 
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6.3.3 Boundary Conditions and Applied Stresses. 

Boundary conditions can be applied at the edges of the model domain, or internal to the domain.  Three 

types of boundary conditions are considered, (1) specified head, (2) specified flux, and (3) head-

dependent flux.  Specified fluxes and head-dependent fluxes are often termed applied stress. 

6.3.3.1 Specified Head Boundary Cells 

For most slope stability problems, the specified head boundary conditions is likely assigned to the up- 

and down-gradient model boundary locations.  Specified head boundary conditions are applied to those 

cells for which MODFLOW does not need to solve heads.  Specified head cells are assigned a head value 

for a specified time for which head does not change.  For steady state simulations, or transient 

simulations for which the specified head does not change in time, these cells are termed constant-head.  

Specified/constant head cells are often used to describe lakes, rivers, streams, or to observed heads at a 

significant distance from the region of interest in the model domain.  The specified head anchors the 

solution in space.  Without some sort of specified head boundary, the model will not know where to 

begin the solution.  Caution is noted when using a specified head boundary condition, since its value 

does not change despite possible stresses to the system (e.g. a well pumping large volumes) and can 

inadvertently represent a nearly inexhaustible source of water.  Nor can a specified head change its 

value, if a large amount of areal flux is applied (i.e. recharge).  For these situations, it is recommended to 

extend specified head boundary conditions well away the region investigated in the model.  In this way, 

boundary condition influence on the model objective is limited. 

6.3.3.2 Specified Flux 

Specified flux boundary conditions are used when discharge is known and MODFLOW will still solve for 

head where this flux is specified.  There are several types of specified flux conditions, including: no flow, 

inter-basin flow, pumping/injection wells, and groundwater recharge. In equation 6.3 specified fluxes 

are denoted by /�,�,
, with positive values indicating water into the cell and negative values indicating 

water removed from the well.  

No-flow cells are those cells for which no water is allowed to enter or exit the cell.  In essence, no-flow 

cells are excluded from the model domain and heads are not estimated with MODFLOW.  No flow cells 

are placed along hydrogeologic divides and bedrock contacts.  Delineating model boundaries at the 

edges of a watershed allows confident use of the no-flow boundary condition and greatly simplifies the 

number of water budget components necessary to quantify with data. MODFLOW automatically assigns 

a no-flow boundary if no other boundary type is specified. 

The MODFLOW WEL package is used to simulate both wells that are used to withdraw or inject water to 

the aquifer, as well as simulate inter-basin groundwater fluxes at the margins of the model domain 

(refer to Figure 6.7 for an example). Water is added (or removed) at a constant rate (L
3
/T) for a given 

stress period in which the rate is independent of the cell’s head or the dimensions of the cell.  

MODFLOW’s recharge (RCH) package is used to simulate areally distributed recharge to the  
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Figure 6.7: Example of boundary conditions applied around the Smith and Mason Valleys, Nevada 

(Collopy and Thomas, 2009) with red = no-flow, blue = specified flux, and green regions = general 

head boundaries.  Specified fluxes defined using Maxey Eakin (1949) approach to mountain block 

recharge with computed values provided in the inset by marked zone. 

 

groundwater system.  This includes precipitation that percolates to the potentiometric surface.  

Recharge is applied to the cell as, 

/!
,� = 	0�,�∆��∆��           (6.4) 

Given /!
,�,� is the recharge flow rate applied to cell I,j (L
3
/T), and Rij is the recharge flux (L/T) applicable 

to the mapped area (L
2
) of cell (∆��∆��).  Values of Rij are defined by the user for each stress period and 

applied to one cell in a vertical column of cells. The user can specify recharge to a specific model layer or 
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allow MODFLOW to apply Rij to the upper most active layer. As a word of caution, if a cell goes dry and if 

dry cells are forced to be inactive, then the first option will negate any recharge entering the model cell.  

Therefore, if there is a potential for a model cell to go dry due to changing water levels over time, then 

the second option is desired to ensure recharge is added to the model.  Recharge will only be added to 

variable-head cells. Recharge is not assigned to cells designated as a constant/specified head or as a no-

flow cell. 

6.3.3.3 Head Dependent Boundaries 

These boundary conditions calculate flux as a function of head difference between the cell and some 

point inside (or outside) the model domain.  Darcy’s law (equation 3.13) computes the flux.  Several 

MODFLOW packages exist that support head-dependent boundaries, and a sum of these fluxes into a 

single MODFLOW cell are represented by 	-�,�,
ℎ�,�,
.  in equation 6.3.  Listed below are those MODFLOW 

packages that might be useful for modeling water levels in a slope environment susceptible to slope 

failure. 

6.3.3.3.1 Drains 

Drains (DRN) in MODFLOW are designed to remove water from the aquifer based on the difference 

between head in the aquifer and the drain’s elevation.  Flow into the drain (and out of the aquifer) 

occurs only when water levels in the aquifer are higher than the drain, and drop to zero when heads 

drop below the drain elevation (Figure 6.8). The relationship is expressed as 

/1 =	−�1(ℎ�,�,
 −	ℎ1) when hijk > hd       (6.5) 

/1 = 0    when hijk ≤ 0       (6.6) 

Given Qd is flow out of the aquifer and into the drain, hi,j,k is the head in the aquifer, hd is the drain 

elevation and Cd is drain conductance.  To understand drain conductance in a physical sense, refer to 

section 4.2.7: Horizontal Drain Flow Characteristics and Drain Flow.   

6.3.3.3.2 General Head Boundary 

The general head boundary (GHB) package in MODFLOW simulates flow into/out of a cell based on a 

proportion of the head difference between the GHB cell and a MODFLOW-computed head. The 

representative equation is, 

/6 =	�6(ℎ6 −	ℎ1,�,�,
)          (6.7) 

Where Qb is the flow into cell i,j,k from the boundary (L
3
/T), Cb is the boundary conductance (L

2
/T), hb is 

the user-defined head in the GHB cell, and hi,j,k is the MODFLOW-computed head (L).   

High values of Cb, or large differences in head, will force the GHB cell to act like a specified/constant 

head cell with no limit on into/out of the model and should be monitored to ensure that fluxes are 

reasonable.  Figure 6.9 illustrates that the relationship between hi,j,k, hb and Qb. A positive Qb refers to 

flow into the aquifer and negative Qb is flow out of the aquifer. 
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Figure 6.8: Plot of flow to a drain (Qd) as a 

function of head in the cell (h), where elevation 

of the drain is hd, and the slope of drain flow is –

Cd (Modified from McDonald and Harbaugh, 

1988). 

 

 

 

 

 

Figure 6.9: Plot of flow into/out of a GHB cell 

(Qb) as a function of head in the cell (h), and 

assigned GHB head hb., and GHB conductance 

Cb(Modified from McDonald and Harbaugh, 

1988). 

 

6.3.4 Initial Conditions 

The initial head distribution across the modeled domain is required for all simulations.  For steady state 

simulations, the choice of initial heads is not critical except the closer the initial head distribution is to 

the steady state solution, then the quicker the model will converge on a solution.  It is also important to 

make sure the initial heads are all above the bottom of the cell to remove instability issues associated 

with wetting and drying of model cells.  For steady state solutions, it is recommended to set initial heads 

at the top elevation of the modeled cells.  

For transient simulations the choice of initial head is very important.  Figure 6.10 shows a simulation in 

which initial heads are not well defined (Model 1), and more accurately defined (Model 2).   Initial heads 

are determined by either interpolating observed water level data across the modeled domain for the 

time period representing the start of the model, or using modeled steady state head distributions.  

Steady state conditions are generally assumed to represent average conditions; such as mean water 

level for a long period of record, mean annual water level or mean water level for a specific period of 
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time.  The latter is really a  quasi-steady state condition and can be assumed to occur during the 

relatively dry periods in the year when little precipitation occurs, or when very consistent precipitation 

occurs over a significant period of time and observed hydrographs are fairly stable.  It’s analogous to 

baseflow conditions in a stream.   

 

 

 

 

 

 

 

Figure 6.10: An example of transient water levels in an observation well and model results. Model 1 

initial conditions are too high.  Model 2, initial conditions are more realistic. 

 

6.3.5 MODFLOW Numeric Solvers 

MODFLOW provides several solvers, and which solver to use is problem dependent.  For most non-linear 

problems, such as unconfined conditions, the geometric multi-grid (GMG) solver is appropriate (Wilson 

and Naff, 2004).  For unconfined situations where fluctuation of the water table results in wetting and 

drying of model cells, the newly created Newton-formulation of MODFLOW, or MODFLOW-NWT is 

required (Niswonger et al., 2011).  Refer to the cited documents for a full description of the approaches 

used by either solver.  Example problems in Chapter 7 highlight the solver used and parameter choices. 

6.4 Calibration Strategies 

Calibration refers to adjusting model parameters to best match observed data.  Calibration strategies 

can range from fairly simple to very complex and generally improve with modeling experience.  

Hydraulic properties, as well as boundary conditions and stresses can be altered to reproduce simulated 

heads and fluxes that best match field measured values.  Measured parameters, as well as expected 

ranges in parameter values, constrain how much adjustment in a calibration parameter is acceptable.  

Calibration is sometimes referred to as the “inverse problem”, in which observed heads are used to 

obtain parameter values, versus known parameter values used to predict groundwater heads.   

Calibration can be done in either steady state or transient simulations.  In general, steady state model 

calibration focuses on adjusting hydraulic conductivity to best match steady state head distributions.  

Likewise, the basic conceptual model can be evaluated.  For example, if model calibration is only 

possible with unrealistic parameter values, then the conceptual model must be revisited.  It may be 
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necessary to modify existing boundary conditions, include additional water sources or sinks, reconsider 

system heterogeneity, or incorporate a geologic feature that was left out of the original model.   

Transient calibration generally focuses on storage parameters to match water level response to change 

in stress.  Decreasing storage will increase water level response, while increasing storage will mute the 

response.  Figure 6.11 provides an example of how specific yield impacts observed water level response 

to a precipitation event.  In addition, it is not uncommon that the steady state calibrated hydraulic 

conductivity needs further adjustment in the transient simulation. In this circumstance, the steady state 

calibrated hydraulic conductivity value acts as an initial guess.  Drain conductance (Cd) is likewise 

adjusted to match drain outflow.  If necessary, drain elevations (hd) can also be tweaked given the 

uncertainty in elevation with drilling practice.  A difference of only a few feet can significantly impact 

drain response. 

Model calibration is qualitatively assessed by matching observed and predicted contour maps of 

groundwater head.  It is important that flow paths observed are reproduced in the model.  Quantitative 

assessment of calibration success is accomplished when the calibration target is simulated within an 

acceptable level of error.  A calibration target is a measured, observed, calculated or estimated hydraulic 

head or groundwater flow rate that the model must reproduce (within a range of acceptable error) for 

the model to be considered calibrated (ASTM D5981, 1996).  Uncertainty in the calibration target  

 

 

 

 

 

 

 

Figure 6.11: An example of changing specific yield (Sy) in transient calibration.  Observed water levels 

are better replicated with Sy = 0.02 compared to Sy = 0.30. 

 

should also be considered, so that excessive effort is not expended in trying to perfectly match a target 

that is highly uncertain.  Error is often measured using the root mean-squared error (rmse),  

�789 = :1 <= ∑ (ℎ? − ℎ@)AB�C# DE.F        (6.8) 

Where hp and ho are the predicted and observed heads, and n is the number of observed data.  Error 

assessment is subjective to project objectives; however, error greater than 10% is often indicative of a 
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poor model, 5-10% is acceptable, while less than 5% is a very good model.  An example of error 

assessment is provided using Figure 6.11, the rmse for Sy equal 0.02 and 0.30 is 1.3 ft and 3.9 ft, 

respectfully.  Normalized by the difference in observed minimum and maximum head (15.8 ft), this 

equates to 8% and 24% error, respectfully.  Model results for Sy = 0.02 more accurately represents 

observed water levels by reducing error compared to Sy = 0.30. 

The rmse criterion for successful model calibration is limited to the average error in the model and can 

hide portions of the model that are poorly predicted.  It is important for model error to be randomly 

distributed across the domain and not show any specific trend.  Figure 6.12 provides an example of 

unbiased and biased error.  Figure 6.12 demonstrates a one-to-one plot of observed versus predicted 

water and a  plot of residuals (observed – predicted).  For the un-biased results, error is randomly 

distributed about the 1:1 line (or residual = 0).  For the biased example, error increases with increased 

observed water level, with the model increasingly under-predicting water levels at larger and larger 

observed values.   If heads are consistently too high or two low in a particular region of the model, then 

boundary conditions may need to be adjusted, or eliminated, to remove the bias. If the source of error 

cannot be isolated, then additional field data should be collected to improve conceptual understanding 

of the system being modeled. 

 

 

 

 

 

 

 

 

(a)          (b) 

Figure 6.12: An example of biased an un-biased model error represented in a (a) one-to-one plot (b) 

plot of residuals. 

 

Calibration can be achieved using manual trial and error by adjusting one parameter at a time, or using 

sophisticated auto-calibration techniques that are available. Both are discussed within the context of an 

application in the Appendix B – Groundwater Modeling Tutorials.  Caution is noted that just because 

calibration targets are met, that the model is valid.  This is because groundwater model calibration 

rarely produces a unique solution.  Instead, many different combinations of parameter values may result 

in an equal solution.  Uncertainty is exacerbated if little data exists to constrain parameters values, little 
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observed water level or flux data exist, or water level data are poorly distributed across the model 

domain.  If calibration error is clearly defined, then at least interpretation is possible of uncertainty 

distribution in the model and of predicted water level values.  In the end, a calibrated model clearly 

demonstrates the ability to reproduce observed data.  Verification will test the model’s ability to predict 

future behavior. 

6.4.1 Sensitivity Analysis 

A sensitivity analysis is the process of changing one parameter in the model at a time and re-computing 

the error function.  The purpose is two-fold.  First, it can determine the best parameters to use in the 

calibration process.  Parameters that have the greatest impact on model output make better calibration 

parameters than those parameters less sensitive.  Secondly, a sensitivity analysis is the most 

rudimentary uncertainty analysis one can perform.  It allows some quantification of uncertainty in 

modeled response if parameters are adjusted over expected ranges.  Figure 6.13 gives an example of a 

typical graph displaying sensitivity of recharge, specific yield and hydraulic conductivity.  Each parameter 

is adjusted independently between -50% and +50% of their calibrated value (calibrated value is 0% 

change in input parameter).  The calibrated value should fall at the global minimum for all parameters 

(minimum rmse).  In this example, model output is more sensitive to recharge than specific yield.  

Hydraulic conductivity is non-unique with two minimum rmse.  One rmse minimum occurs at a lower 

hydraulic conductivity than the chosen calibrated value.  Final choice of the hydraulic conductivity value 

is decided with field and/or laboratory data, or using expert judgment.  It is also notable, that the system 

is insensitive to hydraulic conductivity at larger values, such that Kx values 10% larger than the calibrated 

value produce no appreciable increase or decrease in the error function.   

 

 

 

 

 

 

 

 

 

 

Figure 6.13: An example of a sensitivity analysis looking at influence of independent adjustment of 

recharge, specific yield and hydraulic conductivity on rmse. 
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Independent adjustment of parameters will likely fail to capture covariance between parameters.  

Figure 6.14 provides a contour map where two normalized, hypothetical parameters, X1 and X2, are 

adjusted simultaneously.  Error is represented as 1-unit contour lines.  The solution space is convoluted 

with a dip in error occurring near the one-to-one negative correspondence for X1 and X2.  The resulting 

global minimum for the parameter ranges (space) evaluated occurs at 0.6 the range for X2 and 0.3 for 

the range modeled for X1.  Complexity arises in that a ridge of high error occurs for low values of X2 that 

is relatively insensitive to low values of X1, while a local minimum also occurs at high X1 and high X2.  

Negotiating a complex solution space becomes increasingly complex with more and more parameters 

included in the calibration strategy.  Sensitivity analysis is one way to decipher what level of complexity 

arises, what parameters can be disregarded in the calibration process, and if a parameter needs to be  

 

 

 

 

Figure 6.14: Error (e.g. 

rmse) in model prediction 

given simultaneous 

adjustment of hypothetical 

parameters X1 and X2.  

Range in parameter values 

are normalized (0 to 1), 

while contours are given in 

1-unit intervals. The blue-

circle represents the global 

minimum value in error for 

the parameter spaces 

considered. The red-circle 

is the global maximum. 

 

included, then how to quantify this uncertainty.  Complex solutions spaces, and/or multiple calibration 

parameters are very difficult to assess through trial-and-error approaches.  Instead, sophisticated 

optimization algorithms can negotiate complex solution spaces fairly efficiently.  Implementation of one 

of these algorithms is discussed in the tutorial section of the manual on auto-calibration (refer to 

Appendix C). 
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6.4.2 Verification 

A well calibrated model will reproduce observed behavior for which the model is calibrated.  However, 

the other purpose of a model typically is to predict future behavior in which boundary conditions and 

applied stresses are different than those used in the calibration process.  Verification is a test of the 

model’s robustness over different scenarios, and if verification is successful, will provide confidence in 

the calibration and the ability of the model to replicate system behavior over a range of applied stresses.  

In order to perform a verification of the model, a subset of available data that was not used in the 

calibration process is used.  Ideally, this second set of data corresponds to very different hydrologic 

conditions.  For instance, if the calibration data corresponds to water levels for an average water year, 

then water level data for a drought year can serve as a verification data set.  If water level data is 

limited, then one can use a secondary set of data for the same calibration time period.  For instance, if 

drain conductance is adjusted to help match observed water level response, then correlation of 

observed and modeled drain flow can serve as an independent verification.  If the model fails to 

reproduce the second set of data, then the modeler may need to revisit the conceptual model and 

revise calibration strategies   

6.5 References Cited 

ASTM-D5981-96. 1996.Standard Guide for Calibrating a Ground-Water Flow Model Application. 

American Society for Testing and Materials.  ASTM Committee D-18 on Soil and Rock, 

Subcommittee D18.21 on Ground Water and Vadose Zone Applications. 100 Barr Harbor Dr., West 

Conshohocken, PA 19428. Annual Book of ASTM Standards. 

Anderson, M.P., and W.W. Woessner, 1992. Applied Groundwater Modeling: Simulation of Flow and 

Advective Transport. Academic Press, San Diego, CA. ISBN 0-12-059485-4. 381 p. 

Belcher, W, R., D’Agnese, F.A., and G.M. O’Brian, 2004. Introduction. Chapter D of Death Valley Regional 

Groundwater Flow System, Nevada and California – Hydrogeologic Framework and Transient 

Groundwater Flow Model. U.S. Geological Survey Scientific Investigations Report 2004-5205. Pp. 

3-20. 

Collins, R.E., 1961. Flow of fluids through porous materials. New York, Reinhold Publishing Corp., 270 p. 

Callopy, M.W. and J.M. Thomas, 2009. Restoration of a Desert Lake in an Agriculturally Dominated 

Watershed: The Walker Lake Basin. Bureau of Reclamation Report. 1092 p. 

Harbaugh, A.W. 2005. MODFLOW-2005: The U.S. Geological Survey modular ground-water model—the 

Ground-Water Flow Process: U.S. Geological Survey Techniques and Methods 6-A16, variously p. 

Harbaugh, A.W., and M.G. McDonald, 1996. User's documentation for MODFLOW-96, an update to the 

U.S. Geological Survey modular finite-difference ground-water flow model: U.S. Geological Survey 

Open-File Report 96-485, 56.  



 
130 

Harbaugh, A.W., Banta, E.R., Hill, M.C., and M.G. McDonald, 2000.  MODFLOW-2000, The U.S. Geological 

Survey modular ground-water model -- User guide to modularization concepts and the Ground-

Water Flow Process: U.S. Geological Survey Open-File Report 00-92, 121 p. 

Maxey, G. B. and T. E. Elkin, 1949. Ground water in White River Valley, White Pine, Nye, and Lincoln 

Counties, Nevada. No. 8, State of Nevada Office of the State Engineer prepared in cooperation 

with the United State Department of the Interior Geological Survey, Carson City, Nevada. 

McDonald, M.G. and A.W.Harbaugh, 1988. A modular three-dimensional finite-difference ground-water 

flow model: U.S. Geological Survey Techniques of Water-Resources Investigations, book 6, chap. 

A1, 586 p. 

Niswonger, R.G., Panday, S., and M. Ibaraki, 2011. MODFLOW-NWT, A Newton Formulation for 

MODFLOW-2005. Groundwater Resources Program. Techniques and Methods 6-A37. 44p. 

Washington State Department of Transportation (WSDOT). 2000. Eldon Landslide: Geotechnical Study of 

the Eldon Vicinity Landslide Adjustment to Hood Canal. SR-101, MP 321, C.S. 2303. Reviewed by T. 

M. Allen, State Engineer, and S.M. Lowell, Chief Engineering Geologist. 9 pp. 

 



 
131 

Chapter	7	

Horizontal	Drain	Design	

7.1 Introduction 

While significant research has occurred with respect to the characterization and function of drainage 

systems, most of this work has focused on irrigation systems with relatively shallow slopes and been 

fairly qualitative in its assessment.  Often drainage design is based on experience from past installations, 

rather than on hydraulic conductivity and quantitative assessment using drainage equations or numeric 

analysis.  Merva (1984) stated that drainage design is often a trial-and-error procedure, while Willardson 

(1982) recognized that adequate estimates for hydraulic conductivity and drainage coefficients are 

difficult to obtain and largely selected based on tradition and local experience.  Forrester (2001) 

provided very useful guidance to geotechnical designers on the use of horizontal drains for slope 

stability, but did not offer methodology on evaluating the efficacy of drains for a particular site or a 

quantitative design method to determine the location, type of number of drains. In fact, little to no 

quantitative procedural guidelines are published on drain placement with the goal of increasing slope 

stability during rapid rises in pore pressures.   Every drainage problem is unique, in which experience 

and expert opinion cannot be superseded.   However, a more quantitative framework for drain design 

can aid practitioners to improve drainage performance and to reduce ad hoc decision making. 

The proposed methodology for drain design is given in Figure 7.1, and shows a preliminary analysis 

followed by an iterative procedure between hydrogeologic and geotechnical analysis for slope stability.  

Prior to hydrogeologic analysis, it is necessary to characterize the site (described in Chapter 4) and 

develop a design storm to test system response to a large event (described in Chapter 5).  The technical 

aspects of groundwater influences on slope stability are given in Chapter 2.  The basics of groundwater 

hydrology and groundwater modeling are provided in Chapters 3 and 6, respectively.  Important factors 

controlling success or failure of drain design, the initial feasibility study as well as quantitative analyses 

using analytical, graphical and numerical techniques, are provided in this chapter.   

7.2 Controlling Factors of Drainage Design 

Many factors can influence the effectiveness of a drainage system, which can be grouped into the 

following categories: 

• aquifer characterization, 

• aquifer recharge/response to precipitation, 

• drainage system design,  

• construction methods, and 

• maintenance 
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Figure 7.1: Methodology for drain design to promote slope stability that iterates between 

hydrogeologic analysis (blue region) and slope stability analysis (green region).  
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This chapter focuses on effectiveness of drainage system design, primarily considering drain length, 

elevation, spacing and efficiency, as a function of aquifer characteristics and storm events.  To 

demonstrate the importance of each of these variables, an idealized cross section is presented with a 

linearly sloping ground surface that drops in elevation from 300 ft to 75 ft over a distance of 1000 ft 

distance (slope of 12.7°).  Figures 7.2, 7.3, and 7.4 show the impact of drain length, elevation and 

spacing, respectively, on water table elevations under steady state recharge using MODFLOW.  Site 

parameters are assigned isotropic with K = 1 ft/d, R = 0.01 ft/d and drain hydraulic conductivity equal to 

that of the geologic material (i.e. 1 ft/d).   

 

In Figure 7.2, all drains are installed at an elevation of 50 ft, and are installed at the toe of slope.  As 

drain length increases, water table elevations drop.   

 

 

 

 

Figure 7.2: Water table elevations in an idealized cross section as a function of drains with different 

lengths.   All drains are installed at the toe of slope at an elevation of 50 ft, with the bottom of the 

geologic unit at an elevation of 0 ft.  Water levels results obtained using MODFLOW. 
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In contrast, Figure 7.3 shows that increasing the elevation of a drain will reduce the maximum drop in 

water table.  Drains are installed at an elevation of 50 ft, 100 ft and 150 ft and extend 500 ft into the 

slope.  Drains located at the lowest elevation facilitate the greatest lowering of water table elevations.  

For the example provided, the drain installed at an elevation of 50 ft, or the toe of the slope, is more 

effective at lowering water levels compared to a drain installed upslope at an elevation of 150 ft. 

 

 

Figure 7.3: Water table elevations in an idealized cross section given drain elevations of 50 ft, 100 ft and 

150 ft and extending 500 ft into the slope. 

 

Rahardjo et al., 2003 performed a rigorous measurement campaign combined with numerical modeling 

to determine the effectiveness of horizontal drains for slope stability.  One of the key findings is that 

shallow drains, or drains running parallel and near the ground surface, are ineffective in improving the 

stability of a slope.  In other words, drains installed in the vadose zone are generally ineffective at 

capturing recharge from precipitation events.  Instead, drains are most effective when placed at the 

lowest elevation possible.  The basic tenet is to lower the main water table, with less emphasis placed 

on direct capture of infiltration.  If installed a significant distance into the slope at the lowest possible 

elevation, drains will capture the majority of groundwater and have the largest effect on lowering the 

water table.  These results are also consistent with the research findings of Lau and Kenney (1984) and 

Martin et al., 1994.  Parametric studies have also shown that drains located in the upper region of a 

slope are of no real significance if additional deeper drains are in the lower part of a slope. The water 

table will eventually be reduced to the lowest drain level and any drains above the bottom drain will no 

longer be effective.  With the overall lowering of the water table, the upper drains serve only as 
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interceptor drains during large events, and Rahardjo et al. (2003) found these drains ineffectual.  The 

only exception to this rule might be for site conditions where significant perched water table conditions 

can develop.  If a low permeability layer exists at depth, precipitation events may induce a perched 

water table, which may cause the slope to fail.   

The findings of Rahardjo, et al. (2003) are important when considering which type of model is best for 

drainage design. If water table position is the most important aspect of slope stability and the physical 

processes and matric pressures within the vadose are judged to be less significant, then one can rely on 

saturated models for use in drainage design.  This significantly reduces the complexity of the analysis 

and may allow for the use of analytical solutions for many field conditions. One still has to determine the 

net infiltration that contributes to groundwater recharge following a precipitation event, but this 

analysis can most likely be de-coupled from the groundwater analysis. 

Figure 7.4 tests drain spacing, with drains drilled parallel to the slope strike.  Drain direction is dictated 

by the one-dimensional aspect of MODFLOW simulation.  In other words, the model consists of a single 

cross section with no aerial considerations.  The drain layout, however, is typical of all analytical 

approaches.  For an example of drain layout, refer to Figure 7.5 for drains installed at 250 ft intervals.  As 

expected, given equal recharge and hydraulic characteristics of the site, decreasing the drain spacing will 

lower water table elevations.   

 

 

Figure 7.4: Water table elevations in an idealized cross section with for different drain spacing. 

Drains are parallel to the slope strike (into the page) and all are located at an elevation of 50 ft. 
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Water level response to drain placement is also a function of site characteristics.  Specifically, hydraulic 

conductivity, specific yield (for transient simulations) and recharge rates are important to drainage 

design, and need to be considered.  Figure 7.5 shows water table profiles for a range of hydraulic 

conductivity and recharge rates given a drain spacing of 250 ft.  Water table elevations will rise with 

increased recharge and/or decreased hydraulic conductivity.  Drain design will need to adjust to 

accommodate for variable hydraulic properties. Similarly, Figure 7.6 provides water table elevations as a 

function of K and R, but given a single drain extending from the toe of the slope and into the geologic 

material.   Properly quantifying K and R become important to understanding aquifer response to drain 

design. 

 

 

Figure 7.5: Water table profiles as a function of hydraulic conductivity (K) and recharge rate (R). 

Units are in feet per day. Drain spacing is 250 ft at an elevation of 50 ft and into-the-page.  Drains 

are shown as blue circles. 

7.3 Preliminary Analysis 

The preliminary analysis requires an estimate of the critical water level for which FOS = 1.0.  This is done 

along the primary of the slope.  Data requirements include a pre-defined failure surface, the friction 

angle, cohesion, unit soil weight, unit saturated soil weight and layer thickness for each 

hydrostratigraphic unit.  Choice of analysis methods are provided in chapter 2, and it is recommended 

one compare several methods to ensure a convergence on the estimated critical water level for which 

slope failure is eminent. 
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Figure 7.6: Water table profiles as a function of hydraulic conductivity (K) and recharge rate (R). 

Units are in feet per day. Drain length is 250 ft at an elevation of 50 ft. Drain is shown as a thick 

black line originating at the toe of slope. 

 

Once the critical water level is defined, the question posed in the Figure 7.1 flow chart, “Is a drainage 

solution feasible”?  At this juncture, one must assess the conductance of materials, storage potential 

and recharge rate of the site.  As displayed in Figure 7.5 and 7.6, feasibility of horizontal drains to 

stabilize systems is significantly reduced with a combination of low K, large R, and an estimated critical 

water level at significant depth.  If the system also has a low storage potential (low Sy) and is highly 

anisotropic, the feasibility of a drainage solution further diminishes.  However, if ambiguity in feasibility 

arises, then one should proceed forward in the analysis with either an analytical or numerical approach 

to drainage design. 

7.4 Analytical Equations 

Analytic equations represent mathematical models with a closed form solution.  In order to maintain a 

closed form solution, these equations are limited by many simplifying assumptions.  For example, these 

equations require simple geometry, homogeneous and isotropic conditions, and simple boundary 

conditions.  A numeric model is also a mathematical model, but can relax some of the simplifying 

assumptions necessary to solve an analytic equation.  This can be done because numeric models 

compute an approximation to the solution through a time-stepping procedure that attempts find 

successively better approximations to the roots of the real-valued function (e.g. Newton-Raphson 

method).  In other words, the solution to an analytic model is exact while the solution to a numeric 

model is an approximation.  . 
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Site complexity will determine if one chooses an analytical or numerical approach to modeling 

hydrogeologic response to storm events and impact on horizontal drain design.  Conditions that 

mandate a numerical approach include an irregular drain network, heterogeneous aquifer propertiesand 

fractured systems.   Analytical solutions assume that drains are installed perpendicular to the hillslope.  

This assumption is immediately invalidated by practical installation procedures that often situate 

horizontal drains into steep slopes as fan-networks.  Analytical solutions, however, can provide the 

designer a first-cut at quantitatively assessing possible drainage configurations and should not be 

discounted as a viable means for design.   

7.4.1 Steady-State Conditions 

Steady-state conditions are those that represent a system in equilibrium.  These conditions are not 

indicative of episodic events but greatly simplify the approach.  The applicability is that steady-state 

recharge can represent a baseline boundary condition and resulting water levels, while storm calculated 

recharge can provide worst-case scenario for storm related water levels.  The latter is not realistic 

because large precipitation events do not last long and the slope system never reaches a steady-state 

condition.  Assuming steady-state for a storm event will over-estimate water level elevations.  However, 

such estimates can provide insight to system response as long as the practitioner is cognizant of these 

limitations.  

Steady-state analytical approaches are provided for both flat and sloped surfaces. 

7.4.1.1 Hooghoudt Equation (Flat Surface) 

Hooghoudt (1940) developed the first design equations for subsurface drainage conditions and this 

approach is still used today.  The Hooghoudt methodology calculates steady state drawdown for a given 

recharge rate per unit area, R (L/T).  Recharge and drainage are assumed to occur simultaneously and do 

not change with time. Drains are installed in a flat system, at equal depth and are assumed parallel. The 

approach is dependent on horizontal groundwater flow and the existence of an impermeable layer at 

relatively shallow depths.  Parallel drain spacing (Ld) is calculated using Wesseling (1973) formulation in 

SI units, 

�� = ����� (
��
 +
���)         (7.1) 

Parameters in Equation (7.1) are shown in Figure 7.7.  K1 is hydraulic conductivity above the drains and 

K2 is hydraulic conductivity below the drains.  Homogenous systems assume K = K1 = K2.  Hm is the height 

of the water table midway between the drains (m), and Ha is Hm/2 or the average height of the water 

table above the drain (m).  The equivalent depth, de (m), accounts for convergent flow toward the drain 

(refer to Figure 4.17). As flow converges toward a drain, flow is no longer horizontal but acquires a 

longer flow path with greater head loss required for the same volume of water flowing into the drain.   
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Figure 7.7: Hooghoudt (1940) 

parameters for estimating drain 

spacing in steady state, flat surfaced 

systems with a parallel drain network. 

 

The greater head loss results in a higher water table elevation.  In addition, greater head loss occurs with 

a smaller wetted perimeter of the drain. To maintain the Dupuit’s assumption of horizontal flow, 

Hooghoudt (1940) replaced the actual thickness to the impervious layer (D
^
) below the drain, with a 

smaller equivalent depth (de), through which flow will travel to reach the drain.  The higher flow per unit 

area introduces additional head loss, which is equivalent to losses caused by converging flow lines. 

The equivalent depth is dependent on the depth (D
^
) of the impermeable layer below the drains and the 

radius of the drain (or drain and envelope material, rd).  Hooghoudt (1940) published several tables for 

common-sized pipes.  As an example, Table 7.1 gives de for rd = 0.1 m and incremental values of D
^
and 

Ld, using graphs provided in Figures 7.8 and Figure 7.9, or to use the following approximations.   

�
 = 	 �^
���^

��(�.�� ����^
�� !")

;  for D
^
/Ld ≤ 0.31      (7.2a) 

�
 = 	 #�(�.�� ������� !�.��)
;   for D

^
/Ld > 0.31      (7.2a) 

Where  

$ = 3.55 ' 1.6 �^
#� + 2+�^

#�,
�
         (7.3) 

The value of de increases with D
^
 until D

^
 is approximately 1/4Ld, after which de remains relatively 

constant.  For depths greater than 1/4Ld, little additional impact occurs on drain spacing as a result of 

convergent flow toward drains.  
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Since drain spacing (Ld) is a function of equivalent depth, which is a function of drain spacing, the only 

way to solve Hooghoudt’s equation is either use nomographs Van Beers (1979), to iterate manually via 

trial and error, or to set up a solver in a spreadsheet application.   

 

Table 7.1: Effective depths (de) for various drain spacings (Ld) and depths of impermeable layer 

below drain (D
^
) for a drain with an effective radius of rd = 0.1 m. Table adopted from the U.S. 

Department of the Interior (1978) and uses D = D
^
 and L = Ld. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.8: Curves for determining Hooghoudt’s convergence correction for a drain radius of 0.6 ft, 

metric units (Adopted from U.S Department of the Interior, 1978).  
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Figure 7.9: Curves for determining Hooghoudt’s convergence correction for a drain radius of 0.6 ft, 

English units. (Adopted from U.S Department of the Interior, 1978) 

 

As an example, to find the depth to water table (Im) based on D
^
 = 5 m, Ld = 30 m, rd = 0.1 m, 

de = (30/8)/{[(30-8*1.41)
2
/(8*30*5)] + (1/3.14)*ln(30/(0.1*1.41))} = 2.38  

The effective depth is more than 50% less than the actual depth, and agrees with Table 7.1. 

Rearranging equation 7.2 to produce a quadratic equation using Hm 

-.� (�/)� +
��
�/ ' �(#�)0� = 0        (7.3) 

And the solution roots become, 

�/ = 	!-0�2�3(-0�2)0�4+5.0 ,�6(��)07  
-.         (7.4) 

With depth to maximum water table surface calculated as, 

8/ = 9 '�/ ' :∗          (7.5) 

Where B is the total thickness of the sediment.   

Since the equivalent depth de and the drain spacing Ld are functions of each other, the problem is 

iterative.  However, one can and solve with the steps given below. 

1. Determine/estimate hydraulic conductivity (K). 



 
142 

2. Determine/estimate design storm recharge (R). 

3. Set the elevation of the drain above the impermeable layer (D
^
) 

4. Assume a drain spacing (Ld) and drain radius (rd) 

5. Calculate de as a function of rd, D
^
 and Ld. 

6. Solve Hm via a quadratic root 

7. Solve for Im = B – H - D
^
 

8. Is the drain spacing reasonable to keep Im below the critical water surface as determined in the 

preliminary analysis (section 7.3)? 

Note that the solution is steady state and is not dependent on the initial water level.  In addition, the 

assumption of steady state, in essence, is very conservative as it assumes that the system is in 

equilibrium with the design storm recharge.   

Figure 7.10 illustrates Hooghoudt output using an iterative approach.  For the example, the geologic 

layer susceptible to failure is 20 ft thick and the critical water surface determined in the preliminary 

analysis is land surface (Im = 0.0 ft).  In Figure 7.10a, drain location is at an intermediate depth (20 ft) and 

hydraulic conductivity is allowed to vary.  For equal drain depth, lowering K decreases drain spacing 

considerably such that silty materials and till require drains of approximately 20 ft to maintain a water 

table elevation below the critical water surface (Im > 0). Such a tight drain configuration is likely not 

feasible.  In contrast, well sorted sands may not require drains.  Figure 7.10b assumes a silty, fine sand 

hydraulic conductivity and varies drain depth.  Drain spacing decreases dramatically as drains become 

increasingly shallow.  Drains located at a depth of 18 ft may require drains at 100 ft increments, while 

drains placed only 2 ft below land surface may require spacing on the order of 25 ft. Changes toward a 

thinner geologic layer and/or higher recharge rate will reduce drain spacing more. 

7.4.1.2 Slopes Less than 10° 

Dupuit-Forchheimer (DF) assumptions state that groundwater movement is (1) parallel to the slope and 

(2) horizontal.  While the first DF assumption holds under most slope conditions, the second DF 

assumption is only maintained for gentle slopes.   Guitjens and Luthin (1965) conducted a complete set 

of experiments to test solutions and determine under what conditions the DF assumptions break down 

given steady state infiltration.  Chauhan et al. (1968) and Childs (1971) suggest DF assumption 2 is 

invalidated at slopes in the range of 8-10%.  Luthin and Guitjens (1967) repeated their experiments for 

transient conditions and found that flow to ditches, water table elevation, and the rate of water table 

decline were independent of slope for slopes less than 30%. Likewise, Fipps and Skaggs (1989) 

investigated steady-state drainage of hillslopes up to 40% and found that slopes less than 15% had little 

effect on drain flow rates and water table depths in the center location between drains.  For these 

relatively shallower slopes, flat-surfaced assumptions can be maintained with little error 

The U.S Department of the Interior (1978) defines a methodology for drain spacing valid for slopes less 

than 10%.  While drain spacing is assumed to not change for these slopes in comparison to horizontal 

surfaces, the location of the first transverse drain can be computed by mapping the water table surface  
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(a) 

(b) 

Figure 7.10: Examples of Hooghoudt calculated minimum depth to water table (Im) assuming a 

recharge rate of 0.161 ft/d, and drain diameter rd = 0.3 ft, (a) drain depth set to 10 ft below land 

surface and hydraulic conductivity is varied (b) hydraulic conductivity set to equal a silty, fine sand 

and drain depth varied.  Water table elevations rise above land surface when Im≤ 0 m, and surpasses 

the estimated critical surface.  
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with graphical techniques.  To illustrate the graphical procedure, Figure 7.11 gives profiles based on 

i/K<=�. h/SbL and X/L, where Sb is the slope of the impermeable barrier, X is distance along the slope (L), L 

is the total length of the slope (L), i = deep infiltration from irrigation (synonymous with recharge, R) and 

h is the height above the barrier. 

A design question could be asked as to where should the first drain be placed if drains are installed 2.44 

m below ground surface and depth to maximum water table (Im) is not to exceed 1.22 m?  To 

demonstrate, an example is provided with parameters defined as K = 1.22 m/d, L = 457 m, i =R = 0.00068 

m/d (stead state), S* = 0.03 (land surface slope), Sb = 0.27, aquifer depth at the top of the slope is 7.32 m 

and at the bottom of the slope is 5.94 m (refer to Figure 7.12).  Therefore, 

>-?@0 = �-?@0 =	 A.AAAB�(�.��)(A.A�C)0 = 0.76         (7.6) 

From Figure 7.11, the water table surface for 
�-?@0= 0.76 lies just above the line depicting 0.75.  Table 7.2 

provides values for 
E?@# for increasing values of X/L.  From these normalized values, one can solve for X 

and h knowing Sb and L.  For example, water levels at X/L = 0, and 
�-?@0 = 0.76 produces an 

E?@#=0.335. 

Solving, h = 4.13 m above the barrier. Given a barrier depth of 7.32 m at X = 0, the depth from land 

surface of the water table is 7.32-4.13 = 3.2 m.  At X=0, land surface is at 0 m and the depth to the 

barrier is given as 7.32 m. Therefore, the depth from land surface to the water table surface is (0+7.32)-

4.13 = 3.2 m.  This falls below the established 2.44 m for drain depth. 

A follow-up question might be, at what distance from the up-gradient edge (X=0) does natural 

groundwater flow force the water table to reach 2.44 m below ground surface?  Referring to Table 7.2, 

at X/L = 0.058, 
E?@#=0.3885.  Using X = 0.058*L = 0.058*457 = 26.5, and h = (0.027)(457)(0.3885) = 4.77 m, 

and the depth to the barrier at X26.5m = 7.32 + Sb(26.5) = 8.03 m, the depth to the water table is close to 

2.44 m.  Therefore, no water will enter a drain placed between X = 0 and 26.5 m at a depth of 2.44 m 

below land surface.  When the water table reaches 2.44 m depth at X=26.5 m, it is the same effect as 

placing a drain at this location, and is treated as a virtual drain. 

To maintain a minimum depth to land surface of 1.22 m, which corresponds to a maximum height above 

the drain elevation (Hm) of 1.22 m, the steady-state Hooghoudt method for flat surfaces will suffice for 

slopes up to 10%.  Again, the approach is iterative, since drain spacing Ld depends on the effective depth 

de, and de is dependent on drain spacing.  The steps are as follows: 

1. Assume a drain spacing (Ld) of 300 m as an initial guess. 

2. Drain spacing begins where the water table reaches 2.44 m depth, or X=26.5 m. 

3. Since the slopes for land surface and barrier are not equal, it is necessary to calculate an average 

thickness (Bavg) of the aquifer between X = 0 m and X = Ld+26.5 m =326.5 m: B0 = 7.32 – 0= 7.32 

m and B326.5 = (7.32+Sb(326.5)) – (0+Sa(326.5) =6.38 m.  Therefore Bavg = 6.85 m. 

4. The average depth below the drains is the average thickness of the aquifer less the depth that 

drains are place (2.44 m).  D
^

avg = 6.85 – 2.44= 4.41 m. 
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(a) 

 

 

 

 

 

 

 

 

 

 

(b) 

Figure 7.11: Water table profiles on sloping barriers for (a) 
�-?@0≤ 0.25 and (b) 0.25≤

�-?@0≤ 1.25. 

(adopted from U.S. Department of the Interior, 1978). Deep infiltration (i) is synonymous with 

recharge R.  
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X/L h/SbL X h

0 0.335 0 4.13

0.05 0.38 22.85 4.69

0.058 0.3885 26.506 4.79

0.1 0.425 45.7 5.24

0.15 0.46 68.55 5.68

0.2 0.496 91.4 6.12

0.25 0.528 114.25 6.51

0.3 0.555 137.1 6.85

0.31 0.56 141.67 6.91

1 0.78 457 9.62

Graphical Actual 

Table 7.2: Water Table Surface for 
�-?@0=0.76 obtained from Figure 7.11b and parameter values for 

given example (L = 457 m, Sb = 0.27) 

 

 

 

 

 

 

 

 

 

 

5. The effective depth de is calculated using equation 7.2a since D
^
/Ld < 0.31. For this example, 

assume a drain radius of 0.183 m, and de computes as 4.14 m. 

6. Iterate until Ld defining de (equation 7.2) produces an equal Ld in equation 7.1. 

7. The final Ld = 287.5 m.  Since slopes are less than 10%, it is assumed that Ld = Ldcos(Sb), or the 

that drain spacing is essentially the horizontal distance of the drain.  Drain length begins where 

the water table first reaches 2.44 m below land surface, or X = 26.5 m.  Therefore the drain is 

placed at 314 m from X=0. 

For another example, a surface water body at the end of the slope has an elevation of 13.7 m at X = 457 

m which is a distance of 143 m from the drain.  The maximum water level between the drain and the 

water body is estimated to occur at the mid-point, or X = 314 + (143/2) =385.5 m.  The height of the 

water table at this location is estimated with the following procedure, 

1. Ground surface elevation at the mid-point between the drain and water body is (385.5*0.03) = 

11.6 m. 

2. The depth below land surface for the barrier mid-point between the drain and surface water 

body is 7.32+(314+71.5)(0.03) = 17.7 m 

3. The drain elevation at X=314 m is (314*0.03)+2.44 = 11.9 m 

4. Average elevation between the drain and surface water body = (13.7+11.9)/2=12.8 m 

5. D
^
= 17.7-12.8=3.9 m 

6. de = 3.5 m 

7. Using equation 7.1 solve for Hm such that Ld = 143 m.   

8. Hm = 0.39 m and the water table is located at 12.8-0.39=12.4 m 
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9. Depth to water table surface is 12.4-11.6 = 0.81 m, which is less than the design minimum of 

1.22 m. 

Results are plotted in Figure 7.12.  Graphically one can see that a single drain cannot maintain water 

levels 1.22 m below ground surface past X = 370 m based on the surface water boundary condition.  

However, the single drain, under steady-state conditions, can reduce seepage along much of the slope 

compared to the no-drain scenario.  The inundation of water in the lower slope may be too little to 

cause slope failure, but if not, then an additional drain may be installed.  It should be noted, that in all 

situations, the constant head boundary condition at the toe of slope will not allow the water table to be 

lowered to 1.22 m in its immediate vicinity. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.12: Analytically derived water table profiles under steady state conditions with and without 

a transverse drain. 

 

7.4.1.3 Influence of Recharge and Hydraulic Conductivity on Drainage Design (all slopes) 

Lesaffre (1987) demonstrated that under steady-state infiltration the influence of slope on drainage is 

determined by a single factor (σ), 

F =	 ?@(�!65)�G�/-            (7.7) 
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Where <=  is the barrier slope (L/L), I is the recharge rate (L/T) and 
	the saturated hydraulic 

conductivity (L/T).  The shape of the water table surface is related to σ, with shape changing at the 

critical value of σ = 1.  For σ < 1, part of the flow to the drain is upslope. For σ ≥ 1, flow to the drain is 

only downslope.  Lesaffre (1987) demonstrated that the ratio between steady-state drain spacing in a 

sloped surface (��∗ ) and a horizontal surface (��) is directly related to F.  For values of σ < 1, ��∗ /��	is 

nearly 1, and the effect of slope is negligible.  For σ>1, ��∗ /Ld increases such that slope and the ratio of 

R/K become important on drain spacing (Figure 7.13).   

 

Figure 7.13: Impact of slope on drain spacing as described by Lesaffre (1987). 

 

The functional relationship of equation 7.7 is plotted in Figure 7.14.  σ increases with increased slope, 

and also increases with a decreased ratio of recharge to hydraulic conductivity (R/K). The ratio of 

recharge to hydraulic conductivity is a means to assess the ability of the system to transmit available 

water to mitigate large fluctuations in water level.  For example, systems with low recharge and 

conductive geologic materials will produce a very low ratio indicating system capable mitigating large 

water table fluctuations and the spacing between drains will increase.  In contrast, systems with large 

recharge volumes and low conductive materials produce a large R/K ratio to indicate a system are more 

susceptible to increased water table elevations.  Figure 7.14 shows that for a given slope, σ increases 

only minimally as the ratio of R/K decreases. Only at very low ratios of recharge and hydraulic 

conductivity at which σ increases at a substantially faster rate, with steeper slopes showing producing 

larger increases in σ than shallower slopes.  
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For example, Figure 7.145 shows that a slope as low as 5% and an R/K = 0.0001 will produce σ = 2.5.  

Figure 7.13, this equates to a ��∗ /��= 2.5. Therefore, at a slope of 5% drain spacing can be 2.5 times 

greater than for a flat sloped surface.  In contrast, a slope of 20% and a system with either much larger 

recharge or much less ability to transmit recharge (e.g. R/K = 0.01) will produce σ < 1.0 and drain spacing 

is not impacted by the steep slope.  

 

 

Figure 7.14: Influence of R/K and slope on σ, as defined by equation 7.7. 

 

Lesaffre (1987) presents the following estimate of drain spacing dependent on slope given steady-state 

infiltration, 

��∗ =	�/�4-� +	�-�2��� + +-� ' 1,� (<=)�         (7.8) 

Where de is the equivalent depth calculated by equation 7.2. Equation 7.8 reverts to Hooghoudt  

equation 7.1 when Sb = 0.  As an example, Figure 7.15 plots Ld vs ��∗  given K = 1.0 m/hr, R = 0.002 m/hr.  

For Sb = 0.01, σ = 0.11 and consequently ��∗  is approximately equal to Ld.  Drain spacing then increases 

with increased slope for Sb≥ 0.1 

The implications of Lesaffre’s (1987) work, is that flatter surfaces require drains to be closer together, 

and in this essence, represent the most conservative approach to drain design.   



 
150 

 

 

 

 

 

Figure 7.15: Drain spacing on 

a sloped surface (��∗ ) 

compared to a flat surface (Ld) 

for different slopes. Red 

dashed line represents 1:1 

line. 

 

 

7.4.2 Transient Solutions 

Slope failure is generally caused by rapid increase in water levels (pore pressures) that cause instability, 

and are typically not a function of steady-state recharge conditions.  Graphical methods for flat surfaces 

(U.S. Department of the Interior, 1978) and semi-analytical methods for sloping surfaces (Skukla et al., 

1990) are presented.  In all cases, drain design is limited to parallel, equally spaced, transverse drain 

layouts.   

7.4.2.1 Flat Surfaces 

The U.S. Department of the Interior (1978) method for computing drain spacing is based on maintaining 

dynamic equilibrium in water levels below a specified water level.  The approach was developed for 

irrigation systems, not for maintaining slope stability.   Figure 7.16 shows curves for estimating drain 

spacing based on if the drain is situated directly on the impervious surface or some height above this 

surface.   Axes represent normalized dimensionless parameters with parameters defined within the 

figure.  

To illustrate the use of Figure 7.16, an example is modified from U.S. Department of the Interior (1978) 

given a drain situated above the impermeable layer, and assuming D
^
= 6.7 m (22 ft), the depth of the 

drain is 2.4 m (8 ft), and drain spacing Ld = 442 m (1,450 ft).  As an example, if one wishes to keep the 

maximum water table surface 1.2 m (4 ft) below ground surface, then H0 = 2.4 m – 1.2 m = 1.2 m (4 ft).  

Hydraulic conductivity is 3.05 m/d (10 ft/d) and assumed uniform with depth.  Use Figure 4.16 to  
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Figure 7.16: Curves showing relationship of parameters needed for drain spacing calculations using 

the transient flow theory presented by U.S. Department of the Interior (1978) for flat surfaces. 
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estimate Sy from hydraulic conductivity, Sy = 0.18.  The effective depth de is then found using equation 

7.2, which equals 6.1 m.  The approach will use the effective depth in place of actual depth (D
^
) in the 

calculation of D’, such that De’ = de+y0/2. 

The problem is initiated by assuming that initial water level (yo) begins at the maximum allowable 

height, or 1.2 m above the drains and the system is first modeled through its dry period.  Recharge 

events are then added throughout the wet period to test if the system rebounds over the maximum 

allowable height.  Table 7.3 provides calculations.   

1. Assume maximum allowable water table elevation at the beginning, y0 = 1.2 m 

2. The dry period is 233 days with no recharge. This is divided into two periods of 117 days and 116 

days, respectfully.   

3. First stress period: De’ = y0/2 + 6.1 m = 7.3 m; KDe’/SyLd
2
 = (3.05)(7.3)*117)/(0.18)(442)2 = 0.0742.  

From Figure 7.16, this corresponds to a y0/y = 0.575.  Knowing y0, y is calculated as 0.69 m. 

4. Second stress period: this stress period occurs during the dry period and there is no recharge. 

The initial water table height (y0) equals the water table height at the end of the last stress 

period. Y = 0.69. De’ = 6.1 + 0.69/2 = 6.45 m,  KDe’/SyLd
2
 =0.0695 and from Figure 7.16, y/y0 = 0.59 

such that the water level at the end of the dry season is 0.407 m above the drains. 

5. Third stress period: First recharge event occurs with 0.0252 m assumed to occur 

instantaneously.  The water table build up is 0.0252 m/0.18 = 0.14 m, and the initial water table 

height is the water table height at the end of stress period 2 plus the recharge, or 0.407 + 0.14 = 

0.547 m. Computation of D’, KDe’/SyLd
2
, y/y0 and y are done similar to step 3 and 4. 

 

Table 7.3: Calculation of water table fluctuation (in meters) with a drain above the barrier layer. 

(Example modified from U.S. Department of the Interior, 1978).  

 

 

 

 

 

 

 

  

Stress 

peroid 

(d)

recharge 

(m)
time (d)

cumul. 

time (d)

WT build 

up (m)
Y0 (m) De' (m) KD't/SyL

2
Y/y0 y (m)

1 0 117 0 1.200 6.71 0.0730 0.575 0.690

2 0 116 117 0.690 6.45 0.0695 0.590 0.407

3 0.0252 45 233 0.14 0.547 6.37 0.0267 0.870 0.476

4 0.0252 25 278 0.14 0.616 6.41 0.1490 0.958 0.590

5 0.0252 20 303 0.14 0.730 6.47 0.0120 0.978 0.714

6 0.0252 14 323 0.14 0.854 6.53 0.0085 0.985 0.841

7 0.0252 14 337 0.14 0.981 6.59 0.0086 0.985 0.967

8 0.0252 14 351 0.14 1.107 6.65 0.0087 0.985 1.090

9 0.0252 365 0.14 1.230
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Successive stress periods are treated in the same manner.  At the conclusion of the last recharge event, 

the water table surface is at 1.23 m above the drains, or approximately the maximum allowable height.  

Therefore, a drain spacing of 442 m maintains water levels in dynamic equilibrium.  Figure 7.17 displays 

calculated water levels over time using the U.S. Department of the Interior (1978) transient-step 

approach, assuming a flat surface. As mentioned above, this approach was developed for agricultural 

systems, not slope stability problems.  In this light, it is recommended to use these equations only as a 

first cut of maximum drain spacing at the end of a fan array. 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.17 Height of the water table above drains (y) over time for the example problem provided 

in Table 7.3. (modified from U.S. Department of the Interior, 1978) 

 

The equations presented also allow the designer to compute the time to drop the water table a certain 

amount for a given drain spacing, or the drain spacing to drop the water table a given amount over a 

specified period of time.   

To demonstrate, the example is K = 3.05 m/d, D =6.1 m, depth to the drain y0= 2.7 m, Sy = 0.07 and 

existing drains are 91 m apart.  Assume drain radius is 0.183 m.  If the water table is at land surface at t = 

0, how many days will it take for the water table to drop 1.2 m below ground surface?   

To solve, the effective depth de = 4.4 m is computed from equation 7.2.  Therefore De’ = 4.4+2.7/2=5.75 

m.  The ratio of y/y0 = 1.2/2.7= 0.44, which gives 0.096 for KDe’/SyLd
2
 from Figure 7.16.  Now it is possible 

to solve for t. 
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K = A.ALB?M#�0-�2N = A.ALB(A.AC)(L�)0(A.OA�)(�.C�) = 31.8	�QRS       (7.9) 

It takes nearly 32 days for the water level to recede from land surface to a depth of 1.2 m given a drain 

spacing of 91 m.  If one wants to drop the water table the same amount, but in only 10 days, then one 

solves for Ld.  However, as with steady state solutions, de and De’ are dependent on Ld and iteration must 

be done to solve for Ld.  To solve, 

1. Initial guess of Ld = 70 m 

2. D
^
/Ld = 6.1/70 = 0.08, therefore use equation 7.2a and de = 4.18 m. 

3. Calculate De’. = 4.18 + (2.7/2) = 5.53 m 

4. Compute 
-�2NT?M#�  using t = 10 days. For Ld = 70 m, 

-�2NT?M#�  = 0.049 

5. Compare with graphical value of 
-�2NT?M#�  = 0.096 given y0/y = 0.44. 0.049<0.096, therefore Ld must 

be lowered.  

6. Final iteration, Ld = 47.6 m.
1
  

To decrease the time of drainage by 1/3, it is necessary to decrease spacing of drains by over 47% given 

K = 0.305 m and Sy = 0.07.  Drain spacing required to lower the water table 1.2 m for different time 

intervals and for changes in K and Sy are plotted in Figure 7.18, and tabulated in Table 7.4.  With 

decreases in K, drain spacing must be significantly reduced to lower the water table for equivalent 

periods of time compared to systems with large hydraulic conductivity. Likewise, increasing Sy will force 

Ld to significantly smaller values. 

 

Table 7.4: Drain spacing, Ld (meters) required to lower water table elevations 1.2 m in time t for 

various values of Sy and K.   

 

 

 

 

 

 

  

                                                             
1
 Iteration can be either manual, or use solver capabilities in many spread sheet application.  For example, the 

Excel add-in Solver allows one to set up an objective function (e.g. error between graphical value and computed 

value) in which Ld is changed until objective function is minimized. 

S y 0.07 0.07 0.07 0.01 0.2

K, m/d 0.305 3.05 0.035 0.305 0.305

t,d L d , m Ld , m L d , m L d , m Ld , m

32 91.0 316.4 24.1 262.4 50.9

20 71.0 247.3 18.1 205.0 38.7

10 47.6 171.4 11.7 141.6 25.5

5 31.6 118.0 7.5 97.0 16.6

1 11.7 47.7 2.7 38.7 5.9

0.5 7.5 31.6 1.8 25.5 3.8

0.1 2.7 11.7 - 9.3 1.5
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(a) 

 

 

 

 

 

 

 

(b) 

 

Figure 7.18: Drain spacing, Ld, required to 

lower water table elevation 1.2 m in time 

t given (a) Sy = 0.07 and changing K, (b) K 

= 0.305 m/d and changing Sy. Table 7.4 

provides actual values. 

 

 

7.4.2.2 Sloping Surface – Maximum Water Levels and Rates of Decline 

Analytical, numerical and experimental solutions for drainage given unsteady-state conditions abound 

for flow regimes where parallel ditches penetrate to an impermeable layer, or a covered drain lies on 

the impermeable layer.  Luthin and Guitjens (1967) obtained a transient solution for drainage on sloping 

surfaces using a Hele-Shaw model and concluded that slopes less than 30% can be treated as a flat 

surface.  Chauhan et al. (1968) used an analytic solution to a linearized Boussinesq equation, an 

analogue computer solution as well as experimental solutions from a Hele-Shaw model to solve several 

solutions for unsteady drainage in sloping lands with a variety of boundary conditions, but slopes were 

limited to less than 8% and limited to the rate of fall (no recharge) of the water table surface.  Ram and 

Chauhan (1987a) also used a linearized form of the Boussinesq equation to solve for a transient solution 

but allowed steady rate of recharge, and then added an exponential recharge function over time (Ram 

and Chauhan 1987b). 
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Skukla et al. (1999) uses a combination of explicit and implicit difference methods to numerically solve a 

nonlinear Boussinesq equation for slopes 0-70% to investigate the rate of water table fall after a rain 

event.  Results compared well to experimental solutions provided by Luthin and Guitjens (1967), 

Chauhan et al. (1968), and the finite difference solutions of Moody (1966) for partially penetrating 

drains in a horizontal aquifer.  Shukla et al. (1999) assumes that boundary conditions are defined by 

antecedent vertical recharge, in which the water table rises uniformly to a vertical height of �/A  (parallel 

to the impermeable layer), and then solves for transient head based on drawdown over time between 

two drains (h(x,t)).  Numerical solutions are presented graphically using dimensionless parameters 

similar to the flat-surface solution in section 7.4.2.1.  With parameters defined in Figure 7.19. Figure 

7.20 provides a dimensionless form of maximum water table height (hm/�/A ) versus a dimensionless 

time function incorporating Sy, K and drain spacing (Ld) for slopes equal to 10%, 30%, 50% and 70% and 

different depths of the impermeable layer (m = 1.0, 0.8, 0.4, 0.2 and 0.1), where hm is the maximum 

water table height at time t. 

Note that Skuka et al. (1999) assumes a rise in water level has already occurred to some known height 

and calculated the time and location of the maximum water level over time between two drains.  

Necessary parameters include, (1) the time required to lower the water table elevation to maintain 

stability, t, (2) a measured or assumed value for hydraulic conductivity and specific yield, K & Sy, (3) the 

water table elevation prior to a design storm, and (4) the water table elevation following a design storm 

(D*).   

 

Figure 7.19: Parameters for sloping surface given transient drawdown and drains lying above an 

impermeable layer. (Reprinted from Journal of Irrigation and Drainage Engineering, 116(1), Shukla, K.N., H.S. Chauhan, and V.K. 

Srivastava, Finite Difference Solution of Boussinesq Unsteady-State Equation for Highly Sloping Lands, pp 107–113, 1990, with permission from 

American Society of Civil Engineers.)  
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Figure 7.20: Dimensionless curves of maximum water table height with respect to time for slopes of 

(a) 10%, (b) 30%, (c) 50% and (d) 70%. (Reprinted from Journal of Irrigation and Drainage Engineering, 116(1), Shukla, K.N., 

H.S. Chauhan, and V.K. Srivastava, Finite Difference Solution of Boussinesq Unsteady-State Equation for Highly Sloping Lands, pp 107–113, 

1990, with permission from American Society of Civil Engineers.) 

 

To solve drain spacing (Ld) perform the following steps: 

1. Assume a drain depth with respect to peak water level �/A  

2. Calculate the ratio U = �/A /:∗, where D* is height of maximum water table elevation above 

the impermeable surface. 

3. Calculate the y-axis in Figure 7.20, V//�/A , such that hm is the maximum height of the water 

table for which stability of the slope is maintained. 

4. Find the intersection of the calculated	V//�/A  and curve choice m, and trace back to the x-axis.  

5. Solve for drain spacing Ld for given value of x-axis, 
-WT?M#�0  
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To illustrate, an example similar to that presented in section 7.4.11 and Figure 7.10 is provided in which 

the thickness of the geologic layer is 20 ft, but now has a slope of 30%.   

• It is assumed that the time required to sufficiently lower the water table during a large storm is 

0.5 days. 

• Hydraulic conductivity and specific yield are set to 1.0 ft/d (silty, fine sand) and 0.1, respectively. 

• It is assumed that a design storm will force the water table to flood the system such that water 

rises above land surface. For convenience, let’s assume the water table rises 1 foot above land 

surface, or D* = 21 ft.  

• Assume m = 1.0, then this signifies the drains are located on the impermeable layer.  

• The drains must lower the water table below land surface. Therefore the y-axis V//�/A  = 20/21 

= 0.95. 

• Trace the y-axis to the m= 1.0 curve and follow the x-axis. The x-axis is in a log-scale. , 
-WT?M#�0  is 

approximately 0.04.  

• Solve for �� = �
:∗K 0.04<XY  = 51 ft 

 

These results indicate a reduction in drain spacing by approximately half compared to the Hooghoudt 

example given in Figure 7.10b. 

Figure 7.20a shows curves for a 10% slope.  As the value of m increases (depth below drains to barrier 

decreases), than the water table declines at a slower rate with time.  The rate of water table decline is 

slowest when the drain is placed directly on the barrier (m = 1.0).  When slope is increased to 30% 

(Figure 7.20b), decline is slowest when m = 1.0, and no water table decline is seen beyond 
-WT?M#�0  = 0.4.  At 

50% slope, no further water table decline is seen for m = 0.1 at the dimensionless time parameter 

equaling 0.2. For a 70% slope, water table fluctuations of hm/�/A  = 0.8-0.9 are seen for time parameters 

less than 0.1 given m = 0.8 to 1.0. 

For flat surfaces, the water divide, or the location of the highest water level surface, is located at the 

midpoint between drains and does not change with time.  In the case of sloping systems, the water 

divide is a function of time, moving from its initial location near the upper drain and toward the lower 

drain.  With increased slope, the movement of the divide toward the lower drain occurs more rapidly 

(Figure 7.21a).  The values of maximum height of the water table are given in Figure 7.21b.  The value of 

the highest water table elevation varies at a faster rate for lower slopes, moving toward a maximum 

distance of 0.65 of the drain span.  For higher slopes, the value of the highest point of the water table 

varies more slowly, and its location shifts closer to the lower drain to a distance of 0.9 Ld.  
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(a) 

 

 

 

 

 

 

 

 

(b) 

 

Figure 7.21: (a) Dimensionless time of maximum water table height, and (b) dimensionless height of 

maximum water table of at various distances for different slopes. (Reprinted from Journal of Irrigation and 

Drainage Engineering, 116(1), Shukla, K.N., H.S. Chauhan, and V.K. Srivastava, Finite Difference Solution of Boussinesq Unsteady-State 

Equation for Highly Sloping Lands, pp 107–113, 1990, with permission from American Society of Civil Engineers.) 

 

7.4.3 Limitations of Analytical Approaches 

Analytical solutions require several limiting assumptions that are not applicable to most slope stability 

problems.  While simplified geology and steady-state conditions are readily solved via analytical 

approaches, spatial and temporal distributions of water levels as a function of variable recharge are not 

explicitly calculated.  Transient approaches for flat systems are presented that can give estimates of 

drain spacing as a function of variable recharge.  Transient solutions for sloping surfaces are more 
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difficult to apply and in general, slopes less than 30% can be treated as flat. In addition, the transient 

approaches presented only track the receding water table after peak water levels are obtained.  No 

recharge is modeled. 

Perhaps the most serious limitation to analytical approaches is that drain design is limited to drain 

placement orthogonal to the slope.  This is suitable for irrigation practices, but is not practical for slope 

stability problems in which fan-drain arrays are more commonly applied.  No analytical approach is 

available to deal with fan arrays.  Instead, numerical techniques are needed to test spatially complex 

drain arrays, complex geology, and highly variable recharge. 

7.5 Numeric Modeling Approach to Drainage Design 

Recognizing the limitations of analytical approaches discussed above, numerical modeling with 

MODFLOW is necessary to evaluate the complex hydrogeologic conditions associated with many typical 

applications for horizontal drains.  The following approach considers two generalized types of slope 

failure mechanisms - translational and rotational failures.  Generic, or idealized, sites are presented for 

each failure scenario to serve as templates for site-specific modeling or to directly guide drainage 

design.  Modeling results will look at important controlling features of drainage design, with emphasis 

on drain length, spacing, and elevation, as well as sensitivity of design to site characteristics of recharge, 

hydraulic conductivity, specific yield and drain efficiency.  Proper communication between groundwater 

model results and geotechnical analysis are outlined for the most efficient drainage design.  For an 

introduction to slope stability analysis or groundwater modeling, refer to chapters 2 and 6, respectively. 

 

7.5.1 Hydraulic Soil Properties 

Hydraulic soil properties are adjusted over applicable ranges to ascertain what types of soils are most 

influenced by specific drain configurations.  Table 7.5 outlines the 12 soil types investigated.   

7.5.2 Translational Failure (Site D) 

7.5.2.1 Site Description 

Site D is modeled using the topography shown in Figure 7.23.  The slope is relatively uniform from the 

ridge crest to the base of the slope at approximately 28% (16°).  The hypothetical subsurface conditions 

have been assumed to be a simple two-layer system, with the contact between these layers being 

coincident with slope.  Layer 2 is a 20-ft-thick permeable layer that overlies a low permeability unit 

(layer 1).  For modeling purposes, the lower unit is assumed to be impermeable. 
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Table 7.5: Twelve soil types considered based on hydraulic properties of horizontal hydraulic 

conductivity (Kx, ft/d), specific yield (Sy, dimensionless) and the ratio of horizontal to vertical hydraulic 

conductivity (VKA, dimensionless). 

 

 

7.5.3 Design Storm 

The design storm is defined as a 100-year, 24-hour rain event. For a generalized version of site D, the 

assumptions made include: CN = 80, total precipitation = 9 inches and storm distribution is type IA. The 

resulting recharge during a 24-hour event is shown in Figure 7.22.  Sensitivity of drain design to the CN, 

total precipitation and storm type are discussed in the section 7.4.3.6.4 for translational failure. 

 

7.5.3.1 Model Domain and Conceptual Model 

The model domain encompasses the entire watershed to eliminate the need to designate water flux 

across boundary conditions (Figure 7.24).  Water entering the system is assumed to only occur from 

precipitation, with all water flowing toward the watershed outlet at the lowest elevation.  Figure 7.25 

shows the MODFLOW grid placement in plan-view and a cross section of the model along d-d’.  Cell size 

is 5 ft by 5 ft and a single homogenous unit is modeled at 20 ft thick.  The model grid is orientated 27° so 

that modeled rows run parallel to the slope. 

 

Soil Kx Sy VKA General Soil Description

1 0.1 0.01 1
silt, sandy silt, clayey sand or till with very low storage (1%) and 

isotropic conditions

2 1 0.01 1
silty sands and fine sands with very low storage (1%) and 

isotropic conditions

3 10 0.01 1
well sorted sands, glacial outwash with very low storage (1%) 

and isotropic conditions

4 0.1 0.1 1
silt, sandy silt, clayey sand or till with average storage (10%) 

and isotropic conditions

5 1 0.1 1
silty sands and fine sands with average storage (10%) and 

isotropic conditions

6 10 0.1 1
well sorted sands, glacial outwash with average storage (10%) 

and isotropic conditions

7 0.1 0.01 10
silt, sandy silt, clayey sand or till with very low storage (1%) and 

anisotropic conditions

8 1 0.01 10
silty sands and fine sands with very low storage (1%) and 

anisotropic conditions

9 10 0.01 10
well sorted sands, glacial outwash with very low storage (1%) 

and anisotropic conditions

10 0.1 0.1 10
silt, sandy silt, clayey sand or till with average storage (10%) 

and anisotropic conditions

11 1 0.1 10
silty sands and fine sands with average storage (10%) and 

anisotropic conditions

12 10 0.1 10
well sorted sands, glacial outwash with average storage (10%) 

and anisotropic conditions

Hydraulic Parameter
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Figure 7.22: 24-hour 100 year recharge for CN = 80, total precipitation = 9 inches and type IA storm. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.23 Site D topography for translational failure (a) hill shade, (b) cross sectional profile of land 

surface from D-D’. 
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(a)       (b) 

Figure 7.24: (a) Site D topographic map showing land surface elevation at 5 ft intervals. Gray circle 

represents watershed outlet, while thick black line delineates the watershed. (b) A surface map 

showing elevation in color scale and the watershed boundary given as a white line. 

 

7.5.3.2 MODFLOW-NWT 

In order to model water levels for the thin geologic layer for translational failure it is necessary to use 

MODFLOW-NWT.  MODFLOW-NWT contains the newest USGS numeric solver (Niswonger et al., 2011) 

and maintains numeric stability during the wetting and drying of model cells.  MODFLOW-NWT contains 

two input files not previously used by MODFLOW.  The GUI interface, Groundwater Vista (GWV), will 

automatically convert the MODFLOW LPF package into the UPW package and no changes are explicitly 

required by the user.  The NWT solver package, however, must be designated by the user with only a 

few NWT input parameters changed from their default status.  Parameter changes are listed below, and 

a tutorial is provided in Appendix B on how to assign these parameters in the GWV platform. 

• OPTION = COMPLEX replaces OPTION = MODERATE:  This changes default parameters to those 

best describing very non-linear models.  While “moderate” may describe steady state scenarios, 

large recharge rates over short stress periods during the design storm will require the complex 

default parameters. 

• IBOTAV = a flag that indicates whether corrections will be made to groundwater heads relative 

to the cell-bottom elevation if the cell is surrounded by dewatered cells.  A value of 1 means a 

correction will be made, while a value of 0 means no correction is made.  The designation is 

problem specific.  Tests for this problem found that a value of 1 is desirable.  

• FLUXTOL = this is the maximum root-mean-squared flux difference between outer iterations for 

the solution of the nonlinear problem. Units are in length cubed per time.  This value is lowered 

from 100 to 1 ft3/d.  If mass balance errors still occur, then FLUXTOT needs to be lowered 

further.   
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Figure 7.25: Model grid Site D with (a) plan view showing modeled grid (purple box), active cells in 

color scale of assigned land surface elevations, rotated x-y axis and cross section d-d’.  Cell 

dimension is 5 ft by 5 ft.  (b) Cross section d-d’ depicting single layer model (thickness of layer is 20 

ft) as well as no flow cells and specified head cells.  Recharge is applied evenly across modeled 

domain.  (c) Four-layer model used to test anisotropy (VKA) on drain design where VKA = Kx/Kz. 
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• MAXITEROUT = is the maximum number of iterations to be allowed for solution of the outer 

(nonlinear) problem.  This is increased to 3000, so that a solution has adequate time to 

converge. 

• BACKFLAG = is a flag used to specify whether residual control will be used.  A value of 1 indicates 

that residual control is active.  A value of 0 indicates it is inactive.  Experimentation found that 

solution convergence is best achieved if set to a value of 1. 

7.5.3.3 Geotechnical Parameters and Preliminary Slope Stability Analysis 

Slope stability analysis was carried out using XTABL slope stability analysis software, using limit-

equilibrium methods.  In order to accommodate the translational failure mode, Janbu’s method was 

used in analyses. The results of the factor of safety calculations were confirmed using Spencer’s method 

for a few cases.  Both methods provided near identical results as expected.  

Figure 7.26 indicates cross section d-d’. Layer 1 and 2 are two soil layers. Layer 2 soil properties are, 

friction angle is 35°; cohesion is zero; unit weight is 120 pcf and saturated unit weight is 125 pcf.  Higher 

strength parameters were assumed for Layer 1 to ensure the translational failure of soil along Layer 1. 

Its properties are, friction angle is 55° a; cohesion is 4000 pcf; unit weight is 140 pcf and saturated unit 

weight is 145 pcf. The defined translational failure surface is shown in Figure 7.26.  

 

 

 

 

 

 

 

 

 

 

 

Figure 7.26:  Location of translational failure surface for a typical cross section of site D when the 

water table surface is located at ground surface (fully saturated) and no drains are installed. 
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The initial analysis was carried out when the water table is on the top surface of Layer 2 as shown in 

Figure 7.26.  The factor of safety (FOS) was calculated using three methods: simplified Janbu, Spencer 

and Plane translational slip.  Resulting FOS are provided in Table 7.6 and show that calculations are 

similar.  The critical water level surface is defined as that water table elevation for which slope failure is 

likely to occur (FOS = 1.0).  For site D, the critical water level for slope failure given a soil unit 20 feet 

thick is approximately ground surface.   

 

Table 7.6: FOS using different analysis methods for site D, translational failure and no drains 

installed. 

 

 

 

 

 

7.5.3.4 Drain Configurations 

Thirteen separate drain arrays test design strategies on effectively lowering water levels below a critical 

water level to promote slope stability. Short length drains extend over the lower slope toe, medium 

length drains extend the entire slope toe, while long length drains extend from the base of the toe to 

the upper slope reaches.  Short drains are assumed to have an angle (from the horizontal) of 5 degrees.  

Medium and long drain angles are adjusted so that the entire drain falls within the upper and lower 

elevations of the soil unit.  On average, medium length drains require a 10 degree angle.  Long length 

drains require a16 degree angle from horizontal to avoid intersecting the underlying bedrock (or 

confining unit).  Figure 7.27 shows a cross section with an example of a long, medium and short- length 

drains.  Drain spacing is designated as wide (fan angle is approximately 24˚), medium (fan angle = 12˚) 

and narrow (fan angle = 6˚).  Each spacing category represents a near doubling in the number of drains.  

Four drain configurations are also investigated that combine different length drains. Drain specifications 

for site D are provided in Table 7.7 and illustrated in Figures 7.28 to 7.40.  

Drain conductance is calculated by defining drain length, surface area and hydraulic conductivity.  Drain 

hydraulic conductivity (Kd, ft/d) is assumed equal to surrounding geologic material. A test of model 

output sensitivity to Kd is discussed in the section on sensitivity analysis (section 7.5.3.6.4) 

 

Analysis Method FOS

Simplified Janbu 0.972

Spencer 0.972

Plane translational slip 

(by using equations)
1.031
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Drain Num of Approx. Len. Tot. Len.

Array Length Spacing Drains ft per drain ft Fan, deg. Horiz., deg

1 short wide 4 50 220 24 5

2 short medium 9 50 497 12 5

3 short narrow 18 50 987 6 5

4 medium wide 4 130 487 24 10

5 medium medium 9 130 1,042 12 10

6 medium narrow 18 130 2,047 6 10

7 long wide 4 90-325 902 24 16

8 long medium 9 60-325 1,757 12 16

9 long narrow 18 50-327 3,492 6 16

10 med/short wide 9 50-130 764.99 12 5/10

11 med/short medium 19 50-130 1583.3 6 5/10

12 long/short wide 9 50-325 1177.32 12 5/16

13 long/short medium 19 50-325 2304.34 6 5/16

AngleGeneral Description

 

Figure 7.27: A cross section show examples of long, medium and short length drains for site D. The 

upper slope and the slope toe are marked for reference.  

 

Table 7.7: Drain specifications for site D.  
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Figure 7.28:  Drain array 1 in plan view. Contours represent land surface elevation and red lines 

represent drain placement.  Model cells are 5ft by 5ft. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.29:  Drain array 2 in plan view. Contours represent land surface elevation and red lines 

represent drain placement.  Model cells are 5ft by 5ft. 
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Figure 7.30:  Drain array 3 in plan view. Contours represent land surface elevation and red lines 

represent drain placement.  Model cells are 5ft by 5ft. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.31:  Drain array 4 in plan view. Contours represent land surface elevation and red lines 

represent drain placement.  Model cells are 5ft by 5ft. 
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Figure 7.32:  Drain array 5 in plan view. Contours represent land surface elevation and red lines 

represent drain placement.  Model cells are 5ft by 5ft. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.33:  Drain array 6 in plan view. Contours represent land surface elevation and red lines 

represent drain placement.  Model cells are 5ft by 5ft. 
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Figure 7.34:  Drain array 7 in plan view. Contours represent land surface elevation and red lines 

represent drain placement.  Model cells are 5ft by 5ft. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.35:  Drain array 8 in plan view. Contours represent land surface elevation and red lines 

represent drain placement.  Model cells are 5ft by 5ft. 
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Figure 7.36:  Drain array 9 in plan view. Contours represent land surface elevation and red lines 

represent drain placement.  Model cells are 5ft by 5ft. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.37:  Drain array 10 in plan view. Contours represent land surface elevation and red lines 

represent drain placement.  Model cells are 5ft by 5ft. 
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Figure 7.38:  Drain array 11 in plan view. Contours represent land surface elevation and red lines 

represent drain placement.  Model cells are 5ft by 5ft. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.39:  Drain array 12 in plan view. Contours represent land surface elevation and red lines 

represent drain placement.  Model cells are 5ft by 5ft. 
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Figure 7.40:  Drain array 13 in plan view. Contours represent land surface elevation and red lines 

represent drain placement.  Model cells are 5ft by 5ft. 

 

7.5.3.5 Analysis – No Calibration 

A generalized model is constructed with no calibration or verification.  All hydraulic parameters are 

assumed, with no need to adjust hydraulic parameters to match water levels.  This is an appropriate 

approach if no observed water level data are available and allows one to make decisions based on 

relative response to drainage design.  If observed water level exists, however, then calibration methods 

are recommended (see Appendix B for an example).  Results look at the impact of different drain arrays 

on lowering water table elevations for a range of hydraulic parameters.  Reduced water table elevations 

along cross section d-d’ are then used in the geotechnical analysis to evaluate if slope stability 

requirements are met. 

7.5.3.5.1 Steady State 

Steady state conditions are run prior to transient simulations to establish possible thresholds of system 

response based on hydraulic properties given no drains.  Steady-state recharge is assigned a value of 

0.005 ft/d.  Water table profiles are provided in Figure 7.41 given a range of Kx = 0.2 ft/d to 5 ft/d.  Kx = 

0.1 ft/d is not shown, since the slope would be massively flooded.  Kx larger than 5 ft/d produce water 

table elevations similar to Kx = 5 ft/d.  Even under steady-state recharge conditions, the system is 

flooded for Kx < 0. 5 ft/d, with flooding limited to the slope toe region for values of Kx = 0.5 ft/d.  FOS 

values for each scenario are given in Table 7.8 and show that Kx ≥0.5 ft/d are stable under steady-state 

conditions with no drains, but failure may occur for lower Kx. 
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Figure 7.41: Water table profiles for cross section d-d’ given steady state recharge and no drains. (a) Kx = 

0.2 ft/d, (b) = 0.5 ft/d, (c) 1.0 ft/d, (d) 2.0 ft/d and (e) 5 ft/d 

 

Table 7.8 FOS of site D given steady-state conditions with no drains for 

various hydraulic conductivity (Kx) values. 

 

 

 

 

  

Kx(ft/day) FOS

0.1 <1

0.2 <1

0.5 1.31

1 1.50

2 1.71

5 1.80
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7.5.3.5.2 Maximum Water Levels during 100-Year Event 

Maximum water levels occur at different times within the basin as water moves down slope.  To 

simplify, the maximum water level is assumed to occur after maximum recharge intensity.  This occurs 

0.33 days into the 1-day storm event (recharge = 0.70 ft/d).  Water level response to drains is discussed 

in terms of soil type.  

Silt, Sandy Silt, Clayey Sand (Kx = 0.1 ft/d) 

None of the horizontal drain arrays are efficient at reducing water levels below ground surface for soils 

with low hydraulic conductivity (0.1 ft/d).  Soils with isotropic conditions (VKA = 1) and a storage of 1% 

are not drained quickly enough during large precipitation events for any of the drain arrays. Increasing 

drain density, drain length or both cannot lower the water table below ground surface during very large 

storm events.  Horizontal drains placed in silt, sandy silt and clayey sand or till soils with larger storage 

(10%) can lower water levels below land surface for much of the basin but the required number of 

drains is large.  Figure 7.42 shows depth to water level for Sy=10% given all drainage scenarios tested (no 

drains, drain arrays 1-13).  Medium length drains at medium spacing (drain array 6) can effectively lower 

water levels at the slope toe, but water levels remain above ground surface in the upper reaches of the 

slope.  Long drains of medium spacing can reduce water levels in the upper slope but fail to reduce 

water levels in the slope toe (drain array 8).  Drain array 13, which combines medium spaced long and 

short drains, fails to reduce water levels completely below ground surface.  One combining long and 

medium drains can lower water levels completely below ground surface (not shown).  Horizontal drains 

in fine-grained materials, even with relatively large storage, are inefficient at lowering water levels, and 

given the number and length of drains required, may not be economically feasible.  Therefore for soils 

with this range of hydraulic conductivity, horizontal drains would likely need to be used in conjunction 

with other geotechnical techniques to improve slope stability.  Assuming anisotropic conditions reduces 

the ability of horizontal drains to lower the water table. 

Silty Sands and Fine Sands (Kx = 1.0 ft/d) 

Soils with hydraulic conductivity on the order of 1 ft/d experience seepage (water levels above ground 

surface) in the toe region of the slope.  Seepage increases into the upper reaches of the slope if the 

system is anisotropic.  Water table depths below ground surface for isotropic conditions for all drainage 

scenarios tested are provided in Figure 7.43 for Sy = 10% and Figure 7.44 for Sy = 1%.  Silty or fine sand 

soils with specific yield on the order of 10% are successfully drained with minimal drain placement.  

While most drain configurations effectively maintain water levels below ground surface, it is drain array 

1 (short length drains with wide spacing) found the most cost-effective given a total drain length of only 

220 ft.  Model results suggest that drain array 1 is effective to specific yields as low as 5%, below which 

significant flooding at the slope toe can only be mitigated by increasing drain length and density.  For 

soils with very low storage, horizontal drains may not completely drain the basin to maintain water  
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Figure 7.42: Water table depth below ground surface (ft) on day 0.35 (stress period 8) of the 100-year 

24-hour precipitation event given hydraulic parameters Kx = 0.1 ft/d, Sy = 0.1 and VKA = 1, and (a) no 

drains, (b) drain array 1, (c) drain array 2, (d) drain array 3, (e) drain array 4, (f) drain array 5 (g) drain 

array 6, (h) drain array 7, (i) drain array 8, (j) drain array 9, (k) drain array 10, (l) drain array 11, (m) drain 

array 12 and (n) drain array 13. Drains are represented as brown lines and contours are at 1 ft intervals.  

Colored portions indicate water table is below ground surface, while white regions indicate seepage 

caused by the water table rising above ground surface. Water table elevations predicted above ground 

surface indicate groundwater seepage.  Height above ground is correlated to seepage flux. 
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Figure 7.43: Water table depth below ground surface (ft) on day 0.35 (stress period 8) of the 100-

year 24-hour precipitation event given hydraulic parameters Kx = 1 ft/d, Sy = 0.1 and VKA = 1, and (a) 

no drains, (b) drain array 1, (c) drain array 2, (d) drain array 3, (e) drain array 4, (f) drain array 5 (g) 

drain array 6, (h) drain array 7, (i) drain array 8, (j) drain array 9, (k) drain array 10, (l) drain array 11, 

(m) drain array 12 and (n) drain array 13. Drains are represented as brown lines and contours are at 

1 ft intervals.  Colored portions indicate water table is below ground surface, while white regions 

indicate seepage caused by the water table rising above ground surface. Water table elevations 

predicted above ground surface indicate groundwater seepage.  Height above ground is correlated 

to seepage flux.  
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Figure 7.44: Water table depth below ground surface (ft) on day 0.35 (stress period 8) of the 100year 24-

hour precipitation event given hydraulic parameters Kx = 1 ft/d, Sy = 0.01 and VKA = 1, and (a) no drains, 

(b) drain array 1, (c) drain array 2, (d) drain array 3, (e) drain array 4, (f) drain array 5 (g) drain array 6, (h) 

drain array 7, (i) drain array 8, (j) drain array 9, (k) drain array 10, (l) drain array 11, (m) drain array 12 

and (n) drain array 13. Drains are represented as brown lines and contours are at 1 ft intervals.  Colored 

portions indicate water table is below ground surface, while white regions indicate seepage caused by 

the water table rising above ground surface. Water table elevations predicted above ground surface 

indicate groundwater seepage.  Height above ground is correlated to seepage flux. 
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levels below land surface.  However, a combination of medium and short length drains with medium 

spacing (drain array 11) lowers the water table the most of all drain arrays tested. 

Anisotropy (VKA = 10) needs only be considered for soils with Sy < 5%.  For soils with larger storage, 

drainage design remains the same as for isotropic conditions.  As an example, Figure 7.45 shows that 

water levels for Sy = 0.05 can be held below land surface for a mixture of medium and short length 

drains (drain array 11), but will experience appreciable flooding if Sy = 0.01. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.45: Water table depth below ground surface (ft) on day 0.35 (stress period 8) of the 100-

year 24-hour precipitation event given hydraulic parameters Kx = 1 ft/d,VKA = 10 and drain array 11. 

(a) Sy = 0.01 and (b) Sy = 0.05. Contours are 1 ft intervals. Colored portions indicate water table is 

below ground surface, while white regions indicate seepage caused by the water table rising above 

ground surface. Water table elevations predicted above ground surface indicate groundwater 

seepage.  Height above ground is correlated to seepage flux. 
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Well Sorted Sands (Kx = 10 ft/d) 

Soils with hydraulic conductivity on the order of 10 ft/d and 10% specific yield can transmit water 

quickly and mute large recharge events such that water levels do not exceed ground surface.   Therefore 

drains are not needed to lower water table elevations.  With decreased storage, groundwater seepage 

occurs in the  toe region of the slope (Figure 7.46) and all drain arrays successfully maintain water levels 

below ground surface in the region of cross section d-d’.  However, drain array 2 (short length and 

medium spacing) removes all seepage potential for the least linear foot of drain. Drainage design for 

well sorted sands and gravels are not sensitive to anisotropy given VKA≤25 (Figure 7.47).  Water table 

elevations are increased, but drain array 2 is sufficient in lowering water levels below ground surface for 

much of the basin.   For larger VKA it is necessary to increase length and density of drains, with no drain 

array tested able to lower water tables below ground surface given VKA≥50. 

7.5.3.5.3 Slope Stability Analysis 

FOS calculations were conducted using the simplified Janbu method for all model scenarios along cross 

section d-d’ (refer to Figure 7.24).  Water levels predicted above ground surface (i.e. groundwater 

seepage) were assigned water table elevations at ground surface (Figure 7.48).  FOS calculations for all 

modeled scenarios are provided in Table 7.9.  FOS calculations do not explicitly use water levels across 

the entire modeled domain, but consider groundwater levels along a critical 2-dimensional section 

generally taken through the steepest portion of the slope.  This simplification from three dimensions 

used in the groundwater modeling down to 2 dimensions used for the slope stability analyses may not 

capture portions of the slope where groundwater levels remain elevated after drain placement or other 

heterogeneities of the groundwater system.  For this reason, multiple critical sections of varied 

orientations might be warranted for further iterative slope stability analyses and groundwater modeling 

to help ensure stability conditions are met for the entire slope area of interest.   For site D, the slope is 

fairly uniform is modeled as homogeneous, such that hydraulic properties are the same across the basin.  

Therefore, a single cross section along d-d’ is assumed representative of the entire slope area.  FOS 

calculations are most sensitive to elevated water levels in the upper slope and much less sensitive to 

groundwater seepage in the toe of slope. 
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Figure 7.46: Water table depth below ground surface (ft) on day 0.35 (stress period 8) of the 100-

year 24-hour precipitation event given hydraulic parameters Kx = 10 ft/d, Sy = 0.01 and VKA = 1, 

given (a) no drains, (b) drain array 1, (c) drain array 2, (d) drain array 3, (e) drain array 4, (f) drain 

array 5 (g) drain array 6, (h) drain array 7, (i) drain array 8, (j) drain array 9, (k) drain array 10, (l) 

drain array 11, (m) drain array 12 and (n) drain array 13. Drains are represented as brown lines and 

contours are at 1 ft intervals.  Colored portions indicate water table is below ground surface, while 

white regions indicate seepage caused by the water table rising above ground surface. Water table 

elevations predicted above ground surface indicate groundwater seepage.  Height above ground is 

correlated to seepage flux. 
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Figure 7.47: Water table depth below ground surface (ft) on day 0.35 (stress period 8) of the 100-year 

24-hour precipitation event given hydraulic parameters Kx = 10 ft/d, Sy=-.01 and (a) VKA = 1 and drain 

array 2, (b) VKA = 25 and drain array 2, (c) VKA = 50 and drain array 2, and (d) VKA = 50 and drain array 

13. Contours are 1 ft intervals.  Colored portions indicate water table is below ground surface, while 

white regions indicate seepage caused by the water table rising above ground surface. Water table 

elevations predicted above ground surface indicate groundwater seepage.  Height above ground is 

correlated to seepage flux. 

 

Figure 7.48: An example of 

modifying the water table 

surface with drains to be 

used for FOS calculation.  

Water table elevations 

predicted by MODFLOW to 

be above the ground 

surface represent an area 

of seepage at the surface. 
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Table 7.9:  FOS for different hydraulic properties and drain arrays.  FOS pertains to failure along the 

entire surface and does not consider localized instability (i.e. the toe of the slope).  Kx is in units of 

ft/d.  Shaded highlights signify stable slope conditions (FOS≥1.2) for the least linear feet of drains.  

Several soil types fail to achieve stability for all drain arrays tested. 

 

 

Silt, Sandy Silt, Clayey Sand or Till (Kx = 0.1 ft/d) 

For the example Site D having aquifers with very low hydraulic conductivity and low storage, no 

horizontal drain configuration examined is able to increase FOS above 1.2.  In contrast, low Kx soils with 

higher storage capabilities and isotropic conditions can be stabilized with drain arrays 7, 8, 9, 12 and 13 

despite significant ground water seepage in the toe region of the slope. FOS calculations suggest that 

slope stability is achieved with long drains extending to the upper reaches of the slope.  Tighter drain 

spacing for the long drain arrays appears to have little influence on slope stability.  Drain spacing 

becomes more important for anisotropic soils.  For instance, the FOS calculation shows that long drains 

with narrow spacing (drain array 9) is 1.154 and is the highest FOS in the VKA = 10 analysis.  In contrast, 

long drains with narrow spacing (drain array 7) cannot mitigate slope failure (FOS<1) while long drains 

with medium spacing (drain array 8) produce an FOS only slightly above 1.0.    

  

Soil Type

Soil ID 1 7 4 10 2 8 5 11 3 9 6 12

Kx 0.1 0.1 0.1 0.1 1 1 1 1 10 10 10 10

Sy 0.01 0.01 0.1 0.1 0.01 0.01 0.1 0.1 0.01 0.01 0.1 0.1

VKA 1 10 1 10 1 10 1 10 1 10 1 10

no drain <1 <1 <1 <1 1.113 <1 1.426 1.153 1.273 1.268 1.647 1.343

drain 1 <1 <1 <1 <1 1.148 <1 1.462 1.158 1.449 1.366 1.647 1.343

drain 2 <1 <1 <1 <1 1.216 <1 1.462 1.158 1.449 1.366 1.647 1.343

drain 3 <1 <1 <1 <1 1.216 <1 1.462 1.158 1.449 1.336 1.647 1.343

drain 4 <1 <1 <1 <1 1.148 <1 1.462 1.158 1.462 1.336 1.647 1.343

drain 5 <1 <1 <1 <1 1.216 <1 1.462 1.158 1.462 1.166 1.647 1.343

drain 6 <1 <1 <1 <1 1.216 <1 1.462 1.158 1.462 1.166 1.647 1.343

drain 7 <1 <1 1.239 <1 1.124 <1 1.462 1.158 1.449 1.218 1.647 1.343

drain 8 <1 <1 1.239 1.026 1.216 <1 1.462 1.158 1.449 1.366 1.647 1.343

drain 9 <1 <1 1.239 1.154 1.216 <1 1.462 1.158 1.449 1.166 1.647 1.343

drain 10 <1 <1 <1 <1 1.216 <1 1.462 1.158 1.462 1.166 1.647 1.343

drain 11 <1 <1 <1 <1 1.216 <1 1.462 1.158 1.462 1.166 1.647 1.343

drain 12 <1 <1 1.239 <1 1.216 <1 1.462 1.158 1.449 1.384 1.647 1.343

drain 13 <1 <1 1.239 1.026 1.216 <1 1.462 1.158 1.449 1.166 1.647 1.343

Silt, Sandy Silt, Clayey Sand or Till Silty Sands and Fine Sands Well Sorted Sands, Glacial Outwash 
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Silty Sands and Fine Sands (Kx = 1.0 ft/d) 

For the example Site D having aquifers with isotropic conditions and low storage it was necessary to 

have short length drains of medium spacing (drain array 2) to reduce water levels enough such that FOS 

exceeded 1.2.  Drain array 2 still worked for anisotropic soils up to VKA = 2, but failed to increase FOS 

above 1.2 for VKA ≥ 5.  For VKA = 5 increasing drain length and spacing helped prevent water from 

inundating the entire slope.  For VKA = 10, no drain array could reduce water levels sufficiently to 

increase FOS to reasonable levels.  

For sands with large storage, drains were not necessary.  For isotropic conditions, FOS was greater than 

1.2, and for anisotropic conditions (VKA = 10), drain installation did not improve upon FOS = 1.15. 

Well Sorted Sands (Kx = 10 ft/d) 

Well sorted sands and gravels appeared not need any horizontal drains to improve stability.  Short toe 

drains were needed to reduce groundwater seepage potential, but FOS calculations were not sensitive 

to elevated water levels in the toe of slope.  Increased water levels in the upper slopes only occurred 

with very high VKA (e.g. VKA > 25, refer to Figure 7.47) and for these situations, drains should extend to 

the upper reaches of the slope. For VKA ≥ 50, no drain array sufficed in promoting slope stability. 

7.5.3.5.4 Sensitivity Analysis 

Drain design sensitivity to recharge parameters and drain conductance are investigated given the level 

of uncertainty in these parameter groups.  

Recharge 

Calculation of recharge is dictated by three parameters.  These include the curve number (CN), the total 

precipitation in a 24-hour period, and the shape of the SCS rainfall distribution curve.  Sensitivity to each 

of these parameters is tested on isotropic well sorted sands and gravels (Kx = 10 ft/d) as well as silty or 

fine sands (Kx = 1 ft/d).  The primary question posed; will drain design need to change if recharge 

characteristics are changed? 

Decreasing the CN from 80 to 70 will increase total recharge by 50% and water table elevations will rise 

significantly in silty or fine sands given low storage (Figure 7.49) and to a lesser degree for higher storage 

(Figure 7.50).  Groundwater seepage moves up slope and lowers slope stability. Drain length and density 

must be increased for lower storage situations, while drain array 1 (short drains of wide spacing) are all 

are required for conditions of higher storage.  In contrast, water table elevations are not sensitive to 

recharge parameters in well sorted sands and gravels and change to drainage design is expected (Figure 

7.51 and 7.52). 
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Figure 7.49: Sensitivity of water table elevations to recharge parameters for cross section d-d’ given 

isotropic silty or fine sands of low storage. PPT = total precipitation (inches) during 24-hour event. 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.50: Sensitivity of water table elevations to recharge parameters for cross section d-d’ given 

isotropic silty or fine sands of higher storage. PPT = total precipitation (inches) during 24-hour event. 
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Figure 7.51: Sensitivity of water table elevations to recharge parameters for cross section d-d’ given 

isotropic well sorted sands or gravels of low storage. PPT = total precipitation (inches) during 24-

hour event. 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.52: Sensitivity of water table elevations to recharge parameters for cross section d-d’ given 

isotropic well sorted sands or gravels of higher storage. PPT = total precipitation (inches) during 24-

hour event.  
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Maintaining a CN of 80, but increasing the precipitation for a 24-hour event from 9 inches to 14 inches 

(maximum tabulated 24-hour event total in the USA) will increase the amount of recharge to the site, 

but decreases the estimated percentage of precipitation that becomes recharge from 21% to 15% 

(greater percentage of precipitation becomes runoff).  In addition, the maximum recharge rate for the 

storm decreases slightly.  No change in drain design is needed for soils with storage on the order of 10%.  

A decrease in storage to 1%, however, will require some change in drain design in finer grained soils. For 

less conductive fine sands, drain array 11 will effectively reduce groundwater seepage (short and 

medium length drains of medium spacing). 

Changing the SCS rainfall distribution curve from type IA to type II effectively increases the maximum 

recharge rate during a 24-hour storm event from 0.69 ft/d to 3.31 ft/d, while maintaining the same 

depth of recharge for the entire storm at 1.93 ft, given a CN = 80 and total precipitation of 9 inches in 

24-hours.  No change in drain design is anticipated in well sorted sands and gravels. For finer sands with 

a storage of 10%, medium length drains are required to remove groundwater seepage, while for lower 

storage, no drain array tested can completely remove seepage in the toe of slope. 

Drain Efficiency 

Drain efficiency is described by the drain conductance (Cd) and is described in section 4.2.7 on Horizontal 

Drain Flow Characteristics and Drain Flow.  The coefficient Cd is a lumped conductance term describing 

all the head loss between the drain and the region of the cell in which it resides.   It is a function of the 

convergent flow toward the drain, as well as the physical characteristics of the drain itself. 

The impact of Cd on drain flow is often characterized with a threshold response.  For relatively small 

values of Cd, a slight change in Cd will have significant changes on drain flow.  In contrast, when Cd is 

raised above some threshold value, any further increase in drain conductance will not contribute to 

significant increases in drain flow.  This threshold will occur when Cd equals or is greater to Kx.  

To test drain efficiency, Figure 7.53 shows an example of Kx = 1 (silty or fine sands) with a Sy = 0.01 with 

drain array 11 installed. Results show that Kd = 5 ft/d reduces water levels below land surface, while Kd = 

0.1 ft/d maintains significant flooding in the toe region of the slope.  Figure 7.54 shows that the rate of 

increased drain flow decreases with increased Kd, such that drain flow no longer increases for Kd values 

greater than 10 ft/d, or a conductance of 10 times the geologic material.    

The question of drain design sensitivity to drain efficiency is an important question. If drains have a 

conductance 10 times lower than the geologic material of fine sands, then drains may not reduce water 

levels below the critical water level needed for slope stability.  On the other hand, if Kd is 10 times Kx, 

then the number of drains can be halved (i.e. drain spacing doubled) and still maintain slope stability. 
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Figure 7.53: Colored regions 

represent depth of water 

above land surface as a 

function of drain hydraulic 

conductivity.  The example 

uses soil type 2 (Kx = 1 ft/d, Sy = 

0.01 and VKA = 1).  Drain array 

11 has Kd equal to (a) 0.1 ft/d, 

(b) 1 ft/d, (c) 5 ft/d and (d) 10 

ft/d.  
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Figure 7.54: Maximum drain flow for different drain hydraulic conductivities (Kd) installed in silty or 

fine sands with a storage of 10% and drain array 11.   

 

7.5.3.6 Analysis - Observed Data Available (Isotropic Conditions Assumed) 

Data allows one to calibrate the numerical model.  Typical calibration strategies are shown.  Data for site 

D include: 

• Precipitation data collected at the site. 

• Annual average precipitation 

• 24-hour total precipitation for a 100-year precipitation event. 

• An estimate of CN 

• Groundwater levels collected at the end of the dry period. This data serves to calibrate a steady 

state version of the model. 

• Groundwater levels and precipitation data collected concurrently. 

All data is collected prior to drain installment. Figure 7.55 Indicates observation well locations for site D. 

The CN is estimated to equal 80 and annual average precipitation is 35 inches, while the 100-year event 

produces a total of 11 inches in a 24-hour period.  Calibration is done by adjusting hydraulic conductivity 

(Kx) and specific yield (Sy) to best match observed water levels.   

7.5.3.6.1 Steady State Conditions 

Steady state is modeled to establish a first estimate of hydraulic conductivity and to ensure that water 

levels for recharge estimate are reasonable.  Two methods are presented in section 5.5 to estimate 

steady state recharge.  Assuming limited precipitation data collected as the site, the first method in 

section 5.5 is used.  Given a CN = 80 and 11 inches of rain in a 24-hour period will produce18% recharge  
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Figure 7.55: Site D (a) cross section and modeled steady state water levels for cross section d-d’, (b) plan 

view with steady state water levels contoured at 5 ft intervals. Observation well locations shown. 

 

(refer to Table 5.5).  Given an average annual precipitation total of 35 inches, then 18% is assumed to 

become groundwater recharge, or 6.3 inches/yr.  This equals 0.0014 ft/d and is the assumed steady 

state recharge. 

The soil is identified as a silty sand, but no analysis has been done to refine the value of hydraulic 

conductivity.  An initial guess of 1 ft/d replicates water levels at observation wells 1 and 2, but under 

predicts the dry-season water level at well 3 (Figure 7.56).  A sensitivity analysis (Figure 7.57) shows that 

the root-mean-square error (rmse) is significantly reduced if Kx = 0.2 ft/d.  While this may appear low for 

a silty sand, heterogeneity and anisotropy effectively lower hydraulic conductivity through averaging 

procedures discussed in section 3.36. Decreasing Kx from 1 ft/d to 0.2 ft/d more accurately replicates 

well 3 while not forcing an over prediction in water levels at wells 1 and 2. 
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Figure 7.56: A one-to-one plot showing observed and predicted water levels under steady state 

recharge conditions. 

 

 

 

 

 

 

Figure 7.57: Sensitivity analysis of 

steady state conditions using rmse 

as the objective function. 
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7.5.3.6.2 Transient Conditions (pre-drain) 

Observed transient water levels allow one to fine-tune the initial steady state estimate of Kx and 

determine an effective value of specific yield.  Observed two-hour precipitation and calculated recharge 

are provided in Figure 7.58, with the modeled transient period specified. 

 

 

 

 

Figure 7.58: Two-

hour precipitation 

data collected on 

site, and calculated 

recharge assuming 

CN = 80.  Transient 

modeling period is 

marked. 

 

 

The simulation assumes steady-state conditions prior to initiating the transient scenario.  This removes 

the need to explicitly characterize initial heads.  Steady-state recharge is assumed 0.0014 ft/d as 

determined in the steady-state modeling scenario.  Three model simulations are provided to highlight 

calibration strategies.  First, steady-state value of Kx = 0.2 ft/d is used, while Sy = 0.1 is assumed.  Second, 

a sensitivity analysis is done in which Kx and Sy are adjusted independently over a range of specified 

values.  This analysis shows that Kx = 0.2 and Sy = 0.02 produce the lowest rmse (Figure 7.59).  Finally, 

auto-calibration of Kx and Sy are done simultaneously (program used Parameter Estimation, PEST, 

(Doherty, 2005)).  Results from the sensitivity analysis are used as initial guesses to encourage a rapid 

convergence on a solution.  Calibrated values are 0.2475 ft/d and 0.01957 for Kx and Sy, respectively.  

Simulated water levels for each observation well are compared to observed data in Figure 7.60.  Using 

the steady-state calibrated Kx = 0.2 ft/d, and assuming an Sy = 0.1 (SS), produces water levels with a 

muted response to recharge and water levels in the middle portion of the slope and the lower portion of 

the slope are predicted too low, despite using a Kx nearly equal to the calibrated value.  Reducing Sy to 

0.02 from the transient sensitivity analysis improves predicted results appreciably, but water levels are 

over predicted at all observation locations.  Auto-calibration shows that small changes in Kx and Sy can 

dramatically improve prediction. 
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Figure 7.59: Sensitivity analysis results for Kx and 

Sy using rmse as the objective function. 

 

 

7.5.3.6.3 Transient Conditions (Design Storm) 

With a calibrated model, the design storm is applied to the model using a CN = 80 and a total of 11 

inches of rain in a 24-hour period and assuming a type IA storm distribution.  The model is run with no 

drains as well as drain array 1 through 5.  Plan view results for depth of water table below ground 

surface are given for each scenario in Figure 7.61.  Cross sectional profiles of the water table for d-d’ are 

provided in Figure 7.62 

Table 7.10 Provides FOS values for the cross section d-d’ indicate that short drains with wide spacing 

(drain array 1) can lower water table elevations appreciably to promote slope stability (FOS = 1.21), 

while slightly longer drains (drain array 4) can ensure no translational failure (FOS 1.34).  Drain spacing 

must be decreased (drain array 5), however, to remove any potential for groundwater seepage in the 

toe region (refer to Figure 7.61) 
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Figure 7.60: Observed and predicted water levels for (a) Well 1, (b) Well 2 and (c) Well 3. Locations 

identified in Figure 7.2.  SS indicates steady state Kx = 0.2 and assumed Sy = 0.1. SENS indicates Kx = 

0.2 and Sy = 0.02 as obtained from transient sensitivity analysis. CALIB = results from auto-calibration 

using PEST with a resulting Kx = are 0.2475 ft/d and Sy =0.01957.  
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Figure 7.61: Water table depth below ground surface (ft) on day 0.35 (stress period 8) of the 100-

year 24-hour precipitation event given hydraulic parameters Kx = are 0.2475 ft/d, Sy =0.01957and 

VKA = 1, given (a) no drains, (b) drain array 1, (c) drain array 2, (d) drain array 3, (e) drain array 4, (f) 

drain array 5. Contour interval is 1 ft. Colored portions indicate water table is below ground surface, 

while white regions indicate seepage caused by the water table rising above ground surface.  Height 

above ground is correlated to seepage flux. 
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Drain FOS

nodrain 1.195

1 1.21

2 1.21

3 1.21

4 1.338

5 1.338

 

 

 

 

 

 

 

 

 

 

 

Figure 7.62: Water table profiles for cross section d-d’ for different drain arrays.  Water table 

elevations predicted above ground surface indicate groundwater seepage.  Height above ground is 

correlated to seepage flux. 

 

Table 7.10:  FOS values for site D given Kx = are 0.2475 ft/d, Sy =0.01957and VKA = 1 and different 

drain arrays. 
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7.5.4 Rotational Failure (Site B) 

7.5.4.1 Site Description 

Rotational failure is modeled using the topography shown in Figure 7.63   The slope is relatively uniform 

from the slope crest to the base of the slope at approximately 40% (23°).  The subsurface conditions are 

assumed to consist of a single geologic layer reaching up to 300 feet in thickness. 

 

 

 

 

 

 

 

 

Figure 7.63 Site B topography 

for rotational failure (a) hill 

shade, (b) slope profile of 

ground surface from B-B’. 

 

 

7.5.4.2 Model Domain and Conceptual Model 

The model domain is defined in Figure 7.64 with MODFLOW cells 5 ft by 5 ft in the x-y direction, which is 

rotated 2 degrees so that the grid is parallel to the slope.  Maximum thickness is 300 ft at location B and 

minimum thickness is 20 ft at location B’. The bottom of the modeled layer is at zero ft elevation.  

Specified head boundary conditions are assigned at the slope toe (16.9 ft) and the upslope divide (195 

ft).  The upslope boundary is far from the slope toe and assigned a value below the critical surface as 

determined by slope stability analysis, and numerical modeling found drain design not sensitive to this 

boundary condition.  For isotropic conditions, a single layer is modeled, and for anisotropic conditions, a 

two layer model is used with similar thickness of layers. 
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Figure 7.64: Model grid for rotational failure site. (a) Plan view showing modeled grid (purple box),  

active cells in color scale of assigned land surface elevations, rotated x-y axis and cross section B-B’.  Cell 

dimension is 5 ft by 5 ft. (b) Cross section B-B’ depicting single layer model (maximum thickness is 300 ft 

and minimum thickness is 20 ft), as well as specified head boundary conditions and recharge, are 

applied uniformly across the domain.  Water levels are steady state for Kx = 1 ft/d and Sy = 0.01 and 

recharge = 0.005 ft/d. 

 

7.5.4.3 Drain Configurations 

Two drain arrays are tested for rotational failure. These are shown in Figure 7.65 and 7.66, respectively. 

Each horizontal drain is approximately 150 ft in length with a 5° angle from the horizontal (tip elevation 

at 15 ft and drain end at 30 ft).  The drains are drilled at approximately 6° angles from each other.  Drain 
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array 1 is a total of 1350 linear feet, while array 2 is approximately 2250 linear feet. Drain hydraulic 

conductivity is assumed equal to the hydraulic conductivity of the geologic material it is placed in. 

 

 

 

 

 

 

 

 

 

 

Figure 7.65:  Site B drain array 1 in plan view. Contours represent ground surface elevation and red 

lines represent drain placement.  Model cells are 5ft by 5ft.  

 

 

 

 

 

 

 

 

 

 

Figure 7.66:  Site B drain array 2 in plan view. Contours represent ground surface elevation and red 

lines represent drain placement.  Model cells are 5ft by 5ft.  
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7.5.4.4 Geotechnical Parameters and Initial Slope Stability Analysis 

Soil type in site B is assumed as silty sand /gravel with high friction angle and low cohesion values.  It is 

assumed that the friction angle is 40° and cohesion is 10 psf. Furthermore, soil density is assumed to be 

medium dense to dense with a unit weight of 125 pcf. 

Slope stability analysis was carried out by using the SLOPE/W slope stability analysis software from 

GEOSTUDIO.  In order to accommodate the rotational failure mode, Morgenstern-Price method was 

used in analyses. The results of the FOS calculations were confirmed with the simplified Janbu method 

for a few cases.  Both methods provided near identical results.  The first analysis was carried out to find 

the critical water surface level when FOS = 1. Figure 7.67 indicates the critical rotational failure surface 

and water surface level for this condition.  

 

 

Figure 7.67: Critical water surface and critical rotational failure surface for site B 

 

7.5.4.5 Analysis – No Observed Data 

Hydraulic soil properties are provided in Table7.5, and the design storm defined in section 7.5.2 is used. 

7.5.4.5.1 Steady State  

Steady-state conditions are run prior to any transient simulation.  This allows the user to forego prior 

knowledge of the initial starting heads.  Steady-state conditions are meant to mimic the “dry” season in 

the system, which is assumed to last long enough for steady-state conditions to occur.  Steady-state 

recharge is assumed to be the long term average, with water levels stabilized prior to the design storm.  

Much of the water level lowering of site B is the result of allowing the overall water table to drain prior 
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to the 100-year storm event.  For example, steady-state water levels are shown in Figure 7.68 for Kx=0.1 

ft/d, Sy=0.01, VKA=1 and R=0.005 ft/d, given no drains and drain array 1. Without drains, the toe of slope 

floods , but with drains added, flooding in the toe region is significantly reduced. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.68: Site B steady state water levels for Kx=0.1 ft/d, Sy=0.01, VKA=1 and R=0.005 ft/d, given 

(a) cross section B-B’ and no drains, (b) cross section B-B’ and drain array 1, (c) plan view with no 

drains, and (d) plan view with drain array1.  Contour intervals are 2 ft. Pink overlay in plain view 

represents regions where the water table is above ground surface (i.e. groundwater seepage). 

 

7.5.4.5.2 Maximum Water Levels during 100-Year Event 

Maximum water levels occur at different times as water moves down slope.  To simplify, the maximum 

water level is assumed to occur after maximum recharge intensity.  This occurs 0.33 days into the 1-day 

storm event (recharge = 0.70 ft/d).  Water level response to drains is discussed in terms of soil type.  

Silt, Sandy Silt, Clayey Sand or Till (Kx = 0.1 ft/d) 

Water table elevations are provided in Figure 7.69.  White regions in each diagram represent regions in  
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Figure 7.69: Water levels on day 0.35 (stress period 8) and isotropic, silt, sandy silt, and clayey sand 

(hydraulic parameters Kx = 0.1 ft/d, and VKA = 1), given (a) Sy = 0.01 and no drains, (b) Sy = 0.1 and no 

drains, (c) Sy = 0.01 and drain array 1, (d) Sy = 0.1 and drain array 1, (e) Sy = 0.01 and drain array 2, (f) 

Sy = 0.1 and drain array 2.  Drains are represented as brown lines and contours are at 2 ft intervals.  

Colored portions are scaled by water level depth below the critical water surface (scale 0-72 ft), 

while white areas indicate water levels above the failure surface.  Pink overlay indicates water level 

is above ground surface. 
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site B that have water levels above the critical water surface (where slope instability occurs) shown in 

Figure 7.67. The pink overlay shows regions where the water table is predicted above ground surface.  

With no drains, water levels surpass the critical water level for much of the slope, and groundwater 

seepage occurs along the toe of the slope.  Greater seepage occurs in the corner regions of the toe as a 

result of slightly convex topography.  Water levels are greatly lowered with the addition of drain array 1 

for low and high storage scenarios, though water levels in the toe region of the slope still rise above the 

critical water level and seepage does occur for Sy = 0.01.  For low storage, drain array 2 reduces all 

groundwater seepage. 

For anisotropic soils, water table elevations increase above the critical water level for much of the slope.  

This was true for low anisotropy (VKA = 2) and higher anisotropy (VKA = 10).  However, drain array 1 

successfully lowers water levels below the critical water level for much of the slope up to VKA = 5 and is 

the same for all isotropic soils.  For VKA = 10 (Figure 7.70) and Sy = 10%, the number of drains must 

increase in order to lower water levels below the critical water surface.  For Sy = 0.01 and VKA = 10, 

drain array 2 is unable to lower water levels below the critical water surface for the entire toe region of 

the slope.  

Silty Sands and Fine Sands (Kx = 1.0 ft/d) 

With increased hydraulic conductivity, water table elevations still rise above the critical water level 

surface in the toe region if no horizontal drains are used (Figure 7.71). Groundwater seepage will occur 

for low and high storage, with seepage greatest at the edges of the slope toe due to convex topography.  

Drain array 1 sufficiently lowers water level elevations for isotropic conditions. Drain array 1 sufficiently 

lowers water levels for anisotropic systems up to approximately VKA = 30, above which additional drains 

may be required. 

Well Sorted Sands (Kx = 10 ft/d) 

Figure 7.72 shows that with no drains, highly conductive soils may produce water table elevations above 

the critical water surface in the toe region of the slope, with groundwater seepage expected for low 

storage systems.  Drain array 1 is sufficient in lowering water levels below the critical water surface and 

anisotropy does not impact drainage design. 

 

7.5.4.5.3 Slope Stability Analysis 

Maximum water table elevations along the cross section B-B’ for isotropic conditions are provided in 

Figure 7.73, and for anisotropic conditions for silt, sandy silt, and clayey sand given in Figure 7.74.  As 

with the translational failure, the slope stability analyses may not capture portions of the slope where 

groundwater levels remain elevated after drain placement or other heterogeneities of the groundwater 

system.  For this reason, multiple critical sections of varied orientations might be warranted for further  
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Figure 7.70: Water levels on day 0.35 (stress period 8) and anisotropic silt, sandy silt, or clayey sand 

(hydraulic parameters Kx = 0.1 ft/d, and VKA = 10), given (a) Sy = 0.01 and no drains, (b) Sy = 0.1 and 

no drains, (c) Sy = 0.01 and drain array 1, (d) Sy = 0.1 and drain array 1, (e) Sy = 0.01 and drain array 2, 

(f) Sy = 0.1 and drain array 2.  Drains are represented as brown lines and contours are at 2 ft 

intervals.  Colored portions are scaled by water level depth below the critical water surface (scale 0-

72 ft), while white areas indicate water levels above the failure surface.  Pink overlay indicates water 

level is above ground surface. 
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Figure 7.71: Water levels on day 0.35 (stress period 8) and isotropic silty to fine grained sands 

(hydraulic parameters Kx = 1 ft/d, and VKA = 1), given (a) Sy = 0.01 and no drains, (b) Sy = 0.1 and no 

drains, (c) Sy = 0.01 and drain array 1, (d) Sy = 0.1 and drain array 1, (e) Sy = 0.01 and drain array 2, (f) 

Sy = 0.1 and drain array 2.  Drains are represented as brown lines and contours are at 2 ft intervals.  

Colored portions are scaled by water level depth below the failure surface (scale 0-60 ft), while 

white areas indicate water levels above the failure surface.  Pink overlay indicates water level is 

above ground surface. 

 



 
211 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.72: Water levels on day 0.35 (stress period 8) and isotropic well sorted sands and gravels 

(hydraulic parameters Kx = 10 ft/d, and VKA = 1), given (a) Sy = 0.01 and no drains, (b) Sy = 0.1 and no 

drains, (c) Sy = 0.01 and drain array 1, (d) Sy = 0.1 and drain array 1, (e) Sy = 0.01 and drain array 2, (f) 

Sy = 0.1 and drain array 2.  Drains are represented as brown lines and contours are at 2 ft intervals.  

Colored portions are scaled by water level depth below the failure surface (scale 0-60 ft), while 

white areas indicate water levels above the failure surface.  Pink overlay indicates water level is 

above ground surface. 
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Figure 7.73: Water table elevations for site B along cross section B-B’ for isotropic conditions, VKA = 

1 (a) Kx = 0.1 ft/d, (b) Kx = 1 ft/d and (c) Kx = 10 ft/d.  The red dashed line is the critical water surface 

for which FOS = 1.0. The black line is ground surface. 
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Figure 7.74: Water table elevations for site B along cross section B-B’ for Kx=0.1 ft/d given 

anisotropic conditions, (a) VKA = 2 (b) VKA = 5 and (c) VKA=10.  The red dashed line is the critical 

water surface for which FOS = 1.0. The black line is ground surface. 
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iterative slope stability analyses and groundwater modeling to help ensure stability conditions are met 

for the entire slope area of interest. However, the slope of site B is fairly uniform and is homogeneous. 

Therefore, the single cross section along B-B’ is assumed representative.  In addition, failure potential 

along the model domain margins is assumed much lower than at the apex of the slope. 

Two scenarios of slope failure are modeled using typical water table elevations predicted by MODFLOW.  

First, the FOS for a no drain scenario given Kx = 0.1 ft/d, Sy = 0.01 and VKA≤10 is determined.  Water 

table elevations predicted above ground surface are adjusted to be coincident with (Figure 7.75). It is 

also assumed that the potential for small rotation failure in the toe area is negligible.  FOS is estimated 

using Morgenstern-Price method with Figure 7.76, indicating the critical rotational failure surface for the 

whole slope given no drains. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.75: An example of how MODFLOW water table surface is adjusted for slope stability 

analysis. MODFLOW water table surface is typical of Kx = 0.1 ft/d, Sy = 0.01 and all VKA values given 

with no horizontal drains. 
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Figure 7.76: Critical rotational failure surface for site B without drains (Kx = 0.1 ft/d, Sy=0.01 and 

VKA≤10) 

 

For isotropic conditions, drain array 1 lowers water table elevations (refer to Figure 7.73a), and the 

critical rotational failure surface is given in Figure 7.77. 

 

 

 

 

 

 

 

 

 

 

Figure 7.77: Critical rotational failure surface for site B with drain array 1 (Kx = 0.1 ft/d, Sy=0.01 and 

VKA=1) 
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K x 0.1 0.1 1 1 10 10

VKA S Y 0.01 0.1 0.01 0.1 0.01 0.1

1 No Drain 0.375 0.379 0.428 0.998 0.65 0.998

1 drain 1 1.057 1.211 1.211 1.211 1.211 1.211

1 drain 2 1.163 1.211 1.211 1.211 1.211 1.211

2 No Drain 0.373 0.384

2 drain 1 1.106 1.141

2 drain 2 1.169 1.211

5 No Drain 0.373 0.384

5 drain 1 0.687 1.086

5 drain 2 1.169 1.211

10 No Drain 0.373 0.384

10 drain 1 0.687 1.086

10 drain 2 0.529 1.211

FOS not calculated

FOS not calculatedFOS not calculated

FOS not calculatedFOS not calculated

FOS not calculated

Secondly, slope stability analysis was done for different soil types and drain configurations but assuming 

that the potential for small rotation failure in the toe area is possible. FOS results are provided in Table 

7.11.  If small rotational failure in the toe region is considered in the FOS calculation, then stabilization 

of soils comprised of silt, sandy silt, or clayey sand (Kx = 0.1 ft/d) and low storage (Sy = 1%), may not be 

possible given the drain arrays considered.  This is true even for isotropic conditions (drain array 2, VKA 

= 1.16).  For anisotropic conditions, FOS values do not deviate much for VKA≤5, but decrease 

substantially for VKA = 10, such that FOS < 1.0 and failure is eminent given any of the drain arrays 

tested.   For larger storage, drain array 1 adequately increases FOS, and reduces the potential for slope 

failure in the toe region given isotropic conditions. Drain array 2 may be needed for anisotropic 

conditions up to VKA = 10.   

Rotational failure in the toe region of more permeable sediments (Kx≥1 ft/d) is highly likely given no 

drains are installed.  This holds for both low and high storage scenarios.  However, drain array 1 is 

sufficient in reducing the likelihood of failure (FOS = 1.21) for all storage values as well as for isotropic 

and anisotropic conditions.   

 

Table 7.11: FOS values related to small rotational failure in the  toe region (site B) for different 

hydraulic properties and drain scenarios.  Kx is in units of ft/d. VKA = Kx/Kz  Shaded boxes indicated 

drain array (with least linear feet) that raises FOS ≥1.2. For more conductive materials (Kx≥1 ft/d), 

anisotropy does not significantly impact water levels for VKA≤10, and so FOS was not calculated for 

these scenarios (refer to section 7.4.4.5.2).   
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Chapter	8	

Network-Scale	Flow	and	Drainage	

Network	Design	in	Fractured	Rock	

8.1 Introduction 

The preceding chapters describe in detail how the hydrology of watersheds influence drainage network 

design, and how a hydrological modeling framework can be utilized to evaluate the potential 

performance of drainage networks in lowering pore pressures to improve slope stability.  These 

discussions have focused on soil and unconsolidated sediment where flow occurs through the 

interconnected pore space of the medium.  Many watersheds are underlain by fractured rock of 

igneous, metamorphic and sedimentary origin, that are either directly involved in slope instability or 

host aquifers that can adversely influence the stability of overlying soils.  In these cases, drainage 

networks installed within the overlying soil are likely not to be effective to sufficiently lower pore 

pressures in or reduce recharge from the underlying fractured rock mass.  The installation of a drainage 

network within the fractured bedrock must then be considered. 

Fractured rock presents a very specific challenge to the design of hillslope drainage networks.  This is 

because fractured rock typically has little or negligible porosity and permeability in the rock matrix itself, 

and connected networks of discontinuous fractures impart secondary porosity and permeability that 

dominate through-flow of groundwater.  Unlike porous media where flow occurs at the pore-scale, flow 

in fractured rock systems occurs through complex patterns of interconnected, conductive fractures 

(Long et al., 1982; Smith and Schwartz, 1984; Renshaw, 1999; de Dreuzy et al., 2001; Berkowitz, 2002; 

Neuman, 2005; Reeves et al., 2008a,b; Klimczak et al., 2010; Reeves et al., 2010).  Hence, the design of 

horizontal hillslope drainage networks must take into account the characteristics of the fracture 

networks to maximize the probability for drains to intersect flowing fractures that, in turn, will 

sufficiently reduce pore pressures. 

This chapter exclusively focuses on flow through fractured rock in the context of hillslope drainage 

network design, and is divided into two major parts: network structure and flow, and hillslope network 

design considerations for fractured rock.  The first part emphasizes flow properties of discontinuous 

fracture networks, and presents methods to determine the equivalent hydraulic conductivity of 

fractured rock.  These equivalent hydraulic conductivity values for fractured rock can be directly input 

into the hydrologic modeling framework presented in this manual. The second part is dedicated to 

providing design guidance for the installation of drainage networks in fractured rock, using specific 

fracture network concepts to enhance the probability of success for achieving hillslope drainage and 

stability. Multiple illustrations and a case study are presented to reinforce the material presented. 
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8.2 Network Structure and Flow 

A central theme of this Chapter is to impart an understanding of how flow through fractured rock is 

controlled by fracture attributes. The Fractured Rock Characterization in Chapter 4 (section 4.5) 

discussed in detail how fractured rock masses can be analyzed according to statistics of fracture 

orientation, spacing, length, transmissivity and values of fracture density. This section contains detailed 

explanations on how these attributes are related to flow through a fractured rock mass. We begin by 

defining network structure, and then discuss how this structure can be used to compute network-scale 

flow and equivalent hydraulic conductivity tensors. Simulations of flow in two-dimensional discrete 

fracture networks (DFN) with physically realistic parameters are used to illustrate specific concepts. 

8.2.1 Network Structure 

The structure of natural fracture networks is the end result of the complex interplay between stress 

fields and their anisotropy, mechanical properties of the rock, mechanical fracture interaction and 

distribution of initial flows in a rock mass.  The necessary reliance on probabilistic descriptions of 

fracture attributes reflects our inability to accurately construct fracture networks from mapping or 

subsurface studies alone.  The limited accessibility to the network leaves an incomplete understanding 

of the patterns of fracturing within a rock mass that can often be improved through visual inspection of 

representative networks generated according to site-specific statistics (Reeves et al., 2012). 

A total of three different network types are generated from two fracture sets with power law 

distribution of lengths with exponent values in the range 1 3a≤ ≤ , moderate fracture density,  

orientations of ±45° with variability described by a Fisher distribution with κ = 20 and a log-normal 

transmissivity distribution with log(σT) = 1 (Figures 8.1—8.3).  Once a network is generated, the 

hydraulic backbone is identified by eliminating dead-end segments and isolated clusters.  This is 

accomplished in our model using both geometric and flow techniques.  The hydraulic backbone 

represents the interconnected subset of a fracture network that is responsible for conducting all flow 

and transport across a domain.  Hence, analysis of backbone characteristics can provide insight into 

these processes. 

The generated networks in this study do not explore the full parameter space for fractured media.  

However, the wide range of fracture length exponents provide sufficient variability and produce three 

distinct types of hydraulic backbones.  Networks generated with a = 1 produce backbone structures 

dominated by long fractures (Figure 8.1), and networks with a = 3 produce backbone structures 

dominated by short fractures (Figure 8.2).  Backbones with a mixture of short and long fractures are 

produced for networks generated with a = 2 (Figure 8.3).  Another feature of these networks is that 

density of the network increases from ρ2D = 1.0 m/m
2
 to ρ2D = 2.0 m/m

2
 as the value of a increases from 

1 to 3.  This increase in density is necessary to maintain a percolating backbone that promotes fluid flow 

from one side of the domain to the other.  For example, the density values assigned to a = 1 and a = 2 

(ρ2D = 1.0 m/m
2
 and ρ2D = 1.5 m/m

2
, respectively) result in a non-percolating networks if used with a = 3. 

Conversely, networks generated with a = 1 and ρ2D = 2.0 m/m
2
 (assigned to a = 3) produce unrealistically 

dense networks. The relationship between network density, power-law exponent and backbone 

percolation will be further discussed shortly. 
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Figure 8.1: Discrete fracture network realization (left) and hydraulic backbone (right) generated 

from two fracture sets with power distribution of lengths with exponent a=1, ρ2D=1.0 m/m
2
, lmin=2.0 

m and orientations at ±45°, with variability described by κ=20.  Note that the hydraulic backbone is 

dominated by long fractures. (Reprinted with permission from Reeves, D.M. et al., Radioactive Waste, 2012, InTech Publishing.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 8.2: Discrete fracture network realization (left) and hydraulic backbone (right) generated 

from two fracture sets with power distribution of lengths with exponent a=3, ρ2D=2.0 m/m
2
, lmin=2.0 

m and orientations at ±45°, with variability described by κ=20.  Note that the hydraulic backbone is 

dominated by short fractures. (Reprinted with permission from Reeves, D.M. et al., Radioactive Waste, 2012, InTech 

Publishing.) 
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Figure 8.3: Discrete fracture network realization (left) and hydraulic backbone (right) generated 

from two fracture sets with power distribution of lengths with exponent a=2, ρ2D=1.5 m/m
2
, lmin=2.0 

m and orientations at ±45°, with variability described by κ=20.  Note that the hydraulic backbone is 

a mix of short and long fractures. (Reprinted with permission from Reeves, D.M. et al., Radioactive Waste, 2012, InTech 

Publishing.) 
 

To our knowledge, trends between fracture length, density and the total amount of fluid flow a network 

conducts have not been studied.  There has been some work, however, that relates these same fracture 

parameters to contaminant transport behavior (Reeves et al., 2008a,b,c; Zhang et al., 2010).  This lack of 

knowledge on fluid flow can, in part, be explained by the fact that each natural fracture network exhibits 

unique combinations of fracture attributes, making it difficult to compare total flow through networks 

with differing values of mean transmissivity and density.  Nonetheless, understanding how these 

properties influence overall network scale flow is helpful in indentifying network types that may or may 

not be suitable for installation of drainage networks. 

We conducted a numerical investigation to understand how total network flow may be related to 

backbone structure, i.e., primarily fracture trace length and density.  A total of 50 network realizations 

were generated and solved for flow for each of the network types shown in Figures 8.1—8.3 (Table 8.1).  

Computation of flow in two-dimensional discrete fracture networks involves solving for hydraulic head 

at all internal nodes (intersection point of two or more fractures) inside the domain according to Darcy's 

law (Priest, 1993, de Dreuzy and Ehrel, 2003; Klimczak et al., 2010; Parashar and Reeves, 2012).  Linear 

boundary conditions are applied to the networks to induce flow from top to bottom, and fluid flow 

through the backbone is solved iteratively at each node via a biconjugate gradient method.  This process 

is repeated for each statistically equivalent realization of a given network type. 
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Table 8.1. Discrete fracture network parameters and results for 50 realizations. 

 

a ρρρρ2D 

[m/m
2
] 

Total 

Fractures 

Backbone 

ρρρρ2D [m/m
2
] 

Qσσσσ = 0 

[m
3
/s] 

Qσσσσ = 1 

[m
3
/s] 

1 1.0 1116 0.72 2.86×10
-3 

2.21×10
-2

 

2 1.5 3898 0.70 1.74×10
-3

 4.60×10
-3

 

3 2.0 6757 0.83 1.38×10
-3

 4.22×10
-3

 

 

Each network type was solved for flow with two different distributions of transmissivity.  The first 

distribution of transmissivity assigns all fractures the same value of T to facilitate direct comparisons on 

the influence of fracture trace length on overall network flow, Q [m
3
/s].  The second distribution of 

transmissivity assigns a log-normal distribution with log(σK) = 1 to individual fractures, which provides a 

good representation of variability found in natural fracture networks.  Flow through these networks is 

denoted by Qσ = 0 and Qσ = 1, respectively in Table 8.1. 

Analysis of the DFN data yields several insights.  As previously discussed, network percolation requires 

greater fracture densities as values of a increase.  This can be observed in Table 8.1, where values of ρ2D 

for a = 1 and a = 2 are 1.0 and 1.5 m/m
2
, respectively, yet produce nearly the same backbone density of 

0.70.  A value ρ2D = 2.0 m/m
2
 for a = 3 networks supports this trend, albeit with a slightly higher 

backbone density of 0.83 m/m
2
.  The explanation for this trend is simple: mean fracture length 

decreases with increases in fracture length exponent values, requiring more fractures to reach a 

sufficient degree of network connectivity. 

The use of a constant T value for all fracture segments along with comparable backbone densities 

indicates that network-scale flow decreases as values of a increase (Figure 8.4, sigma = 0 case).  

Implementation of a log-normal T distribution with log(σT) = 1 increases network scale flow for a = 1 

networks by approximately an order of magnitude (Figure 8.4, sigma = 1 case).  This dramatic increase in 

network flow results from domain-spanning fractures, which are common in a = 1 networks, being 

assigned T values greater than the mean.  Network flow for a = 2 and a = 3 are very similar.  This reflects 

the higher densities of these networks, where T values lower than the mean serve as ‘bottlenecks’, 

which have a restrictive influence on total flow. 

Variability in network flow for the constant-T simulations was evaluated to study overall network 

connectivity and backbone structure for individual realizations.  Networks with a = 2 showed the 

greatest variability with up to 90% differences in flow from the mean listed in Table 8.1.  This indicates 

that these networks exhibit the greatest variability in backbone structure and connectivity, and this is 

most likely attributed to the influence of both short and long fractures in producing complex backbone 

structures (Figure 8.3).  Networks with a = 3 have up to 45% differences in flow from the mean listed in 

Table 8.2.  These networks are dominated by short fractures (Figure 8.2), and differences in flow are 

attributed to the degree of connectivity between individual realizations.  Networks with a = 1 exhibited 

the lowest degree of variability with only up to 20% differences in flow from the mean listed in Table 

8.1.  Networks with a = 1 are dominated by very long, often domain-spanning fractures (Figure 8.1) that 

lead to similar degrees of connectivity for individual realizations.  Variability in network flow for the log-
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normal T distribution show similar trends where a = 1 networks have the lowest variability (up to a 

factor of 2 from the mean) and a = 2 and a = 3 networks have higher variability (up to a factor of 3 from 

the mean). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 8.4. Network simulations with comparable backbone densities indicate that total network-

scale flow decreases with increasing values of a.  This trend linearly decreases when all fracture 

segments have the same values of T (sigma = 0).  Application of a realistically parameterized log-

normal distribution with  log(σT) = 1 (sigma = 1) further increases network flow for all cases, with the 

largest increase in flow for the a = 1 networks. 

 

8.2.2 Hydraulic Conductivity Tensor 

Fractured media is highly anisotropic and heterogenous, and the tensorial form of hydraulic conductivity 

K, or more properly denoted K in its tensor form, is highly useful for modeling the quantity and 

directional nature of flow in fracture networks.  In this section, we explain what a K tensor is, how it is 

mathematically defined, and methods for computing the full K tensor for fractured rock systems.  Once 

computed, this tensor can be properly diagonalized to compute scalar values of Kx, Ky and Kz for use in 

numerical models. 

The discussion of flow through porous media thus far has thus focused on a simple form of Darcy's Law: 

dh
Q KA

dl
= −   (8.1) 

which describes the flow of groundwater through a homogenous and isotropic subsurface aquifer, 

where total discharge Q [L
3
/t] is a function of a scalar value of hydraulic conductivity K [L/t], area cross-

sectional to flow A [L
2
], and a linear horizontal hydraulic gradient dh/dl. Equation (1) can be further 

simplified to: 

1.00E-03

1.00E-02

1.00E-01

1 1.5 2 2.5 3

Q [m3/s]

a

sigma = 0 sigma = 1
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Q dh
q K

A dl
= = −   (8.2) 

where specific discharge q [L/t] (also referred to as Darcy flux) describes groundwater discharge per 

cross-sectional area.  In multiple dimensions, (2) can be expanded to: 

h= − ∇q K   (8.3) 

where specific discharge q is a vector along the principal scaling directions of a Cartesian coordinate 

system (i.e, x-, y-, z-), K is a second rank tensor, and ∇h is the gradient operator acting on a head field 

where head values are allowed to vary in three-dimensions: 
h h h

h
x y z

∂ ∂ ∂
∇ = + +

∂ ∂ ∂

i j k .  The multi-

dimensional form of Darcy's Law (3) states that the specific discharge vector q is the sum of its three 

Cartesian coordinate components: 

x y z
q q q= + +q i j k   (8.4) 

which can be alternatively written as: 
1 2 3

q q q= + +q i j k , where Einstein notation is used to denote x, y, z 

components as indices 1, 2 and 3; and i, j, and k are unit normal vectors along x, y, and z.  Thus, in 

Einstein notation (3) can be expressed as: 

,  1,3
i ij j

q K J i= =   (8.5) 

where J = -∇h and
1 2 3

h h h
h

x x x

∂ ∂ ∂
∇ = + +

∂ ∂ ∂

i j k .  Expanding (5) to a set of linear algebraic equations: 

1 11 1 12 2 13 3

2 21 1 22 2 23 3

3 31 1 32 2 33 3

q K J K J K J

q K J K J K J

q K J K J K J

= + +

= + +

= + +

  (8.6) 

we can further understand the nature of hydraulic conductivity as a second rank tensor where: 

1 11 12 12 1

2 21 22 23 2

3 31 32 33 3

q K K K J

q K K K J

q K K K J

     
     

=
     
           .

  (8.7) 

Thus, K is a symmetric, second rank tensor consisting of 9 components to properly scale discharge q to 

the directional permeability of the medium and hydraulic gradient J.  

The tensor form of K in (7) can be diagonalized by eigenvector/eigenvalue transformation: 

1 11 1

2 22 2

3 33 3

0 0

0 0

0 0

q K J

q K J

q K J

     
     

=
     
          

  (8.8) 
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where 

1 11 1

2 22 2

3 33 3 .

xx x

yy y

zz z

h h
q K J K K

x x

h h
q K J K K

y y

h h
q K J K K

z z

∂ ∂
= = − = −

∂ ∂

∂ ∂
= = − = −

∂ ∂

∂ ∂
= = − = −

∂ ∂

  (8.9) 

In this case, Kx, Ky and Kz are commonly referred to as the hydraulic conductivity values in the x-, y- and 

z-directions, respectively, and the off-diagonal components are equal to 0.  These scalar K values can be 

input into MODFLOW or other ground water models for flow simulations.  

Development of methods for computing equivalent K tensors for fractured rock with discontinuous 

fractures has been the subject of numerous investigations (e.g., Snow, 1969; Long et al., 1982; Lee et al., 

1985; Oda, 1985; Zhang et al., 1996; Min et al., 2004; Klimczak et al., 2010).  These studies typically refer 

permeability (denoted as k) rather than hydraulic conductivity (denoted as K) tensors.  It is important to 

note that the relationship of hydraulic conductivity K [L/t] to permeability k [L
2
] is described by: 

gρ

µ

=K k            (8.10) 

where ρ is fluid density, g is the gravitational constant and µ is fluid viscosity.  For example, at 20°C this 

relationship is: 4 2 [m/s] 9.7337 10  [m ]Κ = × k .  As a general rule hydraulic conductivity values are 5 

orders of magnitude greater than permeability when transitioning between units of m/s and m
2
. 

There are two primary methods in which the K tensors can be computed for fractured rock: (1) an 

analytical expression known as the 'Oda tensor' approach and (2) numerical approach involving the 

computation of network-scale flow using discrete fracture network (DFN) simulations with specifically 

applied boundary conditions.  Both of these approaches are discussed below. 

The Oda tensor approach is based on the following analytical expressions (Oda, 1985): 

( )
ρ

λ δ

µ

= −ij kk ij ij

g
K P P

 

 (8.11) 

π
∞ ∞

Ω

= Ω∫ ∫ ∫
2 3

0 0

( , , )
4

ij i j

p
P r t n n E r t d drdtn

 

 (8.12) 

where Pij is the permeability tensor, p is 3D fracture density (ρ3D), r is fracture radius (half-length), t is 

fracture aperture, n is a unit normal vector to the fracture plane (defines orientation) over area Ω, Pkk = 

P11 + P22 + P33 , which define principal components of permeability similar to (8), and E(n,r,t) represents a 

joint distribution of fracture orientation, fracture radius (half-length) and aperture.  These distributions 

are assumed independent.  Values of λ describes fracture connectivity where λ is equal to 1/12 if the 

network is well connected and λ is less than 1/12 if not well connected.  Equations (11) and (12) 
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compute K based on fracture attributes; however, probability distributions of orientation, length and 

hydraulic conductivity are ill-defined if sufficient connectivity is not established.  There is no way other 

than the generation of site-specific equivalent discrete fracture networks to precisely define the level of 

connectivity that is present in a rock mass, and well-connected networks are the exception rather than 

the rule.  Hence, the dominant problem with the Oda tensor approach is reducing the complexity of 

network connectivity to a single, difficult to define parameter.  The prior analysis of network structures 

for different network types in Section 2.1 illustrates the complexity of network structure and 

connectivity.  More specifically, backbone densities are be highly variable and are typically not 

proportional to total network density measured in the field.  We therefore cannot recommend the use 

of the Oda tensor to compute network K and only include this method for completeness. 

The numerical approach to define equivalent network K tensors involves solving flow in discrete fracture 

networks under specified boundary conditions.  The generation of fracture networks requires analysis of 

site-specific fracture properties to assign probability distributions of orientation, length, 

aperture/hydraulic conductivity and values of fracture density (refer to Chapter 4 for fracture 

characterization).  With the exception of fracture density and distribution of spacing, these are the same 

parameters that are required for the Oda tensor.  Rather than determining K directly from these 

statistics using the Oda Tensor approach, the numerical approach stochastically generates discrete 

fracture networks, computes the hydraulic backbone by eliminating dead-end segments and isolated 

clusters, and solves for flow.  In 2D planar representations of fracture networks, determination of the K 

tensor requires two different boundary conditions to compute each component of the K tensor (Figure 

8.5).  This same method can be used to compute the full 3D tensor by first generating a 3D fracture 

network and projecting the fracture network onto corresponding x-y, y-z and x-z planes and solving for 

flow in 2D. Each of these planes requires two sets of boundary conditions as illustrated in Figure 8.5. 

This process is further illustrated in a case study below.  Alternatively, 3D discrete fracture network 

simulators can be used to compute each of the tensor components given specified boundary conditions. 

Like its 2D counterpart, the use of 3D DFN simulators also requires various configurations of boundary 

conditions for computation of individual components of the K tensor. 

The application of a tensor to model flow in fractured rock depends on two criteria. The first criterion is 

that representative elementary volume (REV) conditions are met (e.g., Bear, 1972; Long et al., 1982; 

Klimczak et al., 2010).  The REV approach assumes that hydraulic conductivity oscillates heterogeneously 

within a volume of fractured rock until a specific volume scale is reached where K becomes more or less 

constant (homogeneous) (Figure 8.6).  Thus, the REV represents a volume scale at which variability of 

fracture attributes, including network connectivity and range of K for individual fractures, has been 

sufficiently sampled and perturbations caused by scale effects are effectively averaged.  Fractured 

media is extremely complex and REVs do not exist for some networks at any scale, particularly for sparse 

networks with low power-law length exponent values (a < 2) (Klimczak et al., 2010).  In general, the 

denser a network the more quickly an REV can be established.  This is because dense networks tend to 

have shorter fractures and are well connected, effectively homogenizing the network over shorter 

volume scales.  
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Figure 8.5: Illustration depicting the application of two sets of linear boundary conditions used to 

solve for individual components of the K tensor in the x-y plane. 

 

 

 

Figure 8.6: Illustration of the representative elementary volume (REV) concept where (in this case) 

hydraulic conductivity becomes homogenous (constant) after a volume scale is reached.  Note that 

not all fractured media exhibits REV in K. 

 

The second criterion for the application of a K tensor is that it must be symmetric with orthogonal 

principal components.  The symmetry of the tensor is more difficult to compute as it involves the 

rotation of a generated, site-specific DFN by small increments and solving for flow under the same 

boundary conditions as presented in Figure 8.5.  Under these conditions, a symmetric tensor in 2D will 

K 

Volume 

 

REV 
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form an ellipse with orthogonal major and minor ellipses (Figure 8.7).  In 3D, the K tensor will form an 

ellipsoid. The REV and tensor symmetry concepts will be further illustrated in the following example 

using site-specific fracture data. 

Case Study Example: Lower Carbonate Aquifer in Southern Nevada 

The LCA3 is a hydrostratigraphic unit located on the Nevada National Security Site (NNSS) in the vicinity 

of the Rainier Mesa Corrective Action Unit (Area 12).  The LCA3 label denotes a deep or Lower 

Carbonate Aquifer of Paleozoic age rock that underlies a large portion of the NNSS; the '3' indicates that 

this unit is a thrust wedge of the LCA higher in the stratigraphic sequence than the non-thrusted LCA. 

The LCA3 is densely-fractured and has very low matrix hydraulic conductivity (on the order of 10
-12

 m/s). 

Thus, the hydraulic conductivity of the LCA3 is fracture dominated. 

 

 

Figure 8.7: Theoretical hydraulic conductivity ellipse in the x-y plane where the principal directions 

of hydraulic conductivity, Kx'x' and Ky'y' are oriented 30 degrees from the x-axis.  The major and minor 

axes of the ellipse are represented by √Kx'x' and √Ky'y' where Kx'x' and Ky'y' are equal to 5 and 2 m/d, 

respectively.  If this data represented a field site the model grid should be rotated 30 degrees about 

the x-axis to be consistent with the principal directions of hydraulic conductivity. 

 

Single well hydraulic tests performed on wells ER-12-3 and ER-12-4 yield saturated K values that range 

between 10
-6

 and 10
-8

 m/s, respectively (SNJV, 2006a,b).  Both of these wells each have over 100 meters 

of screened interval open to the LCA3, and hence, these values represent an average or 'effective' K at 

these two locations where only a single value of K is applied to the entire system.  While hydraulic tests 

over large screened intervals are very useful in determining ranges of effective K values for densely 

fractured rock, directional anisotropy cannot be determined from these tests alone, unless multiple 

monitoring wells are used.  In this case, the NNSS has very deep (~800 m) vadose (unsaturated) zones 

and the cost of drilling precludes the installation of any, let alone multiple, monitoring wells for 
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purposes of hydraulic testing.  It is important to note that fractured rock exhibits very complicated 

network geometry and connectivity, and the installation of multiple monitoring wells is no guarantee for 

effective determination of fractured rock anisotropy. 

Fractured rock anisotropy is a result of the structure of discontinuous fracture networks (i.e., number of 

fracture sets of their orientation, length and density), which can lead to the condition Kx ≠ Ky ≠ Kz.  To 

support simulations of flow and radionuclide transport predictions, it was deemed critical to define the 

anistropy of the LCA3.  This involved computation of the K tensor according to collected fracture data. 

Available fracture data from the LCA3 consists of (Boyle, 2003): 

• Dolomite Hill core hole (aperture and frequency/spacing) 

• Right rib U12e south drift (orientation, length, and frequency/spacing) 

• Outcrops near U12e tunnel south portal (orientation, length and frequency/spacing) 

The Dolomite Hill core hole is a 365 m deep core hole within the LCA3 that is located approximately 300 

m southeast of the U12e tunnel south portal, the location of the other two data sets.  The right rib of 

the U12e south drift consists of a 17 m long subsurface exposure of the LCA3 along a tunnel drift.  Two 

transects of approximately 20 m and 15 m, oriented E-W and N-S, were used to measure fracture 

attributes at outcrops of the LCA3 near the U12e tunnel south portal (Figure 8.8). 

 

 

Figure 8.8: Outcrops near U12e tunnel south portal where transects 1 (left) and 2 (right) were used 

to collect fracture data.  Transect 1 is 20 m in length and is orientated approximately N-S; Transect 2 

is 15 m in length and is oriented approximately E-W.  Data along these two transects was collected 

from fractures with lengths greater than 0.45 m (1.5 ft). 

 

Characterization of the LCA3 involved analysis of fracture data to assign distributional properties of 

fracture orientation, length and aperture and values of frequency/spacing.  Poles-to-fracture 

orientations (strike and dip) were first projected to a southern hemisphere stereonet.  Contour plots of 
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pole density revealed two steeply-dipping fracture sets with orientations of 227°, 81° and 292°, 71°, and 

prior probabilities of 0.64 and 0.36, respectively (Figure 8.9, left).  

The fracture aperture data set is exclusively from the Dolomite Hill core hole at depths greater than 173 

m (450 ft) below land surface.  This cutoff depth was selected due to an abrupt transition to smaller 

aperture values that are considered more representative of apertures in the LCA3 at depth.  The cutoff 

depth of 173 m below land surface may approximate the extent of surface weathering at the top of the 

LCA3 (Boyle, 2003).  Aperture data from the underground drift and two surface outcrops were not used 

in this analysis as the lack of confining stress artificially dilates fracture apertures.  An empirical 

relationship: 0.558
h m

K K= is used to adjust mechanical aperture Km to hydraulic aperture Kh (Kwicklis, 

1998) prior to distributional analysis.  Hydraulic aperture values from the Dolomite Hill core hole best fit 

a lognormal distribution with log10 mean and standard deviation of aperture of -3.75 and 0.39 m prior to 

log transformation (Figure 8.9, right).  The average fracture aperture is 187 microns which is a very 

reasonable value for fracture aperture (typically in the range of 50 to 350 microns).  These values are 

used to assign transmissivity to the fractures via the cubic law (eqn 4.34). 

 

Figure 8.9: Stereonet plot (left) showing lower hemisphere projection of fracture poles (n=176) 

along with pole density contours.  The orientation data indicate two steeply dipping fracture sets 

with strike and dip orientations of 227°, 81° and 292°, 71°, and prior probabilities of 0.64 and 0.36, 

respectively.  Histogram of fracture aperture (right) indicates a satisfactory fit to a lognormal 

distribution with log10 mean and standard deviation of aperture of -3.75 and 0.39 m prior to log 

transformation.  Average fracture aperture is 178 microns.  Note that the best fit lognormal 

distribution values listed in the figure represent the equivalent of the parameters given for a log 

base e distribution. 
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Figure 8.10: Histogram (left) and probability plot of fracture lengths (right) indicate a good fit to a 

lognormal distribution with log10 mean and standard deviation of fracture length of -0.09 and 0.43 m 

prior to log transformation.  Average fracture length is 0.8 m.  Similar to Figure 8.6, best fit 

lognormal distribution values listed in the figure represent the equivalent of the parameters given 

for a log base e distribution. 

 

Analysis of fracture lengths collected from the surface and subsurface exposures for fractures with 

lengths greater than 0.45 m (1.5 ft) indicate that fracture length best fits a lognormal distribution (Figure 

8.10).  The use of a lognormal distribution in this analysis is somewhat contrary to the previous 

discussion of power law fracture length distributions in section 4.5.2, and likely arises for two reasons. 

First, the surface and subsurface exposures are limited in scale and this may cause larger fracture 

lengths to be truncated in the data set.  Second, the LCA3 is very densely fractured, which can cause a 

truncation in fracture length and produce a lognormal distribution.  Analysis of the distribution of 

fracture length for power-law tails yielded a weak power-law trend with power-law exponent of a = 2.5 

(not shown). Networks with power-law exponents of a = 2.5 or greater are dominated by very short 

fractures (Figure 8.3), and the utility of power-law distributions in describing a continuum of lengths is 

somewhat lost.  Given the dominance of short fractures (average length is 0.8 m) and goodness of fit of 

the data, a lognormal distribution of fracture length with log10 mean and standard deviation of fracture 

length of 0.09 and 0.43 m prior to log transformation is used to describe fracture length. 

Fracture spacings from data sets collected from the Dolomite Hill core hole and right rib underground 

drift are oriented sub-optimally relative to the fracture set orientations.  For this reason, 1D fracture 

frequency and density is computed exclusively from the two transects on the surface exposures.  These 

transect lines produce an average fracture frequency value of 5.5 fractures per meter.  The inverse of 

this calculation produces average fracture spacing which is 0.18 m.  We consider networks with spacings 

under 1 m to be densely fractured, so a 0.18 m fracture spacing corresponds to a very dense network. 
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The fracture analyses outlined above are then used to reproduce three-dimensional DFN networks 

consist with site-specific data. These networks are not shown due to challenges in visualizing 3D 

networks with high fracture density.  The process of generating the DFNs involves the generation of 

individual fractures according to: (1) fracture location via a random point process, (2) orientation via a 

Fisher distribution consistent with prior probabilities for each set, (3) fracture length via a lognormal 

distribution and (4) fracture transmissivity via a lognormal distribution of apertures and the cubic law.  

This process is repeated until the fracture density criterion of 0.18 m is satisified.  The 3D DFNs are then 

projected onto planes aligned with the Cartesian coordinate system for computation of the K tensor 

(Figure 8.11), i.e., the x-y, x-z and y-z planes.  Two sets of these boundary conditions, consistent with 

Figure 8.5, are used to establish orthogonal flow directions for computation of the diagonal and off-

diagonal components of the K tensor for each plane: 

_ _ _
; ; .

xx xy yy yzxx xz

xy plane xz plane yz plane

yx yy zy zzzx zz

K K K KK K

K K K KK K

    
= = =    

    
K K K  (8.13) 

Fifty statistically-equivalent fracture network realizations are used to generate these tensor values for 

the LCA3.  The K tensor [m/s] for the LCA3 is then computed through arithmetic averaging to determine 

the mean value for each component: 

7 7 8

7 7 8

3

8 8 8

6.6 10 6.1 10 6.0 10

3.8 10 9.7 10 3.0 10 .

9.6 10 4.7 10 8.8 10

xx xy xz
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zx zy zz
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   × × ×   

K  

The principal components of the K tensor are then computed by taken the eigenvalues of the tensor 

matrix: 
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K K

K K

K K

−

−

−
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  

= = = ×  
  = ×   

K  

The LCA3 K tensor honors network structure and resultant anisotropy and overall ranges of hydraulic 

conductivity measured from hydraulic tests.  Values of the K tensor for Kxx, Kyy and Kzz are 3.2×10
-7

, 

1.3×10
-6

, and 7.6×10
-8

 m/s, respectively.  The overall or effective K of the system, computed by taking 

the geometric mean of the tensor components, is: 

( )
7exp log log log / 3 3.2 10  m/s

effective xx yy zz
K K K K

− = + + = ×  . Recall that "effective" estimates of K for the 

LCA3 range from 10
-6

 to 10
-8

 m/s based on single well hydraulic tests at ER12-3 and ER12-4 over large 

screened intervals, and the effective K value is in the middle of this range.  Higher values of Kxx and Kyy 

reflect the higher degree of connectivity in the horizontal plane than the vertical plane. 
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Figure 8.11: Generated three-dimensional fracture network from site-specific LCA3 fracture data 

projected onto x-y, x-z and y-z planes.  Components of the K tensor are then computed for each 

fracture plane by applying the two sets of boundary conditions shown in Figure 8.5. 

 

8.3 Hillslope Drainage Network Design for Fractured Rock 

The information contained in this manual is intended to assist in the design of hillslope drainage 

networks in fractured rock.  The first step in designing a hillslope drainage network in fractured rock is to 

collect site-specific fracture data.  This field data can then be analyzed to determine distributional 

properties of orientation, length, aperture and hydraulic conductivity/transmissivity and values of 

fracture density.  Generation of discrete fracture networks from this data provides valuable insight into 

the structure and flow characteristics of the underlying fracture networks.  These networks can also be 

used to compute equivalent hydraulic conductivity tensors that serve as a basis for evaluating the 

efficiency of hillslope drainage networks in lowering pore pressures using the MODFLOW framework in 

this manual. 

One limitation of the equivalent-hydraulic-conductivity tensor approach, as applied to the MODFLOW 

grid, is that the use of a tensor assumes that the network at the scale of the MODFLOW grid cell is well-

connected.  The well-connected assumption, in part, can be satisfied through an analysis to determine 

the scale at which the Representative Elementary Volume (REV) is valid. However, rock fracture 

networks exhibit high degrees of heterogeneity in both geometric and hydraulic properties, and certain 

fracture characteristics, namely fracture length, spacing, and variance of transmissivity, can lead to 
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networks with irregular connectivity and highly focused flow.  REV conditions for these cases may not be 

satisfied and the tensor approach cannot be utilized. 

In this Section, an additional analysis focusing on the intersection of hillslope drainage networks with 

dominant flow fractures is performed.  Intersecting "dominant" fractures is absolutely critical to 

successfully lowering fluid pore pressures and achieving hillslope stabilization.  This analysis is directly 

performed on models of discrete fracture networks generated from both synthetic and site-specific 

data.  The results of this analysis are valid regardless of REV assumptions, since the analysis itself is 

performed directly on the discrete fracture networks and no up-scaling is introduced.  

 

8.3.1 Differentiating Fracture Types 

Discrete fracture networks are analyzed for intersection with three fracture types: all fractures, 

hydraulic backbone fractures, and dominant fractures.  "All fractures" refer to all fractures present in a 

rock mass, whereas "hydraulic backbone" fractures refer only to the interconnected fractures of the 

hydraulic backbone.  This concept can be readily visualized in Figures 8.1 through 8.3 in this section. 

"Dominant" fractures, as defined in this subsection, refer to fractures of the hydraulic backbone that 

conduct flow exceeding a specified value: 

Global DFN Flow
Dominant Fracture Flow  

Number of Boundary Fractures/2
≥      (8.14) 

where flow through a dominant fracture must equal or exceed the total flow through a DFN realization 

normalized by the number of boundary fractures.  Boundary fractures intersect the outside of the DFN 

model boundary and are responsible for all flow in and out of the model domain.  Half of the boundary 

fractures are used because global DFN flow represents the net flow through a network, and on average 

approximately half of the boundary fractures conduct flow into the network and approximately half of 

the boundary fractures conduct flow out from the network. 

The use of a robust mathematical definition of dominant fractures in (14) is necessary for comparing 

networks with different degrees of heterogeneity in transmissivity, defined by the log variance of 

transmissivity, log(σT) (Figure 8.12).  In the following intersection analysis, "successful" hillslope drainage 

attributed to lowering of pore pressures depends on the intersection of dominant fractures with 

horizontal hillslope drains. 

 

 



 
236 

 

Figure 8.12: Ranked plots of flow through individual fracture segments of the fracture backbone 

along with the identifican of dominant fractures (left).  Flow through individual fracture segments of 

the hydraulic backbone with line thickness proportional to segment flow (right).  The plots are made 

from networks with identical geometric network properties (a=2.0, θ=±45°,κ=20, ρ2D=1.5 m/m
2
) 

with log(σK) = 0 (top) and log(σK) = 1 (bottom).  Note that networks with homogenous distributions 

of K (log(σK) = 0) contain many dominant fractures (top), whereas networks with heterogeneous 

distributions of K (log(σK) = 1) exhibit focused flow through a small subset of fractures of the 

hydraulic backbone (bottom). 
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It is important to understand that fracture networks are highly heterogeneous and that standard 

deviations of transmissivity on the order of log(σT) = 1 are typical for natural networks.  Note that log(σK) 

= 1 represents fracture networks with transmissivity values encompassing 5-6 orders of magnitude!  

Consistent with field observations, the discrete fracture network simulations show that a subset of all 

the fractures belong to the hydraulic backbone and conduct flow, and only a very small subset of the 

hydraulic backbone fractures conduct the majority of flow across a network for log(σK) = 1.  This 

prevalent feature of fracture networks emphasizes the need for the directional fracture intersection 

analyses described below. 

8.3.2 Fracture Intersection Analysis 

Intersection of horizontal hillslope drainage networks is determined by projecting domain spanning 

scanlines across the networks and recording intersections of all three fracture types: all fractures, 

backbone fractures and dominant fractures.  The number of intersections is then normalized by the 

scanline length to provide an average distance of intersection for each the three fracture types.  

Fracture networks are spatially discontinuous features with non-random orientations, and the scanline 

orientation is rotated from 0 to 360 degrees in 5 degree increments to fully capture the directional 

dependence on intersection distances.  This process is repeated for 100 DFN flow realizations and 

ensemble (the average of all realizations) trends are computed.  This analysis assumes that these 

scanlines represent the sampling of a fractured medium with a horizontal drain of varying orientation. 

Distances of scanline intersection with dominant fractures represent horizontal drain lengths necessary 

for successful drainage of a rock mass.  These distances may or may not have directionally dependence 

as illustrated in the following examples. 

A systematic analysis using both synthetic and site-specific fracture data is conducted to understand the 

influence on fracture orientation, length, density and transmissivity on ensemble intersection trends.  

Differences in intersection trends between single fracture network realizations and ensemble-averaged 

trends are both qualitatively and quantitatively defined.  All fractured rock masses are unique and will 

need to undergo this analysis to enhance the probability of success in lowering pore pressures; 

however, the following sections provide detailed information on how fracture network properties 

influence hillslope drainage network design.  

8.3.2.1 Influence of Fracture Length and Transmissivity 

Discrete fracture networks are generated according to synthetic parameter sets to allow for systematic 

study of specific fracture attributes on intersection distances.  Since network connectivity and global 

flow are highly dependent on distributions of fracture length and transmissivity, the influence of these 

parameters on intersection distances is explored first.  Six sets of discrete fracture networks consisting 

of a=1, a=2 and a=3, with standard deviation of transmissivity described by log(σT)=0 (homogeneous) 

and log(σT)=1 (heterogeneous).  These networks all consist of two fracture sets with orientations of ±45˚ 

and deviations in orientation described by κ=20. 
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Radial plots of distance r as a function of angle θ describe the distance of intersection for all fractures, 

backbone fractures and dominant fractures (Figure 8.13).  The top half of Figure 8.13 from left to right 

describe the influence of these fracture trends with increasing values of a given log(σK)=0.  For the most 

part, trends of intersection for all fracture types are similar in distance, with the exception that the 

intersection distance of the all fracture and hydraulic backbone groups are very similar for the a=1 

networks.  This indicates that even though the a=1 networks have a larger fracture spacing in these 

examples, many of these fractures are connected to the hydraulic backbone, because the a=1 length 

distributions favors longer, domain-spanning fractures. 

The effect of deviations in transmissivity about the mean value is readily observed during visual 

inspection of the top (log(σT)=0) and bottom (log(σT)=1) plots.  Heterogeneity in transmissivity greatly 

extends intersection distances for the dominant fractures from approximately 3-4 meters to 6-10 meters 

along the Cartesian coordinate axes.  This reflects the trends shown in Figure 8.12 where increasing 

heterogeneity effectively concentrates flow through a smaller subset of fractures increases the spacing 

of dominant fractures.  Larger intersection distances with increases in log(σK) indicate that the number 

of total fractures intersected by a horizontal drain on average needs to effectively double 

(approximately 3 to 6) to ensure that a dominant fracture is intersected. 

As a final comment, the square shape of average intersection distances signifies a directional 

dependence on hillslope drain length.  If the radial distance to dominant fractures were equal, then the 

overall shape of these intersection trends would be described by a circle of constant radius as shown 

later.  Rather, the square shape indicates that the distance to intersection with all types ranges from a 

minimum along the Cartesian coordinate axes to a factor of √2 at the diagonals.  This pattern reflects 

the mean fracture set orientations of ±45˚, where the minimum distance represents the angles of 

maximum intersection by the two fracture sets (0˚, 90˚, 180˚, 270˚), and the maximum distance 

represents the diagonals, where intersection of the scanline is reliant on only one fracture set as the 

other fracture set is parallel to the scanline. 

8.3.2.2 Influence of Fracture Set Orientation and Density 

Previous intersection analyses have focused on networks containing two fracture sets orientated at 

±45°.  In this section, networks with a=2 and ρ2D=1.5 m/m
2
 are utilized to study the influence of fracture 

set orientation and density assigned to individual fracture sets on resultant intersection distances. 

Intersection trends with fracture set orientation of ±45° are square with the largest distances to fracture 

intersections coinciding with mean fracture orientation (Figure 8.13).  Changing mean fracture set 

orientation from ±45° to ±90° effectively rotates the square shape to a diamond where the largest 

intersection distances of fracture intersection coincide with mean fracture orientation (Figure 8.14 left). 

Changing values of κ used to describe variability in fracture orientation about the mean was observed to 

only slightly alter overall intersection trends (not shown).  The use of a random fracture orientation 

results in circular intersection trends absent of directional dependence (Figure 8.14 center).  In this case,  

  



 
239 

 

Figure 8.13: Directional distances of scanline intersection with all fractures (red), backbone fractures 

(green) and dominant fractures (blue) for a=1 (a,d), a=2 (b,e) and a=3 (c,f).  All networks contain 2 

fracture sets with orientations of ±45° with each set having equal density.  Plot axes all have the 

same scale for consistent visual comparison.  Values of r denote radial distance of average fracture 

intersection distance (meters) to each fracture type according to angle θ.  Note how intersection 

distances for all fractures and hydraulic backbone fractures are more or less consistent for values of 

a, and that intersection distances for dominant fractures are highly dependent on values of 

log(σK)=0 (top, a-c) and log(σK)=1 (bottom, d-f). 

 

the design of a hillslope drainage network would not need to preferentially scale drain length as a 

function of θ.   Trends of intersection plots, whether square, circular or diamond in shape, all exhibit 

symmetry related to fracture orientation.  This is specifically caused by the use of two fracture sets with 

orthogonal orientations (or random in the case of Figure 8.14 center) and assigning an equal number of 

fractures to each set.  These fracture network parameters were intentionally held constant to 

investigate the influence of fracture length and transmissivity.  However, prior probability, defined as 

the ratio of fractures applied to each fracture set, is commonly unequal for natural fracture networks.   

The effect of unequal distribution of fractures among each fracture set is evaluated by assigning 20% 

and 80% of fractures to the -45° and 45° sets, respectively (Figure 8.14 right).  This effectively yields a 

fracture spacing that is 4 times lower along the 45° fracture set than the -45° fracture set.  This type of 

unequal fracture distribution results in strongly skewed and asymmetric plots with the smallest 

intersection distances along -45° (due to intersecting the 45° set with higher density), and largest 

intersection distances along 45° (due to intersecting -45° set with a more sparse density). 
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Figure 8.14: Influences of orientation and density on ensemble intersection trends with all fractures 

(red), backbone fractures (green) and dominant fractures (blue) for networks containing two 

fracture sets with a=2 and ρ2D=1.5 m/m
2
.  The previous intersection analyses contained networks 

with two fracture sets orientated at ±45°.  For these networks, intersection patterns were square 

and the largest distances to fracture intersections coincide with mean fracture orientation.  The use 

of two fracture sets oriented at ±90° (left) effectively rotates the square shape to a dimond where 

the greatest intersection distances coincide with mean fracture orientation.  Use of random fracture 

orientation (center) results in circular intersection plots absent of directional dependence.  Unequal 

weigths assigned to each fracture set can greatly skew directional intersection trends (right), where  

20% and 80% of fractures are assigned to the set with orientation -45° and 45°, respectively. 

 

8.3.2.3 Deviations between Individual Realizations and the Ensemble 

Thus far, the analysis has focused on ensemble-averaged trends from a total of 100 individual fracture 

network realizations.  Spatial configuration and structure of fracture networks are highly uncertain, and 

this is reflected in the fracture generation methodology itself.  To study deviations of individual 

realizations with the ensemble trends, individual realizations (light gray) are plotted against the 

ensemble (dark blue) in Figure 8.15 for networks with a=1, θ=±45°, κ=20, and log(σK)=1.  This is the 

same network shown with ensemble trends in Figure 8.13d. 

Variability of intersection distances to dominant fractures for 100 individual realizations about the 

ensemble is large, with the majority of realizations clustered around the ensemble mean and a small 

subset of individual realizations showing extreme variability (Figure 8.15a,b).  For example, some 

scanlines for specific network realizations intersect only 1-2 dominant fractures, which generate 

intersection distances in excess of 40-50 meters.  No dominant fractures were intersected along a given 

angle θ for a very small subset of realizations. 

To restrict variability to a quantitative limit, 95%-confidence intervals are computed from the 100 

intersection distance trends (Figure 8.15c,d).  The most important confidence interval for the purpose of 
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hillslope drainage network design is the 95
th

 percentile, as this metric defines the distance necessary to 

intersect at least one dominant fracture for 95% of the simulations.  This is the distance that will be used 

later on to guide directional length of hillslope drains for the site-specific networks. 

It is apparent from examination that the 95
th

 percentile is not fully formed and its shape is inconsistent 

with the square shape exhibited by the 5
th

 percentile and ensemble mean (Figure 8.15c).  The shape of 

the 95
th

 percentile should be approximately square with a larger length scale than the mean.  The 95
th

 

percentile trend in Figure 8.15c is a result of undersampling from 100 realizations, and it is anticipated 

that nearly 10,000 realizations would need to be run before the 95
th

 percentile trend would be 

stabilized.  However, this high number of realizations is not computationally feasible for this analysis. 

Instead, a modified 95
th

 percentile is determined by first averaging the distance defined by the 95
th

 

percentile over all θ.  The ensemble intersection distance trend is normalized by its average, and the 

normalized ensemble trend is then multiplied by the 95
th

 percentile average.  This process generates the 

modified 95
th

 percentile curve (red) in Figure 8.15d that is remarkably similar to the trend of a perfect 

square (dotted pink).  This check validates that the constructed 95
th

 percentile trend correctly 

reproduces the square shape observed in the 5
th

 percentile and ensemble-mean plots. 

8.3.2.4 Site-Specific Fracture Networks 

The directional-intersection analysis method is applied to two sets of site-specific fracture data in this 

subsection.  The first field site is the Lower Carbonate Aquifer (LCA3) located on the Nevada National 

Security Site (NNSS), and the second is the Climax Fractured Granite Stock also located on the NNSS.  

The statistical analysis of fracture data is presented in the case study within Section 8.2.2.  To briefly 

summarize, the LCA3 fracture networks are very dense (ρ2D=6.9 m/m
2
), with two sets of non-orthogonal 

fractures with strikes of θ1=227° and θ2=292° and prior probabilities equal to 0.64 and 0.36, respectively.  

This translates to networks with two non-orthogonal fracture sets separated by 65° and an unequal 

distribution of fractures between the sets, where one set contains approximately two-thirds of the 

fractures.  These factors result in skewed intersection distance trends (Figure 8.16). 

The Climax stock is an intrusive, densely-fractured (ρ2D=4.3 m/m
2
) granite body on the NNSS that was 

characterized and analyzed for flow and transport properties by Reeves et al. (2010).  This rock mass 

was subjected to multiple fracturing events under various stress-field configurations, which reflects the 

multiple groups of fracture orientation (Table 8.2).  All fracture sets were assigned fracture lengths 

according to a power-law distribution with exponent a=1.6, and transmissivity according to a lognormal 

distribution with log(σT)=1.0. 

Networks for the Climax stock were generated in 3D according to stochastic methods presented in the 

manual, and then mapped to horizontal 2D planes.  Despite the presence of so many fracture sets, the 

resultant intersection distances for all fracture types are nearly circular (Figure 8.17). 
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Figure 8.15: Variability of intersection distances to dominant fractures for 100 individual realizations 

about the ensemble-averaged trends for a=1, κ=20, θ=±45˚, and log(σK)=1.  This is the same network 

simulations shown in Figure 8.13d.  These plots show a high degree of variability about the mean 

(a,b).  To provide quantitative estimates of the uncertainty about the ensemble average, 95% 

confidence intervals are computed from the individual realizations (bottom).  These plots indicate 

that the 5
th

 percentile and mean trends are well-developed and follow a square trend, yet the 95
th

 

percentile is irregular due to incomplete sampling of the fracture network parameter space.  The 

modified 95
th

 percentile shown in (d) was developed by taking the mean of the irregular 95
th

 

percentile over all θ, and rescaling the mean trend.  This method worked well in preserving the 

amplitude and frequency of the 95
th

 percentile, as shown by the good match to the theoretical trend 

for a perfect square (dotted line). 
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Figure 8.16: Intersection distances for the LCA3 for all fracture types (left) and trends of distance to 

dominant fractures for ensemble mean with 95% confidence intervals (center, right).  Note how the 

non-orthogonal fracture sets and non-equal number of fractures in each set leads to a skewed 

trends. 

 

Table 8.2. Fracture properties for each of the six identified fracture sets from Reeves et al. (2010). 

 Set 1 Set 2 Set 3 Set 4 Set 5 Set 6 

Prior Probability 0.04 0.15 0.12 0.16 0.15 0.38 

Mean Strike (°) 125 317 360 321 289 48 

Mean Dip (°) 19 25 85 83 82 80 

Dispersion (κ) 65 37 33 24 23 18 

 

 

 

Figure 8.17: Intersection distances for the Climax granite stock for all fracture types (a) and trends of 

distance to dominant fractures for ensemble mean with 95% confidence intervals (b,c).  Note that 

the presence of multiple fracture sets with of several unique orientations creates intersection rends 

that are nearly circular. 
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8.3.3 Summary 

Monte Carlo analyses of global flow for networks with a=1, a=2, and a=3 with comparable background 

densities indicate that total network flow decreases as values of a increase. This trend is further 

amplified under the influence of heterogeneous distributions of fracture transmissivity.  Networks with 

a=2 exhibit the greatest variability in flow about the mean, following by a=3 and a=1 networks. 

Surprisingly, the long, domain-spanning fractures in a=1 networks result in the least amount of flow 

variability about the mean. The large degree of flow variability for a=2 networks likely reflects variability 

in backbone structure and connectivity caused by combinations of both short and long fractures. 

An analysis of the distance of intersection with three defined fracture types was conducted.  The 

analysis systematically identified the influences of fracture length, transmissivity, orientation and 

density on directional intersection trends.  The overall shape of the intersection distances is highly 

sensitive to mean fracture orientation, where minimum and maximum distances to two sets of 

orthogonal fractures coincide with the directions most perpendicular and parallel to the mean fracture 

set orientations, respectively.  All examples, regardless of fracture network attributes, indicate that 

many fractures need to be intersected on average before a dominant fracture is crossed.  The spatially 

discontinuous nature of fracture networks and large variability in transmissivity indicates that a high 

degree of variability exists between individual realizations and ensemble averages.  For example, the 

sampling scanline for a very small subset of individual fracture network realizations did not intersect a 

dominant fracture.  To account for this variability, it is suggested that the horizontal drain length is 

scaled according to the distance defined by the 95
th

 percentile.  This concept is illustrated by Figure 8.18, 

where the length of individual drains is scaled to the directional dependence of the 95
th

 percentile trend 

for the LCA3 and Climax granite stock fracture statistics. 

 

 

 

Figure 8.18: Discrete fracture 

network realization and resultant 

hillslope drainage network for LCA3 

(a,b) and Climax (c,d).  Drain length 

as a function of θ is based on the 95
th

 

percentile trend.  Note that the 

drainage network is more symmetric 

for Climax than for the LCA3, and 

that hillslope drain lengths are three 

times larger for the Climax site 

(~30m) than for LCA3 site (~10 m).  
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A result of this analysis not yet discussed is the possibility that some sparsely fractured networks may 

require drain lengths (or drain densities) that are not economically feasible for successful dewatering.  

As an example, average drain length for the Climax site is approximately 30 meters. This calls into 

question the practice of installing horizontal hillslope drains prior to a rigorous analysis of fracture 

network statistics.  It is highly recommended that the intersection analysis contained in this section be 

conducted prior to the design and installation of drainage networks in fractured media. 
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Chapter	9	

Summary	

9.1 Concluding Remarks 

Every drainage problem is unique, in which experience and expert opinion cannot be superseded.   

However, a framework for drain design can aid practitioners with quantitative analysis to reduce ad-hoc 

decision making.  The proposed methodology requires a conceptual model of the site for proper 

assessment of data collection, water balance and site complexity.   A description of important 

parameters for hydrologic and geotechnical assessment is provided along with a variety of techniques to 

estimate these parameters, as well as the spatial and temporal scale of collection.   

An iterative approach is given for determining the minimum drain construction to lower water levels 

enough to keep the factor of safety (FOS) greater than 1.2 (refer to Figure 7.1).  Simple systems may 

only require an analytic approach to computing maximum water levels. Techniques are supplied for 

steady state conditions given a flat surface (Hooghoudt, 1940), a sloped surface less than 10° (U.S. 

Department of the Interior, 1978) and a discussion is provided on the influence of recharge and 

hydraulic conductivity on drainage design (Lesaffre, 1987).  Analytic equations for transient solutions for 

a flat surface (U.S. Department of the Interior, 1978) are given for different drain depths with respect to 

the impermeable barrier as well as for sloping surface with a declining water table over time (Skukla et 

al., 1999). Past research has found that flow to ditches; water table elevation and the rate of water table 

decline were independent of slope for slopes less than 15-30% (Luthin and Guitjens, 1967; Fipps and 

Skaggs, 1989).  For these relatively shallower slopes, flat-surfaced assumptions can be maintained with 

little error.  In all cases drainage design based on analytic (and graphical) approaches is focused only on 

drain spacing or the location of the first interceptor drain in a sloped system.  However, analytic results 

can be used to assess impact of system response to lowering the overall water table prior to a rapid rise 

caused by a large storm event.  This emphasis is concordant with Rahardjo et al. (2003) who found that 

horizontal drain placement should stress the overall lowering of the water table, not the direct capture 

of infiltration.  Therefore, analysis does not focus on emergency drain placement.  Analytic equations 

can also guide practitioners on the rapidity of water table drawdown given a specified drain spacing and 

depth, and provide a first-cut on drain efficiency. 

Irregular drain networks, heterogeneous or anisotropic aquifer conditions, complex slope geometry as 

well as fractured rock network may mandate a numeric modeling approach.  To create an effective and 

verifiable numeric model necessitates a full understanding of the assumptions applied, can require 

significant amounts of data, and be expensive to build.  However, numeric models can more fully 

incorporate data into a unified conceptual rendering of the site so that personnel can make more 

informed decisions on managing the system.  An idealized cross section (chapter 7.2) shows that shallow 

drains are relatively ineffective at lowering water levels, while drains are most effective when placed at 
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the lowest elevation possible.  If installed a significant distance into the hillslide at the lowest possible 

elevation, drains will capture the majority of groundwater and have the largest effect on lowering the 

water table.  Drains located in the upper region of a slope are found to have no real significance if 

additional deeper drains are in the lower part of a slope. The water table will eventually be reduced to 

the lowest drain level and any drains above the lowest-most drain will no longer be effective. The only 

exception to this rule might be for site conditions that have the ability to setup significant perched water 

table conditions. 

To aid the practitioner, idealized sites for translational (chapter 7.4.3) and rotational (chapter 7.4.4) 

failure are modeled over a range of hydraulic properties.  Water level sensitivity to hydraulic 

parameters, drain efficiency, storm design and recharge characteristics are also presented.   

For translational failure, examples are given for model development given no data collection (i.e. no 

model calibration), and for a situation where data has been collected (calibration procedure provided). 

Stability analysis finds that thin geologic sections susceptible to slope failure are most sensitive to 

increased water levels in the upper regions of the slope, and less sensitive to groundwater seepage in 

the toe region.  Slopes comprised of silt, sandy silt, clayey sand or till with low storage cannot be 

stabilized with horizontal drains alone.  Slopes containing fine material, but higher storage potential can 

be stabilized with long drains extending to the upper reaches of the slope. While groundwater seepage 

in the toe region is not important to FOS calculations, seepage can be mitigated by increasing drain 

density and adding short length toe drains. Modeling results find that FOS is sensitive to anisotropy, with 

fine soils not stabilized for Kx = 10Kz (i.e. VKA = 10).  For silty and fine sands (Kx = 1 ft/d) with low storage 

and isotropic or mildly anisotropic (VKA = 2) conditions, short length drains in the toe region of medium 

spacing are sufficient to raise FOS>1.2.  Drains should be lengthened to the upper slopes and drain 

density increased for medium anisotropy (i.e. VKA = 5), and no drain array will work for large anisotropy 

(VK=10).  Silty and fine sands with higher storage will not require any horizontal drains.  Likewise, well 

sorted sands and glacial outwash should not need horizontal drains to improve stability.  Increasing 

anisotropy in both cases, however, may necessitate drains reaching to the upper slope. 

Rotational failure analysis considered for two scenarios: failure along the entire slope and failure in the 

toe region only. Groundwater seepage prevails in the toe region during large storm events with simple 

fan arrays placed in the toe region capable of lowering water levels enough to mitigate seepage.  Whole 

surface failure for the conditions modeled is unlikely, but rotational failure in the toe region is very high 

for lower conductive materials such as silt, sandy silt, clayey sand or till.  It may not be possible to 

stabilize toe-slides for fine materials with low storage since no drain configuration tested was able to 

achieve FOS>1.2.  However, increasing drain density in the toe region comes close for anisotropy ≤ 5, 

with the potential for mitigated risk decreasing substantially for VKA ≥ 10. For higher storage conditions 

in low conducting soils and isotropic conditions a low density arrangement of toe-drains will suffice. 

Density of drains should be increased for more anisotropic soils.  More conductive soils only require low 

density toe-drains to mitigate failure. 
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Chapter 8 on flow in fractured rock and network design represents a special problem for slope stability. 

Fractured rock typically has little or negligible porosity and permeability in the rock matrix itself.  

Instead, connected networks of discontinuous fractures impart secondary porosity and permeability.  

The primary focus of the discussion on fractured systems is two-fold.  First, methods are presented to 

determine the equivalent hydraulic conductivity of fractured rock. These equivalent hydraulic 

conductivity values can be directly input into the hydrologic modeling framework presented in Chapter 

7.  Secondly, the stochastic approach, and associated implications of drainage network systems in 

fractured rocks are presented with case studies located on the Nevada National Security Site.  It is highly 

recommended that drain installation only be done following a rigorous analysis of fracture network 

statistics and intersection analysis to avoid costly and perhaps not economically feasible, solutions to 

drainage design. 

The purpose of the manual is to provide a single comprehensive reference for geotechnical engineers 

and hydrogeologist on designing horizontal drainage systems to improve slope stability.  Guidelines are 

provided for translational and rotational failure and consider fractured systems.  Basics of hydrogeologic 

and geotechnical terminology, site characterization and conceptualization, groundwater modeling 

techniques and template projects help to guide the user with respect to identifying important 

parameters to drainage design.  Type of failure, along with hydraulic properties of hydraulic 

conductivity, specific yield and anisotropy are found important to effectiveness of drain design.  It is 

hoped that with greater understanding of drainage systems in sloped surfaces, that results become 

more predictable and performance of drainage networks is improved while simultaneously lowering 

expenditures for slope stabilization. 
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Appendix	A	

Definition	of	Symbols	Used	

Geotechnical Symbols 

Units Definition: L = Length; M = Mass; T = Time; F = Force (ML/T
2
) 

 

  

Symbol units definition

α degress inclination of the base to the horizontal

b L width of each slice in FOS calculation

β degress inclination of slope from the horizontal

c' F/L
2 cohesion

δ degress
inclination angle for normal force acting on side of 

slice

E 1 , E 2 F normal force acting on the sides

φ ' degress friction angle

FOS dimensionless factor of safety

γ F/L
3 unit weight of dry soil

 γ sat F/L
3

unit weight of saturated soil

γ w F/L
3

unit weight of water

h L height of slice measured on the center line

l L length of base of slice

mz L depth of water table above failure plane

N F normal force acting on base

N' F effective normal force

r L radius of circular arc defining failure surface

σ ' F/L
2 effective normal stress

T F shear force

τ F/L
2 shear strength that must be mobilized to maintain a 

condition of limiting equilibrium

τ f F/L
2

available shear strength

τ m F/L
2

mobilized shear strength to maintain equlibrium

u F/L
2 pore water pressure

W F weight of soil slice

x 1 , x 2 F shear force on the sides

z L depth of failure plane for translational slip
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Hydrologic Symbols 

Units Definition: L = Length; M = Mass; T = Time; F = Force (ML/T
2
) 

Symbol units definition 

A L
2
 cross sectional area perpendicular to flow 

a dimensionless 
power coefficient for fracture length describing tail of 

distribution 

Ac L
2
 cross sectional area of sample in permeameter 

At L
2
 inside area of tube in falling head permeameter 

α 1/M/LT
2
 compressibility of the aquifer's skeleton 

α∗ radians 
angle of the transect relative to the mean fracture 

orientation 

B L thickness of geologic unit 

B' L thickness of envelope material around a drain 

b L 
thickness of individual geologic layer given multiple 

layers 

β 1/M/LT
2
 compressibility of water 

C dimensionless dimensionless shape factor 

C' dimensionless constant based on Imin and a 

C* dimensionless 
variable that relates to how the stress singularity at 

the fault tip is rmoved 

Cd L
2
/T drain conductance 

Cb L
2
/T general head boundary conductance 

Cu  dimensionless uniformity coefficient 

CN dimensionless curve number  

D L true fracture spacing 

D' L apparent fracture spacing 

D
^
 L depth of impermeable layer below drain 

D
*
 L depth of impermeable layer below water table surface 

Dmax  L 
maximum shearing displacement located at the fault 

midpoint 

d L pore size diameter 

dd L 
equivalent depth accounts for convergent flow toward 

drain 

d10 L grain size that is 10% finer by weight 

d60 L grain size that is 60% finer by weight 

Ε F/L
2
 Young's modulus 

Fa L depth of precipitation that infiltrates 

f(t) L/T infiltration rate as a function of time 
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fc L constant infiltration rate 

f0 L initial infiltration rate 

f(x) dimensionless Fisher distribution for fracture orientation 

g L/T
2
 gravitational acceleration 

γ and υ  L lower and upper fracture length cutoff values 

h L head 

hb L user defined general head boundary 

hd L user defined drain elevation 

ho L observed head 

hp L model predicted head 

h0 L initial water level in permeameter test 

Ha L average height of water table above drains 

Hm L height of water table midway between drains 

la L amount of rainfall that occurs before runoff 

lm L minimum depth to water table between drains 

lmin L power length cutoff 

K L/T 
hydraulic conductivity in isotropic medium (Kx = Ky = 

Kz) 

Kc F(L
0.5

/L
2
) fracture toughness 

Kd L/T hydraulic conductivity of drain and its envelop material 

Ki L
2
 intrinsic permeability 

Kx L/T horizontal hydraulic conductivity in the x-direction 

Ky L/T horizontal hydraulic conductivity in the y-direction 

Kz L/T horizontal hydraulic conductivity in the z-direction 

K1 L/T horizontal hydraulic conductivity above drain 

K2 L/T horizontal hydraulic conductivity below drain 

k 1/T decay constant for infiltration rate 

κ dimensionless dispersion coefficient 

L L length in the direction of flow 

Le L Length of screened portion of well 

Ld L drain spacing for flat land surface 

Ld
*
 L drain spacing for sloped land surface 

Lf L horizontal fault trace length 

M M mass of the control volume 

µ F T/L
2
 dynamic viscosity 

N dimensionless raio of geologic offset to short-term slip 
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n dimensionless porosity 

P* M/LT
2
 pressure 

P  L depth of precipitation 

Pe L depth of excess precipitation for runoff 

Q L
3
/T flow rate 

Qb L
3
/T general head boundary flow rate 

Qd L
3
/T drain flow rate 

qx,qy,qz L/T 
flow per unit cross sectional area in the x, y and z 

directions 

R L/T recharge rate 

Re L 
effective radial distance of at which head is dissipated 

in a slug test 

r L radial distance from pumping well to a monitoring well 

rc L radius of well in slug test 

rd L radius of drain and envelope material around the drain 

rw L 
effective radius of well and gravel pack around the 

well 

ρw M/L
3
 water density 

rmse L root mean squared error 

S dimensionless storativity 

S' L maximum potential storage in basin 

S* L/L slope of land surface 

Sb L/L slope of impermeable layer 

Ss 1/L specific storage 

Sy dimensionless specific yeild 

σ L drawdown, also shown as ∆h 

σd F/L
2
 shear driving stress 

σy  ? yield strength of the rock at the fault tip 

σ1D, σ2D 1/L ratio of total number of fractures to transect length 

T L
2
/T transmissivity 

t T time 

t0 T initial time 

v L/T velocity of water 

VT L
3
 total volume of soil 

Vv  L
3
 volume of voids in soil 

VKA dimensionless ratio of Kx to Kz 

υ ? Poisson's ratio of the rock mass 
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w L width of geologic strata 

W(u) dimensionless well integral 

z L elevation of water level 
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Appendix	B	

MODFLOW	Tutorial	Using	Groundwater	

Vistas	Graphical	User	Interface	

A step-by-step guide to create a model describing translational failure is provided as a tutorial for a 

beginning groundwater modeler.  The site used as an example is described in chapter 7 (section 7.5.3) 

with reiteration here for ease of manual use. Groundwater Vistas (GWV) is the graphical user interface 

used to create input and output files necessary for MODFLOW implementation, as well as the display 

and analysis of modeled water levels.  Groundwater modeling begins with a conceptual model, includes 

setting up the model domain, finite difference grid, adding boundary conditions and stresses and 

integrating with geotechnical analysis. The tutorial on what menus to access for importing/exporting 

data, visualization and analysis are presented in detail with screen captures, and formatting 

requirements for GWV upload and download.  Modeling is done with and without calibration, and 

includes an introduction to sensitivity analysis as well as auto-calibration.  

B-1 Site Description 

Translational failure (site D) is modeled using the topography shown in Figure B.1 .  Slopes are relatively 

constant from the peak to the base of the slope at approximately 28% (16°).  The system contains two 

geologic layers. Layer 2 is a permeable layer that is 20 ft thick and overlies layer 1 overlying a low 

permeability unit.  The lower unit is assumed impermeable. 

 

 

 

 

 

 

 

 

Figure B.1 Site D topography for 

translational failure (a) hill shade, (b) 

cross sectional profile of land surface 

from D-D’.  

(a) 

(b) 
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B-2  Model Domain and Conceptual Model 

The model domain encompasses the entire watershed to eliminate the need to designate water flux 

across boundary conditions (Figure B.2).  Water entering the system is assumed to only occur from 

precipitation, with all water flowing toward the watershed outlet at the lowest elevation.  Figure B.3 

shows the MODFLOW grid placement in plan-view and a cross section of the model along d-d’.  Cell size 

is 5 ft by 5 ft and a single homogenous unit is modeled at 20 ft thick.  The model grid is orientated 27° so 

that modeled rows run parallel to the slope 

 

 

( 

Figure B.2  Site topographic map showing land 

surface elevation at 5 ft intervals. Gray circle 

represents watershed outlet, while thick black line 

delineates the watershed.  

 

 

 

 

 

 

Figure B.3: Model grid for translational 

failure site. (a) plan view showing modeled 

grid (purple box),  active cells in color scale 

of assigned land surface elevations, rotated 

x-y axis and cross section d-d’. cell 

dimension is 5 ft by 5 ft. (b) Cross section d-

d’ depicting single layer model (thickness of 

layer is 20 ft) as well as no flow cells and 

specified head cells. (c) Four-layer model 

used to test anisotropy (VKA) on drain 

design where VKA = Kx/Kz.Recharge is 

applied evenly across modeled domain. 
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B-3 Steady State Model (Isotropic Conditions) 

To build a steady state model one will need to define: grid location and cell size, model domain, land 

surface elevations, bottom elevations, initial heads, hydraulic conductivity, as well as boundary 

conditions (e.g. recharge, specified heads). 

B-3.1 Model Grid and Domain 

Open GWV. 

To begin a new model, press File->New  

A menu will pop up to initialize the model grid. Fill out the boxes as shown below. The grid is rotated 27 

degrees so that model rows are parallel to flow.  Grid spacing is set at 5 feet in the x and y directions and 

the origin of the grid is established to line up with the coordinate system of LIDAR elevation data 

collected at the site: X = 1336130, Y = 196375.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Go to Grid->Options… 

In the Grid Display Options dialogue check the box ‘display Site Coordinates When Tracking Cursor. 
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To import shapefiles defining regional contours of the land surface at the site, go to File->Map-

>Shapefile.  Navigate to import_files\shapefiles\siteD_contours.shp. Hit the ‘open’ key.  
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GWV will then ask you to provide a location for the corresponding map file it will produce from the 

shaptefile.  Navigate to to import_files\maps\ and call the file siteD_contours.map and hit ‘Save’. Save 

the color of the contour shapefile to any color you want using the drop-down menu.  For this example, 

green is chosen. Press ‘OK”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

If necessary, you may need to hit ‘zoom to full grid’ button  to scale the grid back to the full screen. 

Or you can hit  to zoom in or  to zoom out.  To change the thickness of the shapefile lines, you 

can go to Plot->Map Overlays…and use the drop-down to thicken the lines. Lines are thickened to 0.75. 

This shapefile is imported to provide you some reference of the grid’s location in the landscape. 

To import the model domain shapefile (built using land surface contours to isolate contributing 

watershed area (refer to Figure B.2), repeat the same procedure as for contours.  Navigate to 

import_files\shapefiles\siteD_domain_polys.shp and create a map file under 

import_files\maps\siteD_domain.map. Choose the color ‘blue’ and thicken the lines to 0.75. 
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The shapefiles and grid should look as follows. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Save your GWV file to sited\noCALIB\SS\ and call the file SS_noDRN.GWV 

A prompt will ask to change all root file names. Click ‘Yes’ and repeat the name SS_noDRN under 

MODFLOW Root File name. Press ‘OK”. 
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To set up MODFLOW, first it is necessary to set up a path to the directory you want files written.  Go to 

Models->Paths to Models… 

 

 

And in the Working Directory browse to the location sited\noCALIB\SS\. Highlight the GWV file 

SS_noDRN and click “Open”, then click “OK”. 
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Zoom to full grid .  

 

 

 

B-3.2 Top and Bottom Elevations 

To import land surface elevations, LIDAR for the modeled domain is imported as an XYZ data file and 

interpolated. Make sure the properties dialogue is on ‘Top Elevation’. This can be done by going to Props 

->Top Elevation, or by using the drop-down menu as shown below and highlighting Top Elevation. Your 

grid will become a solid red color, with a default top elevation currently set at 100 feet.  
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Once the dialogue says ‘Top Elevation’, go to Props->Import->Text XYZ. 
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Browse to sited\import_files\data\siteD_LIDAR.dat 

 

 

 

The format of the text file looks as follows, 
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With column 1 = X, column 2 = Y and column 3 = land surface elevation.  GWV allows flexibility in text 

file format, with the user telling GWV what each column of data represents.  For this example, fill out 

the import XYZ dialogue as follows. Feel free to view the text file using the button on the right side of 

the dialogue box and make sure the box ‘File contains site coordinates’ is checked. 

 

 

In the bottom left hand corner of the screen the Matrix Top should now show interpolated elevations. 

 

Next it is necessary to assign bottom elevations. This is done by switching the property box to Bottom 

Elevation  
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Re-import the top elevations as just done. Cell thickness is 0 ft thick. Go to Props->Property Values-

>Matrix Editor and hit the “Math” button and fill out the dialogue as shown below to force the bottom 

elevation to 20 ft below the land surface elevation, and hit “OK”.   

 

If a thicker/thinner geologic unit is 

desired, then change the value 

subtracted. 

 

 

 

 

 

 

B-3.3 Initial Heads 

For steady state simulations the initial 

heads are not important, but should be 

above the bottom of the cell to avoid 

numeric instabilities caused by cells 

going dry. Therefore, a starting head is 

equal to land surface (or top of layer 1) 

is a good initial guess. Go to Model-

>MODFLOW->Package Options… and 

in the initial heads tab, use the drop-

down menu to set initial head location 

to “Use Top of Layer 1” and unclick the 

“Surfer File.  Click “Save Starting Heads 

to Initial Heads Property Next Time 

MODFLOW files are created”. 
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Now switch to the Basic tab and make sure “Steady State Simulation” is checked and change length units 

from “Undefined” to “feet”. 

 

 

B-3.4 Hydraulic Parameters 

Go to Props->Options… and make sure that Hydraulic Conductivity and recharge are not checked under 

“Use Matrices”. If they are checked, then uncheck. 

Switch the properties box to Hydraulic Conductivity 

 

Go to Props->Property Value->Database… 

Change the number of zones to 1 and hit “Update”. Place a value of 1 ft/d in the Kx, Ky and Kz box. And 

hit “Apply”. If a different hydraulic conductivity is desired, then use a different value than 1 ft/d. 
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For steady state simulations it is not necessary to parameterize storage terms. For a one layer model, its 

not necessary to parameterize leakance. These terms will be defined in later examples. 

 

B-3.5 Boundary Conditions 

It is now time to define boundary conditions. For this example, 

boundary cells of no-flow, constant heads and recharge are 

specified. 

 

First no-flow cells will be defined. Go to BC->No-Flow 

 

Or toggle the BC window to Noflow  
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Go to BC->Import->Shapefile… and navigate the browser to 

sited\import_files\shapefiles\siteD_domain_polys.shp 

Click ‘No” to the next two questions. Cells outside the domain are assigned as no-flow cells. 

 

Constant heads (CHD), also known as specified heads, are assigned to the low elevation cells on the right 

hand side of the modeled domain.  They are set at 1 foot below land surface.  Switch the BC box from 

Noflow to Constant Head. 

 

A text file is created defining CHD values.   

 

As with land surface elevations, the format of the text file is flexible and defined using the import box. 

 

To import CHD values go to BC->Import-

>Text File… 

Browse to 

siteD\Import_files\data\siteD_chd.dat 

The number of lines to skip = 1 and 

head is made a constant value. 
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Click on the Coordinate Data... button and fill in as follows. 

 

Under the Boundary Data… assign the ‘Column Containing Head or Q’ to 4,  
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Hit “OK” twice.  To modify head values use BC->modify->simplified editing.  Review the GWV manual for 

other ways to import or create constant heads. 

The last boundary condition to define is recharge. For this example, open the excel file under 

design_storms\percentage recharge.xls 

Listed in Table 5.5 are recharge values, percentage recharge and storm maximum recharge rates based 

on curve numbers (CN) and total precipitation for a 24-hour period.. For this example, the following 

information is used 

Inches of rain in a 24 hour period = 11 

Curve Number = 80 

Rainfall distribution = IA 

Therefore the assumed percentage of recharge is 18%. 

Using an example of average total annual precipitation of 35 inches and 18% recharge is 6.3 inches/year 

or 0.0014 ft/d.  This is the estimated steady state recharge. 

In the properties dialogue highlight recharge  

 

Go to Props->Property Values-

>Database… 

Change the number of zones 

from 10 to 1 and hit “Update”. 

In zone 1 type 0.0014 and hit 

“Apply”.  Then “OK”. 
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The model screen should look similar to the image below. 

 

 

B-3.6 MODFLOW-NWT 

Since unconfined solutions are highly 

non-linear the new MODFLOW-NWT 

solver should be used. 

Under Models->MODFLOW… change the 

Model Version from MODFLOW2000 to 

MODFLOW2005 and click “OK”.  
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Under Models->MODFLOW2005->Packages… check the box “Use Upstream Weighting Package (UPW) 

and Newton Solver (NWT) Instead of LPF. Click “OK”. 

 

 

Go to Models->MODFLOW2005->Options…  

 

Toggle to  the NWT General tab, change “MODERATE” to “COMPLEX”, and check “Use Residual Control 

(BACKFLAG)” and check “Correct Heads Surrounded by Dewatered Cells (IBOTAV)”. Change the FLUXTOL 

from 100 to 1, and MAXITEROUT from 100 to 3000, as shown below. Then click “OK”. 
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To turn off the plotting of contour and domain shapefiles go to Plot->What to Display… and click on 

“Maps…”. On the drop-down options set to “Do Not Draw”. Click “OK”. Before exiting the graphics 

dialogue click “Display Color Flood of head”. 

Save the model prior to execution. 
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B-3.7 Model Execution 

To run MODFLOW hit the  button. Click “yes” to create Data files first?” and “Yes” to “Display Error 

File” if desired. 

The model will run very quickly and will ask to process results. Click “Yes”. The path to the head file is 

defined by the path established earlier and automatically imported. The CCF budget file is not 

automatically imported. It is necessary to click this box to view the flow budget. Go ahead and click the 

Cell-by-Cell Flow 

 

 

The default contour fonts are very small and can be adjusted to preference of the user by going to Plot-

>Contour->Parameters (Plan View)… Change the minimum Level to 215, the Interval to 5. Change Label 

every N to 1 and Percision to 0. Font can be made to 18 point and the color and thickness of the contour 

label line information set to black and 1/3 point. Click “Do not change levels” 

Hit “OK”.  
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Make sure head contours are displayed by going to Plot->What to Display… and making sure ‘Display 

Contours of Head” and “Display Color Flood of Head” are checked. Other variables can be mapped by 

using the drop down menus.  
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If you cannot see the color contours, then it is necessary to change from Property view  to any other 

view (e.g. ,  or ) 

Color flood is defined under Plot->Color Flood->Color Flood Options… The minimum value is set at 215 

and the maximum is set at 315. 
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Flooded cells are plotted automatically, unless one unclicks the box under to Plot->What to Display…To 

establish the color of flooded cells, go to Plot->Dry/Flooded Cells… and pick Flooded Cell color.  The 

color pink is chosen since it’s a color not used in the color scale for heads and easy to visualize. 

 

 

Screen output should look similar to the image below, with the cross sectional view for row 30.  

Contours are at 5 ft intervals.  One can toggle across rows and columns and layers (if more than one 

layer) by using the options to the left of the display. 
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Save the model. 

 

B-3.8 Steady State Calibration 

Often the steady state model is used to calibrate hydraulic conductivity to best match observed water 

level data.  Low precipitation months (e.g. end of summer) are most representative of the steady state 

scenario and data collected during these time periods should be used if available.   

Save the model created above in the following location, 

siteD\CALIB\SS_noDRN\SS_noDRN_Calib.gwv 

Rename the MODFLOW Root Names SS_noDRN_Calib. 

Reassign the working directory by going to Model->Paths to Models… and browsing to 

siteD\CALIB\SS_noDRNsited\ and press “OK”. 

The text file defining observed targets looks like the following 
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To import observed data go to AE->Import->Target Text File… and navigate to 

siteD\import_files\data\SS_noDRN_obs.dat, click “OK”. 

 

 

An “Options for Importing Targets” dialogue opens with an option to view the file if desired. Fill in the 

dialogue as shown below. 
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The default size of targets is 100, which is too large for this domain. To scale the target symbol, go to AE-

>Modify->Targets->Display Options… and change the size of target to 15. 

The location of the observation sites, or targets, is shown below, 
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Assuming Kx and Ky are still at 1 ft/d, rerun the model in its current directory and import results. To see 

how well the model reproduces observed water levels go to Plot->Calibration->Statistics/Plots.  
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In the dialogue box press “Plot Observed vs. Simulated”. And the chart given below will appear showing 

modeled water levels predicted lower than two of the three observed values.  The ‘Statistics…’ button 

on the same dialogue box will produce the statistics shown with a rmse = 5.06 ft, and a scaled rmse of 

7.3%.  
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Often a sensitivity analysis is performed before calibration to determine which parameters are most 

influential on model output. For our example, recharge rate and hydraulic conductivity are tested. 

Go to, Model->Autosensitivity->Options… 

It is now necessary to produce a script that GWV will use to run different model realizations.  First, the 

parameter Kx=Ky is the default parameter to modify. Leave this as is.  Change the Number of Simulations 

to 6. Then Press the “Multipliers...” button to see the default multipliers used to modify the current K 

values.  Modify these multipliers to 0.1, 0.5, 1, 2, 5, 10.  Press the button “New Script”, with a default 

name of “sens.in”. Press “Open” and then press “OK”. 

Now switch the “Parameter to Modify” to Recharge via the drop-down menu.  Keep the number of 

simulations at 6 and the same multipliers as used for hydraulic conductivity. Press “Add to Script”. Press 

“OK”. 

 

Press the button “Edit Script”. The script should look like the following. If it does not, then edit to be 

similar. 

 

 

Click the “Run from Script” box and browse the Script File Name to the sens.in  wasjust created.  The 

default Output file name is sens.in.out. Leave as is. 

Press “OK” to exit the dialogue and go to Model->Autosensitivity->Run Analysis. The model runs very 

quickly and should only take a few moments to run all 12 simulations. 
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To see results go to Plot->Sensitivity->sum of squared residuals 

The graph should look similar to that shown below.  Interestingly, modeled water levels are relatively 

sensitive to hydraulic conductivity for values less than 5 times the K value of 1 ft/d, or 5 ft/d, above 

which sensitivity decreases.  The minimum rmse value occurs when Kx =0.5 ft/d. Recharge is relatively 

insensitive to a multiplier greater than 5.0 (0.007 ft/d) with sensitivity increasing exponentially for 

smaller recharge rates.   

 

 

If uncertainty in parameter values is limited to hydraulic conductivity, then calibration is limited to 

adjusting hydraulic conductivity and assuming recharge is properly parameterized.  This can be done by 

manually adjusting Kx, or using automated inverse models provided by GWV.  PEST is provided with 

GWV and is considered one of the most robust parameter estimation tools for many groundwater 

problems.  For this example, we will use PEST to help us calibrate Kx to best match water levels. 

Go to, Model->PEST-> Parameters 
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And fill out the dialogue as follows, letting the range in Kx vary between 0.001 and 100 ft/d.  The search 

is run in log-space, since hydraulic conductivity can vary over several orders of magnitude. 

 



 
288 

Hit “OK” 

Now it is time to create the PEST input files and check that all files are properly created.  To do this, go 

to, Model->PEST->Create Date Sets, view the Error/Warning file to ensure no errors were created.  

Then Model->PEST->run PESTCheck, and finally, Model->PEST->run PEST. 

When PEST is complete, the optimized value for hydraulic conductivity can be uploaded into GWV by 

going to, Model->PEST->Update Parameters. 

This is checked by having Hydraulic Conductivity toggled, 

  

And going to Props->Property Values->Database and seeing that Kx = 0.22956 ft/d.  

 

Rerun the model by clicking on the . The Plot->Calibration->Statistics/Plots->View Statistics, shows 

that the scaled rmse is reduced to 0.5%. The steady state calibrated Kx will serve as an initial guess in the 

transient calibration. Modeled heads are given below, with some groundwater seepage in the toe region 

(pink overlay). 
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B-4 Transient Conditions (Isotropic Conditions, Pre-Drain) 

Save the model created above in the following location, 

siteD\CALIB\Tr_noDRN\Tr_noDRN_Calib.gwv 

Rename the MODFLOW Root Names Tr_noDRN_Calib. 

Reassign the working directory by going to Model->Paths to Models… and browsing to 

siteD\CALIB\Tr_noDRNsited\ and press “OK”. 

 

B-4.1 Stress Period Set Up 

The model must be converted from steady state to transient with the appropriate time steps and length 

of stress periods provided.  The first stress period represents steady state conditions, and the remaining 

are transient.  The length of the steady state stress period does not matter, while each transient stress 

period is 0.25 days (or 6 hours). 
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Go to, MODEL->MODFLOW->Options and in the Basics Tab unclick the steady state simulation box and 

change the number of stress periods to 705 and hit “OK”. 

 

 

GWV will ask to copy recharge, hit Yes, and ET, hit Yes (this will be overwritten later). GWV will then ask 

to set up the new stress periods. Hit Yes. 

From the Stress Period Data dialogue box, hit import, and browse to 

siteD/import_files/data/sp_705.dat.  If you cannot see this file, then make sure that text files are 

viewed, not just cvs files. The stress period data dialogue box should look like the one shown below. The 

format of the stress period input file must be as follows: stress period length, number of time steps and 

time step multiplier. 
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GWV will ask if you want to check that the type of stress periods is properly set. Click Yes.  The first 

stress period should be steady state, or set to zero. All other stress periods are transient and should be 

set to 1. 

 

 

B-4.2 Observation Wells 

The same observation wells used in the steady state simulation are used in the transient simulation. But 

observation data must be imported for the transient simulation.  This will be done for each individual 

well.  Observation data needs to be in the following format: time of observation (e.g. days in simulation) 

and observation well water level.  Observation well 1 is located in the upper portion of the slope.  

Double click on this well, with  toggled. Unclick the box that says “Target is steady state”. And then 

click on the Import… button.   
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Browse to siteD/import_files/data/wl01.dat. Make sure that all text files, not just cvs files can be 

viewed.  Click on the Transient Data… button and 55 data points should be imported. 

 

Repeat for well 2 (middle of the basin, wl02.dat) and well 3 (toe of the basin, wl03.dat). 
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B-4.3 Recharge 

Six hour precipitation and calculated recharge values are provided in Figure 7.58.  To import recharge 

values, make sure recharge property is toggled. 

 

Then open Props->Import->Transient Data by Zone… 

 

Browse to siteD/import_files/data/rch_cn90.txt.  If you cannot see the file, then double check that all 

files (*.*) are visible.  The recharge data file must have the following format: stress period number and 

recharge rate. 
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GWV will ask if the File Contains Data for Multiple Zones. Click No. Then GWV will ask if the recharge 

pertains to zone 1. Click OK.  

B-4.4 Storage Parameters 

Unlike the steady state simulation, transient simulations require storage parameters to be defined.  

Toggle the properties box to Storage|Sy|Porosity 

 

Then go to, Props->Property Values->Database.  Change the number of zones to 1 and hit ‘Update’. 

Water Table elevations are not sensitive to specific storage, Ss, and this parameter is set to a commonly 

used value of 10
-4

.  Porosity values are only defined for transport simulations and so do not need to be 

specified.  Specific yield, Sy, is an important parameter and with no knowledge, Sy it is set to 0.1 (or 10%) 

for the initial run.  Calibration of Sy will occur by adjusting Sy to help match observed water levels. Hit 

OK. 
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B-4.5 Model Execution. 

To run MODFLOW hit the  button. Click “yes” to create Data files first?” and “Yes” to “Display Error 

File” if desired. The model will take much longer to run than the steady state version as 705 stress 

period must be solved.  Once the simulation is done, GWV will ask if you want to process the results. 

Click Yes, then hit OK. The water levels visualized will automatically be for the last stress period. If you 

want to bring in a different stress period, then adjust the dialogue box to reflect the stress period 

desired. This can also be done by clicking on  and switching the stress period from 705 to the desired 

stress period.  The  will bring in the previous stress period water levels, while  will bring in the 

water levels for the next stress period. 

There are several ways to compare water levels.  One can go to Plot->Hydrograph->Target and then 

specify the well that is desired to view. Or one can double click on the observation well and then click 

“graph”. For water levels in well 3, 
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Data can be exported as a data file by right clicking on the graph and exporting, 

 

Results show that the computed water level for well 3 is too low compared to observed values. 

For well 2, water levels show a muted response to recharge, indicating that Sy is too high. 
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B-4.6 Transient Calibration  

Prior to calibration, it is often informative to run a sensitivity analysis. Since the sensitivity analysis is 

done using multipliers, K is set back to a value of 1 ft/d and Sy is kept at 0.1.  The sensitivity script is set 

up similar to the one used in the steady state simulation. 

Go to, Model->Autosensitivity->Options…and unclick ‘run from script file (if its still checked from the 

steady state simulation). 

It is now necessary to produce a script that GWV will use to run different model realizations.  First, the 

parameter Kx=Ky is the default parameter to modify. Leave this as is.  Change the Number of Simulations 

to 11. Then Press the “Multipliers...” button to see the default multipliers used to modify the current K 

values.  Modify these multipliers to 0.1, 0.2,0.5, 1, 1.5,2,2.5,3, 5, 10.  Press OK. Press the button “New 

Script”, with a default name of “sens.in” in the directory CALIB\TR_noDRN\.. Press “Open” and then 

press “OK”. 

Now switch the “Parameter to Modify” to Specific Yield via the drop-down menu.  Change the number 

of simulations at 6 and then click the Multipliers… button.  Change the multipliers to 0.1, 0.2, 0.5, 0.7, 1, 

2.  The largest Sy tested is therefore 0.2.  Press “Add to Script”. Press “OK”. 

Press the button “Edit Script”. The script should look like the following. If it does not, then edit to be 

similar. 
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Click the “Run from Script” box and browse the Script File Name to the sens.in  wasjust created.  The 

default Output file name is sens.in.out. Leave as is. 

Press “OK” to exit the dialogue and go to Model->Autosensitivity->Run Analysis.   

Once all 17 simulations are done, GWV will ask to plot results and open the file sens.in.out and plot the 

sum of squared residuals.  Another way to see results is to go to, Plot->Sensitivity->sum of squared 

residuals.   

The scale for SSR is not good in comparing Kx and Sy.  To improve, right click on the graph and then hit 

“properties”. On the Y-Axis tab, change the type from arithmetic scale to logarithmic scale and change 

the minimum Y to 1000, as well as click the box for Automatic Minimum and Automatic Maximum. 

Change the number format to POWER 
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Results for the transient sensitivity are shown graphically below. 
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Sensitivity shows that Kx minimizes the SSR at 0.2 ft/d, while Sy also minimizes SSR at 0.2. Water levels 

are relatively insensitive to a multiplier of 2 for Kx (Kx ≥ 2ft/d), and sensitivity to Sy is less than for Kx.  

This is seen with only small changes in SSR with change in multiplier.  

Auto-calibration is done using PEST and is similar to that done with the steady state scenario, but no 

calibration will include Sy.  The initial guess of Kx will be set at the steady state value of 0.22956 ft/d. Go 

to Props->Property Values->Database and change 1 ft/d to the steady state value.  From the sensitivity 

analysis, Sy = 0.2 produced the less error. Change the Sy value from 0.1 to 0.02.  The better the initial 

guess, the quicker PEST will converge on the calibrated values. 

 

Go to, Model->PEST-> Parameters 

 

 

Keep the search range for Kx the same as for the steady state simulation.  However, add Sy and allow Sy 

to vary between 0.001 and 0.35.  The dialogue box should look similar to the one shown below. 
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Hit “OK” 

Now it is time to create the PEST input files and check that all files are properly created.  To do this, go 

to, Model->PEST->Create Date Sets, view the Error/Warning file to ensure no errors were created.  

Then Model->PEST->run PESTCheck, and finally, Model->PEST->run PEST. This may take a little while and 

is a good opportunity to get a cup of coffee. 

When PEST is complete, the optimized value for hydraulic conductivity can be uploaded into GWV by 

going to, Model->PEST->Update Parameters. Calibrated parameters: Kx =0.2547 ft/d, Sy =0.02404. 

Rerun MODFLOW with the updated parameters.  Calibrated results provide a rmse = 2.26 ft and a scaled 

rmse = 3.1%.   

Plots of calibrated water level for each of the three observation wells are given below.  Modeled results 

do not perfectly match observed data, but system response to recharge events is well mimicked. 
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Save the model. 



 
303 

B-5 Design Storm (Isotropic Conditions) 

Save the model created above in the following location, 

siteD\Design_Storm\Design_Storm_noDRN.gwv 

Rename the MODFLOW Root Names Design_Storm_noDRN. 

Reassign the working directory by going to Model->Paths to Models… and browsing to 

siteD\Design_Storm\ and press “OK”. 

The design storm is the 100 year, 24-hour event.  Calculated recharge is formatted as stress period, 

recharge (ft/d) as given below in data file 100yr_cn80.dat with 23 stress periods. 

 

 

Go to Model->MODFLOW->Package Options… and on the ‘Basics Tab, change the number of stress 

periods to 23 and click Yes, and OK.  Disregard the last message.  
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Next the stress periods need to be redefined for the 100 year event. Go to Model->MODFLOW->Stress 

Period Setup… 

Hit the Import… button, and browse to siteD/import_files/data/sp_100yr.dat.  The Stress Period Data 

dialogue box should look like the following. 
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Hit OK to exit. 

Toggle the properties box to recharge 

 

Then open Props->Import->Transient Data by Zone… 

 

Browse to siteD/import_files/data/100yr_cn80.txt.  If you cannot see the file, then double check that all 

files (*.*) are visible.  Hit “No” and “OK”. 

A graph of the recharge rates are provided below. 



 
306 

 

 

To use the same observation wells, it is necessary to remove the observed data pertaining to the 

transient run just completed.  Double click on any one of the observation wells, then click on the 

“Transient Data…” button.  Change the number of observation times to 1 and hit update.  Change the 

time listed for the observation to 1. The steady state stress period occurs on the first day. 
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Repeat this for the other two observation wells. The observation, or target value, is not important, other 

than 1 value is needed to see model results without changing the target to a monitoring well (with no 

data).  

 

Save the model. Then hit  and hit Yes to building the new files. After model execution, import stress 

period 23.  Review of water levels in each of the observation wells shows that the highest water levels 

occur on stress period 23 for the upper basin, and stress period 11 for the slope toe.   

 

Hit  and import stress period 11. 
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Modeled heads should look similar to the figure below, 

 

To see modeled heads in a spread sheet go to Plot->View Results in Spread Sheet…. Results can be 

copied and pasted to a spread sheet application of choice (e.g. Excel, etc). 
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Row 28 is highlighted. This is the row used for slope stability analysis. Values of 999.0 are dummy values 

used by MODFLOW to signify a no-flow cell.  Heads are not predicted. 

Save the model 

Now to install drains. Save the model with a new name but in the same directory, 

Design_Storm_DRN01. Hit Yes, and change the MODFLOW Root File Name to Design_Storm_DRN01. Hit 

OK. 

Toggle the boundary condition to Drain. 

 

Then go to BCs->Import->Text File… 

 

And navigate to siteD/import_files/data/drn01_siteD.dat. The data file looks like the following, 

 

The number of lines to skip = 2 and the box allowing overlapping boundary conditions needs to be 

checked. 
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Now press the Coordinate Data… button and fill out as follows, 

 

 

Hit OK.  Now hit the Boundary Data button and fill out as follows, 
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Then hit OK.  Now hit the Conductance… button and fill out the dialogue box as follows, where Hydraulic 

Conductivity of the drains is set to the calibrated value. Length is given in column 5. Hit OK when done 

and hit OK once more to import the drain data.  
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60 boundary cells should be imported.   

To change boundary condition parameters, such as hydraulic conductivity of the drain cells, it is best to 

go to BCs->Modify-> Simplified Editing…. 

 

To import either a shapefile, or a GWV map file of drain array 1, go to File->Map->and choose format for 

import.  For purposes of this example, choose GW Vistas…. 
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And browse to siteD/import_files/maps/drn01_siteD.map.  To change the thickness of the drain lines, go 

to Plot->Map Overlays… and change line thickness to 1 pt. 

 

Now its time to execute the model. Save the model and then hit  and import stress period 11. 

Recontour water levels to 2 ft intervals by going to Plot->Contour->Parameters (Plan)… 
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And changing the contour interval from 5 ft to 1 ft, and label every 5
th

 contour To remove GWV shading 

of drain cells, go to Plot->What to Display… and unclick Display Boundary Conditions. Your model should 

look similar to the image below. 
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Save this model. 

Included in the sited\Input_data\ file directory are shapefiles, map files and text files for drain arrays 1 

through 13 for experimentation. 

B-6 Modeling Anisotropy 

B-6.1 Adding Model Layers 

In order to model anisotropy it is necessary to have more than one model layer.  For this site, four layers 

are modeled, each layer 5 ft thick.  To add layers to the model, take the Isotropic transient model with 

no drains (siteD\CALIB\TR_noDRN\Tr_noDRN_Calib.GWV) and copy to a new directory 

sited\CALIB\4L\Tr_4L_noDRN_Calib.gwv.  

Hit Yes, and rename the MODFLOW root file names to, Tr_4L_noDRN_Calib and hit OK.   

Go to Model->Paths to Model and browse the working directory to the location the GWV file was just 

saved. 

 

To add layers to the model, go to Grid->Insert->Layer Above. The default is the new layer is 50% of the 

current layer (layer 1). Hit OK. 
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Do this one more time. There are now three layers.  Toggle the left hand Layer number to layer 3,

 

And repeat adding one more layer.  By adding layers above, the no-flow cells were copied to the new 

layers, but the constant head cells were not.  To copy CHD cells make sure that the boundary condition 

is toggled to Constant Head, 

 

And the left hand layer number is still set to 3. Go to BCs->Copy… and copy the BC from layer 4 to layer 

3. Hit OK. 

 

Toggle to layer 2 and repeat, then toggle to layer 1 and repeat. 

No it is necessary to define leakance.  Toggle the properties box to Leakance, 

 

Go to Props->Property Values->Database… and change the number of zones from 10 to 1 and hit 

Update.  Type in a value of 10 for leakance, and hit OK to exit. 
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No go to Model->MODFLOW->Model 

Options… and go to the BCF-LPF tab.  

Change Leakance Zones represents 

Leakance, and switch to Vertical 

Anisotropy.  Vertical anisotropy is the ratio 

of horizontal hydraulic conductivity to 

vertical hydraulic conductivity, or VKA. By 

setting VKA = 10, the vertical hydraulic 

conductivity is one order of magnitude less 

than horizontal hydraulic conductivity. 

Also make all layers unconfined.  Make 

sure that the storage coefficient is set to 

specific storage. 
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When the single layer model was re-discretized into four layers, the observation wells were 

automatically kept in the bottom-most layer (this is because layers were added above).  GWV 

observation points (i.e. targets) can only exist in one layer.  Water table elevations will be plotted in 

layer 1 when imported, therefore observation wells need to be moved from layer 4 to layer 1.  To do 

this, double click on an observation well, and change the layer number from 4 to 1. 

 

Repeat for the other two wells. Then save the model. 

New observation data is imported to each of the wells.  Data files are found in the 

sited\import_data\data\anisotropic_wl01.dat for the upslope well wl01, anisotropic_wl02.dat for the 

mid-slope well wl02 and anisotropic_wl03.dat for wl03 located in the slopes toe. To import, double click 

on the well, then click on Import and browse to data file location and hit OK. Do for all three observation 

wells. 

Hit the  button. Click “yes” to create Data files first?” and “Yes” to “Display Error File” if desired. The 

model will take much longer to run than the single layer model due to the additional model layers.  
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When the run is executed, make sure to click Contour Water Table in Layer 1.  This is because model 

layers will go dry and this contouring will allow one to use the spread sheet application in GWV to obtain 

a single 2D representation of the water table surface without having to export all water levels for all four 

layers. 

 

Using calibrated Kx and Sy parameters from the isotropic simulation water levels are modeled  
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B-6.2 Calibration of VKA 

Calibration of VKA is done manually.  VKA = 1, 2, 4, 6, 8, 10 and 20 are run independently.  To accomplish 

this, change the Leakance value from 10 to 1 in the Zone Database by toggling the property to Leakance, 

 

Then going to Props->Property Values->Database… 
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Then hit OK and then after each model simulation, go to Plot->Calibration->Statistics… 

Statistics on the sum squared error (SSE) and rmse are obtained by hitting the “Statistics…” button. 

Results are tabulated and graphed below, 

 

 

VKA SSE rmse (ft) rmse (%)

1 131 0.8 1

2 10.8 0.23 0.3

4 94.8 0.68 0.8

10 197 3.09 3.5

20 3280 3.98 7.8
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Data pertaining to the one-to-one regression are obtained by hitting the “Plot Observed vs. Simulated” 

button.  Data can be exported from the plot by right-clicking and assigning to a *.dat file.  Regression 

results are compared below. 

 

Regression statistics and one-to-one plots show that VKA = 2 produces the best comparison to observed 

behavior.  Variability is most evident at higher elevations in the basin, with increased VKA causing over 

prediction.  VKA = 1 produces nearly equal results to VKA = 2, except at the highest well (wl01), where a 

VKA of 1.0 (isotropic) slightly under predicts observed behavior.   
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Appendix	C	

Groundwater	Modeling	Example	-	Site	SR	

101	MP	69.8	

C-1  Site Description 

Demonstration site SR 101 MP 69.8 is located in western WA State with Figure C-1 pinpointing the 

location via Google Earth.  The surveyed map for the site is provided in Figure C-2, with 1 ft topographic 

contours provided.  Unfortunately, the site was not surveyed to the top of the hydrologic divide and so 

uncertainty does exist with respect to possible water flux across the model domain. The highway crosses 

the site about 2/3 from the top of the surveyed site 

and a creek defines the lower portion of the site. 

 

 

 

Figure C-1: Location of study site with respect to the 

state of Washington. 

 

 

 

 

Figure C-2: Site map 

with 1 ft elevation 

contours surveyed.  

SR 101 is mapped 

across the site as well 

as inferred ancient 

and active landside 

locations.  The creek 

defines the lower 

boundary of the site. 
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Figure C-3 provides a cross section of the site with well locations provided.  Geologically, the system 

consists mostly of disturbed claystone situated above intact claystone. Thickness of the geologic unit is 

approximately 100 ft.  The ancient landslide slip surface is located at the contact of the disturbed and 

intact claystone and marked with a dashed red line.  At the slope toe is a passive zone. This is assigned a 

separate hydraulic conductivity compared to the disturbed zone. 

 

 

Figure C-3: Cross section of site SR 101 MP 69.8.  A no-flow and CHD boundary are assigned to the 

edges of the site and the intact claystone is assumed impermeable. SR 101 is indicated as are several 

monitoring wells located at the site. 

C-2 Model Domain and Grid 

The model domain and grid are shown in Figure C-4. Cell dimension is 10 ft x 10 ft and wells are shown 

in plan-view.  

 

 

 

 

 

Figure C-4: Model grid with well 

locations and CHD marked. 
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C-3 Modeling Strategy 

The modeling sequence for MP 69.8 is shown in Figure C-5.  A slightly more advanced iterative approach 

to calibration is done for pre- and post - drain scenarios. 

 

 

Figure C-5: Modeling sequence used for MP 69.8.  

 

C-3.1 Steady State Conditions 

Steady state conditions for pre-drain water conditions in four wells is done by adjusting the hydraulic 

conductivity in the disturbed claystone to 0.46 ft/d and in the passive zone in the slope toe to 0.6 ft/d.  

Steady state recharge is estimated at 0.00924 ft/d, to represent the average computed recharge 

between years 2005-2007.  A regression of observed and predicted steady state water levels is given in 

Figure C-6, with an rmse = 0.33 ft. 

 

C-3.2 Transient Conditions 

Transient simulations are defined as pre-drain, and post drain. Figure C-7 shows water levels in various 

drains along with a timeline of when emergency drains were installed in upper slopes of the site during 
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the winter of 2006, as well as when non-emergency drains were installed in the slope’s toe region 

(summer of 2006).   

 

 

Figure C-6: Pre-drain steady state water levels. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure C-7: Water levels for various monitoring wells located in site MP69.8.  Modeled time periods 

are indicated as “pre-drain” and “post drain”.  The post drain period represents both emergency and 

toe drains.  
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The pre-drain scenario was used to calibrate the storage terms Ss and Sy to 0.003311/ft and 0.045, 

respectfully to best match 2005 water levels in H-1A-05. Figure C-8 shows observed and predicted water 

levels.   

 

 

Figure C-8: Observed 

and predicted water 

levels for well H-1A-05 

for the pre-drain 

scenario. 

 

 

 

Drain layout with wells marked is given in Figure C-9. Modeled water table elevations are provided for 

the first stress period that is run to steady state in order to get water levels a function of drain layout.  

Emergency drains are located in the upper portion of the basin (above and just below the highway), 

while the landslide toe drains originate at the bottom of the slope. Drain specifications were provided by 

the geotechnical report; however, many of the elevations of drain are only approximate.  

 

 

 

 

 

Figure C-9: 2010 post 

drain scenario 

showing steady state 

water levels at the 

start of the 

simulation.  Well 

locations are 

indicated. 
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Steady state conditions are assumed in the summer of 2010, prior to significant rainfall on the site.  

Uncertainty in drain elevations and lack of knowledge of drain conductance allowed the adjustment of 

these parameters to help match summer water levels.  The former was adjusted to lower the rmse in 

predicted water levels while Cd was adjusted to best match observed drain flow (Cd = 9.0f ft2/d). 

MODFLOW simulated drain flow is unable to capture lags in system since unsaturated flow is not 

accounted for and recharge is assumed to occur immediately with precipitation.  In addition, drains do 

not always flow with stored water, while MODFLOW tracks all water entering the drain as drain flow at 

the moment it enters the drain system, not necessarily what exits the drain pipe at the tip of the cluster.  

However, trends in drain flow are captured as is overall water balance aspects.  In addition, calibrated 

hydraulic conductivity was used as an initial guess in the new simulation.  Results indicate little change 

in K values. 

Predicted water levels are provided in Figure C-10 and show that greater response in water levels is 

predicted than observed.  This is believed a result of not including unsaturated flow in the model, which 

may mitigate water levels as water percolates through the vadose zone during small rain events.  

Therefore model results are likely a “worst” case scenario of water level response for relatively thick 

geologic strata, but may be more indicative of water levels for thinner geologic layers (i.e. 20 ft as 

demonstrated in Chapter 7).  Model results oscillate about observed values and are considered 

adequate for modeling purposes.  

 

 

Figure C-10: Transient water levels for post drain scenario 2010. 
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C-4 Design Storm 

The design storm is based on the 100-year 24-hour total precipitation of 6.5 inches based on NOAA atlas 

2 (1973, http://www.wrcc.dri.edu/pcpnfreq.html).  The groundwater model is initiated with steady state 

conditions prior to the storm using the drain layout shown in Figure C-9.  The rise in water levels is 

compared to steady state conditions.  The model is run for a total of two weeks to monitor how water 

levels recede after the 24-hour storm event.  Modeled water levels for each of the monitoring wells is 

given in Figure C-11. 

 

 

Figure C-11: Predicted water levels at the four monitoring wells for the 100-year design storm.  

Rising water levels are compared to steady state conditions computed with steady state recharge.  

Water levels drop below steady state water levels after 10 days with no recharge. 

 

The question that arises in terms of design is which drains are doing the most to maintain water levels at 

steady state conditions at the end of the 1-day storm event?  Figure C-12a shows contours of water level 

increase over steady state water levels on day 1 of the storm.  It is evident that only one drain array is 

able to keep water levels close to steady state conditions during the storm event. This drain array is 

located in the toe region.  Other drains are ineffectual due to installation elevations that are too high. 

A hypothetical simulation is conducted with all drains lowered by 10 ft.  Figure C-12b shows contours of 

water level increase over steady state water levels on day 1 of the storm.  Lowering drain elevations 

improves the effectiveness of the upper slope’s emergency drains in lowering water levels, but most of 

the gain in maintaining steady state water levels is acquired in the toe region of the slope.  The 

experiment is repeated given a lowering of all drains by 20 ft. Figure C-12c shows that effectiveness of 
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drains continues to improve, with more notable changes in the upper slope.  In conclusion, toe drains 

are most efficient in reducing water levels, with effectiveness of drains highly dependent on the 

elevation of these drains.  

 

 

 

 

 

 

 

 

(a)        (b) 

 

 

 

 

 

 

 

 

(c)  

Figure C-12: The maximum change in water level from steady state conditions (a) for estimated 

drain elevations, (b) drain elevations lowered 10 ft, (c) drain elevations lowered 20 ft. 

C-5 Geotechnical Analysis and Drain Arrays 

Figure C-13 shows a cross section down the central axis of the basin as provided in Figure C-3.  Using the 

Bishop simplified method two rotational failures are found for which FOS < 1.0.  A small rotational 

failure is predicted to occur below US 101 in the toe of the slope, and a larger rotational failure that 

extends upslope above the highway.  The critical water surface, for which failures are expected to occur 
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is shown as a dashed red line while the range in observed water levels in well H-1A-05 shows that at this 

location water levels are close to critical.   

 

Figure C-13: Estimated critical water surface and associated failures for which FOS < 1. 

 

Figure C-14 shows the water table profile estimated using the numeric model and the design storm 

event given no horizontal drains.  Water levels rise above the critical failure surface and failure will occur 

above and below the highway.  Figure C-15 shows several predicted water level profiles for the design 

storm given different drain configuration.  The blue-line represents water levels if only emergency drains 

are installed in the upper slope.  These drains are unable to sufficiently lower the water table surface 

below the critical water level in a majority of the slope and failure is likely.  Water table profiles for all 

drains and only slope toe drains are nearly identical.  This signifies that landslide toe drains are 

responsible for most (all) of the water level reduction and the upslope emergency drains are made 

obsolete after the toe drains are installed.   
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Figure C-13: Water levels predicted during the design storm given no horizontal drains and 

compared to the critical water surface. 

 

Figure C-14: Water levels predicted during the design storm given the emergency and toe drains are 

installed (purple line), only the toe drains are installed (dashed yellow line), and only the emergency 

drains are installed (blue line) 
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Appendix	D	

Major	Soils	and	Associated	Hydrologic	

Soil	Groups	in	the	United	States	

Two mechanisms are provided for obtaining the hydrologic soil group.  First, the National Resources 

Conservation Service (NRCS) interactive website can help isolate major soil groups for a region of 

interest as well as provide hydrologic soil group information.  NRCS tabulated values for major soils 

across the United States are provided (NRCS, 1986).  

D-1 NRCS Interactive Website 

A comprehensive list of soil surveys by state can be found on the National Resources Conservation 

Service (NRCS) website (http://websoilsurvey.nrcs.usda.gov/).  Follow the directions for creating and 

setting an area of interest (AOI) for which one can then access soil information and associated reports. 

Once an AOI is defined, soils are listed in the tab “Soil Map” with an example given below. 

 

Navigate to the tab “Soil Data Explorer” and find a sub-tab called “Soil Properties and Quantities”.  On 

the left, is a drop-down menu on “Soil Quantities and Features”. Hydrologic Soil Group is included as a 

heading. A screen shot of the site is given below.  
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Hit the button “View Rating”.  This results in tabulated summary of hydrologic soil group, 

 

Along with a color coded map of the AOI. 
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D-2 Tabulated Hydrologic Soil Groups for the United States 
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